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Read Me First

= Notes on Online Manual Usage
= How to Print

Notes on Online Manual Usage

» Reproduction, diversion or copying of any text, photo or image published in the Online Manual
(hereinafter referred to as "this guide"), in whole or in part, is prohibited.

* In principle, Canon shall change or delete the contents of this guide without prior notice to customers.
In addition, Canon may suspend or stop the disclosure of this guide due to unavoidable reasons.
Canon shall not be liable for any damage suffered by customers as a result of changes in or deletion
of information in this guide, or suspension/stoppage of disclosure of this guide.

» Although the contents of this guide have been prepared with utmost care, please contact the service
center if you find any incorrect or missing information.

* In principle, the descriptions in this guide are based on the product at the time of its initial sale.

» This guide does not disclose the manuals of all the products sold by Canon. See the manual supplied
with the product when using a product that is not described in this guide.

How to Print

Use the print function of your Web browser to print this guide.

To set to print background colors and images, follow the steps below.

> Note

* In Windows 8, print in the desktop version.

* In Internet Explorer 9, 10, or 11

1. Select {@} (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

* In Internet Explorer 8

1. Press the Alt key to display the menus.

Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.
2. Select Page Setup... from the File menu.
3. Select the Print Background Colors and Images checkbox.

* In Mozilla Firefox

1. Press the Alt key to display the menus.
Alternatively, click Firefox, then select Menu Bar from the right arrow of Options to display the
menus.

2. Select Page Setup... from the File menu.

3. Select the Print Background (colors & images) checkbox in Format & Options.

* In Google Chrome

1. Select = (Chrome Menu) > Print....
2. Select the Background colors & images checkbox in Options.
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How to Use the Online Manual

Symbols Used in This Document

A\ Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

3% Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»» Note

* Icons may vary depending on your product.

Touch-enabled Device Users

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"

with "press and hold."
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Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Android, Google Play and Picasa are either registered trademarks
or trademarks of Google Inc.

» Adobe, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are either
registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

» Photo Rag is a trademark of Hahnemdhle FineArt GmbH.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
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1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for
the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
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their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
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goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any

liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS
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Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Search Tips

You can search for target pages by entering keywords in the search window.

Canon » Language
Search Tips &

Online Manual

You can see manuals of your product and applications.

Product Manuals

You can learm how to handle and operate your product.

»» Note

» The displayed screen may vary.

* When searching from this page or the "Home" page without entering your product's model name or your
application's name, all products supported by this guide will be considered for the search.
If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

» Searching for Functions
Enter your product's model name and a keyword for the function you want to learn about
Example: When you want to learn how to load paper
Enter "(your product's model name) load paper" in the search window and perform a search
» Troubleshooting Errors
Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1000" in the search window and perform a search
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Cancn BN scries N

poor Code ; 1000

Paper has fun aut.
Mada Type : Plain Paper
Fage Size : Letler B.5"%11" 22¢28cm

1. Load paperinto the rear bray, 2, Pressihe printer’s Stat
button

If Emaor Parsicts

»» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions

Enter your application's name and a keyword for the function you want to learn about

Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

Enter your model name and a reference page title*

* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning

procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.
Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a

search
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Notes on Operation Explanations

In this guide, most of the operations are described based on the windows displayed when Windows 8.1
operating system (called Windows 8.1 below) or Windows 8 operating system (called Windows 8 below) is

used.
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Useful Functions Available on the Machine

» Connect Wirelessly with Ease in "Access Point Mode"

v

Print Photos Easily Using My Image Garden

v

Download a Variety of Content Materials

v

Print Items with Easy-PhotoPrint+ (Web Application)

v

Print Photos on Facebook Easily Using a Facebook App "Print Your Days"

Y

Connection Methods Available on the Machine

Y

Notice for Web Service Printing

Use PIXMA Cloud Link

v

v

Printing with Google Cloud Print

v

Checking Printer Information

» Online Storage Integration Function

» Print Easily from a Smartphone or Tablet with PIXMA Printing Solutions
» Printing with Windows RT
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Connect Wirelessly with Ease in "Access Point Mode™

The machine supports "access point mode" in which you can connect to the machine wirelessly from a
computer or smartphone even in an environment without an access point or wireless LAN router.
Switch to "access point mode" with simple steps to enjoy scanning and printing wirelessly.

When you use the machine with the access point mode, be sure to specify the access point name of the
machine and the security setting in advance.

= Using the Machine with the Access Point Mode
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Print Photos Easily Using My Image Garden

Organize Images Easily

In My Image Garden, you can register the names of people and events to photos.
You can organize photos easily as you can display them not only by folder but also by calendar, event,
and person. This also allows you to find the target photos easily when you search for them later on.

<Calendar View>

Display Recommended Items in Slide Shows

Based on the information registered to photos, Quick Menu automatically selects the photos on your
computer and creates recommended items such as collages and cards. The created items appear in slide
shows.

If there is an item you like, you can easily print it in just two steps.

1. In Image Display of Quick Menu, select the item you want to print.
2. Print the item with My Image Garden.
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Place Photos Automatically

Delightful items are created easily as the selected photos are placed automatically according to the
theme.

Other Various Functions

My Image Garden has many other useful functions.

Refer to "What You Can Do with My Image Garden" for details.
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Download a Variety of Content Materials

CREATIVE PARK

A "printing materials site" where you can download all the printing materials for free.

Various types of content such as seasonal cards and paper crafts that can be made by assembling paper
parts are provided.

It is easily accessible from Quick Menu.

CREATIVE PARK PREMIUM

A service where customers using models that support PREMIUM Contents can download exclusive
printing materials.

PREMIUM Contents can be downloaded easily via My Image Garden. Downloaded PREMIUM Contents
can be printed directly with My Image Garden.

To download PREMIUM Contents, make sure that genuine Canon ink tanks/ink cartridges are installed for
all colors on a supported printer.

»» Note

» The designs of PREMIUM Contents provided in this page are subject to change without prior notice.
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Print Items with Easy-PhotoPrint+ (Web Application)

You can easily create and print personalized items such as calendars and collages, anytime and anywhere,
by simply accessing Easy-PhotoPrint+ on the web from a computer or tablet.

By using Easy-PhotoPrint+, you can create items in the latest environment without going through the trouble
of installation.

Moreover, you can use various photos for your item through integration with social networks such as
Facebook, or with online storage, web albums, etc.

Refer to "Easy-PhotoPrint+ Guide" for details.
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Print Photos on Facebook Easily Using a Facebook App "Print
Your Days"

Use Print Your Days to collect Facebook photos of memories of parties and travel, recent activity of your
family and friends, your hobbies, etc., then create and print a work of art.
Print Your Days is available from the Print Your Days Facebook page.

Print and enjoy the

@xcitemant and

mismarias depicted

Facabook!
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Connection Methods Available on the Machine

The following connection methods are available on the machine.
()

With an access point

Without an access point
USB Connection

c D
&
-

Wireless Connection

Wireless Connection

There are two methods for connecting the printer to your device (such as a smartphone). One method is
to connect using an access point, and the other method is to connect without using an access point.
The two connection methods cannot be used at the same time.

If you have an access point (or wireless network router), it is recommended that you use the method
described in Connection Using an Access Point.

When connecting another device while a device is already connected to the printer, connect it using the
same connection method as the connected device.
If you connect using a different connection method, the connection to the device in use will be disabled.

Connection Using an Access Point

« Connect the printer and a device using an access point.

» Connection methods vary depending on the access point type.
* You can change network settings such as the SSID and security protocol on the printer.

P,
« When the connection between a device and an access point is completed and = (Wi-Fi icon) is
displayed in the device's screen, you can connect the device to the printer using the access point.
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Connection without Using an Access Point

o

Connect the printer and a device without using an access point. Connect a device and the printer
directly using the printer's access point mode function.

When establishing a connection in access point mode, Internet connection may become unavailable.
In that case, web services for the printer cannot be used.

If you connect a device connected to the Internet via an access point to the printer that is in access
point mode, the connection between the device and access point will be disabled. In that case, the
connection of the device may switch to a mobile data connection automatically depending on your
device. Transmission fees for connecting to the Internet using a mobile data connection apply.

In access point mode, you can connect up to five devices at the same time. If you try to connect a
sixth device while five devices are already connected, an error will appear.

If an error appears, disconnect a device that does not use the printer, then configure settings again.
Network settings such as the SSID and security protocol can be changed on the printer.

When Using Windows XP:

Connection without Using an Access Point (Windows XP)

Restrictions

(Appears in a new window)

USB Connection

Connect the printer and a computer with a USB cable. Prepare a USB cable.
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Connection without Using an Access Point (Windows XP)

Restrictions

(Appears in a new window)

1. Hold down the Wi-Fi button (A) on the printer until the Alarm lamp (B) flashes 3 times,
then release the Wi-Fi button after the third flash.

The printer's access point mode will be enabled.

[apTTE
- I_

B ] A

2. Check the SSID and network key of your printer.
The default SSID is the printer name. Print the LAN setting information and check the SSID field.

* How to print the LAN setting information

Hold down the Stop button on the printer until the Alarm lamp flashes 15 times, then release the
Stop button after the fifteenth flash.

The LAN setting information will be printed.

The default network key is the serial number of the printer. Check the rear side of the printer or
warranty.

3. Right-click the Wireless Network Connection icon in the notification area of the taskbar
on the computer, then select View Available Wireless Networks.

Charge Windows Firewal sethings

Oipars Nstwork Comnedtions

R
|'||ilu|||mI Available Wireless Networks I

4. Select the network name (SSID) you want to use, then click Connect.
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P—— Choose a wireless network
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6. When connection is complete, click Back until the screen below appears.
Proceed with the setup.

Canon - e . gy R
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et huel

Pl 1o B Paqused shiss using th prsbir =i LAK comnacsan I
The seten o sleescly completed, The comration s

wotoratcaly IF the seiup @ nat compimned Sollow this orescresn
AT 10 B o T B
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Restrictions

When connecting another device while a device (such as a smartphone) is already connected to the
printer, connect it using the same connection method as the connected device.
If you connect using a different connection method, the connection to the device in use will be disabled.

Connection Using a Wired Network cannot be performed on printers that do not support a wired
connection.

Connection Using an Access Point

Make sure that a device and an access point (or wireless network router) are connected. For details
on how to check the settings, refer to the manual supplied with the access point or contact its
manufacturer.

As for a device already connected to the printer without using an access point, reconnect it via an
access point.

The configuration, router functions, setup procedures and security settings of the network device vary
depending on your system environment. For details, refer to the manual of your network device or
contact its manufacturer.

Check if your device supports IEEE802.11n (2.4 GHz), IEEE802.11g or IEEE802.11b.

If your device is set to the "IEEE802.11n only" mode, WEP or TKIP cannot be used as a security
protocol. Change the security protocol for your device to something other than WEP and TKIP or
change the setting to something other than "IEEE802.11n only."

The connection between your device and the access point will be temporarily disabled while changing
the setting. Do not operate the screen of this guide until the setup is complete.

For office use, consult your network administrator.

Take added care when connecting to a network that is not protected with security measures, as there
is a risk of disclosing data such as your personal information to a third party.

Connection without Using an Access Point

32 Important

If you connect a device connected to the Internet via an access point to the printer that is in access
point mode, the connection between the device and access point will be disabled. In that case, the
connection of the device may switch to a mobile data connection automatically depending on your
device. When you connect to the Internet using a mobile data connection, charges may apply
depending on your contract.

* When you connect a device and the printer in access point mode, the connection information will
be saved to Wi-Fi settings. The device may be connected to the printer automatically even after
disconnecting it or connecting it to another access point.

* You cannot connect to an access point and the printer that is in access point mode at the same
time. If you have an access point, it is recommended that you use the access point to connect to
the printer.

» To prevent automatic connection to the printer that is in access point mode, change the
connection mode after using the printer, or set not to connect automatically in the Wi-Fi settings
of the device.

For details on how to change the settings of a device, refer to the manual supplied with the
device or contact its manufacturer.
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* When connecting a device and the printer in access point mode, Internet connection may become
unavailable. In that case, web services for the printer cannot be used.

* In access point mode, you can connect up to five devices at the same time. If you try to connect a
sixth device while five devices are already connected, an error will appear.
If an error appears, disconnect a device that does not use the printer, then configure settings again.

» Devices connected to the printer in access point mode cannot communicate with each other.

Firmware updates for the printer are not available while using the access point mode.

* When a device has been connected to the printer without using an access point and you want to set it
up again using the same connection method, disconnect it first. Disable the connection between the

device and printer in the Wi-Fi setting screen.
Connection Using a Wired Network

 This printer cannot be used over wireless and wired connections at the same time.
* When using a router, connect the printer and a device to the LAN side (same network segment).
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Notice for Web Service Printing

When Using Web Service

Canon does not guarantee the continuity and reliability of the web services provided, the availability of
site access, or permission to download the materials.

Canon may at any time update, change, or delete the information provided through the web service,
or may suspend or discontinue the service without prior notice. Canon shall not be held responsible
for any damages resulting from such actions.

In no event shall Canon be liable for any damages whatsoever resulting from the use of the web
services.

User registration is necessary before using the photo sharing site.

When you use the photo sharing site, observe the conditions of use of the site and use the service
within your own responsibility.

All or part of the web service may not be available depending on the country or region you live in.
Depending on your network environment, some functions on web service are not available. Even if
they are available, it may take a while to print or display the contents, or communication may be
interrupted while operation is in progress.

When you use web service, your machine's name, information of your region or country, your selected
language, and what kind of service you use (e.g. photo sharing site) are sent to and saved in our
server. Canon is unable to identify specific customers using this information.

Your login name and password for the photo sharing site are saved in the machine's memory (not
encrypted).

If you hand over the machine to anyone or dispose of it, delete your login name and password from
the machine's memory in advance.

The account information will be sent to Canon Inc. server (located in Japan), then forwarded to the
service provider's server.

Canon handles your account information as follows:

o Your account information will be used in personal identification process of the selected service.

o Canon will not provide your account information to any third party without your consent, except for
sending to the service provider or providing based on laws and regulations.

o After the conclusion of non-disclosure agreement, Canon may deposit your account information to
the contractor to achieve the purpose of use.

o Canon endeavors to secure the safety of your account information.

o ltis at your option to enter and send your account information. However, the service that requires
to enter your account information is not available unless you enter and send it.

o Your account information does not remain in Canon Inc. server. At the latest, it will be deleted
when you have disconnected your printer from LAN.

o For details, contact a Canon-authorized sales representative in the country or region you live in.

Copyrights and Rights of Publicity

When printing from the photo sharing site:

.

Observe the conditions of use of the photo sharing site when you use photos on the site.

It is unlawful to reproduce or edit the copyrighted work of another person without permission from the
copyright holder, except for personal use, use within the home, or other use within the limited scope
as defined by the copyright. Additionally, reproducing or editing photographs of people may infringe
on Rights of Publicity.
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When printing downloaded template forms:

1. The copyright of each material (photos, illustrations, logos, or documents: hereinafter referred to as
"the materials") provided on the web template printing service belongs to their respective owners.
Issues pertaining to Rights of Publicity may arise regarding the use of any of people or characters
displayed on the web template printing service.

Except as otherwise permitted (please see "2" below), copying, modifying or distributing all or a
portion of any of the materials contained on the web template printing service without prior consent of
the respective rights (Rights of Publicity and Copyright) holder is strictly prohibited.

2. All of the materials provided on the web template printing service can be freely used for personal and
non-commercial purposes.
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Use PIXMA Cloud Link

By using PIXMA Cloud Link, you can connect your printer to a cloud service, such as CANON iMAGE
GATEWAY, Evernote, or Twitter, and use the following functions from your printer or from the web browser
on your smartphone, tablet, or computer.

* Print images from a photo-sharing service
* Print documents from a data management service
+ Use Twitter to report the printer status, such as no paper or low ink levels.

In addition, you can use various functions by adding and registering apps that are linked with various cloud
services.

= Using PIXMA Cloud Link from Your Smartphone, Tablet, or Computer

3% Important

* In certain countries, PIXMA Cloud Link may not be available or the available apps may be different.

» Some apps require that you have an account before you use those apps. For such apps, please set up
an account beforehand.

* To find out which models support PIXMA Cloud Link check the Canon homepage.

» The screen display may change without prior notice.
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Using PIXMA Cloud Link from Your Smartphone, Tablet, or
Computer

» Before Using Canon Inkjet Cloud Printing Center

» Preparations Before Using Canon Inkjet Cloud Printing Center
» Using Canon Inkjet Cloud Printing Center

» Adding a Printer

» Troubleshooting Canon Inkjet Cloud Printing Center
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Before Using Canon Inkjet Cloud Printing Center

Canon Inkjet Cloud Printing Center is a service that links with the cloud function of the printer and allows you
to perform operations such as registering and managing apps from your smartphone or tablet device, and
checking the print status, print error, and ink status of the printer. You can also print app photos and
documents from your smartphone or tablet.

First, check the following content:

* Precautions

If you plan to use the web service to print documents, be sure to check these precautions beforehand.

* Printer specification

Check that Canon Inkjet Cloud Printing Center supports the printer.

* Network environment
The printer must be connected to a LAN and to the Internet.

32 Important

* The user will bear the cost of Internet access.

* Operating requirements

For computers, smartphones, and tablet devices, see "Requirements for Canon Inkjet Cloud Printing

Center operation".

22 Important

 This service may not be available in certain countries or regions. Also even if the service is available,
there are apps that cannot be used in certain regions.

= Preparations Before Using Canon Inkjet Cloud Printing Center
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Requirements for Canon Inkjet Cloud Printing Center operation

Computer
CPU x86 or x64 1.6 GHz or higher
RAM 2 GB or higher

Resolution 1024 x 768 pixels or higher

Monitor displa
Y Number of display colors 24 bits (true-color) or higher

oS Browser

Internet Explorer 8*
Windows XP SP3 or later Mozilla Firefox
Google Chrome

Internet Explorer 8%, 9
Windows Vista SP1 or later Mozilla Firefox
Google Chrome

Internet Explorer 8%, 9, 10
Windows 7 Mozilla Firefox
Google Chrome

Internet Explorer 10
Windows 8 Mozilla Firefox
Google Chrome

Internet Explorer 11
Windows 8.1 Mozilla Firefox
Google Chrome

Mac OS X v10.6-OS X Mavericks v10.9 | Safari 5.1, 6, 7

* When you use Internet Explorer 8, the web pages may not display correctly. Canon recommends that
you upgrade to Internet Explorer 9 or later, or use another browser.

Smartphone or tablet

(015 Browser Resolution
iOS 5.1 or later 320 x 480 (HVGA) or higher
OS standard browser
Android 2.3.3 or later 480 x 800 (HVGA) or higher

*Android3.x is not supported.

22 Important

» On the browser you are using, enable JavaScript and cookies.
« If you use the zoom function or change the font size on your browser, the web pages may not display
correctly.

+ If you use the translation function of Google Chrome, the web pages may not display correctly.

* If you use a proxy server outside of your country, the service may not be able to determine the correct
region.
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* In an in-house network environment, the 5222 port must be released. For confirmation instructions,
contact the network administrator.
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Preparations Before Using Canon Inkjet Cloud Printing Center

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
the user information.

1. Check that the printer is connected to the Internet

32 Important

» To use this function, you must connect this printer to the Internet.

2. Remote Ul startup

3. Select IJ Cloud Printing Center setup -> Register with this service

4. Follow the instructions displayed in the window, and run the authentication

5. When the printer registration screen is displayed, select Create new account

Canon IJ Cloud Printing Center E
Register with 1J Cloud Printing Center.
Linregistered users

Create new account
Registerad users

Add printer

| — |
v

6. Enter the E-mail address of the printer's owner, and then select OK

The registration page URL is sent to the e-mail address entered.
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Preparation

To create an account, enter your e-mail
address and the printer reqgi i0

Printer registration |D:

About printer registration 1D

Cancel

32 Important

» There are character restrictions for the e-mail address, as shown below.

* You can use up to 255 alphanumeric characters consisting of single-byte characters and
symbols (#$%&" +/=2"_{}|~.-@).

» Multibyte characters cannot be used.
You will get an error if the e-mail address you enter contains a character that cannot be used.

* If you registered a different e-mail address by mistake, you can cancel the registration by starting
the remote Ul and selecting IJ Cloud Printing Center setup -> Delete from this service.

* You may not be able to receive the notification if you are using a spam filter. If you have a setting
to receive only the e-mails from certain domains, be sure to change the setting to allow receiving
e-mails from "noreply@mail.cs.c-ij.com".

There will be no error display even if you could not receive the e-mail because of the spam filter
setting or if you entered an incorrect e-mail address.

> Note

* When you access the service from Remote Ul, the Printer registration ID is entered
automatically.

. When an e-mail with the subject "Information on Canon Inkjet Cloud Printing Center" is sent
to the e-mail address that you entered, select the URL

. In the License agreement and Privacy statement windows of Canon Inkjet Cloud Printing
Center, read the statements, and select Agree if you agree
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License agreement

- =
Important: Please read this before using
this service

Service Terms of Use

These Service Terms of Use (the "Terms")
are a binding agreement between you and
Canon Inc an™) which govern your
use of the defined in Arficle 1
heraof offared a Canon brand printer.
You may agree to the Terms !
"Agree”. Your use of the Service :
be deemed as agreement to the Terms. If
you do not agree to the Terms, you may
not use the Service,

Canon reserves the right to modify the
Terms at any time at its sole discretion.

VAl ears tha Tarme aras madiiad Mamsas

Do not agree Agree

Privacy statement

LEnaion 2

Important: Please read this before using
this service

Privacy Statement

This Privacy Statement (the "Privacy
Statement™) ibes information that
Canon Inc. { ;
rvice” defined in Article 1 herecf
yul the world (subject to certain
exceptions) and how this information is
used and disclos
you expressly agree
llection, use and disclosure of

9. In the user information entry screen, enter your Password, and select Next

Enter your password for logging in to the Canon Inkjet Cloud Printing Center.
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Register user info

Set a password for logging into this
SErvice.

Password:

Password (Confirmation):

12 charachars

Cancel

32 Important

* There are character restrictions for the Password, as shown below.

» The password needs to be between 8 and 32 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./;;<=>?@[\]*_"{|}~). (Alphabets are case-sensitive)

10. Enter the User name

Enter the name that identifies the user.

Register user info

Liser Mame:

1 b 20 charactars

Time zone:

UTC) Coordinated Universal Time b

32 Important

» The User name entry field has the following character restrictions:

» The password needs to be between 1 and 20 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./;;<=>?@[\*_"{|}~). (Alphabets are case-sensitive)
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11. Specify the Time zone setting, and select Next

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.

Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.

Register user info

Lisar Mame:

1 & 20 charactars

Time zone:

UTC) Coordinated Universal Time b

12. Enter the Security code and select Done

Enter the code for authenticating the user.

Register user info

0 5o & digits

2» Important

» The Security code entry field has the following character restrictions:

+ Single-byte numbers
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The registration is complete. A registration completion message is displayed.
When you select the OK button in the message, the login screen is displayed.

Enter the registered e-mail address and password, and log in to the Canon Inkjet Cloud Printing Center.

= Using Canon Inkjet Cloud Printing Center

48



Canon Inkjet Cloud Printing Center window

This section describes the Canon Inkjet Cloud Printing Center screens that are displayed on your
smartphone, tablet device, or computer.

= Description of the Login screen
= Description of the Main screen

Description of the Login screen

This section provides the description of the Login screen of Canon Inkjet Cloud Printing Center.

i ™

24

= -
—

Canan Ll Cleud Printing Cenler

Canon L Cloud Printing Center

E-mail address:

Pas=word

Keep kogin inlo

Resel passwoed rom benge

Crle e AD0iE]

Spsivmi-paremanis  Sobecre Boend s info

Ll 8 ]
Lo in
N o
32 Important
* You have 5 tries to enter your password. If you fail, you will not be able to log in for about the next
hour.

* You remain logged in for an hour after the last access.

Language
Select the language you will be using.

E-mail address
Enter the e-mail address that you entered in the user registration.

32 Important

* The e-mail address is case-sensitive. Make sure the case is correct.

Password
Enter the password that you entered in the user registration.

Keep login info
When you select the check box, the login screen is skipped for 14 days since the last day that the

service screen was accessed.

Reset password from here
Select this if you forgot the password.
Reset your password by following the instructions on the screen.
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Create new account
A new registration will be added to the Canon Inkjet Cloud Printing Center.

System requirements
This displays the system requirements for the Canon Inkjet Cloud Printing Center.

Help/legal notices (smartphone and tablet devices only)
The description of the Canon Inkjet Cloud Printing Center screen and various reminders are
displayed.

Software license info
The licensing information of Canon Inkjet Cloud Printing Center is displayed.

About this service
This displays the descriptions of this service.

Description of the Main screen

When you log in to the Canon Inkjet Cloud Printing Center, the Main screen appears.

With this service, the functions available to Standard user of the printer are different from those available
to the printer Administrator.
Standard user can only use the functions marked by an asterisk (*).

You can use areas shown below to start*, add, and manage apps.

If you are using a smartphone or a tablet, you can also print photos and documents.

= |f you are using a smartphone or tablet
= |f you are using a PC

If you are using a smartphone or tablet

Evarnabi

Dropbox

Google Drive

(1) Left context menu
(2) Printer name area
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(3) Right context menu

(4) Display area
(5) Menu area

(1) Left context menu

When you select E the Mng. printer screen of the Manage users screen appears.
For general users, the Select printer screen appears.

Mng. printer screen (Select printer screen)

—

I Mng. printer

Updated date: May 1, 2014 5:01 AM
v series @
Copy apps : x

+ Add printer

From the Mng. printer screen (Select printer screen), you can check*and update* printer information
registered to the Canon Inkjet Cloud Printing Center, change printer names, delete printers, add
printers, and copy apps.

* Check the printer information*

The registered printer name is displayed.

indicates the currently selected printer.

indicates that an error occurred on the printer.
+ Display update date/time of the printer information*

[—

e Mng. printer

Updated date: May 1, 2014 5:01 AM

v arias ]
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This displays the date and time the printer information was last updated.

refreshes the information.

+ Copy apps

Select this to copy apps added in the selected printer to another printer.

When you select , the screen shown below appears.
Copy registerad apps to another
printer.
® Dastination printer:
Source printer:

series

Cancel

Set the Destination printer and the Source printer. Then select OK.
» Change the printer name

When you select , a screen to change the printer name appears.
Follow the instructions on the screen to change the name.

»» Note

» The printer name entry has the following character limitation:

» Up to 128 characters

* Delete printers

When you select , the printer is deleted from the Canon Inkjet Cloud Printing Center.
When transferring the ownership of the printer, select Clear the information saved on the printer.

« Add printers

+ Add printer

Select this to add printers to be used in the Canon Inkjet Cloud Printing Center.

»» Note

» Up to 16 printers are guaranteed to operate for each e-mail address.
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Manage users screen

e Manage users —

Delete

User name Authority

Administrator

Standard user

Add user

From the Manage users screen, you can check user information registered to the Canon Inkjet Cloud
Printing Center, delete users, add users, and change the Administrator and Standard user settings.

* User deletion

Select the check box of the user to be deleted, and select Delete.
However, you cannot delete yourself. To delete yourself, cancel your membership from the user
information screen.

+ Adding a user

Select Add user. The user registration screen appears.

» Changing Administrator and Standard user settings

You can change the privileges of the Administrator and Standard users.

(2) Printer name area

The registered name of the printer selected is displayed.

The Administrator can change the printer name.

(3) Right context menu

When you select E the context menu appears.
The information displayed depends on the menu currently selected in the menu area.

The symbol indicates that there is a new unread notice.
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I+ series o

oo || Sont
IMAGSE

CATIVAY

Latest notices

User information

n Helpflegal notices

Log out

f Facebook
U Evernota

s

AppS Propaties Manage jebs

Sort
This displays the screen to sort registered apps.

You can use the El EI buttons to change the display order of apps. When you finish sorting,
press the Done button to confirm the order.

CANON iMAG

Flickr
Facek

Evernote

Cancel

Latest notices

Latest notices*

This displays the latest notices. The symbol indicates that there is a new unread notice.

M LIser information User information*

This displays the User information screen.
You can change the registered e-mail address, password, language, time zone, and other settings.

54



. Help/legal notices*

The description of the Canon Inkjet Cloud Printing Center screen and various reminders are
displayed.

This opens the Log out screen of the Canon Inkjet Cloud Printing Center.
(4) Display area
The display changes based on the menu you select.

I+ - series —

Caran
IMALEE CANON IMAGE GATEWAY

CATIWAY

q Scan to E-mail

Evernote

L Google Drive
- SkvDriva

Candg Properties Manage jobs

. Dropbox

®

(5) Menu area

The following 4 menu buttons are displayed:

. Apps Apps*

This displays the list of registered apps in the Display area.

- EECZEEE Config

This displays the Register apps screen in the Display area.
The display can be toggled between Registered and Search apps.

The Registered screen lists registered apps.
You can check the information of these apps or deregister them.
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series —

earch apps

CANON IMAGE GATEWAY

CANON ING. 0

Picasa Web Albums

CANON ING. (] ]

Flickr

CANDN INC.

Facebook

LR |

Caniig Proparties

On the Search apps screen, the apps that you can register by using the Canon Inkjet Cloud
Printing Center are displayed by category.
e sories

Registered | Search apps
Al
Latast

Frotography —
Lt sories =

Produciivity )
Rogstered  Search apps

Creativity
E\"':n:. Picasa Web Albums

CARON NG, 0’

Facebook

Cards

Crafls

GANON ING. []]

Flickr

CANDHN INC.

Phetos in Tweets

o When you select , the details of the app are displayed.
When you select m / - you can choose to register or unregister the app.

»» Note

 Description of displayed icons

: Cannot be used because it is not yet released, not available in your region, or does
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not support your model.

u : Can be used with genuine Canon ink.

Properties*

This screen displays the status of the printer that is currently selected.
You can check how much ink is remaining or details about an error that occurred. You can also
access the ink purchasing site and the Online Manual.

22 Important

» The Properties displayed may differ from the actual status at the display time, depending on
the printer status.

Manage jobs*

This screen displays the print status and the print history.

You can check the print status by looking at Status list, and the print history by looking at History.
You can also cancel print jobs and delete history information.

To cancel or delete a job, select that job and then select Cancel or Delete.

If you are using a PC

= Mng_ peintar Manage users Userinformation  stadions  Logoul
==

[ag apps to reamange the order.
_ﬁ:,.: Sort

WMAGE  CANON iMAGE GATEWAY
Config
Evernote

Properties
Dropbox

";E Marnage jobs

Google Drive

Latestnclices
OneDrive

Holice lial

Notices

Copyright CANCH ENC.

(1) Mng. printer (Select printer) button
(2) Manage users button

(3) Printer name area

(4) Menu area
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(5) Notices area
(6) Information area
(7) Global navigation area

(8) Display area

(1) Mng. printer (Select printer) button

When you select the Mng. printer (Select printer) button, the Mng. printer (Select printer) screen
appears.

=gy NG prirfed =& Manage users Ugef informalion  WREbudbans  Logoul
— -]

Primter list Close

Lipdatad datec Mar 4, 2074 4048 A

Copyapps || # Copy apps

HAudd printer

From the Mng. printer screen (Select printer screen), you can check*and update* printer information
registered to the Canon Inkjet Cloud Printing Center, change printer names, delete printers, add
printers, and copy apps.

* Check the printer information*

Copy apps

The registered printer name is displayed.

indicates the currently selected printer.

indicates that an error occurred on the printer.
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 Display update date/time of the printer information*

Userinformation Instructions Log out

Close

Updated date: Mar 4, 2014 4:59 AM

This displays the date and time the printer information was last updated.

refreshes the information.

+ Change the printer name

When you select , a screen to change the printer name appears.
Follow the instructions on the screen to change the name.

»» Note

» The printer name entry has the following character limitation:

» Up to 128 characters

* Delete printers

When you select , the printer is deleted from the Canon Inkjet Cloud Printing Center.
When transferring the ownership of the printer, select Clear the information saved on the printer.

* Add printers

=N
—

Add printer

Select this to add printers to be used in the Canon Inkjet Cloud Printing Center.

»» Note

» Up to 16 printers are guaranteed to operate for each e-mail address.

* Copy apps

Select this to copy apps added in the selected printer to another printer.

Copy apps

When you select , the screen shown below appears.
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Copy registered apps to another printer

® Destination printer:
Source printer:

Cancel

Set the Destination printer and the Source printer. Then select OK.

(2) Manage users button

When you select the Manage users button, the Manage users screen appears.

—:= Manage users Wsef informalion  Wastudcbons  Lag out
Uiser list
Delata

User name Aathority

Administrator

Standard user

+ A user

From the Manage users screen, you can check user information registered to the Canon Inkjet Cloud
Printing Center, delete users, add users, and change the Administrator and Standard user settings.

¢ User deletion

Select the check box of the user to be deleted, and select Delete.
However, you cannot delete yourself. To delete yourself, cancel your membership from the user
information screen.

+ Adding a user

Select Add user. The user registration screen appears.

+ Changing Administrator and Standard user settings

You can change the privileges of the Administrator and Standard users.

(3) Printer name area

The registered name of the printer selected is displayed.

The Administrator can use the Mng. printer functions to change the printer name.

(4) Menu area

The following 4 menu buttons are displayed:
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Sort (Apps)

This displays the list of registered apps in the Display area.
Drag the app to change the order.

Drag apps to rearrange the order

CAROH
|m:'§:‘£ CAMON iIMAGE GATEWAY

H Picasa Web Albums
I — = .
\ CREATIVE PARK PREMIUM
F paper craft
When you finish sorting, press the Set sort order button and confirm the order.

. E Config

This displays the Register apps screen in the Display area.
The display can be toggled between Registered and Search apps.

The Registered screen lists registered apps.
You can check the information of these apps or deregister them.

=i Mg pricier Manage users User informalion  Instuciions | Log oul

Regisierned Search apps

S0t = H

CANON IMAGE GATEWAY Picasa Web Albums

ol
Lonflg CANOMN NG CANON INE

OM ﬂ (5]

ool f

Flickr Facebook

Froperes

Manage jobs

CAHICH NG, CANOH NG
CREATIVE PARK PREMIUM
pop-up card

Farailable Mow

Floboe lis!

On the Search apps screen, the apps that you can register by using the Canon Inkjet Cloud
Printing Center are displayed by category.
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Posgpisdiened Seasch apps

Al
Prodographs Productnaly Croalmaly
Larfesd
Protography =
Picasa Web Albass. CAHOHN IMAGE GATEWAY
Producinaly
CAMOH . CAMON NG,

Manage jobs Creatmly

Cards
LATIVE PARK PREMILIM f
G Facabook

CAMON NG

o When you select , the details of the app are displayed.
When you select m / - you can choose to register or unregister the app.

»» Note

» Description of displayed icons

: Cannot be used because it is not yet released, not available in your region, or does
not support your model.

u : Can be used with genuine Canon ink.

. - Properties*

This screen displays the status of the printer that is currently selected.
You can check how much ink is remaining or details about an error that occurred. You can also
access the ink purchasing site and the Online Manual.

22 Important

» The Properties displayed may differ from the actual status at the display time, depending on
the printer status.

. E Manage jobs*

This screen displays the print status and the print history.

You can check the print status by looking at Status list, and the print history by looking at History.
You can also cancel print jobs and delete history information.

To cancel or delete a job, select that job and then select Cancel or Delete.
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History
Updaled date: Mar 3, 2014 455 &M

Dale ol i55ue Detaiks

Mar3, 2014 420 AM =S Prink-CANOM IMAGE G

Mar3, 2014 £19AM S Prink-CANON IMAGE G

=

Mar 3, 2014 217 AM INVITE

(5) Notices area

This displays the latest notice. Nothing is displayed in this area if there is no notice.
When you select Notice list, you can display up to 40 items.

(6) Information area

This display other information, including the privacy statement and other companies' licensing
information.

(7) Global navigation area

The User information®, Instructions™, and Log out* buttons are displayed.
Press the User information to change the settings.

ma==y, ling previes =& Manage users User information  Instudkons | Log oul
— [~}

Liser information

E-mail address:
Change

Change

Change

(UTC+:00) Tokyo Change

Securty code Change

Landguage:
English

Unsubscnbse from this
Pesform unsubscription. Unsubscribe

(8) Display area

The display changes based on the menu you select.
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==y Mnag peinter
—

Evernobe

Properties
Dropbox

| Manage jobs
Google Drive
Latestnofices

Thire are no new OneaDrive

Motices

Coryright CANON ENC.
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Using Canon Inkjet Cloud Printing Center

When the user registration is completed, you can log in to the Canon Inkjet Cloud Printing Center and use
the service.

1. From your PC, smartphone, or tablet, access the service login URL (http://cs.c-ij.com/)

2. On the Login screen, enter the E-mail address and Password, and then select Log in

2% Important

* The e-mail address and password are case-sensitive. Make sure the case is correct.

Canon IJ Cloud Printing Center E

E-mail address:

Password:

Keep login info

Login

Resel password from here

Create new account

E-mail address
Enter the e-mail address that you entered in the user registration.

Password
Enter the password that you entered in the user registration.

Keep login info
When you select the check box, the login screen is skipped for 14 days since the last day that the
service screen was accessed.

22 Important

« If you fail to log in five straight times, you will not be able to login again for an hour.
* You remain logged in for an hour after the last access.
» The service may not function properly if you log in from multiple devices at the same time.

After logging in, you can use useful services such as adding/managing apps that work in conjunction with
this product's cloud functionality and checking the ink status.

For screen descriptions and operation instructions, see "Canon Inkjet Cloud Printing Center window".

Printing procedure

This section introduces the photo printing procedure by using CANON iIMAGE GATEWAY as an example.
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32 Important

» The available functions differ depending on the app.

» The printing procedure differs depending on the app.

* You need to get the account and register photo and other data beforehand.

» The following file formats can be printed: jpg, jpeg, pdf, docx, doc, xlIsx, xlIs, pptx, ppt, and rtf.
The file formats that can be printed differ depending on the app.

» Before you print, check that printer is on and is connected to the network. Then start.

« This is available if you are using a smartphone or tablet.

»» Note

* You can use CANON iMAGE GATEWAY to print jpg and jpeg file formats.

1. On the Main screen, select the app to be used

2. Enter the information according to the instructions on the authentication screen, and then
select Log in

Country/Region:

Japan

User ID

Password

Cancel

3. In the displayed album list, select the album of your choice
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{ CANONIMAGE GATEWAY —

e
Sample00

Ei.""- Sample01

it
"='| Sample02
o

E Sample0dd
-]
W Sample04

<\ Sample05

5. Make the necessary print settings, and then select Print
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4 Print settings

.+ EEERL N -
i o

Selected : 5
Paper size Letter
Media type Plus Glossy Il
Print quality Standard
Border Borderless
Photo fix ON |

Red-EveCorrection

Print

6. A print job completion message appears, and printing starts

The print data has been sent.

Continue

To continue printing, select Continue, and perform the operation from Step 3.
To end the printing, select Apps. The screen returns to the apps list screen.

32 Important

« If a print job is not printed within 24 hours after the print job is issued, the print job will expire and
cannot be printed.

» With premium apps that limit the number of print jobs, print jobs that expire and cannot be printed are
also included in the print count.

= Adding a Printer
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Adding a Printer

With one account, you can use the Canon Inkjet Cloud Printing Center services on multiple printers.

The procedure for adding a printer is as follows:

1. From the browser on your smartphone, tablet, or computer, access the authentication site
URL

http://cs.c-ij.com/join

2. Select Add printer

Canon IJ Cloud Printing Center E
Register wilth IJ Cloud Printing Center.
Unregistered users

Create new account
Registered users

Add printer

Engisn____1g

3. When the confirmation message is displayed, select OK

4. Enter your Printer registration ID, and select OK
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Add printer

Add a printer. Enter the printer registration
ID.

Printer registration |D:

About printer registration 1D

Cancel

»» Note

* When you access the service from Remote Ul, the Printer registration ID is entered
automatically.

5. Enter the Password for the account you obtained beforehand, and select OK

Authentication is required to perform
this process. Enter your password.

E-mail address:

Fassword:

Printer addition is completed.
If a printer added message is not displayed, follow the instructions on the displayed screen.

= Troubleshooting Canon Inkjet Cloud Printing Center

70



Troubleshooting Canon Inkjet Cloud Printing Center

If an app cannot be installed

If the registered app is not in the Apps list

If the information is not updated when you press the Update button

If you do not receive the registration e-mail

Printing starts on its own even if you do not do anything

If you are unable to log in correctly even after entering the correct password in iOS or Mac

LR 2R 2% 2R 2 4

If an app cannot be installed

Check the country or region where the printer was purchased.
If the printer is taken outside the country or region where it was purchased, apps cannot be installed.

If the registered app is not in the Apps list

Check the display language of Canon Inkjet Cloud Printing Center.

If the display language is switched to a language that does not support an app, the app will not be
displayed in the apps list but will continue to be registered.

If you switch back to the target language of the app, it will be displayed in the apps list and you will be
able to start, register, or unregister the app.

If the information is not updated when you press the Update button

Because the Properties screen requires network connection with this product, the information may not be
reflected immediately. Please wait awhile, and then try updating the information again.
If the information is still not updated, then check that the product is connected to the Internet.

If you do not receive the registration e-mail

You may have entered a different e-mail address during the user registration of Canon Inkjet Cloud
Printing Center.

Remote Ul startup -> IJ Cloud Printing Center setup -> Delete from this service to delete the service
registration.

After resetting the printer, repeat the user registration of Canon Inkjet Cloud Printing Center from the
beginning.

Printing starts on its own even if you do not do anything

A third party may be able to illegally use the Canon Inkjet Cloud Printing Center services.
Remote Ul startup -> IJ Cloud Printing Center setup -> Delete from this service to delete the service

registration.
After resetting the printer, repeat the user registration of Canon Inkjet Cloud Printing Center from the
beginning.
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If you are unable to log in correctly even after entering the correct
password in iOS or Mac

If you are using iOS or Mac, and the password contains the ¥ symbol, enter a backslash instead. For
instructions on entering a backslash, see the OS help.
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Printing with Google Cloud Print

The printer is compatible with Google Cloud Print™ (Google Cloud Print is a service provided by Google
Inc.).

By using Google Cloud Print, you can print from anywhere with applications or services supporting Google
Cloud Print.

1. Preparations for Printing with Google Cloud Print

2. Printing from Computer or Smartphone with Google Cloud Print

22 Important

* LAN connection with the printer and Internet connection are required to register the printer and to print

with Google Cloud Print. Internet connection fees apply.
+ This function may not be available depending on the country or region you live in.
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Preparations for Printing with Google Cloud Print

To print with Google Cloud Print, you need to get Google account and register the printer with Google Cloud
Print in advance.

= Getting Google Account

If you already have Google account, register the printer.

= Registering the Printer with Google Cloud Print

Getting Google Account

First, get your Google account in order to register the printer with Google Cloud Print.

Access to Google Cloud Print with the web browser on the computer or the mobile device, then register
the required information.

Google

One account. All of Google.

| Slay signed in Need help?
Create an account

* The screen above may change without prior notice.

Registering the Printer with Google Cloud Print

Register the printer with Google Cloud Print.

The authentication procedure using the web browser on the computer or the mobile device is required in
the process of registering. Because the authentication URL is printed from printer when the authentication
process is performed, prepare A4 or Letter-sized plain paper.

32 Important

* LAN connection with the printer and Internet connection are required to register the printer and to
print with Google Cloud Print. Internet connection fees apply.
« If the printer's owner changes, delete the printer from Google Cloud Print.

1. Make sure that the printer is turned on
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2. Remote Ul startup

3. Select Google Cloud Print setup -> Register with Google Cloud Print
2> Note

« If you have already registered the printer with Google Cloud Print, the confirmation message to
re-register the printer is displayed.

4. When the confirmation screen to register the printer is displayed, select Yes

5. In the print setup for Google Cloud Print, select the display language, and then select
Authentication.

6. When the registration completion message appears, select OK.

Deleting the Printer from Google Cloud Print

If the printer's owner changes or if you want to re-register the printer, delete the printer from Google Cloud
Print by following the steps below.

1. Make sure that the printer is turned on

2. Remote Ul startup

3. Select Google Cloud Print setup -> Delete from Google Cloud Print.

4. When the confirmation screen to delete the printer is displayed, select Yes.
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Printing from Computer or Smartphone with Google Cloud Print

When you send print data with Google Cloud Print, the printer receives the print data and prints it
automatically if the printer is turned on.

When printing from a smartphone, tablet, computer, or other external device by using Google Cloud Print,
load paper into the printer in advance.

1. Make sure that the printer is turned on

> Note

+ If you want to send the print data from an outside location, turn on the printer in advance.

2. Send print data from your smartphone, tablet, or computer

The figure below is an example of when printing from the web browser corresponding with Google Cloud
Print. The screen differs depending on the applications or services supporting Google Cloud Print.

wiA

Mew tab

MNew windew

iy in;ggni‘tv wingdgrw
Bookmarks 3
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When the preparation for printing with Google Cloud Print is complete and when the printer is turned on,
the printer receives the print data and prints it automatically.

»» Note

» Depending on the communication status, it may take a while to print the print data or the printer may not
receive the print data.

» While printing with Google Cloud Print, the printing may be canceled depending on the printer's status,
such as when the printer is being operated or an error has occurred. To resume printing, check the
printer's status, then print with Google Cloud Print again.

 For print settings:

« If you select the media type other than plain paper or if you select the paper size other than A4/
Letter/B5/A5-size, the print data is printed in single-sided even when you select the duplex print
setting. (* The paper size differs depending on the model of your printer. For information about the
supported paper sizes, go to the Online Manual home page, and refer to the "Cannot Print Properly
with Automatic Duplex Printing" for your model.)
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« If you select plain paper as media type or if you select B5/A5-size as paper size, the print data is
printed with border even when you select the borderless print setting.

» The print results may differ from the print image depending on the print data.

» Depending on the device sending the print data, you may not select the print settings when sending
the print data with Google Cloud Print.
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Checking Printer Information

You can use your smartphone, tablet, or computer to check the Printer status and execute utility functions
from apps such as Canon Inkjet Print Utility and PIXMA Printing Solutions.

You can also use the convenient web services presented by Canon.

1. Selecting Printer Information in an Apps Screen

»» Note

* You can also enter IPv4 address directly in the web browser to display printer information.
1. Check that the printer has been turned on

2. Load one sheet of A4 size or Letter size plain paper
3. Hold down the Stop button until the Alarm lamp flashes 6 times
4. Release the button

Printing of the network setup information starts.

5. From your computer, smartphone, or tablet device, open the Web browser, and enter the
following URL:

http:// <Printer IP address>

For <Printer IP address>, enter the IP address that you checked in the previous procedure.

2. Entering Username and Administrator's Password

From the authentication screen, enter the Username and Password.

Username: ADMIN
Password: See "About the Administrator Password."

> Note

* The Username display may differ depending on your browser.

3. Displaying Printer Information

The top screen for printer information is displayed.
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Menu
Printer status
Utilities
Google Cloud Print setup
I Cloud Printing Center setup
Security

Firmware update

Manual {Online)

Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed
error information.
You can also connect to the ink purchase site or support page, and use Web Services.
Utilities
This function allows you to set and execute the printer utility functions such as cleaning.

Google Cloud Print setup
This function allows you to register this printer to Google Cloud Print or delete the printer.

IJ Cloud Printing Center setup
Allows you to register to IJ Cloud Printing Center or to delete a registration.

Security
Allows you to set the Administrator's password and Operation restrictions for the machine.

3% Important

 For the initial Password, see "About the Administrator Password."

For Security reasons, we recommend that you change the Password to an individual
password.
» The following character restrictions apply to the password that you enter:

+ Set the password by using 0 to 32 characters.
» The allowed characters are single-byte alphanumeric characters.

Firmware update
This function allows you to update the firmware and check version information.

Manual (Online)
This function displays the Online Manual.
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Online Storage Integration Function

The printer can integrate with online storage services such as Evernote.

Integration with Online Notetaking Service [Fd "Evernote"

If an Evernote client application is installed on your computer, you can import scanned images into the
application and upload them to the Evernote server.

The uploaded images can be browsed from other computers, smartphones, etc.

To use Evernote, you need to create an account. See the "CREATE ACCOUNT" page of Evernote for
account creation.

» Settings

In the Settings Dialog Box of IJ Scan Utility, select the item you want to set, then select Evernote for
Send to an application in Application Settings.
Refer to "Settings Dialog Box" for your model from Home of the Online Manual for details.

32 Important

» The Evernote service features are subject to change or termination without prior notice.
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Print Easily from a Smartphone or Tablet with PIXMA Printing
Solutions

Use PIXMA Printing Solutions to easily print photos saved on a smartphone or tablet wirelessly.
You can also receive scanned data (PDF or JPEG) directly on a smartphone or tablet without using a

computer.

PIXMA Printing Solutions can be downloaded from App Store and Google Play.
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Printing with Windows RT

When you use Windows RT, printing is easy because you simply connect this printer to the network.

For information about connecting to the network, see the setup URL (http://www.canon.com/ijsetup) for
using this product from your computer, smartphone, or tablet device.

When the connection is complete, the Canon Inkjet Print Utility software, which allows you to specify
detailed print settings, is downloaded automatically.

By using Canon Inkjet Print Utility, you can check the Printer status and specify detailed print settings. (The
available functions will differ depending on your usage environment and connection method.)
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Overview of the Machine

» Safety Guide

@ Safety Precautions
@ Regulatory and Safety Information

v

Main Components and Basic Operations
@ Main Components
@ About the Power Supply of the Machine

v

Loading Paper / Originals
@ Loading Paper
@ Loading Originals

v

Replacing a FINE Cartridge
@ Replacing a FINE Cartridge
@ Checking the Ink Status from Your Computer
@ Checking the Ink Status

v

Maintenance
@ When Printing Becomes Faint or Colors Are Incorrect
@ Performing Maintenance from a Computer
@ Cleaning the Machine

Y

Changing the Machine Settings

Changing Machine Settings from Your Computer
Changing the Machine Settings Using the Operation Panel
Initializing the Machine Settings

Disabling the Wireless LAN Function of the Machine

©E & & €

Y

Information about Network Connection
@ Useful Information about Network Connection

» About Network Communication

Changing and Confirming Network Settings
Screens for Network Connection of IJ Network Tool
Other Screens of |J Network Tool

Appendix for Network Communication

E & & €

» Tips for Ensuring Optimal Printing Quality
@ Useful Information about Ink
Key Points to Successful Printing
Be Sure to Make Paper Settings after Loading Paper
Canceling a Print Job
Storing Printed Images
Machine Handling Precautions
Key to Enjoying Consistent Printing Quality
Precautions for Safe Transport of the Machine

©E & & & ® © ¥

» Legal Limitations on Use of Your Product and Use of Images

» Specifications
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Safety Guide

» Safety Precautions

» Regulatory and Safety Information
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Safety Precautions

Choosing a location

» Do not install the machine in a location that is unstable or subject to excessive vibration.

* Do not install the machine in locations that are very humid or dusty, in direct sunlight, outdoors, or
close to a heating source.
To avoid the risk of fire or electric shocks, use the machine under the operating environment specified
in the On-screen Manual.

* Do not place the machine on a thick rug or carpet.

* Do not place the machine with its back attached to the wall.

Power supply

» Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the
power cord if necessary.

» Never remove the plug by pulling on the cord.
Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

» Do not use an extension lead/cord.

Working around the machine

» Never put your hands or fingers in the machine while it is printing.

* When moving the machine, carry the machine at both ends. In case the machine weighs more than
14 kg, it is recommended to have two people lifting the machine. Accidental dropping of the machine
causes injury. For the machine's weight, refer to the On-screen Manual.

» Do not place any object on the machine. Especially do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the machine.

» Do not transport or use the machine on a slant, vertically or upside-down, as the ink may leak and
damage the machine.

Working around the machine (For the multifunction printer)

* When loading a thick book on the Platen Glass, do not press hard on the Document Cover. The
Platen Glass may break and cause injury.

Print Heads/ink tanks and FINE Cartridges

» Keep ink tanks out of the reach of children. In case ink* is accidentally licked or swallowed, rinse out
mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.

* Clear Ink contains nitrate salts (For models containing Clear Ink).

* In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

» Never touch the electrical contacts on a Print Head or FINE Cartridges after printing.

The metal parts may be very hot and could cause burns.
» Do not throw ink tanks and FINE Cartridges into fire.
» Do not attempt to disassemble or modify the Print Head, ink tanks, and FINE Cartridges.
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Regulatory and Safety Information

For models containing lithium battery

» Dispose of used batteries according to the local regulations.
 Risk of explosion if battery is replaced by an incorrect type.

Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10405 (Contains FCC ID: AZDK30357)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

FCC ID:AZDK30357

Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This
equipment should be installed and operated with minimum distance at least 20cm between the radiator
and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or
operated with any other antenna or transmitter.

Canon U.S.A,, Inc.

One Canon Park
Melville, New York 11747
1-800-652-2666
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Users in Canada

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the
following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment and
meets RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and
operated keeping the radiator at least 20cm or more away from person's body (excluding extremities:
hands, wrists, feet and ankles).

Pour les usagers résidant au Canada

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts
de licence. L'exploitation est autorisée aux deux conditions suivantes :

(1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de I'appareil doit accepter tout brouillage
radioélectrique subi, méme si le brouillage est susceptible d'en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un
environnement non contrdlé et respecte les régles d'exposition aux fréquences radioélectriques (RF)
CNR-102 de I'lC. Cet équipement doit étre installé et utilisé en gardant une distance de 20 cm ou plus
entre le dispositif rayonnant et le corps (a I'exception des extrémités : mains, poignets, pieds et chevilles).

Users in Jordan

This printer contains WLAN Module approved by TRC/LPD/2013/130
Name of WLAN Module : K30357

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

h24

This symbol indicates that this product is not to be disposed of with your household waste, according to
the WEEE Directive (2012/19/EU) and national legislation. This product should be handed over to a
designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product
or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper
handling of this type of waste could have a possible negative impact on the environment and human
health due to potentially hazardous substances that are generally associated with EEE. At the same time,
your cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about where you can drop off your waste equipment for recycling, please
contact your local city office, waste authority, approved WEEE scheme or your household waste disposal
service. For more information regarding return and recycling of WEEE products, please visit www.canon-
europe.com/weee.
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Korisnici u Srbiji

h2d

Ovaj simbol oznacava da ovaj proizvod ne sme da se odlaze sa ostalim kuénim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU) i nacionalnim zakonima. Ovaj proizvod treba predati odredenom centru
za prikupljanje, npr. na osnovi "jedan-za-jedan" kada kupujete sli¢an novi proizvod, ili ovlaS¢enom centru
za prikupljanje za reciklazu istroSene elektricne i elektronske opreme (EEE). Nepravilno rukovanje ovom
vrstom otpada moze da ima moguce negativne posledice po zivotnu sredinu i ljudsko zdravlje usled
potencijalno opasnih materijala koji se uglavnhom vezuju za EEE. U isto vreme, va8a saradnja na
ispravnom odlaganju ovog proizvoda ¢e doprineti efikasnom koriS¢enju prirodnih resursa. Za viSe
informacija o tome gde mozZete da predate vadu staru opremu radi recikliranje, vas molimo, da
kontaktirate lokalne gradske vlasti, komunalne sluzbe, odobreni plan reciklaze ili Gradsku Cistoéu. Za vise
informacija o vracanju i recikliranju WEEE proizvoda, posetite stranicu www.canon-europe.com/weee.

India only.

)i¢

This product is not to be disposed of with your household waste, according to the e-waste (Management
and Handling) Rules, 2011.

This product should be handed over to a designated collection point, e.g., to an authorized collection site
for recycling waste electrical and electronic equipment (EEE). Improper handling of this type of waste
could have a possible negative impact on the environment and human health due to potentially hazardous
substances that are generally associated with EEE. At the same time, your cooperation in the correct
disposal of this product will contribute to the effective usage of natural resources. For more information
regarding return and recycling of WEEE products, please visit http://www.canon.co.in/environment/.

Also, this product complies with the "India E-waste Rule 2011" and prohibits use of lead, mercury,
hexavalent chromium, polybrominated biphenyls or polybrominated diphenyl ethers in concentrations
exceeding 0.1 % by weight and 0.01 % by weight for Cadmium, except for the exemptions set in Schedule
Il of the Rule.

Environmental Information

Reducing your environmental impact while saving money

Power Consumption and Activation Time

The amount of electricity a device consumes depends on the way the device is used. This product is
designed and set in a way to allow you to reduce your electricity costs. After the last print it switches to
Ready Mode. In this mode it can print again immediately if required. If the product is not used for a time,
the device switches to its Power Save Mode. The devices consume less power (Watt) in these modes.
If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode,
please consider that this device may then only switch to a lower energy level after a longer period of
time or not at all.

Canon does not recommend extending the Activation Times from the optimum ones set as default.
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Energy Star®

The Energy Star® programme is a voluntary scheme to promote the development and purchase of
energy efficient models, which help to minimise environmental impact.

Products which meet the stringent requirements of the Energy Star® programme for both environmental
benefits and the amount of energy consumption will carry the Energy Star® logo accordingly.

Paper types

This product can be used to print on both recycled and virgin paper (certified to an environmental
stewardship scheme), which complies with EN12281 or a similar quality standard. In addition it can

support printing on media down to a weight of 64g/m2, lighter paper means less resources used and a
lower environmental footprint for your printing needs.

Regulatory Model Code (RMC) is for identification and proof that the product complies with the
regulations. Please note that RMC is different from the marketing model number of the product.

)

ENERGY STAR

m
m
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Main Components and Basic Operations

» Main Components

» About the Power Supply of the Machine
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Main Components

» Front View
» Rear View
» Inside View

» Operation Panel
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Front View

(1) (2) (3)

(4)

(7) (8) (3)

(1) document cover
Open to load an original on the platen glass.

(2) paper support

Open to load paper in the rear tray.
(3) paper guide

Align with the left side of the paper stack.
(4) rear tray

Load paper here. Two or more sheets of the same size and type of paper can be loaded at the same
time, and fed automatically one sheet at a time.

= | oading Plain Paper / Photo Paper
= | oading Envelopes

(5) cover
Open to replace the FINE cartridge or remove jammed paper inside the machine.

(6) paper output tray
Printed paper is ejected. Pull out it before printing.

(7) output tray extension
Extend to support ejected paper. Extend it when printing.
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(8) (9)

(8) operation panel
Use to change the settings of the machine or to operate it.

= QOperation Panel

(9) platen glass
Load an original here.
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Rear View

(1) (2)

(1) power cord connector
Plug in the supplied power cord.

(2) USB port
Plug in the USB cable to connect the machine with a computer.

32 Important

* Do not touch the metal casing.
* Do not plug in or unplug the USB cable while the machine is printing or scanning originals with the
computer.
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Inside View

(1) FINE cartridge (ink cartridges)
A replaceable cartridge that integrates print head and ink tank.

(2) FINE cartridge holder
Install the FINE cartridge.

The color FINE cartridge should be installed into the left slot and the black FINE cartridge should be
installed into the right slot.

> Note

 For details on replacing a FINE cartridge, see Replacing a FINE Cartridge.

22 Important

» The area around the parts (A) may be splattered with ink. This does not affect the performance of the
machine.
» Do not touch the parts (A). The machine may not print properly if you touch them.
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Operation Panel

* All lamps on the operation panel are shown lit in the figure below for explanatory purposes.

()
(2) ——t—s (&
(3) ———
(4) ——— (w0

(5) —— &

iﬁ}—

(1) —— ]
(8) —— © |

()

(1) ON button
Turns the power on or off. Before turning on the power, make sure that the document cover is closed.

= Turning the Machine On and Off
(2) ON lamp

Lights after flashing when the power is turned on.

»» Note

* You can check the status of the machine by the ON and Alarm lamps.

» ON lamp is off: The power is off.

* ON lamp lights: The machine is ready to print.

* ON lamp flashes: The machine is getting ready to print, or printing is in progress.

» Alarm lamp flashes: An error has occurred and the machine is not ready to print.

* ON lamp flashes and Alarm lamp flashes alternately: An error that requires contacting the service
center may have occurred.

= |f an Error Occurs

(3) Wi-Fi button
Hold down to automatically set up the wireless LAN connection.
(4) Wi-Fi lamp
Lights or flashes to indicate the wireless LAN status.
Lights:
Wireless LAN connection is enabled.
Flashes:

Printing or scanning over wireless LAN. Also flashes while configuring the wireless LAN
connection.
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(5) Alarm lamp
Lights or flashes when an error occurs. When performing machine maintenance or machine settings,
options can be selected according to the number of flashes.

(6) ink lamps
Light or flash when ink runs out, etc.

The upper lamp indicates the black FINE cartridge status, the lower lamp the color FINE cartridge
status.

(7) Stop button
Cancels operations. You can press this button to cancel a print, copy, or scan job in progress. Holding
this button down lets you select maintenance options or machine settings.

(8) Black button*
Starts black & white copying. You can also press this button to finalize your selection for the setting
item.

(9) Color button*
Starts color copying. You can also press this button to finalize your selection for the setting item.

* In the software applications or manuals, the Color and Black buttons are collectively called the "Start" or
"OK" button.
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About the Power Supply of the Machine

» Confirming that the Power Is On
» Turning the Machine On and Off
» Notice for the Power Plug/Power Cord

» Notice for Unplugging the Power Cord
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Confirming that the Power Is On

The ON lamp is lit when the machine is turned on.

»» Note

+ It may take a while for the machine to start printing immediately after you turn on the machine.
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Turning the Machine On and Off

Turning on the machine

1. Press the ON button to turn on the machine.

The ON lamp flashes and then remains lit.

= Confirming that the Power Is On

> Note

* It may take a while for the machine to start printing immediately after you turn on the machine.

« |If the Alarm lamp lights up or flashes, see If an Error Occurs.

* You can set the machine to automatically turn on when a print or scan operation is performed
from a computer connected by USB cable or wireless network. This feature is set to off by
default. For details on the auto power on feature, see below.

From the machine

= Turning on/off the Machine Automatically

From the computer

= Managing the Printer Power

Turning off the machine

1. Press the ON button to turn off the machine.

When the ON lamp stops flashing, the machine is turned off.

P

32 Important

» When you unplug the power cord after turning off the machine, be sure to confirm that the ON

lamp is off.
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»» Note

* You can set the machine to automatically turn off when no operations are performed or no print
jobs are sent to the machine for a certain interval. This is the default setting. For details on the
auto power off feature, see below.

From the machine

= Turning on/off the Machine Automatically

From the computer

= Managing the Printer Power
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Notice for the Power Plug/Power Cord

Unplug the power cord once a month to confirm that the power plug/power cord does not have anything
unusual described below.

» The power plug/power cord is hot.

» The power plug/power cord is rusty.
» The power plug/power cord is bent.
» The power plug/power cord is worn.
» The power plug/power cord is split.

/% Caution

* If you find anything unusual with the power plug/power cord described above, unplug the power cord
and call for service. Using the machine with one of the unusual conditions above may cause a fire or an
electric shock.
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Notice for Unplugging the Power Cord

To unplug the power cord, follow the procedure below.

22 Important

* When you unplug the power cord, press the ON button, then confirm that the ON lamp is off.
Unplugging the power cord while the ON lamp is lit or flashing may cause drying or clogging of the print
head and print quality may be reduced.

1. Press the ON button to turn the machine off.

3. Unplug the power cord.

The specification of the power cord differs depending on the country or region of use.
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Loading Paper / Originals

» Loading Paper

» Loading Originals

104



Loading Paper

» Loading Plain Paper / Photo Paper
*» Loading Envelopes

» Media Types You Can Use

» Media Types You Cannot Use

» Printing Area
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Loading Plain Paper / Photo Paper

You can load plain paper or photo paper.

22 Important

* If you cut plain paper into small size such as 4" x 6" (10 x 15 cm) or 5" x 7" (13 x 18 cm) to perform trial
print, it can cause paper jams.

»» Note

* We recommend Canon genuine photo paper for printing photos.

For details on the Canon genuine paper, see Media Types You Can Use.

* You can use general copy paper.

For the page size and paper weight you can use for this machine, see Media Types You Can Use.

1. Prepare paper.

Align the edges of paper. If paper is curled, flatten it.

»» Note

+ Align the edges of paper neatly before loading. Loading paper without aligning the edges may
cause paper jams.

« If paper is curled, hold the curled corners and gently bend them in the opposite direction until the
paper becomes completely flat.

For details on how to flatten curled paper, see "Load the paper after correcting its curl." in Paper |s
Smudged/Printed Surface Is Scratched.

2. Load paper.
1. Open the paper support.

2. Pull out the paper output tray and the output tray extension.
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(1)

()

3. Slide the paper guide (A) to the left, and load the paper against the far right of the rear tray
WITH THE PRINT SIDE FACING YOU.

4. Slide the paper guide (A) to align it with the paper stack.
Do not slide the paper guide too hard against the paper. The paper may not be fed properly.
(4) (A) (3)

2% Important

» Always load paper in the portrait orientation (B). Loading paper in the landscape orientation (C) can
cause paper jams.

(B) (C)

23 Note

» Do not load sheets of paper higher than the load limit mark (D).
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22> Note

» The machine may make operating noise when feeding paper.
+ After loading paper, select the size and type of the loaded paper on the print settings screen of the
printer driver.
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Loading Envelopes

You can load Envelope DL and Envelope Com 10.

The address is automatically rotated and printed according to the envelope's direction by specifying with the

printer driver properly.

22 Important

* Printing of envelopes from a digital camera is not supported.
» Do not use the following envelopes. They could jam in the machine or cause the machine to

malfunction.

» Envelopes with an embossed or treated surface

» Envelopes with a double flap
* Envelopes whose gummed flaps are already moistened and adhesive

1. Prepare envelopes.

» Press down on all four corners and edges of the envelopes to flatten them.

+ If the envelopes are curled, hold the opposite corners and gently twist them in the opposite

direction.

« If the corner of the envelope flap is folded, flatten it.
» Use a pen to press the leading edge in the inserting direction flat and sharpen the crease.

ST s

WS-

The figures above show a side view of the leading edge of the envelope.

3% Important

* The envelopes may jam in the machine if they are not flat or the edges are not aligned. Make sure
that no curl or puff exceeds 0.1 inch (3 mm).

2. Load envelopes.
1. Open the paper support.

2. Pull out the paper output tray and the output tray extension.
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(1)

()

. Slide the paper guide (A) to the left, and load the envelopes against the far right of the rear
tray WITH THE PRINT SIDE FACING YOU.

The folded flap of the envelope will be faced up on the left side.

Up to 5 envelopes can be loaded at once.

. Slide the paper guide (A) to align it with the envelopes.
Do not slide the paper guide too hard against the envelopes. The envelopes may not be fed properly.

(4) (A) (3)

(B} (C)

(B) Rear side
(C) Address side
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22 Note

» Do not load envelopes higher than the load limit mark (D).

22> Note

» The machine may make operating noise when feeding envelopes.
« After loading envelopes, select the size and type of the loaded envelopes on the print settings screen of
the printer driver.
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Media Types You Can Use

Use plain paper for printing texts or photo paper for printing photos, for the best print results. We
recommend the use of Canon genuine paper for printing your important photos.

Media Types

Commercially available papers

+ Plain Paper (including recycled paper)
* Envelopes*1

Canon genuine papers

The Model Number of Canon genuine paper is shown in brackets. Refer to the instruction manual
supplied with the paper for detailed information on the printable side and notes on handling paper. For
information on the page sizes available for each Canon genuine paper, access our website.

»» Note

* You may not be able to purchase some Canon genuine papers depending on the country or region
of purchase. Paper is not sold in the US by Model Number. Purchase paper by name.

Paper for printing photos:

* Glossy Photo Paper "Everyday Use" <GP-501/GP-601>*1
» Photo Paper Glossy <GP-601>*1
» Photo Paper Plus Glossy Il <PP-201>

*1 Printing to this paper from a digital camera is not supported.

= Paper Load Limit
= Paper Settings on the Printer Driver

»» Note

* When printing photos saved on a PictBridge compliant device, you must specify the page size and
media type.

= Printing from a Digital Camera

Page Sizes

You can use the following page sizes.

»» Note

* Printing on the following paper sizes from a digital camera is not supported.

» B5, A5, Legal, and Envelopes

Standard sizes:
e Letter
* Legal
« A5
- A4
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* B5

* 4" x6" (10 x 15 cm)

* 5"x7"(13x 18 cm)

* Envelope DL

* Envelope Com 10
Non-standard sizes:

You can print on non-standard size paper within the following ranges.

* Minimum size: 4.00 x 6.00 inches (101.6 x 152.4 mm)
* Maximum size: 8.50 x 26.61 inches (215.9 x 676.0 mm)

Paper Weight
You can use paper in the following weight range.

+ 17 to 28 Ib (64 to 105 g /m2) (plain paper except for Canon genuine paper)

Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the machine.

Notes on Storing Paper

» Take out only the necessary number of paper from the package, just before printing.
» To avoid curling, when you do not print, put unused paper back into the package and keep it on a
level surface. And also, store it avoiding heat, humidity, and direct sunlight.
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Paper Load Limit

Commercially Available Papers

Media Name

Rear Tray

Paper Output Tray

Plain Paper (including recycled paper)

Approx. 60 sheets
(10 sheets: Legal)

Approx. 10 sheets

Envelopes

5 envelopes

Canon Genuine Papers

»>» Note

* We recommend that you remove the previously printed sheet from the paper output tray before

continuously printing to avoid blurs and discoloration.

Paper for printing photos:

Media Name <Model No.>

Rear Tray

Glossy Photo Paper "Everyday Use" <GP-501/GP-601>*2

20 sheets: 4" x 6" (10 x 15 cm)

Photo Paper Glossy <GP-601>*2

20 sheets: 4" x 6" (10 x 15 cm)

Photo Paper Plus Glossy Il <PP-201>*2

10 sheets: 5" x 7" (13 x 18 cm)
20 sheets: 4" x 6" (10 x 15 cm)

*1 We recommend that you remove the previously printed envelope from the paper output tray before
continuously printing to avoid blurs and discoloration.
*2 When loading paper in stacks, the print side may become marked as it is fed or paper may not feed

properly. In this case, load one sheet at a time.
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Media Types You Cannot Use

Do not use the following types of paper. Using such paper will cause not only unsatisfactory results, but also
the machine to jam or malfunction.

* Folded, curled, or wrinkled paper

» Damp paper

« Paper that is too thin (weighing less than 17 Ib (64 g /m?))

« Paper that is too thick (plain paper weighing more than 28 Ib (105 g /m2), except for Canon genuine
paper)

» Paper thinner than a postcard, including plain paper or notepad paper cut to a small size (when printing
on paper smaller than A5)

* Picture postcards

» Postcards

» Envelopes with a double flap

* Envelopes with an embossed or treated surface

» Envelopes whose gummed flaps are already moistened and adhesive

» Any type of paper with holes

» Paper that is not rectangular

» Paper bound with staples or glue

» Paper with adhesives

» Paper decorated with glitter, etc.
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Printing Area

* Printing Area
» Other Sizes than Letter, Legal, Envelopes
> Letter, Legal

» Envelopes
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Printing Area

To ensure the best print quality, the machine allows a margin along each edge of media. The actual
printable area will be the area inside these margins.

Recommended printing area M : Canon recommends that you print within this area.

Printable area 1 : The area where it is possible to print. However, printing in this area can affect the print
quality or the paper feed precision.
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Other Sizes than Letter, Legal, Envelopes

Size Printable Area (width x height)
A5 5.56 x 7.49 inches (141.2 x 190.3 mm)
A4 8.00 x 10.92 inches (203.2 x 277.3 mm)
B5 6.90 x 9.34 inches (175.2 x 237.3 mm)
4" x 6" (10 x 15 cm) 3.73 x 5.22 inches (94.8 x 132.7 mm)
5"x 7" (13 x 18 cm) 4.73 x 6.22 inches (120.2 x 158.1 mm)
}
c) - 5
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@ | 1] | ©
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Il Recommended printing area

(A) 1.24 inches (31.6 mm)
(B) 1.15 inches (29.2 mm)

[ Printable area

(C) 0.12inch (3.0 mm)
(D) 0.66 inch (16.7 mm)
(E) 0.13 inch (3.4 mm)
(F) 0.13 inch (3.4 mm)
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Letter, Legal

Size Printable Area (width x height)
Letter 8.00 x 10.22 inches (203.2 x 259.7 mm)
Legal 8.00 x 13.22 inches (203.2 x 335.9 mm)
b T2
o S B

I Recommended printing area

(A) 1.24 inches (31.6 mm)
(B) 1.15 inches (29.2 mm)

1 Printable area

(C) 0.12 inch (3.0 mm)
(D) 0.66 inch (16.7 mm)
(E) 0.25 inch (6.4 mm)
(F) 0.25 inch (6.3 mm)

119




Envelopes

Size Recommended Printing Area (width x height)

Envelope DL 3.88 x 7.06 inches (98.8 x 179.5 mm)

Envelope Com 10 3.68 x 7.90 inches (93.5 x 200.8 mm)

&
(A) T
® 73 :
-t :-|- -I-: |-
(C) (D)

Il Recommended printing area

(A) 0.31 inch (8.0 mm)
(B) 1.28 inches (32.5 mm)
(C) 0.22 inch (5.6 mm)
(D) 0.22 inch (5.6 mm)
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Loading Originals

» Loading Originals on the Platen Glass

» Originals You Can Load
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Loading Originals on the Platen Glass

1. Load an original on the platen glass.

1. Open the document cover.

2% Important

» Do not place any object on the document cover. It will fall into the rear tray when the document cover
is opened and cause the machine to malfunction.

2. Load the original WITH THE SIDE TO SCAN FACING DOWN on the platen glass.
= QOriginals You Can Load

Align the corner of the original with the alignment mark E

(1)

(2)

2» Important

» Be sure to observe the following when loading the original on the platen glass.

» Do not place any objects weighing 4.4 Ib (2.0 kg) or more on the platen glass.

* Do not put any pressure of 4.4 Ib (2.0 kg) or more on the platen glass, such as pressing down
the original.

Failure to observe the above may cause the scanner to malfunction or the platen glass to break.

» The machine cannot scan the striped area (A) (0.04 inch (1 mm) from the edges of the platen
glass).

s B

(A)

f "

2. Close the document cover gently.
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32 Important

+ After loading the original on the platen glass, be sure to close the document cover before starting to
copy or scan.
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Originals You Can Load

Item

Details

Types of originals

- Text document, magazine, or newspaper

- Printed photo, postcard, business card, or disc (BD/DVD/CD, etc.)

Size (width x height)

Max. 8.5 x 11.7 inches (216 x 297 mm)

124




Replacing a FINE Cartridge

» Replacing a FINE Cartridge
» Checking the Ink Status
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Replacing a FINE Cartridge

When remaining ink cautions or errors occur, the ink lamps and the Alarm lamp will flash to inform you of
the error. Count the number of flashes and take appropriate action.

= |f an Error Occurs

Replacing Procedure

When you need to replace a FINE cartridge, follow the procedure below.

32 Important

» Do not touch the electrical contacts (A) or print head nozzle (B) on a FINE cartridge. The machine
may not print properly if you touch them.

(B)

* If you remove a FINE cartridge, replace it immediately. Do not leave the machine with the FINE
cartridge removed.

» Use a new FINE cartridge for replacement. Installing a used FINE cartridge may cause the nozzles to
clog.

Furthermore, with such a FINE cartridge, the machine will not be able to inform you when to replace
the FINE cartridge properly.

» Once a FINE cartridge has been installed, do not remove it from the machine and leave it out in the
open. This will cause the FINE cartridge to dry out, and the machine may not operate properly when it
is reinstalled. To maintain optimal printing quality, use a FINE cartridge within six months of first use.

»>» Note

« If a FINE cartridge runs out of ink, you can print with either color or black FINE cartridge, in whichever
ink remains, only for a while. However the print quality may be reduced compared to when printing
with both cartridges. We recommend to use a new FINE cartridge in order to obtain optimum
qualities.

Even when printing with one ink only, print with leaving the empty FINE cartridge installed. If either of
the color FINE cartridge or black FINE cartridge is not installed, an error occurs and the machine
cannot print.

For information on how to configure this setting, see Setting the Ink Cartridge to be Used.

» Color ink may be consumed even when printing a black-and-white document or when black-and-
white printing is specified.

Both color ink and black ink are also consumed in the standard cleaning and deep cleaning of the
print head, which may be necessary to maintain the performance of the machine. When ink runs out,
replace the FINE cartridge immediately with a new one.
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= Useful Information about Ink

1. Make sure that the power is turned on.

2. Retract the paper output tray and the output tray extension.

3. Open the cover.

4. The FINE cartridge holder moves to the replacement position.

/1 Caution

» Do not hold the FINE cartridge holder to stop or move it forcibly. Do not touch the FINE
cartridge holder until it stops completely.

22 Important

» The inside of the machine may be stained with ink. Be careful not to stain your hands or
clothing when replacing the FINE cartridge. You can easily wipe off the ink from the inside of
the machine with tissue paper or the like.

* Do not touch the metallic parts or other parts inside the machine.

« If the cover is left open for more than 10 minutes, the FINE cartridge holder may move and the
Alarm lamp light. In this case, close the cover, then open it again.

5. Remove the empty FINE cartridge.

1. Push down the FINE cartridge until it clicks.

2. Remove the FINE cartridge.
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22 Important

Handle the FINE cartridge carefully to avoid staining of clothing or the surrounding area.
Discard the empty FINE cartridge according to the local laws and regulations regarding disposal

of consumables.

6. Prepare a new FINE cartridge.

1. Take a new FINE cartridge out of its package and remove the protective tape (C) gently.

™

22 Important

If you shake a FINE cartridge, ink may spill out and stain your hands and the surrounding area.
Handle a FINE cartridge carefully.

Be careful not to stain your hands and the surrounding area with ink on the removed protective
tape.

Do not reattach the protective tape once you have removed it. Discard it according to the local
laws and regulations regarding disposal of consumables.

Do not touch the electrical contacts or print head nozzle on a FINE cartridge. The machine may
not print properly if you touch them.
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7. Install the FINE cartridge.

1. Insert the new FINE cartridge at a slant into the FINE cartridge holder.

The color FINE cartridge should be installed into the left slot and the black FINE cartridge should be
installed into the right slot.

2% Important

« Insert the FINE cartridge gently so that it does not hit the electrical contacts on the FINE cartridge
holder.

2. Push the FINE cartridge in and up firmly until it snaps into place.
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3% Important

» Check if the FINE cartridge is installed correctly.
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» The machine cannot print unless both the color FINE cartridge and black FINE cartridge are
installed. Be sure to install both cartridges.

8. Close the cover.

»» Note

« If the Alarm lamp lights or flashes after the cover is closed, take appropriate action.

= |f an Error Occurs

» The machine may make noise during operation.

9. Adjust the print head position.

10. After replacing the FINE cartridge, align the print head.
2> Note

* When print head alignment is performed, the machine starts cleaning the print head
automatically before printing the print head alignment sheet. Do not perform any other
operations until the machine completes the cleaning of the print head.
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Checking the Ink Status from Your Computer

You can check the remaining ink level and the FINE cartridge types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Maintenance tab, click View Printer Status.
The Canon IJ Status Monitor opens and displays an image of the ink status.

44 Canon MG2500 series Printer - USB001 - oIEN|
Qpbicen Ik Details  Help
Prirder b it
Estmaiad ik leveli (Coewamesnt B
] Ohweren:
1| e
r Black
Shop Mo, Dispay Prirt Grsus
»» Note

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.

» When you receive a notice about the remaining ink level, a mark appears above the ink icon.
For example: &
The ink is running low. Prepare a new ink cartridge.

3. If necessary, click Ink Details

You can check the ink-related information.

If a warning or error related to the remaining ink amount occurs, a notification icon is displayed at the top
of the image in the Ink Details dialog box.
In such cases, take the appropriate action as described on the screen.

»» Note

* You can also display the Ink Details dialog box by selecting the ink icon on the Canon IJ Status
Monitor.
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Checking the Ink Status

» Checking the Ink Status with the Ink Lamps on the Operation Panel
You can also check the ink status on the computer screen.

» Checking the Ink Status from Your Computer
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Checking the Ink Status with the Ink Lamps on the Operation Panel

¥ Note

» The ink level detector is mounted on the machine to detect the remaining ink level. The machine
considers as ink is full when a new FINE cartridge is installed, and then starts to detect a remaining ink
level. If you install a used FINE cartridge, the indicated ink level of it may not be correct. In such case,
refer to the ink level information only as a guide.

» When remaining ink cautions or errors occur, the ink lamps and the Alarm lamp will flash to inform you
of the error. Count the number of flashes and take appropriate action.

= |f an Error Occurs

In the copy standby mode, you can check the ink status with the Color Ink lamp and Black Ink lamp.

* All the lamps on the operation panel are shown lit in the figure below for explanatory purposes.

Lol [ G0 )
(A)—— A
(B) m—

(C) —7>

(A) Alarm lamp

(B) Black Ink lamp

(C) Color Ink lamp

Color Ink lamp or Black Ink lamp lights

The ink is running low. Prepare a new ink cartridge.

Color Ink lamp or Black Ink lamp flashes, while Alarm lamp flashes
An error has occurred.

= |f an Error Occurs

* For some types of errors, the Alarm lamp may not flash.

»» Note

* You can also check the ink status on the computer screen.

= Checking the Ink Status from Your Computer
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Maintenance

» When Printing Becomes Faint or Colors Are Incorrect
» Performing Maintenance from a Computer

» Cleaning the Machine
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When Printing Becomes Faint or Colors Are Incorrect

» Maintenance Procedure

» Printing the Nozzle Check Pattern

» Examining the Nozzle Check Pattern
» Cleaning the Print Head

» Cleaning the Print Head Deeply

» Aligning the Print Head
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Maintenance Procedure

If print results are blurred, colors are not printed correctly, or print results are unsatisfactory (e.g. misaligned
printed ruled lines), perform the maintenance procedure below.

32 Important

» Do not rinse or wipe the FINE cartridge. This can cause trouble with the FINE cartridge.

»» Note

» Check if ink remains in the FINE cartridge.

= Checking the Ink Status with the Ink Lamps on the Operation Panel

Check if the FINE cartridge is installed correctly.

= Replacing Procedure

Also check if the protective tape on the bottom of the FINE cartridge is removed.

« If the Alarm lamp lights or flashes, see If an Error Occurs.

* Increasing the print quality in the printer driver settings may improve the print result.

= Changing the Print Quality and Correcting Image Data

When the Print Results Are Blurred or Uneven:

Print the nozzle check pattern.

From the machine

= Printing the Nozzle Check Pattern

From the computer

= Use Your Computer to Print a Nozzle Check Pattern

[ Step2 | Examine the nozzle check pattern.

If there are missing lines or horizontal white streaks in the pattern:

Clean the print head.

From the machine

= Cleaning the Print Head

From the computer
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= Cleaning the Print Heads from Your Computer

After cleaning the print head, print and examine the nozzle check pattern: = Step1
If the problem is not resolved after performing from step 1 to step 3 twice:
[ Step4 | Clean the print head deeply.

From the machine

= Cleaning the Print Head Deeply

From the computer

= Cleaning the Print Heads from Your Computer

If the problem is not resolved, turn off the power and clean the print head deeply again after 24 hours.
If the problem is still not resolved:
[ Step5 | Replace the FINE cartridge.

= Replace a FINE cartridge

»>» Note

« If the problem is still not resolved after replacing the FINE cartridge, contact the service center.

When the Print Results Are Not Even such as the Ruled Lines Are
Misaligned:

Align the print head.

From the machine

= Aligning the Print Head

From the computer

= Aligning the Print Head Position Automatically from Your Computer
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzle.

»>» Note

« If the remaining ink level is low, the nozzle check pattern will not be printed correctly. Replace the FINE
cartridge whose ink is low.

You need to prepare: a sheet of A4 or Letter-sized plain paper
1. Make sure that the power is turned on.
2. Load a sheet of A4 or Letter-sized plain paper in the rear tray.
3. Pull out the paper output tray and the output tray extension.

4. Hold down the Stop button until the Alarm lamp flashes once, then release it immediately.
The nozzle check pattern will be printed.

Do not perform any other operations until the machine completes the printing of the nozzle check
pattern.

5. Examine the nozzle check pattern.

139



Examining the Nozzle Check Pattern

Examine the nozzle check pattern, and clean the print head if necessary.

1. Check if there are missing lines in the pattern (A) or horizontal white streaks in the pattern

(B).

(A)

(B)

(C) Number of sheets printed so far

If there are missing lines in the pattern (A):

Cleaning the print head is required.

SESSgsE

(o) (E)

(D) Good
(E) Bad (lines are missing)

If there are horizontal white streaks in the pattern (B):

Cleaning the print head is required.

(F) (G)
(F) Good
(G) Bad (horizontal white streaks are present)

»>» Note

» The total number of sheets printed so far is shown in increments of 50 sheets on the printout of the
nozzle check pattern.
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Cleaning the Print Head

Clean the print head if lines are missing or if horizontal white streaks are present in the printed nozzle check
pattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the print head
consumes ink, so clean the print head only when necessary.

1. Make sure that the power is turned on.

2. Hold down the Stop button until the Alarm lamp flashes twice, then release it immediately.

The machine starts cleaning the print head.
The cleaning will be complete when the ON lamp lights after flashing.

Do not perform any other operations until the machine completes the cleaning of the print head. This
takes about 30 seconds.

3. Check the print head condition.

To check the print head condition, print the nozzle check pattern.

»>» Note

+ If the problem is not resolved after cleaning the print head twice, clean the print head deeply.
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Cleaning the Print Head Deeply

If print quality does not improve by the standard cleaning of the print head, clean the print head deeply.
Cleaning the print head deeply consumes more ink than the standard cleaning of the print head, so clean
the print head deeply only when necessary.

1. Make sure that the power is turned on.

2. Hold down the Stop button until the Alarm lamp flashes three times, then release it
immediately.
The machine starts cleaning the print head deeply.
The cleaning will be complete when the ON lamp lights after flashing.

Do not perform any other operations until the machine completes the deep cleaning of the print head.
This takes about 1 minute.

3. Check the print head condition.

To check the print head condition, print the nozzle check pattern.

If the problem is not resolved, turn off the power and clean the print head deeply again after 24 hours.

If the problem is still not resolved, replace the FINE cartridge with a new one.

If the problem is still not resolved after replacing the FINE cartridge, contact the service center.
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Aligning the Print Head

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, adjust the print head
position.

»>» Note

+ If the remaining ink level is low, the print head alignment sheet will not be printed correctly.

Replace the FINE cartridge whose ink is low.

You need to prepare: a sheet of A4 or Letter-sized plain paper (including recycled paper)*

* Be sure to use paper that is white and clean on both sides.

1. Make sure that the power is turned on.
2. Load a sheet of A4 or Letter-sized plain paper in the rear tray.
3. Pull out the paper output tray and the output tray extension.

4. Hold down the Stop button until the Alarm lamp flashes four times, then release it
immediately.

The print head alignment sheet will be printed.
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3% Important

* Do not touch any printed part on the print head alignment sheet. If the sheet is stained or wrinkled,
it may not be scanned properly.
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« If the print head alignment sheet was not printed correctly, press the Stop button, then redo this
procedure from the beginning.

5. Scan the print head alignment sheet to adjust the print head position.

1. Load the print head alignment sheet on the platen glass.

Load the print head alignment sheet WITH THE PRINTED SIDE FACING DOWN and align the mark 4 on

the bottom right corner of the sheet with the alignment mark E

# "

2. Close the document cover gently, then press the Black button or the Color button.

The machine starts scanning the print head alignment sheet, and the print head position will be adjusted
automatically.

The print head position adjustment will be complete when the ON lamp lights after flashing.

Remove the print head alignment sheet on the platen glass.

32 Important

» Do not open the document cover or move the print head alignment sheet on the platen glass until
adjusting the print head position is complete.

« If adjusting the print head position has failed, the Alarm lamp flashes. Press the Black button or the
Color button to release the error, then take appropriate action.

= |f an Error Occurs

»» Note

« If the print results are still not satisfactory after adjusting the print head position as described above,
adjust the print head position manually from the computer.

= Aligning the Print Head Position from Your Computer

» To print and check the current head position adjustment values, hold down the Stop button until the
Alarm lamp flashes six times, then release it immediately.
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Performing Maintenance from a Computer

» Cleaning the Print Heads from Your Computer

» Cleaning the Paper Feed Rollers from Your Computer

» Aligning the Print Head

» Aligning the Print Head Position Automatically from Your Computer
» Aligning the Print Head Position from Your Computer

*» Use Your Computer to Print a Nozzle Check Pattern

» Cleaning Inside the Printer
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Cleaning the Print Heads from Your Computer

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for cleaning the print head is as follows:

:;1:

N\

Cleaning

1. Open the printer driver setup window

2. Click Cleaning on the Maintenance tab

When the Print Head Cleaning dialog box opens, select the ink group for which cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing cleaning.

3. Execute cleaning

Make sure that the printer is on and then click Execute.

Print head cleaning starts.

4. Complete cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

If cleaning the head once does not resolve the print head problem, clean it once more.

32 Important

» Cleaning consumes a small amount of ink.
Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

Deep Cleaning

Deep Cleaning is more thorough than cleaning. Perform deep cleaning when two Cleaning attempts do
not resolve the print head problem.

1. Open the printer driver setup window

2. Click Deep Cleaning on the Maintenance tab
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When the Deep Cleaning dialog box opens, select the ink group for which deep cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing deep cleaning.

3. Execute deep cleaning

Make sure that the printer is on and then click Execute.
Click OK when the confirmation message appears.

Print head deep cleaning starts.

4. Complete deep cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

32 Important

» Deep Cleaning consumes a larger amount of ink than Cleaning.
Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

»» Note

+ If there is no sign of improvement after Deep Cleaning, turn off the printer, wait 24 hours, and then
perform Deep Cleaning again. If there is still no sign of improvement, see "Ink Is Not Ejected."

Related Topic

= Use Your Computer to Print a Nozzle Check Pattern
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Cleaning the Paper Feed Rollersfrom Your Computer

Cleans the paper feed rollers. Perform feed roller cleaning when there are paper particles sticking to the
paper feed rollers and paper is not fed properly.

The procedure for performing the feed roller cleaning is as follows:

Roller Cleaning

1. Prepare the printer

Remove all sheets of paper from the rear tray.

2. Open the printer driver setup window

3. Click Roller Cleaning on the Maintenance tab

The confirmation message appears.

4. Execute paper feed roller cleaning

Make sure that the printer is on and then click OK.
Paper feed roller cleaning starts.

5. Complete paper feed roller cleaning

After the rollers have stopped, follow the message instructions and load one sheet of plain paper or a
cleaning sheet available on the market into the rear tray. Then click OK.

Paper will be ejected and feed roller cleaning will be completed.
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Aligning the Print Head

When you perform head position adjustment, errors in the print head adjustment position are corrected and
conditions such as color and line streaking are improved.

If the print results appear uneven because of line shifts or other conditions, adjust the position of the print
head.

On this printer, you can adjust the print head either automatically or manually.
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Aligning the Print Head Position from Your Computer

Print head alignment corrects the installation positions of the print head and improves deviated colors and
lines.

This printer supports two head alignment methods: automatic head alignment and manual head alignment.

The procedure for performing manual print head alignment is as follows:

1. Open the printer driver setup window

Print Head Alignment

2. Click Custom Settings on the Maintenance tab

The Custom Settings dialog box opens.

3. Switch head alignment to manual

Check the Align heads manually check box.

4. Apply the settings

Click OK and when the confirmation message appears, click OK.

5. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

6. Load paper in the printer

Load three sheets of A4 size or Letter size plain paper into the rear tray.

7. Execute head alignment

Make sure that the printer is on and click Align Print Head.
Follow the instruction in the message.

3% Important

» Do not open the cover while printing is in progress.

8. Check the printed pattern

Enter the numbers of the patterns with the least noticeable streaks or stripes in the associated boxes.
Even if the patterns with the least noticeable streaks or stripes are clicked in the preview window, their
numbers are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

2> Note
« If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical
streaks.
i i
i !
(&) (B)

(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

« If it is difficult to pick the best pattern, pick the setting that produces the least noticeable
horizontal stripes.

(A) (B)

(A) Least noticeable horizontal stripes
(B) Most noticeable horizontal stripes

9. Confirm the displayed message and click OK

The second pattern is printed.

32 Important

» Do not open the cover while printing is in progress.

10. Check the printed pattern

Enter the numbers of the patterns with the least noticeable streaks in the associated boxes.
Even if the patterns with the least noticeable streaks are clicked in the preview window, their numbers
are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

2> Note
« If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical
streaks.
i i
i !
(&) (B)

(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

Confirm the displayed message and click OK

The third pattern is printed.
32 Important

* Do not open the cover while printing is in progress.

Check the printed pattern

Enter the numbers of the patterns with the least noticeable stripes in the associated boxes.
Even if the patterns with the least noticeable stripes are clicked in the preview window, their numbers
are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

> Note

« If it is difficult to pick the best pattern, pick the setting that produces the least noticeable
horizontal stripes.

(A) (B)

(A) Least noticeable horizontal stripes
(B) Most noticeable horizontal stripes

> Note

» To print and check the current setting, open the Start Print Head Alignment dialog box, and click
Print Alignment Value.
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Aligning the Print Head Position Automatically from Your
Computer

Print head alignment corrects the installation positions of the print head and improves deviated colors and
lines.

This printer supports two head alignment methods: automatic head alignment and manual head alignment.
Normally, the printer is set for automatic head alignment. If the printing results of automatic print head
alignment are not satisfactory, perform manual head alignment.

The procedure for performing automatic print head alignment is as follows:

1. Open the printer driver setup window

Print Head Alignment

2. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

3. Load paper in the printer

Load one sheet of A4 size or Letter size plain paper into the rear tray.

»» Note

» The number of sheets to be used differs when you select the manual head alignment.

4. Print head alignment pattern printing

Make sure that the printer is on and click Align Print Head.
The adjustment pattern is printed.

22 Important

» Do not open the cover while printing is in progress.

5. Adjustment pattern scanning

After the adjustment pattern is printed, a message is displayed.

As instructed in the message, load the adjustment pattern onto the platen, and press the Start button
on the printer.

Print head alignment starts.

»>» Note

» To print and check the current setting, open the Start Print Head Alignment dialog box, and click
Print Alignment Value.
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Use Your Computer to Print a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

Nozzle Check

1. Open the printer driver setup window

2. Click Nozzle Check on the Maintenance tab

The Nozzle Check dialog box opens.
Click Initial Check Items to display the items that you need to check before printing the nozzle check
pattern.

3. Load paper in the printer

Load one sheet of A4 size or Letter size plain paper into the rear tray.

4. Print a nozzle check pattern

Make sure that the printer is on and click Print Check Pattern.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.
The Pattern Check dialog box opens.

5. Check the print result

Check the print result. When the print result is normal, click Exit.

If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the print
head.

Related Topic

= Cleaning the Print Heads from Your Computer
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Cleaning Inside the Printer

Perform bottom plate cleaning before you execute duplex printing to prevent smudges on the back side of
the paper.

Also perform bottom plate cleaning if ink smudges caused by something other than print data appear on the
printed page.

The procedure for performing bottom plate cleaning is as follows:

Bottom Plate Cleaning

1. Open the printer driver setup window

2. Click Bottom Plate Cleaning on the Maintenance tab

The Bottom Plate Cleaning dialog box opens.

3. Load paper in the printer

As instructed in the dialog box, fold the A4 size or Letter size plain paper in half horizontally, and then
unfold the sheet.
Load the paper into the rear tray in the portrait orientation with the crest of the crease facing down.

4. Perform the bottom plate cleaning

Make sure that the printer is on and then click Execute.
Bottom plate cleaning starts.
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Cleaning the Machine

» Cleaning the Exterior of the Machine
» Cleaning the Platen Glass and Document Cover
» Cleaning the Paper Feed Roller

» Cleaning the Inside of the Machine (Bottom Plate Cleaning)
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Cleaning the Exterior of the Machine

Be sure to use a soft and dry cloth such as eyeglasses cleaning cloth and wipe off dirt on the surface gently.
Smooth out wrinkles on the cloth if necessary before cleaning.

32 Important

» Be sure to turn off the power and unplug the power cord before cleaning the machine.

* Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not
to scratch the surface.

» Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to clean
the machine, as this may cause a malfunction or damage the surface of the machine.
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Cleaning the Platen Glass and Document Cover

22 Important

* Be sure to turn off the power and unplug the power cord before cleaning the machine.

» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not
to scratch the surface.

» Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to clean
the machine, as this may cause a malfunction or damage the surface of the machine.

With a soft, clean, lint-free and dry cloth, wipe the platen glass (A) and the inner side of the document cover
(white sheet) (B) gently. Make sure not to leave any residue, especially on the glass surface.

(B)

(A)

22 Important

» The inner side of the document cover (white sheet) (B) is easily damaged, so wipe it gently.
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Cleaning the Paper Feed Roller

If the paper feed rollers are dirty or paper powder is attached to it, paper may not be fed properly.
In this case, clean the paper feed rollers. Cleaning will wear out the paper feed rollers, so perform this only

when necessary.

You need to prepare: a sheet of A4 or Letter-sized plain paper or cleaning sheet available on the
market

1. Make sure that the power is turned on and remove any paper from the rear tray.

2. Clean the paper feed rollers without paper.

1. Hold down the Stop button until the Alarm lamp flashes seven times, then release it
immediately.

The paper feed rollers will rotate as it is cleaned.

3. Clean the paper feed rollers with paper.

1. Make sure that the paper feed rollers have stopped rotating, load a sheet of A4 or Letter-sized
plain paper or cleaning sheet available on the market in the rear tray.

2. Pull out the paper output tray and the output tray extension.

3. Hold down the Stop button until the Alarm lamp flashes seven times, then release it
immediately.

The machine starts cleaning. The cleaning will be complete when the paper is ejected.
If the problem is not resolved after cleaning the paper feed rollers in the rear tray, turn off the power, unplug

the power cord, then wipe the paper feed rollers (the center roller and the right roller) (A) located inside the
rear tray with a moistened cotton swab or the like while rotating them manually. Do not touch the rollers with

your fingers. Rotate the rollers two or more times.
8

After cleaning the paper feed rollers, turn on the power, then clean the paper feed rollers again.

If the problem is not resolved after cleaning the paper feed rollers, contact the service center.
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Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Remove stains from the inside of the machine. If the inside of the machine becomes dirty, printed paper may
get dirty, so we recommend performing cleaning regularly.

You need to prepare: a sheet of A4 or Letter-sized plain paper*

* Be sure to use a new piece of paper.

1. Make sure that the power is turned on and remove any paper from the rear tray.

2. Prepare paper.
1. Fold a single sheet of A4 or Letter-sized plain paper in half widthwise, then unfold the paper.
2. Load only this sheet of paper in the rear tray with the open side facing you.

3. Pull out the paper output tray and the output tray extension.

3. Hold down the Stop button until the Alarm lamp flashes eight times, then release it
immediately.
The paper cleans the inside of the machine as it feeds through the machine.
Check the folded parts of the ejected paper. If they are smudged with ink, perform Bottom Plate Cleaning
again.
2> Note

» When performing Bottom Plate Cleaning again, be sure to use a new piece of paper.

If the problem is not resolved after performing cleaning again, the protrusions inside the machine may be
stained. Wipe off any ink from the protrusions using a cotton swab or the like.
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32 Important

* Be sure to turn off the power and unplug the power cord before cleaning the machine.
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Changing the Machine Settings

» Changing Machine Settings from Your Computer
» Changing the Machine Settings Using the Operation Panel
» Initializing the Machine Settings

» Disabling the Wireless LAN Function of the Machine
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Changing Machine Settings from Your Computer

» Changing the Print Options

» Registering a Frequently Used Printing Profile
» Setting the Ink Cartridge to be Used

» Managing the Printer Power

» Reducing the Printer Noise

» Changing the Printer Operation Mode
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Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Specify this option if you encounter print failures such as part of an image data being cut off.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Print Options... on the Page Setup tab
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12> Note

* When you use the XPS printer driver, the functions available to you are different.

3. Change the individual settings
If necessary, change the setting of each item, and then click OK.

The Page Setup tab is displayed again.
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Registering a Frequently Used Printing Profile

You can register the frequently used printing profile to Commonly Used Settings on the Quick Setup tab.
Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:
Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

From Commonly Used Settings on the Quick Setup tab, select the printing profile to be used and if
necessary, change the settings after Additional Features.
You can also register necessary items on the Main and Page Setup tabs.

3. Click Save...
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The Save Commonly Used Settings dialog box opens.

Save Commaonly Used Settings ﬂ

4. Save the settings

Enter a name in the Name field. If necessary, click Options..., set the items, and then click OK.

In the Save Commonly Used Settings dialog box, click OK to save the print settings and return to the
Quick Setup tab.

The name and icon are displayed in Commonly Used Settings.
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32 Important

» To save the page size, orientation, and number of copies that was set in each sheet, click Options...,
and check each item.

»>» Note

* When you re-install the printer driver or upgrade the printer driver version, the print settings that are
already registered will be deleted from Commonly Used Settings.
Registered print settings cannot be saved and preserved. If a profile is deleted, register the print
settings again.

Deleting Unnecessary Printing Profile

1. Select the printing profile to be deleted

Select the printing profile you want to delete from the Commonly Used Settings list on the Quick
Setup tab.

2. Delete the printing profile

Click Delete. When the confirmation message appears, click OK.
The selected printing profile is deleted from the Commonly Used Settings list.

»» Note

* Printing profiles that are registered in the initial settings cannot be deleted.
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Setting the Ink Cartridge to be Used

This feature enables you to specify the most appropriate FINE cartridge among installed cartridges
according to an intended use.

When one of the FINE cartridges becomes empty and cannot be replaced immediately by a new one, you
can specify the other FINE cartridge that still has ink and continue printing.

The procedure for specifying the FINE cartridge is as follows:

1. Open the printer driver setup window

Ink Cartridge Settings

2. Click Ink Cartridge Settings on the Maintenance tab

The Ink Cartridge Settings dialog box appears.

3. Select the FINE cartridge to be used

Select the FINE cartridge to be used for printing and click OK.
The specified FINE cartridge will be used from the next printing.

3% Important

* When a setting other than Plain Paper or Envelope is selected for Media Type on the Main tab,
Black Only is disabled because the printer uses the color FINE cartridge to print documents.

» Do not detach the FINE cartridge that is not in use. Printing cannot be performed while either FINE
cartridge is detached.
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Managing the Printer Power

This function allows you to manage the printer power from the printer driver.

The procedure for managing the printer power is as follows:

©

The Power Off function turns off the printer. When you use this function, you will not be able to turn the
printer on from the printer driver.

Power Off

1. Open the printer driver setup window

2. Execute power off

Click Power Off on the Maintenance tab. When the confirmation message appears, click OK.

The printer power switches off, and the Maintenance tab is displayed again.

‘@

Auto Power allows you to set Auto Power On and Auto Power Off.

Auto Power

The Auto Power On function automatically turns on the printer when data is received.
The Auto Power Off function automatically turns off the printer when there are no operations from the
printer driver or the printer for a specified period of time.

1. Open the printer driver setup window

2. Make sure that the printer is on and then click Auto Power on the Maintenance tab

The Auto Power Settings dialog box opens.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Auto Power On
Specifying Enable from the list will turn the printer on upon receipt of print data.

Auto Power Off
Specify the time from the list. When this time lapses without any operations from the printer driver
or the printer, the printer is turned off automatically.

4. Apply the settings
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Click OK. When the confirmation message appears, click OK.
The Maintenance tab is displayed again.

The setting is enabled after this. When you want to disable this function, select Disable from the list
according to the same procedure.

»>» Note

* When the printer is turned off, the Canon IJ Status Monitor message varies depending on the Auto
Power On setting.
When the setting is Enable, "Printer is standing by" is displayed. When the setting is Disable,
"Printer is offline" is displayed.

22 Important

+ If you connect this printer to a network and use it, you can set Auto Power Off but the power will not be
turned off automatically.
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Reducing the Printer Noise
The silent function allows you to reduce the operating noise of this printer. Select when you wish to reduce

the operating noise of the printer at night, etc.
Using this function may lower the print speed.

The procedure for using the quiet mode is as follows:

&

1. Open the printer driver setup window

Quiet Settings

2. Click Quiet Settings on the Maintenance tab

The Quiet Settings dialog box opens.
2> Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.

3. Set the quiet mode

If necessary, specify one of the following items:

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified
period of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to
the same time, the quiet mode will not function.

32 Important

* You can set the quiet mode from the printer, the printer driver, or ScanGear (scanner driver).
No matter how you use to set the quiet mode, the mode is applied when you perform
operations from the printer or printing and scanning from the computer.

* If you specify a time for Use quiet mode during specified hours, quiet mode is not applied
to operations (copy, direct print, etc.) performed directly from the printer.

4. Apply the settings

Make sure that the printer is on and click OK.
Click OK when the confirmation message appears.

The settings are enabled hereafter.
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»» Note

» The effects of the quiet mode may be less depending on the print quality settings.
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Changing the Printer Operation Mode

If necessary, switch between various modes of printer operation.

The procedure for configuring Custom Settings is as follows:

— | Custom Settings

1. Open the printer driver setup window

2. Make sure that the printer is on, and then click Custom Settings on the Maintenance
tab

The Custom Settings dialog box opens.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Align heads manually
Usually, the Print Head Alignment function on the Maintenance tab is set to automatic head
alignment, but you can change it to manual head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head

alignment.
Check this check box to perform the manual head alignment. Uncheck this check box to perform

the automatic head alignment.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the
Orientation.
To rotate the print data 90 degrees to the left during printing, select this item. To rotate the print
data 90 degrees to the right during printing, clear this item.

32 Important

» Do not change this setting while the print job is displayed in the print wait list. Otherwise,
characters may be omitted or the layout may become corrupt.

Ink Drying Wait Time
You can set the length of the printer rest time until printing of the next page begins. Moving the
slider to the right increases the pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page
dries, increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

4. Apply the settings

Click OK and when the confirmation message appears, click OK.

The printer operates with the modified settings hereafter.
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Changing the Machine Settings Using the Operation Panel

» About Quiet setting
» Turning on/off the Machine Automatically

» Using the Machine with the Access Point Mode
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About Quiet setting

Enables this function on the machine if you want to reduce the operating noise, such as when printing at
night.

Follow the procedure below to perform setting.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 9 times.
3. Release the Stop button.

4. Press the Color button.

To disable the function, press the Black button in step 4.

2% Important

» Operating speed may be reduced compared to when the quiet mode is not selected.

»» Note

» You can set the quiet mode from the operation panel of the machine, the printer driver, or
ScanGear (scanner driver). No matter how you set the quiet mode, the mode is applied when you
perform operations from the operation panel of the machine or printing and scanning from the
computer.
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Turning on/off the Machine Automatically

You can enable the machine to turn on/off automatically considering the environment

= Turning on the Machine Automatically

= Turning off the Machine Automatically

Turning on the Machine Automatically

You can enable the machine to turn on automatically when you perform printing or scanning operations
from the computer.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 14 times.

3. Release the Stop button.

4. Press the Color button.

To disable the function, press the Black button in step 4.

> Note

* You can select whether you turn the machine on automatically from the operation panel of the
machine, the printer driver, or ScanGear (scanner driver). No matter how you set the quiet
mode, the mode is applied when you perform printing or scanning operations from the
computer.

Turning off the Machine Automatically

You can enable the machine to turn off automatically when no operation is made or no printing data is
sent to the machine for a specified period of time.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 13 times.

3. Release the Stop button.

4. Press the Color button.
To disable the function, press the Black button in step 4.

»» Note

* You can select whether you turn off the machine automatically from the operation panel of the
machine, the printer driver, or ScanGear (scanner driver). From the printer driver or ScanGear
(scanner driver), you can specify the time before turning off the machine.
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Using the Machine with the Access Point Mode

By using the machine as an access point in an environment that does not have wireless LAN router or
access point, or by using the machine as an access point temporarily in an environment that has wireless
LAN router or access point, you can connect the machine to an external device such as a computer or a
smartphone and print/scan from them.

This section describes how to enable the access point mode, the access point name of the machine, and
the security setting.

= How to enable the Access Point Mode

= Printing/Scanning with the Access Point Mode

= How to terminate the Access Point Mode

= Setting of the Access Point Mode
22 Important

+ Before using the machine with the access point mode, confirm the usage restrictions then switch the
machine to the access point mode.

= Restrictions

* If you use the machine with the access point mode for the long time, it is recommended that you
change the default access point name and the default password to the combination of numbers and
letters with the point of view of security.

How to enable the Access Point Mode

Enable the access point mode following the procedure below.

1. Make sure that the machine is turned on.

2. Press and hold the Wi-Fi button until the Alarm lamp flashes 3 times.

3. Release the Wi-Fi button.

When the ON lamp changed from flashing to lit, the access point mode is enabled.

»>» Note

» To confirm the current access point mode setting of the machine, print out the network setting
information.

= Printing Out Network Setting Information

» You can specify the access point name (SSID) and the security setting optionally.

= Setting of the Access Point Mode

Printing/Scanning with the Access Point Mode

Print/Scan with the access point mode following the procedure below.
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1. Connect an external device such as a computer or a smartphone to the machine via

wireless LAN.
Perform wireless LAN settings with your external device, then assign the access point name specified
for the machine as a destination.

»» Note

» For details on how to perform wireless LAN settings with an external device, refer to the
device's instruction manual.

* When a WPA2-PSK (AES) password is valid on the machine, entering the password is required
to connect an external device to the machine via wireless LAN. Enter the password specified for

the machine.

2. Start printing or scanning from an external device such as a computer or a smartphone.

»» Note

* For details on how to print or scan from an external device such as a computer or a smartphone
via wireless LAN, refer to the device's or application's instruction manual.

How to terminate the Access Point Mode

In environments that the machine is connected with the computer over the wireless LAN usually, set the
machine to the wireless LAN connection following the procedure below when you finish using the machine
with the access point mode temporarily.

1. Press and hold the Wi-Fi button until the Alarm lamp flashes 4 times.

2. Release the Wi-Fi button.

When the ON lamp changed from flashing to lit, the wireless LAN mode is enabled.

»» Note

* If you do not use the machine with the access point mode or over the wireless LAN:

Follow the procedure below to disable the access point mode and the wireless LAN.
1. Press and hold the Stop button until the Alarm lamp flashes 18 times.
2. Release the Stop button.
3. Press the Black button.

The Wi-Fi lamp goes off.

Setting of the Access Point Mode

The initial value of the access point mode is set as follows.

SSID (access point name) | XXXXXX-MG2900series
* IXXXXXX" is the last six digits of MAC address of the machine.

Security setting WPA2-PSK (AES)
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Password Serial number of the machine

»» Note

» To confirm the MAC address of the machine, print out the network setting information.

= Printing Out Network Setting Information

* You can change the security setting and the password using IJ Network Tool.

If you change the access point mode setting of the machine, also change the access point setting of
the external device such as a computer or a smartphone.
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Initializing the Machine Settings

You can initialize the machine settings.

32 Important

* When using the machine over wireless LAN, note that initialization erases all network settings on the
machine, and printing operation from a computer over network may become impossible. To use the
machine over network, perform setup with the Setup CD-ROM or perform it according to the instructions
on our website.

Follow the procedure below to initialize the machine settings.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 21 times.

3. Release the Stop button.

All the machine settings are initialized. The administrator password specified by IJ Network Tool reverts
to the default setting.

»» Note

* You cannot initialize the current position of the print head.
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Disabling the Wireless LAN Function of the Machine

Follow the procedure below to disable the wireless LAN.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 18 times.

3. Release the Stop button.

4. Press the Black button.
The Wi-Fi lamp goes off.
> Note

* When you enable the wireless LAN, press the Color button in step 4.

181



Information about Network Connection

» Useful Information about Network Connection
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Useful Information about Network Connection

» Default Values Set at Factory (Network)
» Connecting the Machine to the Computer Using a USB Cable
» When Detecting the Printers Have the Same Name during Setup

» Connecting to Other Computer with LAN/Changing the Connection Method
from USB to LAN

» Printing Out Network Setting Information
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Default Values Set at Factory (Network)

Default Values of the LAN Connection

Item The default
Enable/disable LAN Enable
SSID BJNPSETUP
Communication mode Infrastructure
Wireless LAN security Disable
IPv4 IP address Auto setup
IPv6 IP address Auto setup
Set printer name* XXXXXXXXXXXX
Enable/disable IPv6 Enable
Enable/disable WSD (WSD settings) Enable
Timeout setting (WSD settings) 1 minute
Enable/disable Bonjour (Bonjour settings) [ Enable
Service name (Bonjour settings) Canon MG2900 series
LPR protocol setting Enable
PictBridge communication Enable
Wireless LAN DRX Enable

(* The default value in this item varies by the machine.)

Default Values of the Access Point Mode

Item The default

SSID (access point name) | XXXXXX-MG2900series

Security setting WPA2-PSK (AES)

Password Serial number of the machine

(XXXXXX is the last six digits of MAC address of the machine.)
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Connecting the Machine to the Computer Using a USB Cable

Connect the machine and the computer using a USB cable as the illustration below. The USB port is located
on the rear of the machine.
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When Detecting the Printers Have the Same Name during Setup

When the printer is detected during setup, you may see multiple printers of the same name on the detection
result screen.

Select a printer with checking the MAC address or the serial number set to the printer against that on the
detection result screen.

»» Note

* A serial number may not be displayed on the detection result screen.

To check the MAC address of the printer, print out the network setting information.

= Printing Out Network Setting Information
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Connecting to Other Computer with LAN/Changing the Connection
Method from USB to LAN

To add the computer connecting the machine with LAN or to change the connection method between the
machine and the computer from USB to LAN, perform setup with the Setup CD-ROM or perform it according
to the instructions on our website.

Connecting to Other Computer with LAN

To add the computer connecting the machine with LAN, perform setup with the Setup CD-ROM or
perform it according to the instructions on our website.

Changing the Connection Method from USB to LAN

To change the connection method to LAN while you are using the machine with USB connection, perform
setup again with the Setup CD-ROM or perform it again according to the instructions on our website and
select Change Connection Method.
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Printing Out Network Setting Information

You can print out the current network settings of the machine.

32 Important

 This print out contains valuable information about your computer. Handle it with care.

1. Make sure that the printer is turned on.

2. Load a sheet of A4 or Letter-sized plain paper.

3. Press and hold the Stop button until the Alarm lamp flashes 15 times.

4. Release the Stop button.

The machine starts printing the network setting information.

The following information on the machine's network setting is printed out.

Item Explanations of the item Setting
Wireless LAN Wireless LAN Enable/Disable
Connection Connection status Active/Inactive
MAC Address MAC Address XXXX XX XX XX XX
SSID SSID SSID of the wireless LAN/SSID of the access
point mode
Password Password Password of the access point mode (8 to 10

alphanumeric characters)

Communication Mode

Communication Mode

Infrastructure/Access Point Mode

Channel *1

Channel

XX (1to 13)

Encryption

Method of the Encryption

none/WEP/TKIP/AES

WEP Key Length

WEP Key Length

Inactive/128/64

Authentication

Method of the Authentication

none/auto/open/shared/WPA-PSK/WPA2-PSK

Signal Strength

Signal Strength

0 to 100 [%]

TCP/IP Version TCP/IP Version IPv4 & IPv6/IPv4

IPv4 |P Address Selected IP Address (IPv4) XXX XXX XXX XXX

IPv4 Default Gateway Default Gateway (IPv4) XXX XXX XXX XXX

Subnet Mask Subnet Mask XXX XXX XXX XXX

IPv6 IP Address *2 Selected IP Address (IPv6) XXXXXXXXKXXXXKXXXX
XXXX XXX XXXXKXXXX
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IPv6 Default Gateway *2 | Default Gateway (IPv6) XXXXXXXX X XXX XXXX
XXXXXXXXKXXXXKXXXX

Subnet Prefix Length *2 | Subnet Prefix Length XXX

IPsec *3 IPsec setting Active

Security Protocol *3

Method of the Security Protocol

ESP/ESP & AH/AH

WPS PIN CODE

WPS PIN code

XXXXXXXX

Wireless LAN DRX

Discontinuous reception
(wireless LAN)

Enable/Disable

Other Settings

Other settings

Printer Name

Printer name

Printer name (Up to 15 alphanumeric characters)

WSD WSD setting Enable/Disable
WSD Timeout Timeout 1/5/10/15/20 [min]
LPR Protocol LPR protocol setting Enable/Disable
Bonjour Bonjour setting Enable/Disable

Bonjour Service Name

Bonjour service name

Bonjour service name (Up to 52 alphanumeric
characters)

PictBridge Commun. PictBridge Communication Enable/Disable
DNS Server Getting DNS Server Auto/Manual
automatically
Primary Server Primary server address XXX XXX XXX XXX
Secondary Server Secondary server address XXX XXX XXX XXX
Proxy Server Proxy Server setting Enable/Disable
Proxy Port Specifying Proxy Port 1 to 65535
Proxy Address Proxy Address XXXXXXX XXX XX XXXXXXXX

("XX" represents alphanumeric characters.)

*1 Depending on the country or region of purchase, one of the channels from 1 to 11 is printed.

*2 Only when IPv6 is enabled, the status of the network is printed.

*3 Only IPv6 and the IPsec setting are enabled, the status of the network is printed.
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About Network Communication

» Changing and Confirming Network Settings
» Screens for Network Connection of IJ Network Tool
» Other Screens of IJ Network Tool

» Appendix for Network Communication
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Changing and Confirming Network Settings

» |IJ Network Tool

» Changing the Settings in the Wireless LAN Sheet

» Changing the WEP Detailed Settings

» Changing the WPA/WPAZ2 Detailed Settings

» Changing the Settings in the Wired LAN Sheet

» Changing the Settings in the Admin Password Sheet
» Monitoring Wireless Network Status

» Initializing the Network Settings of the Machine

» Viewing the Modified Settings
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IJ Network Tool

IJ Network Tool is a utility that enables you to display and modify the machine network settings. It is installed
when the machine is set up.

22 Important

» To use the machine over LAN, make sure you have the equipment necessary for the connection type,
such as an access point or a LAN cable.

* Do not start up IJ Network Tool while printing.
» Do not print when IJ Network Tool is running.

« If the firewall function of your security software is turned on, a message may appear warning that
Canon software is attempting to access the network. If the warning message appears, set the security
software to always allow access.

* |1J Network Tool has been verified to work on Windows XP, however, it does not support Fast User
Switching. It is recommended to exit IJ Network Tool when switching users.

Starting up IJ Network Tool

1. Start up IJ Network Tool as shown below.

* In Windows 8.1 or Windows 8, select IJ Network Tool on the Start screen to start IJ Network
Tool. If IJ Network Tool is not displayed on the Start screen, select the Search charm, then
search for "IJ Network Tool".

+ In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon
Utilities, IJ Network Tool, and then IJ Network Tool.

Depending on the printer you are using, an administrator password is already specified for the printer at
the time of purchase. When you change the network settings, authentication by the administrator
password is required.

For details:

= About the Administrator Password

For improving security, it is recommended to change the administrator password.

= Changing the Settings in the Admin Password Sheet
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Changing the Settings in the Wireless LAN Sheet

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection

without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

»>» Note

* This screen is not available depending on the printer you are using.

+ Activate the wireless LAN setting of the printer to change the settings in the Wireless LAN sheet.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with
"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

The Wireless LAN sheet is displayed.

Wirnleas LAN | Adein Passwerd
o
Patwior Taps
& infrastructune
5510 o Searh
Encryption Method: | Use: WEP v Configuration
TCPAP Sshup ) Gl |P advireas gl omaticaly
Use nexd IF address
rs{ructors [ Cancsl

For details on the Wireless LAN sheet, see Wireless LAN Sheet.

5. Change the settings or confirm.

SSID:
Enter the same value that was set for the target access point.

When the printer is connected with USB, the Search screen appears by clicking Search.... Set the
SSID of the access point by selecting the one of the detected access points.

= Search Screen
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»» Note

» Enter the same SSID that the access point is configured to use. The SSID is case-sensitive.

Encryption Method:
Select the encryption method used over the wireless LAN.

You can change WEP settings with selecting Use WEP and clicking Configuration....

= Changing the WEP Detailed Settings

You can change WPA/WPAZ2 settings with selecting Use WPA/WPA2 and clicking Configuration....
= Changing the WPA/WPA2 Detailed Settings

2% Important

« If all encryption types of the access point, printer, or computer do not match, the printer cannot
communicate with the computer. If the printer cannot communicate with the computer after the
encryption type of the printer was switched, make sure that encryption types for the computer and
the access point match that set to the printer.

« If you connect to a network that is not protected with security measures, there is a risk of disclosing
data such as your personal information to a third party.

TCPI/IP Setup:
Sets the IP address of the printer to be used over the LAN. Specify a value appropriate for your
network environment.

. Click OK.

After changing configuration, a screen is displayed asking you for confirmation before the settings are
sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings
screen is displayed.

> Note

» Changing the network settings with the USB cable temporarily may switch the default printer. In
this case, reset Set as Default Printer.
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Changing the WEP Detailed Settings

»>» Note

» This screen is not available depending on the printer you are using.

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection
without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

1. Start up |J Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with

"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WEP in Encryption Method: and click Configuration....

The WEP Details screen is displayed.

6. Change the settings or confirm.

When changing the password (WEP key), the same change must be made to the password (WEP key)
of the access point.

WEP Details E

[-r-'s=5ey }— 1

| Ky Langth 1284 vj=—2

[”ﬂ?m ASCH v }— 3

[ Hev D | - }—a

[im.ll'm-ca.m ALED w }— 5

Insipuctions 0% Cancsl

1. WEP Key:

Enter the same key as the one set to the access point.

The number of characters and character type that can be entered differ depending on the
combination of the key length and key format.

Key Length

64bit 128bit

Key Format | ASCII 5 characters | 13 characters

Hexadecimal (Hex) | 10 digits 26 digits
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2. Key Length:
Select either 64bit or 128bit.
3. Key Format:
Select either ASCII or Hex.
4. Key ID:
Select the Key ID (index) set to the access point.
5. Authentication:
Select the authentication method to authenticate the printer's access to the access point.

Normally, select Auto. If you want to specify the method manually, select Open System or
Shared Key according to the setting of the access point.

7. Click OK.
2% Important

« If the printer cannot communicate with the computer after the encryption type of the printer was
switched, make sure that encryption types for the computer and the access point match that set to
the printer.

> Note

+ Changing the network settings with the USB cable temporarily may switch the default printer. In
this case, reset Set as Default Printer.
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Changing the WPA/WPA2 Detailed Settings

»>» Note

» This screen is not available depending on the printer you are using.

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection
without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

The example screenshots in this section refer to the WPA detailed settings.

1. Start up |J Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with

"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WPA/WPAZ2 in Encryption Method: and click Configuration....

The WPA/WPAZ2 Details screen is displayed.

If encryption is not set to the printer, the Authentication Type Confirmation screen is displayed. Go to
step 7.

6. Click Change Settings....

WPAMWPAZ Details “
T cument, sellings dor cienl autberticalion are as [sllows. To change
W meltings. click [Change Seltings]
Authentication Type PEK
Dyniamic Encryption Type: A0
Instruciors CK

7. Check the client authentication type and click Next>.
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Chack the suthertication type. and chck [Next]
Futhertcation Type
®/E5H
Instructions Bk Pt Cancel

8. Enter the passphrase, then click Next>.

Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63 alphanumeric
characters or a 64-digit hexadecimal value.

If you do not know the access point passphrase, refer to the instruction manual provided with the access
point or contact its manufacturer.

The dynamic encryption method is selected from either TKIP (basic encryption) or AES (secure
encryption) automatically.

= 3% Important

« If Auto is not displayed on Dynamic Encryption Type:, select either TKIP(Basic Encryption) or
AES(Secure Encryption).

then click [Med |

9. Click Finish.
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Check Lhe seilings for cient aulberficaion, and then cid
[Firigh}.

Futhertication Type FSK

Dynamc Ercryphon Type:  Auto

% Important

« |If the printer cannot communicate with the computer after the encryption type of the printer was
switched, make sure that encryption types for the computer and the access point match that set to
the printer.

122> Note

» Changing the network settings with the USB cable temporarily may switch the default printer. In
this case, reset Set as Default Printer.
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Changing the Settings in the Wired LAN Sheet

»» Note

» This screen is not available depending on the printer you are using.

+ Activate the wired LAN setting of the printer to change the settings in the Wired LAN sheet.

1. Start up |J Network Tool.

2. Select the printer in Printers:.
3. Select Configuration... from the Settings menu.

4. Click the Wired LAN tab.

The Wired LAN sheet is displayed.

Wiend LAN  Admin Password
w

TCPAP Sehup #) Gt |P address guiomaticaly
Lise nca IP acideees

ns{nuctions O Cancal

For details on the Wired LAN sheet, see Wired LAN Sheet.

5. Change the settings or confirm.
Set the IP address of the printer to be used over the LAN. Specify a value appropriate for your network
environment.

6. Click OK.

After changing configuration, a screen is displayed asking you for confirmation before the settings are
sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings
screen is displayed.
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Changing the Settings in the Admin Password Sheet

»>» Note

* You cannot change the settings when using the access point mode.

1. Start up |J Network Tool.

2. Select the printer in Printers:.
3. Select Configuration... from the Settings menu.

4. Click the Admin Password tab.

The Admin Password sheet is displayed.

Wiesless LAN  Admin Password
o | Lse aomin password

Password

Password Confiemation

rs{ructors [ Cancsl

For details on the Admin Password sheet, see Admin Password Sheet.

5. Change the settings or confirm.

To use an administrator password, select the Use admin password check box and enter a password.

2% Important

» The password should consist of alphanumeric characters and be no longer than 32 characters.
The password is case-sensitive. Do not forget the password you set.

If you forget the administrator password you specified, initialize the printer to revert the password
to the default setting.

6. Click OK.

A screen is displayed asking you for confirmation before the settings are sent to the printer. If you click
Yes, the settings are sent to the printer and the Transmitted Settings screen is displayed.
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Monitoring Wireless Network Status

22> Note

» This screen is not available depending on the printer you are using.

* When using the machine over the wired LAN, you cannot monitor network status.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

3. Select Status from the View menu.

The Status screen is displayed and you can check the printer status and connection performance.

2% Important

« If the indicated value is low, move your printer closer to the wireless network device.

4. If you measure the connection performance in detail, click Advanced Measurement...

The Connection Performance Measurement screen is displayed.

5. Click Next>.

The measurement starts and the status displays. Measurement takes a few minutes.

Thig veizard veill maasure the connection perfammance betwesn the panber and
the actess point. and diaplay whether & is sultable for printing.
Chomci; ithiak this prinber is bumed on_ and click [Ned]

'When the connection pesformance is poor, place the printer closer (o the access
peoant and remowe any nterfenng objects between them. Poor comnection
pesformance wil cause unstable operation mnmm

- will tmkon B couple of minules 10 measune the cornection perdamance.
(You can cancel the operation whils the measurement is in progress.)
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6. Check the status.

When the measurement is complete, the status is displayed.

EF_‘h? The resits are a3 fiolows =

ALl |

E— 3
91 | PES

Cornaction Performance betwean the Printer and the Access Pont
p—— EEme ] [

@ cocd

Chck [Remaasuremant] o maasum the padomancs agan

When Q is displayed in Connection Performance between the Printer and the Access Point:, the
printer can communicate with the access point. Otherwise, refer to displayed comments and the
following to improve the status of communication link, and click Remeasurement.

Check that the printer and the access point are located within the wireless connectivity range with
no obstacles between them.

Check if the distance between the printer and the access point is not too far.
If they are too far, move them closer together (within 164 ft./50 m).
Check that there is no barrier or obstacle between the printer and the access point.

In general, connection performance decreases for communications through walls or between
different floors. Adjust the locations to avoid such situations.

Check that there are no sources of radio interference near the printer and the access point.

The wireless connection may use the same frequency band as microwave ovens and other
sources of radio interference. Try to keep the printer and the access point away from such sources.

Check if the radio channel of the access point is close to that of other access points nearby.

If the radio channel of the access point is close to that of other access points nearby, the
connection performance may become unstable. Be sure to use a radio channel that does not
interfere with other access points.

Check that the printer and the access point face each other.

Connection performance may depend on the orientations of the wireless devices. Replace the
access point and the printer in another direction to achieve the best performance.

Check whether other computers are not accessing the printer.

If @ appears in the result of the measurement, check whether other computers are not accessing
the printer.
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If@ still appears even if you have tried the above, finish the measurement, then restart the |J Network
Tool to start over the measurement.

7. Click Finish.
> Note

+ If any messages appear on Overall Network Performance:, move the machine and access point
as instructed to improve the performance.
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Initializing the Network Settings of the Machine

22 Important

* Note that initialization erases all network settings on the machine, printing or scanning operation from a
computer over network may become impossible. To use the machine over network, perform setup with
the Setup CD-ROM or perform setup according to the instructions on our website.

1. Start up |J Network Tool.

2. Select the printer in Printers:.

3. Select Maintenance... from the Settings menu.

The Maintenance screen is displayed.

4. Click Initialize.

Settng Indialzabon
Tio retuam the prinder setiings to the faciony defaulls, chck: [Intislize]

Mebwords Ssbug of the Card Slot
¥ yeu plan fo use the cand slol via the nebwork, click [Sebup)
Status: Mot st

Insjructions 0% Cancs

5. When the confirmation screen is displayed, click Yes.

initialize Settings x|

Returns the printer settings to the factory defaults
Initialize settings?

The network settings of the printer is initialized.

Do not turn off the printer during initialization.
Click OK when initialization is complete.

Performing initialization when connected over wireless LAN will break the connection, so perform setup
with the Setup CD-ROM or perform setup according to the instructions on our website.

»» Note

* You can change the network settings of the printer using IJ Network Tool with USB connection after
initializing the LAN settings. To change the network settings using Canon IJ Network Tool, activate
wireless LAN in advance.
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Viewing the Modified Settings

The Confirmation screen is displayed when you modified the printer settings on the Configuration screen.
When you click Yes on the Confirmation screen, the following screen is displayed for confirming the
modified settings.

The followang settings were seni o the: printer,

Gettngs

ltem Setting Value
Adimin Passwond Lise
Adimiry Password Sl up

—
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Screens for Network Connection of |J Network Tool

» Canon IJ Network Tool Screen

» Configuration Screen

» Wireless LAN Sheet

» Search Screen

» WEP Details Screen

» WPA/WPA2 Details Screen

» Authentication Type Confirmation Screen

» PSK:Passphrase and Dynamic Encryption Setup Screen

» Setup Information Confirmation Screen

» Wired LAN Sheet

» Admin Password Sheet

» Network Information Screen

» Access Control Sheet

» Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen
» Edit Accessible IP Address Screen/Add Accessible IP Address Screen
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Canon IJ Network Tool Screen

This section describes the items and menus displayed on the Canon IJ Network Tool screen.

= [tems on the Canon |J Network Tool Screen

= Canon |J Network Tool Menus

Items on the Canon IJ Network Tool Screen

The following item is displayed on the Canon IJ Network Tool screen.

wd Canon Ll Netwerk Tool ﬂ
Eide View Settings Help
Frnlen
Harme St Moaded Post Name
- Canon Sy e . Avaiable  Canon SIS 75850y 1

Tl

F the prnber you nbend 10 uss is Aot debacied, refer 1o the |Instnucions], and check the
settings. Check the status of the printer 1o configune the seSings

I vy tabos & ferw mirwtes for @ prinder to be visible on the network after £ i tumed on
Plaase wal & whils and then click [Update)

1. Printers:

The printer name, status, printer model name, and port name are displayed.

A check mark next to the printer in the Name list indicates it is set as the default printer.

Configuration changes are applied to the selected printer.

2. Update

Performs printer detection again. Click this button if the target printer is not displayed.

22 Important

To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
If No Driver is displayed for the name, associate the port with the printer.

= \When the Printer Driver |s Not Associated with a Port

If Not Found is displayed for the status, check the followings:
* The access point is turned on.
* When using wired LAN, the LAN cable is connected properly.

If the printer on a network is not detected, make sure that the printer is turned on, then click
Update. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then click Update.

If the printer is being used from another computer, a screen is displayed informing you of this
condition.
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»» Note

* This item has the same function as Refresh in the View menu.

3. Configuration...

Click to configure settings of the selected printer.

= Configuration Screen

»» Note

* You cannot configure a printer that has the status Not Found.

» This item has the same function as Configuration... in the Settings menu.

Canon IJ Network Tool Menus

The following menu is displayed from the Canon IJ Network Tool screen.

1 2 3 4

| | canon u Network Tool | < |
[ e Juiew ) (Settings)( Hele] ;

Pnntens
Harma Statua Modad Pt Mama:
- Canon Sl P B Ayplable  CononSI®  NEAF SRS

Update Cerfiguraten

F the penler you riband 16 s & nol debadled, reler 1o the |Rstnaciens], and chedck the
settings. Check the status of the printer to configure the ssings

I iy tabon & ferr mirwtes for @ prinder to be visible on the network after £ i tumed on
Plaass wall & whils and then chck |Updata)

1. File menu

Exit
Exits IJ Network Tool.

2. View menu

Status
Displays the Status screen to confirm the printer connection status and wireless communication

status.

In the access point mode, this item is grayed out and you cannot confirm the printer connection
status.

= Status Screen

Refresh
Updates and displays the contents of Printers: on the Canon IJ Network Tool screen to the

latest information.

3% Important

» To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.

209



+ If No Driver is displayed for the name, associate the port with the printer.

= \When the Printer Driver Is Not Associated with a Port

+ If Not Found is displayed for the status, check the followings:
» The access point is turned on.
* When using wired LAN, the LAN cable is connected properly.

« If the printer on a network is not detected, make sure that the printer is turned on, then select
Refresh. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then select Refresh.

« If the printer is being used from another computer, a screen is displayed informing you of this
condition.

»» Note

 This item has the same function as Update in the Canon IJ Network Tool screen.

Network Information
Displays the Network Information screen to confirm the network settings of the printer and the
computer.

= Network Information Screen

Display Warning Automatically
Enables or disables automatic display of the instruction screen.

When this menu is selected, the instruction screen is displayed if one or more ports are
unavailable for printing.

. Settings menu

Configuration...
Displays the Configuration screen to configure settings of the selected printer.

= Configuration Screen

»» Note

» This item has the same function as Configuration... in the Canon IJ Network Tool screen.

Enable switch printer function
When you cannot use your printer, you can use the same one on the network instead. When you
enable this function and you cannot use your printer, the screen to confirm if you start searching
the same printer as yours is displayed. Follow the message on the screen.

»» Note

» When this function is enabled, a check mark appears on the menu.

Associate Port...
Displays the Associate Port screen and you can associate a port with the printer.

= Associate Port Screen

This menu is available when No Driver is displayed for the selected printer. Associating a port
with the printer enables you to use it.
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Maintenance...

Displays the Maintenance screen to revert the network settings of the printer to factory default
and to mount the card slot as the network drive.

= Maintenance Screen

Set up printer's wireless LAN...

You can change the access point mode settings. Perform settings following the message on the
screen.

If you change the Encryption Method: setting and the Password: setting on the Set up printer's
wireless LAN screen, the changed settings are applied to the printer settings.

> Note

* You can use this function only when you are using a computer compatible with the wireless LAN.

4. Help menu

Instructions
Displays this guide.
About

Displays the version of IJ Network Tool.
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Configuration Screen

You can change the configuration of the printer selected on the Canon IJ Network Tool screen.
Click the tab to select the sheet to change the settings.

The following screen is the example to change the setting on the Wireless LAN sheet.

22> Note

» This screen is not available depending on the printer you are using.

Virnieas LAN | Admin Password

o Lse the panber with wrsless LAN connection
Matwioek Topsa:
) Ifrastructne
55D Lea o o Search
Encrvption Mathod: | Lse WEP v | | Configurstion

TCPAP Sehup: (@) Get |P address guicmatically
) se neod IF address

For details on each sheet, see the following.
= Wireless LAN Sheet
= \Wired LAN Sheet

= Admin Password Sheet
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Wireless LAN Sheet

»>» Note

» This screen is not available depending on the printer you are using.

Allows you to set the printer with wireless LAN connection.

To display the Wireless LAN sheet, click the Wireless LAN tab on the Configuration screen.

Wienless LAN | iddein Password
W

Matwork Typa 1

l ® infrastructunes
I 2
SSie [e=—wrrs ) seaeh. }—3
Encryotsn Mathod: | Use WEP I cortigratin }—— B
. 4

TCPAP Sehup 5l |P pdeireas gl omaticaly
Use necd IF address

Insjructorns oK Cancel

1. Network Type:

Displays the wireless LAN mode currently selected.

Infrastructure
Connects the printer to the wireless LAN with an access point.

Access point mode
Connects external wireless communication devices (e.g. computers, smartphones, or tablets) to the
printer using it as an access point.

»» Note

* When Access point mode is displayed on Network Type:, you cannot change the settings on the
Wireless LAN sheet or the Admin Password sheet.

* You can perform setting from Set up printer's wireless LAN... on the Settings menu when you
use the printer with the access point mode.

Depending on the printer you are using, you can change the settings using the operation panel.

2. SSID:

The network name (SSID) of the wireless LAN currently used is displayed.
In the access point mode, the access point name (SSID) of the printer is displayed.
As the initial settings, the unique value is displayed.

»» Note

» Enter the same SSID that the access point is configured to use. The SSID is case-sensitive.
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3. Search...

The Search screen is displayed to select an access point to connect to.

= Search Screen

»» Note

» When IJ Network Tool runs over a LAN, the button is grayed out and cannot be selected. Connect
the printer and the computer with a USB cable temporarily to change the settings.

4. Encryption Method:

Select the encryption method used over the wireless LAN.

Do not use
Select to disable encryption.

Use WEP
Transmission is encrypted using a WEP key you specified.

If a WEP key has not been set, the WEP Details screen is displayed automatically. To change WEP
settings set before, click Configuration... to display the screen.

= Changing the WEP Detailed Settings

Use WPA/WPA2
Transmission is encrypted using a WPA/WPAZ2 key you specified.

The security has been strengthened more than WEP.

If a WPA/WPA2 key has not been set, the Authentication Type Confirmation screen is displayed
automatically. To change WPA/WPA2 settings set before, click Configuration... to display the
WPA/WPA2 Details screen.

= Changing the WPA/WPAZ2 Detailed Settings

5. Configuration...

The detailed settings screen is displayed. The WEP or the WPA/WPAZ2 key selected in Encryption
Method: can be confirmed and changed.

For details on WEP setting:
= Changing the WEP Detailed Settings

For details on WPA/WPA2 setting:
= Changing the WPA/WPA2 Detailed Settings

6. TCP/IP Setup:

Sets the IP address of the printer to be used over the LAN. Specify a value appropriate for your network
environment.

Get IP address automatically
Select this option to use an IP address automatically assigned by a DHCP server. DHCP server
functionality must be enabled on your wireless LAN router or access point.

Use next IP address
Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a particular IP address or a fixed IP address.
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Search Screen

»» Note

» This screen is not available depending on the printer you are using.

The access points detected are listed.

Search ﬂ

The following ecoess poirts were deleci=d
Seled] 1he access panl Lo conned o, and click [541]

Detected Access Points:

Swength  Encpbon Access Pomt Mam... Chanmel &

T rr
T WPAMWPAZ
T T
a3
— Con

1. Detected Access Points:

The signal strength from the access point, encryption type, name of access point, and the radio channel
can be confirmed.

3% Important

« If you connect to a network that is not protected with security measures, there is a risk of
disclosing data such as your personal information to a third party.

»» Note

+ Signal strength is displayed as follows.
Tl Good
T - Fair
T - Poor

» Type of encryption is displayed as follows.
Blank: No encryption
WEP: WEP is set
WPA/WPA2: WPA/WPAZ2 is set

2. Update

Click to update the list of access points when your target access point is not detected.

If the target access point is set to the stealth mode, click Cancel to return to the previous screen and
enter the access point's SSID in SSID: on the Wireless LAN sheet.

= \\Vireless LAN Sheet
> Note

* When detecting your target access point, make sure that the access point is turned on.
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3. Set

Click to set the access point's SSID in SSID: on the Wireless LAN sheet.
2> Note

» The WEP Details screen or the WPA/WPAZ2 Details screen appears if the selected access point
is encrypted. In this case, configure the details to use the same encryption settings set to the
access point.

» Access points that cannot be used by this machine (including those configured to use different
encryption methods) are displayed grayed out and cannot be configured.
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WEP Details Screen

»>» Note

» This screen is not available depending on the printer you are using.

Specify the printer WEP settings.

WEP Details u
[wep key =1
{ Ky Longin 12808 2
[Kz:.- Fomat ASCH «-]— 3
(e 0 i 4
[i\lhrrl:r_.u:,m LT H]— 5
Indlf icliong 0K Cancsl

»» Note

» When changing the password (WEP key) of the printer, the same change must be made to the
password (WEP key) of the access point.

1. WEP Key:

Enter the same key as the one set to the access point.

The number of characters and character type that can be entered differ depending on the combination of
the key length and key format.

Key Length

64bit 128bit

Key Format | ASCII 5 characters | 13 characters

Hexadecimal (Hex) [ 10 digits 26 digits

2. Key Length:

Select either 64bit or 128bit.

3. Key Format:

Select either ASCII or Hex.

4. Key ID:

Select the Key ID (index) set to the access point.

5. Authentication:

Select the authentication method to authenticate the printer's access to the access point.

Select Auto or Open System or Shared Key.
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WPA/WPA2 Details Screen

»>» Note

» This screen is not available depending on the printer you are using.

Specify the printer WPA/WPAZ2 settings.

The value displayed on the screen differs depending on the present settings.

WPA/WPAZ Details H
The cument, ssllings Yor ciend sutherticalion ae as [dlews. To change
e wsitingm. click [Change Sellings)
[.r‘-.l.l'\-r.-mr;mm Tipe: F‘E-K] 1
2 1
[D'rnaﬂc Encryption Type Mo | a
Insfrucions CK

1. Authentication Type:
Displays the type of authentication used for client authentication. This machine supports the PSK
authentication method.

2. Dynamic Encryption Type:

Displays the dynamic encryption method.

3. Change Settings...

Displays the Authentication Type Confirmation screen.

= Authentication Type Confirmation Screen
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Authentication Type Confirmation Screen

22> Note

» This screen is not available depending on the printer you are using.

Type of authentication used for client authentication is displayed.

Check the authentication type. and chok [hed]
Autheniscabion Type
oBSK T’
Instructions Bock [ Mew» | [ Cancel

1. Authentication Type

Type of authentication used for client authentication is displayed.

PSK
This machine supports the PSK authentication method.

This authentication type PSK uses a passphrase.
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PSK:Passphrase and Dynamic Encryption Setup Screen

22> Note

» This screen is not available depending on the printer you are using.

Enter the passphrase and select the dynamic encryption method.

[ Pamsphress.

1. Passphrase:

Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63 alphanumeric
characters or a 64-digit hexadecimal value.

If you do not know the access point passphrase, refer to the instruction manual provided with the access
point or contact its manufacturer.

2. Dynamic Encryption Type

The dynamic encryption method is selected from either TKIP (basic encryption) or AES (secure
encryption) automatically.
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Setup Information Confirmation Screen

22> Note

» This screen is not available depending on the printer you are using.

Displays the settings used for client authentication.

Confirm the settings and click Finish.

Check Lhe sellings for diert aulberfication, and then cick
[Firigh].

Ffuthentication Type PSK

Dynamc Ercryphion Type:  Auto

221



Wired LAN Sheet

»>» Note

» This screen is not available depending on the printer you are using.

Allows you to set the printer with wired LAN connection.

To display the Wired LAN sheet, click the Wired LAN tab on the Configuration screen.

Configuration “

Weed LAN  Admin Password

TEPAP Sehup ® (et IF adoress puiomaticaly
Liss resd IF addenss

Insjructorns oK Cancel

1. TCPI/IP Setup:

Sets the IP address of the printer to be used over the LAN. Specify a value appropriate for your network
environment.

Get IP address automatically

Select this option to use an IP address automatically assigned by a DHCP server. DHCP server
functionality must be enabled on your router.

Use next IP address
Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a particular IP address or a fixed IP address.
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Admin Password Sheet

Set a password for the printer to allow specific people to perform setup and configurations operation.

To display the Admin Password sheet, click the Admin Password tab on the Configuration screen.

1. Use admin password

Set an administrator password with privileges to set up and change detailed options. To use this feature,
select this check box and enter a password.

2. Password:

Enter the password to set.

3. Password Confirmation:

Enter the password again for confirmation.

32 Important

« If you forget the administrator password you specified, initialize the printer to revert the password to the
default setting.
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Network Information Screen

Display the network information that is set for the printers and the computers.

To display the Network Information screen, select Network Information from the View menu.

-
Network Inforsation
Gereral Info.
B R e e LT | B b
WI;:IH..,.,,.,..,..,.,:-t—l?:'—o-
(OPParEr « & o v v v aow e oa oo o 3 e R oy Pt
MIEINP Port Name. . . . . . . . @ 60k Sl e .
DSNScarmer . . . v v v von e e R ey ey —
L T . R R | o g
(M0IRNP Port Mormitor Version . . . . . . 1 LA
Application Info.
< >
instructions ok coov 0 nommaton
|
1 2
1. OK

Returns to the Canon IJ Network Tool screen.

2. Copy All Information

All network information displayed is copied to the clipboard.
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Access Control Sheet

22> Note

» This screen is not available depending on the printer you are using.

You can register the MAC addresses or the IP addresses of computers or network devices to allow access.

To display the Access Control sheet, click the Access Control tab on the Configuration screen.

Wreless LAM | Wead LAN  Access Dontrol | Admin Passwond
[E‘rnur Access Control Type: MAL Adedr 58 W ]- =1
[ Ensble printer socess con trolldAD sddre 55)
MAL Address Commant
Edl At (£
Instructions : (=13 ] Cancel

1. Printer Access Control Type:

Select the type of access control with which to limit access of computers or network devices to the
printer over a network.

The setting items may differ depending on the choice of access control methods.

= \When Selecting MAC address

= \When Selecting IP address

When Selecting MAC address

The accessible computers or network devices are specified by their MAC addresses. Computers or
network devices whose MAC addresses appear on the list are allowed access.

Wraless LaM | Wread Lap Acsess Dontrol | asmin Paseeeosd

Brinter Acoers Control Type: WAD haddru s .
[oF| Envalsbe printer aooess oontrolAL widre ss) — 1
Accesrble WAL Addrerses
MLAL Address Commant

[ T T

Instructions | oK Clan el
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1. Enable printer access control(MAC address)

Select to enable access control to the printer by MAC address.

> Note

» The two types of access control (i.e., by MAC address and by IP address) can be enabled at

the same time.
An access control type is enabled as long as the Enable printer access control check box is
selected, regardless of the type currently displayed by selecting in Printer Access Control
Type:.

* When both access control types are enabled at the same time, a computer or a network device
whose address is registered to either list will be allowed access to the printer.

2. Accessible MAC Addresses:

Shows the registered MAC addresses and any comments.

3. Edit...

The Edit Accessible MAC Address screen is displayed to edit the settings selected in Accessible
MAC Addresses:.

= Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen

4. Add...

The Add Accessible MAC Address screen is displayed to register the MAC address of a computer or
a network device from which to access the printer over the network.

22 Important

» Add the MAC address of all computers or network devices within the network from which to
access the printer. The printer cannot be accessed from a computer or a network device that is

not on the list.

5. Delete

Deletes the selected MAC address from the list.
When Selecting IP address

The accessible computers or network devices are specified by their IP addresses. Computers or network
devices whose IP addresses appear on the list are allowed access.
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Wirikiss LAM | Wrad LAM  Access Dontrol | Asmen Passmoed

Printar dcouss Control Type 1P Addrans

o | Enalila prin bar accass ooninol]F sddress) 1
Aoce gzt P Adre 5es

IF Adddra a3 Comimsi 't
]

e -

Diancal

ﬂ
I

B

Instructons

1. Enable printer access control(IP address)

Select to enable access control to the printer by IP address.

»» Note

» The two types of access control (i.e., by MAC address and by IP address) can be enabled at
the same time.

An access control type is enabled as long as the Enable printer access control check box is
selected, regardless of the type currently displayed by selecting in Printer Access Control
Type:.

* When both access control types are enabled at the same time, a computer or a network device
whose address is registered to either list will be allowed access to the printer.

2. Accessible IP Addresses:

Shows the registered IP addresses and any comments.

3. Edit...

The Edit Accessible IP Address screen is displayed to edit the settings selected in Accessible IP
Addresses:.

= Edit Accessible I[P Address Screen/Add Accessible IP Address Screen

4. Add...

The Add Accessible IP Address screen is displayed to register the IP address of a computer or a
network device from which to access the printer over the network.

32 Important

» Add the IP address of all computers or network devices within the network from which to access
the printer. The printer cannot be accessed from a computer or a network device that is not on
the list.

» Up to 16 IP addresses can be registered. IP addresses specified by Range Specification are
counted as one address. Use Range Specification when you intend to register 17 or more IP
addresses.
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5. Delete

Deletes the selected IP address from the list.
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Edit Accessible MAC Address Screen/Add Accessible MAC
Address Screen

»» Note

» This screen is not available depending on the printer you are using.

The example screenshots in this section refer to the Add Accessible MAC Address Screen.

[H.Al: A g = = = i 3 J_ 1
[Qoﬂm nt ]—E
Insiructions oK Cancel

1. MAC Address:

Enter the MAC address of a computer or a network device to allow access.

2. Comment:
Optionally enter any information to identify the device, such as the name of the computer.

3% Important

+ Comments will be displayed only on the computer used to enter them.
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Edit Accessible IP Address Screen/Add Accessible IP Address
Screen

»» Note

» This screen is not available depending on the printer you are using.

The example screenshots in this section refer to the Add Accessible IP Address Screen.

Add Accessible IP Address E

S pacitcaion b thod Singhe Address Specilcation w 1

T ) -
[ewwn' ]—3

Instructions [=].4 Cpnc!

1. Specification Method:

Select either Single Address Specification or Range Specification to add the IP address(es).

Single Address Specification
Specify each IP address separately.

Range Specification
Specify a range of successive IP addresses.

2. IP Address:

Enter the IP address of a computer or a network device to allow access when you selected Single
Address Specification in Specification Method:.

An IP address is expressed as four values ranging from 0 to 255.

Start IP Address:
Enter the first IP address in the range of addresses of the computers or network devices to allow
access when you selected Range Specification in Specification Method:.

An IP address is expressed as four values ranging from 0 to 255.

End IP Address:
Enter the last IP address in the range of addresses of the computers or network devices to allow
access when you selected Range Specification in Specification Method:.

An IP address is expressed as four values ranging from 0 to 255.

> Note

* The Start IP Address: must be a smaller value than the End IP Address:.

3. Comment:
Optionally enter any information to identify the device, such as the name of the computer.

2% Important

» Comments will be displayed only on the computer used to enter them.
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Other Screens of |J Network Tool

» Canon IJ Network Tool Screen

» Status Screen

» Connection Performance Measurement Screen
» Maintenance Screen

» Network Setup of the Card Slot Screen

» Associate Port Screen

» Network Information Screen
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Canon IJ Network Tool Screen

This section describes the items and menus displayed on the Canon IJ Network Tool screen.

= [tems on the Canon |J Network Tool Screen

= Canon |J Network Tool Menus

Items on the Canon IJ Network Tool Screen

The following item is displayed on the Canon IJ Network Tool screen.

wd Canon Ll Netwerk Tool ﬂ
Eide View Settings Help
Frnlen
Harme St Moaded Post Name
- Canon Sy e . Avaiable  Canon SIS 75850y 1

Tl

F the prnber you nbend 10 uss is Aot debacied, refer 1o the |Instnucions], and check the
settings. Check the status of the printer 1o configune the seSings

I vy tabos & ferw mirwtes for @ prinder to be visible on the network after £ i tumed on
Plaase wal & whils and then click [Update)

1. Printers:

The printer name, status, printer model name, and port name are displayed.

A check mark next to the printer in the Name list indicates it is set as the default printer.

Configuration changes are applied to the selected printer.

2. Update

Performs printer detection again. Click this button if the target printer is not displayed.

22 Important

To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
If No Driver is displayed for the name, associate the port with the printer.

= \When the Printer Driver |s Not Associated with a Port

If Not Found is displayed for the status, check the followings:
* The access point is turned on.
* When using wired LAN, the LAN cable is connected properly.

If the printer on a network is not detected, make sure that the printer is turned on, then click
Update. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then click Update.

If the printer is being used from another computer, a screen is displayed informing you of this
condition.

232



»» Note

* This item has the same function as Refresh in the View menu.

3. Configuration...

Click to configure settings of the selected printer.

= Configuration Screen

»» Note

* You cannot configure a printer that has the status Not Found.

» This item has the same function as Configuration... in the Settings menu.

Canon IJ Network Tool Menus

The following menu is displayed from the Canon IJ Network Tool screen.

1 2 3 4

| | canon u Network Tool | < |
[ e Juiew ) (Settings)( Hele] ;

Pnntens
Harma Statua Modad Pt Mama:
- Canon Sl P B Ayplable  CononSI®  NEAF SRS

Update Cerfiguraten

F the penler you riband 16 s & nol debadled, reler 1o the |Rstnaciens], and chedck the
settings. Check the status of the printer to configure the ssings

I iy tabon & ferr mirwtes for @ prinder to be visible on the network after £ i tumed on
Plaass wall & whils and then chck |Updata)

1. File menu

Exit
Exits IJ Network Tool.

2. View menu

Status
Displays the Status screen to confirm the printer connection status and wireless communication

status.

In the access point mode, this item is grayed out and you cannot confirm the printer connection
status.

= Status Screen

Refresh
Updates and displays the contents of Printers: on the Canon IJ Network Tool screen to the

latest information.

3% Important

» To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
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+ If No Driver is displayed for the name, associate the port with the printer.

= \When the Printer Driver Is Not Associated with a Port

+ If Not Found is displayed for the status, check the followings:
» The access point is turned on.
* When using wired LAN, the LAN cable is connected properly.

« If the printer on a network is not detected, make sure that the printer is turned on, then select
Refresh. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then select Refresh.

« If the printer is being used from another computer, a screen is displayed informing you of this
condition.

»» Note

 This item has the same function as Update in the Canon IJ Network Tool screen.

Network Information
Displays the Network Information screen to confirm the network settings of the printer and the
computer.

= Network Information Screen

Display Warning Automatically
Enables or disables automatic display of the instruction screen.

When this menu is selected, the instruction screen is displayed if one or more ports are
unavailable for printing.

. Settings menu

Configuration...
Displays the Configuration screen to configure settings of the selected printer.

= Configuration Screen

»» Note

» This item has the same function as Configuration... in the Canon IJ Network Tool screen.

Enable switch printer function
When you cannot use your printer, you can use the same one on the network instead. When you
enable this function and you cannot use your printer, the screen to confirm if you start searching
the same printer as yours is displayed. Follow the message on the screen.

»» Note

» When this function is enabled, a check mark appears on the menu.

Associate Port...
Displays the Associate Port screen and you can associate a port with the printer.

= Associate Port Screen

This menu is available when No Driver is displayed for the selected printer. Associating a port
with the printer enables you to use it.

234



Maintenance...

Displays the Maintenance screen to revert the network settings of the printer to factory default
and to mount the card slot as the network drive.

= Maintenance Screen

Set up printer's wireless LAN...

You can change the access point mode settings. Perform settings following the message on the
screen.

If you change the Encryption Method: setting and the Password: setting on the Set up printer's
wireless LAN screen, the changed settings are applied to the printer settings.

> Note

* You can use this function only when you are using a computer compatible with the wireless LAN.

4. Help menu

Instructions
Displays this guide.
About

Displays the version of IJ Network Tool.
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Status Screen

You can check the printer status and connection performance.

To display the Status screen, select Status from the View menu.

13 Note

» This screen is not available depending on the printer you are using.

* When using wired LAN, Signal Strength:, Link Quality: and Advanced Measurement... are not
available.

Im&m-ml 1
Signal rength
B1% -2
Lirk sty
% % -3
|

1. Device Status:

The device status is displayed as Available or Unavailable.

2. Signal Strength:

Indicates the strength of the signal received by the printer, ranging from 0% to 100%.

3. Link Quality:

Indicates the signal quality excluding the noise while communicating, ranging from 0% to 100%.

4. Advanced Measurement...

To examine the connection performance between the printer and the access point or between the printer
and the computer.

When you click, the Connection Performance Measurement is displayed.

= Connection Performance Measurement Screen
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Connection Performance Measurement Screen

22> Note

» This screen is not available depending on the printer you are using.

Displays to execute the connection performance measurement.

= Connection Performance Measurement Screen (Initial Screen)

= Connection Performance Measurement Screen (Completion Screen)

Connection Performance Measurement Screen (Initial Screen)

Click Next> to start measurement.

Thia veizard vell maasure the correction perfoemance bsiwesn the peanber and
then Bccesa point. and dapley whather & i3 sulable for prnting.
Chasch thaat the panber i tumed an_ and clck [Nesd]

'When the connection pesformancee is poor, place the panber closer to the access
between them, Poor

- R will 1akos B couple of minules 1o measune the cornaction
Hmmwﬂmmnﬂhm:nmj

Iratpuctiona o (T

Connection Performance Measurement Screen (Completion Screen)

Displays when the measurement is finished.

]aﬂ ﬁ’bj

Cormaction Pedomance bebwesn the Printer and the Access Point
—————e e ]

@ e .
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1. Connection Performance between the Printer and the Access Point:

A mark indicates the result of the connection performance measurement between the printer and the
access point.

9: Good connection performance
&: Unstable connection performance
@: Cannot connect

@: Measurement is canceled, or cannot measure

2. Remeasurement

Measures the connection performance again.

»» Note

* If any messages appear on Overall Network Performance:, move the machine and access point as
instructed to improve the performance.
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Maintenance Screen

Displays to perform Setting Initialization and Network Setup of the Card Slot.

To display the Maintenance screen, select Maintenance... from the Settings menu.

1. Setting Initialization

Setting Initialzation
Ta retuem Bhe porder setimgs Ba the faciony defaulls, chok [Indishas] .I
Intihze
Network Setup of the: Card Slot
¥y plary 1o use the cand slol via the networ:, sick [Sebup) 2
Status: Mot set Sehu
Insjructions: 0% Cancsl

Reverts all the network settings of the printer to factory default. Click Initialize to display the Initialize
Settings screen and click Yes to initialize the network settings of the printer. Do not turn off the printer
during initialization. Click OK when initialization is complete.

Performing initialization when connected over wireless LAN will break the connection, so perform setup

with the Setup CD-ROM or perform setup according to the instructions on our website.

2. Network Setup of the Card Slot

»» Note

» This item is not available depending on the printer you are using.

Status displays whether the card slot is mapped as a network drive.

When you click, the Network Setup of the Card Slot is displayed.

= Network Setup of the Card Slot Screen
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Network Setup of the Card Slot Screen

»>» Note

» This screen is not available depending on the printer you are using.

Displays settings of the card slot and allows you to map a card slot on the network as a network drive on the
computer.

Displays when you click Setup on the Maintenance screen.

= Network Setup of the Card Slot Screen (Setup Screen)

= Network Setup of the Card Slot Screen (Setup Failed Screen)
»>» Note

* You can change the network settings of the printer using IJ Network Tool with USB connection after
initializing the LAN settings. To change the network settings using IJ Network Tool, activate the LAN

settings in advance.

Network Setup of the Card Slot Screen (Setup Screen)

Metwork Setup of the Card Slot E

Map the cand siot as a network deve bo this computer
Speeciby thes deves letber ared chick JOK]

I 1

= Lannll Eago1-»

Insjructions [ 0K Cancsl

1. Drive:

Select the drive letter to assign to the network drive.

2. Update

Reloads the drive letters that are unassigned in Computer (My Computer in Windows XP) and
displays them in the Drive: list.

Network Setup of the Card Slot Screen (Setup Failed Screen)

Display when the network setup of the card slot is failed.
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Communication with the Card Slof fadled .
Plaass refer io the [Instructions]. then click; [Retry].

1. Skip

Completes the setup without mapping a network drive to the card slot.

2. Retry

Returns to Network Setup of the Card Slot screen and re-executes the network drive mapping.

3. Cancel

Cancels the card slot setup. When IJ Network Tool is running over LAN, the Cancel button is
displayed grayed out and cannot be clicked.
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Associate Port Screen

Allows you to associate a created port with a printer driver.
Select the printer for which you want to change the association, then click OK.

13 Note

* You cannot print with the printer unless the printer driver is associated with the port.

o |
Conon B ™1
Microscht . PORTPROMPT:
Micregeft . SHRFAX:

mr_m

1. Model:

Displays the name of device specified as a destination port.

It is blank if the name of device is not detected.

2. Printer:

Displays the printer driver installed in the computer.

Select the printer for which you want to change the association.

3. OK

Performs association.
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Network Information Screen

Display the network information that is set for the printers and the computers.

To display the Network Information screen, select Network Information from the View menu.

-
Network Inforsation
Gereral Info.
B R e e LT | B b
WI;:IH..,.,,.,..,..,.,:-t—l?:'—o-
(OPParEr « & o v v v aow e oa oo o 3 e R oy Pt
MIEINP Port Name. . . . . . . . @ 60k Sl e .
DSNScarmer . . . v v v von e e R ey ey —
L T . R R | o g
(M0IRNP Port Mormitor Version . . . . . . 1 LA
Application Info.
< >
instructions ok coov 0 nommaton
|
1 2
1. OK

Returns to the Canon IJ Network Tool screen.

2. Copy All Information

All network information displayed is copied to the clipboard.
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Appendix for Network Communication

» Using the Card Slot over a Network

» When the Printer Driver Is Not Associated with a Port
» About Technical Terms

» Restrictions

» About Firewall
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Using the Card Slot over a Network

22> Note

» This screen is not available depending on the printer you are using.

= Mounting the Card Slot as the Network Drive

= Restrictions on Card Slot Use over a Network

Mounting the Card Slot as the Network Drive

The card slot must be mounted to use it over a network.

To mount the card slot as the network drive, follow the procedure below.

[

. Insert a memory card into the card slot of the machine.

N

. Start up IJ Network Tool.

w

. Select the machine in Printers:.

D

. Select Maintenance... on the Settings menu.

o

. Click Setup.

Setting Intialization
T restuam thes prinder settings ba the faciony defeulls, ek [Intislize].
st
Network Sebup of the Card Slot
¥ you plan 1o use the cand siol via the networ, ook [Sahup].
s v (== )
Insjructions o8 Cancsl

Map the card siot a5 a network deve to this compuber
Speciy the déve letter and diick [OK]
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7. Make sure that the card slot is mounted.
When the card slot is mounted, the following icon appears on Computer (or My Computer).

canon_memory

-2

Restrictions on Card Slot Use over a Network

» The card slot can be shared by multiple computers, if the machine is connected to a network. Multiple
computers can read files from a memory card in the card slot at the same time. However, while one
computer is writing a file into a memory card, other computers cannot access the same file.

* If your computer joins a domain, the card slot may not be mounted as the network drive.

* If you use the memory card stored the large size files or many files, a large amount of card access
may be generated. In this case, the operation in the memory card may be impossible or slow. Operate
after the Access lamp of the machine is lit.

* When you access the network drive for the card slot over the network, file names consisting of eight
or less lowercase letters (not including its extension) may be shown in uppercase.

For example, a file name such as "abcdefg.doc" will be "ABCDEFG.DOC", while a name such as
"AbcdeFG.doc" will appear the same.

The file is not actually renamed, but merely appears to be changed.

» When you enable a memory card in the card slot of the machine to be writable only from a USB-
connected computer, you cannot access the network drive of the card slot. On the other hand, when
you enable it to be writable only from a LAN-connected computer, the card slot is not detected via
USB. Make sure that the card slot setting is selected properly according to your connection method.

To read files from a memory card via USB and over a network, disable the function to write files to a
memory card from a computer. You cannot write files to a memory card in either way with this setting.

* When you enable a memory card in the card slot of the machine to be writable only from a LAN-
connected computer, you can write files to a memory card from a computer connected to a network.
Note that it may increase the risk that the data on the memory card is infected by computer viruses or
accessed illegally.

It is recommended to use the access control function of the machine or connect to the Internet via a
router. For information on using a router, contact your Internet service provider or a network device
manufacturer.

« If you write files to a memory card over a network when IJ Network Scanner Selector EX is not
running, the Date Modified of the files may not be proper. Make sure to start up IJ Network Scanner
Selector EX before you write files to a memory card over the network. For details, refer to "IJ Network
Scanner Selector EX Menu and Setting Screen” from the HOME of your product's Online Manual.

246



When the Printer Driver Is Not Associated with a Port

If No Driver is displayed for the printer's name on the Canon IJ Network Tool screen, the printer driver is
not associated with a created port.

To associate a port with a printer driver, follow the procedure below.

1. Start up |J Network Tool.

2. Select the printer displayed as No Driver on Name.

3. Select Associate Port... on the Settings menu.

The Associate Port screen is displayed.

Associsbe a port with an instaled printer, Select 3 printerto associate with, and
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4. Select a printer to associate with a port.

The list of the printers that the printer driver is installed is displayed at Printer: on the Associate Port
screen. Select a printer to associate with a created port.

5. Click OK.
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About Technical Terms

In this section, technical terms used in the manual are explained.

»A

Access Point

A wireless transceiver or base station that receives information from wireless clients/the machine and
rebroadcasts it. Required in an infrastructure network.

Access point mode

The machine is used as an access point to connect external wireless communication devices (e.g.
computers, smartphones, or tablets) in an environment where no access point or wireless LAN router
is available. You can connect up to 5 devices to the machine using the access point mode.

Ad-hoc

Client computer and machine setting where wireless communication occurs on a peer-to-peer basis,
i.e., all clients in with the same SSID/network name communicate directly with each other. No access
point is required. This machine does not support ad-hoc communication.

Admin Password

Administrator password in IJ Network Tool to restrict access to network users. It must be entered to
access the printer and change printer settings.

AES

An encryption method. It is optional for WPA/WPAZ2. Strong cryptographic algorithm adopted within
U.S. government organizations for information processing.
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Authentication Method

The method that an access point uses to authenticate a printer through a wireless LAN. The methods
are agreeable each other.

When using WEP as an encryption method, the authentication method is able to fix to Open System
or Shared Key.

For WPA/WPA2, authentication method is PSK.
o Auto
The printer automatically changes its authentication method to match the access point.
o Open System

In this authentication method, the communication partner is authenticated without using WEP key
even if Use WEP is selected.

o Shared Key

In this authentication method, the communication partner is authenticated using the WEP key that
was set for encryption.

Bonjour

A service built into Mac OS X operating system to detect the connectable devices on a network
automatically.

Channel

Frequency channel for wireless communication. In the infrastructure mode, the channel is
automatically adjusted to match that set to the access point. This machine supports channels 1 to 13.
(Channels 12 and 13 are not supported depending on the country or region of purchase.) Note that
the number of channels that can be used for your wireless LAN varies depending on the region or
country.

Default Gateway

A relay device to connect to another network such as a router or a computer.

DHCP server functionality

The router or the access point assigns an IP address automatically whenever the printer or the
personal computer on a network starts up.

DNS server

A server that converts device names into IP addresses. When specifying IP addresses manually,
specify the addresses of both a primary and a secondary server.
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¢ Firewall

It is a system that prevents an unlawful computer access in the network. To prevent, you can use the
firewall function of a broadband router, the security software installed in the computer, or operation
system for computer.

» |IEEE 802.11b
International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
11 Mbps.

* |IEEE 802.11g

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
54 Mbps. Compatible with 802.11b.

IEEE 802.11n

International standard for wireless LAN using the 2.4 GHz and 5 GHz frequency ranges. Even when
using two or more antennas simultaneously or obtaining a bigger transfer rate than before by using
multiple communication channels at the same time, the transmission speed may be influenced by the
connected apparatus.

At the maximum transfer rate of 600 Mbps, it is possible to communicate with multiple computer
terminals within a dozen or so metre radius.

Compatible with 802.11b and 802.11g.

Infrastructure

Client computer and machine setup where all wireless communications pass through an access point.

¢ |IP Address

A unique number with four parts separated by dots. Every network device that is connected to the
Internet has an IP address. Example: 192.168.0.1

An IP address is usually assigned by an access point or a DHCP server of the router automatically.

IPv4/IPv6

They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and IPv6 uses
128-bit addresses.

* Key Format

Select either ASCII or Hex as the WEP key format. The character that can be used for the WEP key
differs depending on the selected key formats.

> ASCII

Specify with a 5 or 13-character string that can include alphanumeric and underscore
characters. It is case-sensitive.
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o Hex

Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, Ato F, and a to f).

Key Length

Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a more
complex WEP key.

Link Quality

The status of connection between the access point and the printer excluding noise (interference) is
indicated with a value from 0 to 100%.

LPR

A platform-independent printing protocol used in TCP/IP networks. It is not supported bidirectional
communication.

MAC Address

Also known as the physical address. A unique and permanent hardware identifier that is assigned to
network devices by its manufacturer. MAC addresses are 48 bits long and are written as a
hexadecimal number separated by colons, i.e., 11:22:33:44:55:66.

Operation Status

Indicates the status on whether the printer can be used.

Proxy server

A server that links a LAN-connected computer to the Internet. When using a proxy server, specify the
address and the port number of the proxy server.

PSK
An encryption method employed by WPA/WPA2.

Router

A relay device to connect to another network.
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+ Signal Strength
The strength of the signal received by the printer from the access point is indicated with a value from
0 to 100%.

+ SSID

Unique label for wireless LAN. It is often represented such as a network name or an access point
name.

SSID distinguishes one wireless LAN from another to prevent interference.
The printer and all clients on a wireless LAN must use the same SSID in order to communicate with
each other. The SSID can be up to 32 characters long, and is made up of alphanumeric characters.
The SSID may also be referred to by its network name.

« Stealth
In the stealth mode, an access point hides itself by not broadcasting its SSID. The client must specify
the SSID set to the access point to detect it.

* Subnet Mask

IP address has two components, the network address and the host address. Subnet Mask used to
calculate the Subnet Mask address from the IP address. A Subnet Mask is usually assigned by an
access point or a DHCP server of the router automatically.

Example:

IP Address: 192.168.127.123

Subnet Mask: 255.255.255.0

Subnet Mask Address: 192.168.127.0

* TCP/IP

Suite of communications protocols used to connect hosts on the Internet or the LAN. This protocol
allows different terminals to communicate with each other.

* TKIP

An encryption protocol employed by WPA/WPAZ2.

- USB

Serial interface designed to enable you to "hot-swap" devices, i.e., by plugging and unplugging them
without turning off the power.
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* WCN (Windows Connect Now)
Users running Windows Vista or later can obtain the setting information directly via wireless network
(WCN-NET).

+ WEP/WEP Key

An encryption method employed by IEEE 802.11. Shared security key used to encrypt and decrypt
data sent over wireless networks. This printer supports key length of 64 bits or 128 bits, key format of
ASCII code or Hexadecimal, and key number of 1 to 4.

* Wi-Fi

International association that certifies interoperability of wireless LAN products based on the IEEE
802.11 specification.

This machine is a Wi-Fi authorized product.

* Wireless LAN
A network that, instead of being connected by physical wires, is connected by a wireless technology,
such as Wi-Fi.

+ WPA

Security framework announced by the Wi-Fi Alliance in October 2002. The security has been
strengthened more than WEP.

o Authentication

WPA defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA-802.1x that do require an authentication server.

This machine supports WPA-PSK.
o Passphrase
This encrypted key is used to perform WPA-PSK authentication.
The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.
+ WPA2

Security framework released by the Wi-Fi Alliance in September 2004 as a later version of WPA.
Provides a stronger encryption mechanism through Advanced Encryption Standard (AES).

o Authentication

WPA2 defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA2-802.1x that do require an authentication server.

This machine supports WPA2-PSK.
o Passphrase
This encrypted key is used to perform WPA2-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.
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* WPS (Wi-Fi Protected Setup)
WPS is a standard for easy and secure establishment of a wireless network.
There are 2 primary methods used in the Wi-Fi Protected Setup:
PIN entry: a mandatory method of setup for all WPS certified devices

Push button configuration (PBC): an actual push button on the hardware or through a simulated push
button in the software.
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Restrictions

If you use a printer over the wireless LAN, the printer may recognize nearby wireless systems, you should
set a network key (WEP or WPA/WPA?2) to the access point to encrypt wireless transmission. Wireless
communication with a product that does not comply with the Wi-Fi standard cannot be guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.

255



About Firewall

A firewall is a function of the security software installed in the computer or operation system for computer,
and is a system that is designed to prevent unauthorized access to a network.

Precautions When a Firewall Function is Enabled
« A firewall function may limit communications between a printer and a computer. This may disable
printer setup and communications.

» During the printer setup, you may be prompted to enable or disable communications, depending on
the firewall function of the security software or operation system. If so, choose to enable
communications.

* When using IJ Network Tool, you may be prompted to enable or disable communications, depending
on the firewall function of the security software. If so, choose to enable communications.

« If you cannot set up the printer, temporarily disable the firewall function of the security software or
operation system.

32 Important

+ If you disabled the firewall function, disconnect your network from the Internet.

» Some applications (like the network configuration software) override firewall settings. Check the
application's settings beforehand.

« If the printer you use is set to Get IP address automatically, the IP address changes every time the
printer connects to the network. This may disable printer setup and communications, depending on
the firewall settings. In this case, either change the firewall settings or assign a fixed IP address to the
printer. An IP address can be set using |J Network Tool.

= Changing the Settings in the Wireless LAN Sheet

= Changing the Settings in the Wired LAN Sheet

When assigning a fixed IP address to the printer, you will need to specify an IP address with which the
computer can communicate.

> Note

» For the operation system firewall settings or the security software firewall settings, refer to the
instruction manual of the computer or software, or contact its manufacturer.
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Tips for Ensuring Optimal Printing Quality

» Useful Information about Ink

» Key Points to Successful Printing

» Be Sure to Make Paper Settings after Loading Paper
» Canceling a Print Job

» Storing Printed Images

» Machine Handling Precautions

» Key to Enjoying Consistent Printing Quality

» Precautions for Safe Transport of the Machine
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Useful Information about Ink

How is ink used for various purposes other than printing?

Ink may be used for purposes other than printing. Ink is not only used for printing, but also for cleaning the
print head to maintain the optimal printing quality.

The machine has the function to automatically clean the ink jet nozzles to prevent clogging. In the
cleaning procedure, ink is pumped out from the nozzles. Used ink for nozzle cleaning is limited to a small
amount.

Does black-and-white printing use color ink?

Black-and-white printing may use ink other than black ink depending on the type of printing paper or the
settings of the printer driver. So, color ink is consumed even when printing in black-and-white.
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Key Points to Successful Printing

Check the machine status before printing!

* |Is the print head OK?

If a print head nozzle is clogged, print will be faint and papers will be wasted. Print the nozzle check
pattern to check the print head.

= Maintenance Procedure

« Is the inside of the machine smeared with ink?

After printing large quantities of paper, the area where papers go through may get smeared with ink.
Clean the inside of your machine with Bottom Plate Cleaning.

Check how to load the paper correctly!

* |Is the paper loaded in the correct orientation?

To load paper in the rear tray, load paper WITH THE PRINTING SIDE FACING YOU.

= | oading Paper

* |Is the paper curled?
The curled paper causes paper jam. Flatten the curled paper, then reload it.

= "Load the paper after correcting its curl." in Paper Is Smudged/Printed Surface Is Scratched
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Be Sure to Make Paper Settings after Loading Paper

If the media type setting is not the one for the loaded paper, printing results may not be satisfactory. After
loading paper, be sure to select the appropriate media type setting for the loaded paper.

= Print Results Not Satisfactory

There are various types of paper: paper with special coating on the surface for printing photos with optimal
quality and paper suitable for documents.

Each media type has specific preset settings, such as how ink is used and sprayed, distance from nozzles,
etc., so that you can print on that type with optimal image quality.

This allows you to print with the settings best suited for the loaded media type just by selecting that media
type.
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Canceling a Print Job

Never press the ON button!

If you press the ON button while printing is in progress, the print data sent from the computer queues in
the machine and you may not be able to continue to print.

Press the Stop button to cancel printing.
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Storing Printed Images

Store printed images in albums, clear photo sleeves, or glass frames to protect them from direct exposure to
air.

13 Note

« Storing printed images without sufficient drying may cause blurring or discoloration.
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Machine Handling Precautions

Do not place any object on the document cover!

Do not place any object on the document cover. It will fall into the rear tray when the document cover is
opened and cause the machine to malfunction. Also, place the machine where objects will not fall on it.

i N

263



Key to Enjoying Consistent Printing Quality

The key to printing with the optimal printing quality is to prevent the print head from drying or clogging.
Always observe the following rules for optimal printing quality.

Never unplug the power cord until the power is turned off!

If you press the ON button to turn off the power, the machine caps the print head (nozzles) automatically
to prevent from drying. If you unplug the power cord from the wall outlet while the ON lamp is lit or
flashing, the print head will not be capped properly and this will cause drying or clogging.

When unplugging the power cord, make sure that the ON lamp is not lit.

Print periodically!

Just as the tip of a felt pen becomes dry and unusabile if it has not been used for a long time, even if it is
capped, the print head too, may become dried or clogged if the machine has not been used for a long
time.

We recommend you to use the machine at least once a month.

»>» Note

» Depending on the type of paper, ink may blur if you trace the printed area with a highlight pen or
paint-stick, or bleed if water or sweat comes in contact with the printed area.
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Precautions for Safe Transport of the Machine

When relocating the machine, make sure of the following.

22 Important

Pack the machine in a sturdy box so that it is placed with its bottom facing down, using sufficient
protective material to ensure safe transport.

With the FINE cartridge left installed in the machine, press the ON button to turn off the power. This
allows the machine to automatically cap the print head, thus preventing it from drying.

After packing, do not tilt the box containing the machine or turn it on its side or upside down. Doing so
may cause the ink to leak during transport and cause damage to the machine.

When a shipping agent is handling transport of the machine, have its box marked "THIS SIDE UP" to
keep the machine with its bottom facing down. Mark also with "FRAGILE" or "HANDLE WITH CARE".

. Turn the machine off.

. Confirm that the ON lamp is off and unplugging the power cord.

2% Important

* Do not unplug the machine while the ON lamp is lit or flashing, as it may cause malfunction or
damage to the machine, making the machine unable to print.

. Retract the paper output tray and the output tray extension, then close the paper support.

Unplug the printer cable from the computer and from the machine, then unplug the power
cord from the machine.

Use adhesive tape to secure all the covers on the machine to keep them from opening
during transportation. Then pack the machine in the plastic bag.

. Attach the protective material to the machine when packing the machine in the box.
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Legal Limitations on Use of Your Product and Use of Images

It may be unlawful to make copies of, scan, print, or use reproductions of the following documents.

The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.

* Paper money

* Money orders

* Certificates of deposit

» Postage stamps (canceled or uncanceled)

+ ldentifying badges or insignias

» Selective service or draft papers

» Checks or drafts issued by governmental agencies
» Motor vehicle licenses and certificates of title

» Traveler's checks

» Food stamps

» Passports

» Immigration papers

* Internal revenue stamps (canceled or uncanceled)
» Bonds or other certificates of indebtedness

» Stock certificates

» Copyrighted works/works of art without permission of copyright owner
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Specifications

General Specifications

Printing resolution (dpi)

4800* (horizontal) x 600 (vertical)

* Ink droplets can be placed with a pitch of 1/4800 inch at minimum.

Interface

USB Port:

Hi-Speed USB *1

LAN Port:

Wireless LAN: IEEE802.11n / IEEE802.11g / IEEE802.11b *2

*1 A computer that complies with Hi-Speed USB standard is required. Since
the Hi-Speed USB interface is fully upwardly compatible with USB 1.1, it can
be used at USB 1.1.

*2 Setup possible through WPS (Wi-Fi Protected Setup), WCN (Windows
Connect Now) or Cableless setup.

USB and LAN can be used at the same time.

Print width

8 inches/203.2 mm

Operating environment

Temperature: 41 to 95 °F (5 to 35 °C)
Humidity: 10 to 90 % RH (no condensation)

* The performance of the printer may be reduced under certain temperature
and humidity conditions.

Recommended conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 10 to 80 % RH (no condensation)

* For the temperature and humidity conditions of papers such as photo paper,
refer to the paper's packaging or the supplied instructions.

Storage environment

Temperature: 32 to 104 °F (0 to 40 °C)
Humidity: 5 to 95 % RH (no condensation)

Power supply

AC 100-240 V, 50/60 Hz

Power consumption

Printing (Copy): Approx. 11 W *1
Standby (minimum): Approx. 1.6 W *1*2
OFF: Approx. 0.3 W

*1 Wireless LAN is active.

*2 The wait time for standby cannot be changed.

External dimensions

Approx. 16.8 (W) x 12.1 (D) x 5.8 (H) inches
Approx. 426 (W) x 306 (D) x 145 (H) mm

* With the Paper Support and Paper Output Tray retracted.

Weight

Approx. 7.6 Ib (Approx. 3.5 kg)
* With the FINE Cartridges installed.

Canon FINE Cartridge

Total 1280 nozzles (BK 320 nozzles, C/M/Y each 320 nozzles)
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Copy Specifications

Multiple copy

max. 21 pages

Scan Specifications

Scanner driver

Windows: TWAIN 1.9 Specification, WIA
Mac OS: ICA

Maximum scanning size

Ad/Letter, 8.5" x 11.7"/216 x 297 mm

Scanning resolution

Optical resolution (horizontal x vertical) max: 600 x 1200 dpi *1
Interpolated resolution max: 19200 x 19200 dpi *2

*1 Optical Resolution represents the maximum sampling rate based on ISO
14473.

*2 Increasing the scanning resolution will limit the maximum possible scanning
area.

Gradation (Input / Output)

Gray: 16 bit/8 bit
Color: 48 bit/24 bit (RGB each 16 bit/8 bit)

Network Specifications

Communication protocol

TCP/IP

Wireless LAN

Supported Standards: IEEE802.11n / IEEE802.11g / IEEE802.11b
Frequency bandwidth: 2.4 GHz
Channel: 1-11 or 1-13

* Frequency bandwidth and available channels differ depending on country or
region.

Communication distance: Indoors 164 feet/50 m

* Effective range varies depending on the installation environment and location.
Security:

WEP (64/128 bits)

WPA-PSK (TKIP/AES)

WPA2-PSK (TKIP/AES)

Setup:

WPS (Push button configuration/PIN code method)

WCN (WCN-NET)

Cableless setup

Other Features: Administration password

Minimum System Requirements

Conform to the operating system's requirements when higher than those given here.
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Windows

Operating System

Windows 8, Windows 8.1

Windows 7, Windows 7 SP1

Windows Vista SP1, Windows Vista SP2
Windows XP SP3 32-bit only

Browser

Internet Explorer 8 or later

Hard Disk Space

3GB
Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display

XGA 1024 x 768

Mac OS

Operating System

Mac OS X v10.6.8 or later

Browser

Safari 5 or later

Hard Disk Space

1.5 GB
Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display

XGA 1024 x 768

Other Supported OS

Some functions may not be available with each OS. Refer to the manual or the Canon web site for details on
operation with iOS, Android, and Windows RT.

Mobile Printing Capability

Google Cloud Print

PIXMA Cloud Link

* An internet connection is required to view the Online Manual.

» Windows: Operation can only be guaranteed on a computer with Windows 8.1, Windows 8,
Windows 7, Windows Vista or Windows XP pre-installed.

* Windows: A CD-ROM Drive or internet connection is required during software installation.

* Windows: Internet Explorer 8, 9, 10 or 11 is required to install Easy-WebPrint EX.

» Windows: Some functions may not be available with Windows Media Center.

» Windows: .NET Framework 4 or 4.5 must be installed to use the Windows software.

* Windows: XPS Essentials Pack is required to print on Windows XP.

» Windows: The TWAIN driver (ScanGear) is based on the TWAIN 1.9 Specification and requires the
Data Source Manager bundled with the operating system.

* Mac OS: Hard Disk must be formatted as Mac OS Extended (Journaled) or Mac OS Extended.

* Mac OS: For Mac OS, an internet connection is required during software installation.

* In an in-house network environment, the 5222 port must be open. Contact the network

administrator for details.
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Information in this guide is subject to change without notice.
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About the Administrator Password

An administrator password "canon" is already specified for the printer at the time of purchase.

32 Important

» For security reasons, it is recommended to change the password before you use the printer.

* You can change the password using one of the tools below. (Some tools may not be available
depending on the printer you are using.)

 operation panel of the printer

* 1J Network Tool

+ printer information screen displayed on some Canon application software
* When you change the password, use 0 to 32 alphanumeric characters.

« If the password has been changed while you are sharing the printer and you do not know the password,
ask the administrator of the printer you are using.

» The password reverts to the default setting by initializing the printer settings.
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Printing

oD

Printing from a Computer Printing from a Digital Camera
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Printing from a Computer

» Printing with Application Software that You are Using (Printer Driver)
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Printing with Application Software that You are Using (Printer
Driver)

» Printing with Easy Setup
» Various Printing Methods
» Changing the Print Quality and Correcting Image Data

» Overview of the Printer Driver

Y

Printer Driver Description

Updating the MP Drivers

Y
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Printing with Easy Setup

This section describes the simple procedure for setting the Quick Setup tab so that you can carry out
appropriate printing on this printer.

1. Check that the printer is turned on

2. Load paper on the printer

3. Open the printer driver setup window

4. Select a frequently used profile

In Commonly Used Settings on the Quick Setup tab, select a printing profile suited for the purpose.
When you select a printing profile, the Additional Features, Media Type, and Printer Paper Size
settings are automatically switched to the values that were preset.
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5. Select the print quality

For Print Quality, select High, Standard, or Draft according to your purpose.
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= 3% Important

» The print quality settings that can be selected may differ depending on a printing profile.

6. Complete the setup
Click OK.

When you execute print, the document is printed with settings that match your purpose.

Comrarly Used Setirns
E stardara

Bl Prets Prrtrgy
1] Eusiness Document

I Paper Saving
I - T

Prdar Paper Spe:
| Lol 2EE11 IRem hd

frertion:  @Fowss  Olodiowe
Piear Troy

Copees:

el ==

2 3% Important

* When you select the Always Print with Current Settings check box, all settings specified on the

Quick Setup, Main, and Page Setup tabs are saved, and you can print with the same settings from the
next time as well.

» In the Commonly Used Settings window, click Save... to register the specified settings.
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Paper Settings on the Printer Driver
When you use this printer, selecting a media type that matches the print purpose will help you achieve the

best print results.
You can use the following media types on this printer.

Commercially available papers

Media name Media Type in the printer driver

Plain Paper (including recycled paper) Plain Paper

Envelopes Envelope

Canon genuine papers (Photo Printing)

Media name <Model No.> Media Type in the printer driver
Photo Paper Plus Glossy Il <PP-201> Photo Paper Plus Glossy Il
Photo Paper Glossy <GP-501/GP-601> Glossy Photo Paper
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Various Printing Methods

» Setting a Page Size and Orientation

» Setting the Number of Copies and Printing Order
» Setting the Stapling Margin

» Fit-to-Page Printing

» Scaled Printing

» Page Layout Printing

Y

Tiling/Poster Printing

v

Booklet Printing

v

Duplex Printing

v

Stamp/Background Printing

v

Registering a Stamp

Y

Registering Image Data to be Used as a Background

Y

Setting Up Envelope Printing

v

Displaying the Print Results before Printing
» Setting Paper Dimensions (Custom Size)

» Editing the Print Document or Reprinting from the Print History
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Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:
You can also set page size and orientation on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.
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3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate 180 degrees check box when you want to
perform printing with the original being rotated 180 degrees.

4. Complete the setup

Click OK.

When you execute print, the document will be printed with the selected page size and the orientation.

»» Note

+ If Normal-size is selected for Page Layout, then Automatically reduce large document that the
printer cannot output is displayed.
Normally, you can leave the check box checked. During printing, if you do not want to reduce large
documents that cannot be printed on the printer, uncheck the check box.
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Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:
You can also set the number of copies on the Quick Setup tab.

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Page Setup tab, specify the number of copies to be printed.
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3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.

Check the Collate check box when you are printing multiple copies of a document and want to print out
all pages in each copy together. Uncheck this check box when you want to print all pages with the same
page number together.

* Print from Last Page: [ /Collate: [
A 1

* Print from Last Page: [l /Collate: [

LoaR 2,
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* Print from Last Page: @ /Collate: [']
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4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

32 Important

* When the application software that you used to create the document has the same function, specify the
settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.

» Print from Last Page appears grayed out and is unavailable when Tiling/Poster is selected for Page
Layout.

* When Booklet is selected for Page Layout, Print from Last Page and Collate appear grayed out and
cannot be set.

* When Duplex Printing (Manual) is selected, Print from Last Page appears grayed out and cannot be
set.

»» Note

» By setting both Print from Last Page and Collate, you can perform printing so that papers are collated
one by one starting from the last page.
These settings can be used in combination with Normal-size, Fit-to-Page, Scaled, and Page Layout.
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Setting the Stapling Margin

The procedure for setting the staple side and the margin width is as follows:

1. Open the printer driver setup window

2. Specify the side to be stapled

Check the position of the stapling margin from Stapling Side on the Page Setup tab.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best

staple position. When you want to change the setting, select from the list.
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3. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.
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»» Note

» The printer automatically reduces the print area depending on the staple position margin.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified staple side and margin width.

22 Important

+ Stapling Side and Specify Margin... appear grayed out and are unavailable when:
« Tiling/Poster or Booklet is selected for Page Layout
+ Scaled is selected for Page Layout (When Duplex Printing (Manual) is also selected, only
Stapling Side can be specified.)
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Fit-to-Page Printing
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The procedure for printing a document that is automatically enlarged or reduced to fit the page size to be

used is as follows:

1. Open the printer driver setup window

2. Set fit-to-page printing
Select Fit-to-Page from the Page Layout list on the Page Setup tab.
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3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
When the Printer Paper Size is smaller than the Page Size, the page image will be reduced. When the
Printer Paper Size is larger than the Page Size, the page image will be enlarged.

The current settings are displayed in the settings preview on the left side of the printer driver.

284



| Ousth Setup | Man | Fage S0 | Mastenance |

2 Page 5gm: Letter 8.5°%11" Z8diom

5. Complete the setup

Click OK.
When you execute print, the document will be enlarged or reduced to fit to the page size.
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Scaled Printing
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The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Set scaled printing
Select Scaled from the Page Layout list on the Page Setup tab.
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3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Set the scaling rate by using one of the following methods:

» Select a Printer Paper Size
When the printer paper size is smaller than the Page Size, the page image will be reduced. When
the printer paper size is larger than the Page Size, the page image will be enlarged.
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» Specify a scaling factor
Directly type in a value into the Scaling box.
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The current settings are displayed in the settings preview on the left side of the printer driver.

5. Complete the setup

Click OK.
When you execute print, the document will be printed with the specified scale.

= ¥%» Important
* When the application software which you used to create the original has the scaled printing function,
configure the settings on your application software. You do not need to configure the same setting in

the printer driver.
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»» Note

» Selecting Scaled changes the printable area of the document.
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Page Layout Printing

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for performing page layout printing is as follows:

1. Open the printer driver setup window

2. Set page layout printing

Select Page Layout from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Specify..., specify the following settings in the Page Layout Printing dialog box, and
click OK.
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To change the number of pages to be printed on a single sheet of paper, select the number of
pages from the list.

Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, check this check box.

. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.
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Tiling/Poster Printing

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for performing tiling/poster printing is as follows:
Setting Tiling/Poster Printing

1. Open the printer driver setup window

2. Set tiling/poster printing

Select Tiling/Poster from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the number of image divisions and the pages to be printed
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If necessary, click Specify..., specify the following settings in the Tiling/Poster Printing dialog box,
and then click OK.
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Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create
a larger poster.

Print "Cut/Paste” in margins
To leave out words "Cut" and "Paste", uncheck this check box.

»» Note

» This feature may be unavailable when certain printer drivers or operating environments are
used.

Print "Cut/Paste” lines in margins
To leave out cut lines, uncheck this check box.

Print page range
Specifies the printing range. Select All under normal circumstances.
To reprint only a specific page, select Pages and enter the page number you want to print. To
specify multiple pages, enter the page numbers by separating them with commas or by entering a
hyphen between the page numbers.

> Note

* You can also specify the print range by clicking the pages in the settings preview.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the document will be divided into several pages during printing.

Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Set the print range

In the settings preview on the left of the Page Setup tab, click the pages that do not need to be
printed.
The pages that were clicked are deleted, and only the pages to be printed are displayed.

292



uick Setup | Man | Fage Seip | Martensnce

X Page 5qm Letter 5511 22ci8cm

& Onertwion: A @ Form A Dllangecae
[ Rt 180 dagrens

BB Frrow Pocer Sa: | Leter 85017 23elem

Pogs Lopout:  Tiing Poater

g 3 & & =

P
mﬁ;n'm&m Momalsee  FrioPege  Scaled  Pogelowou [EEIEEE

< k]

B

Duples Prnting (anual)
Lorie-sicls iging (Lafl)

S
ﬁf of| Pant fom Last Page
] Catate
| Pagptptors | | Gamp/ladogend | [ Defmas |

[ || ol oy || b

23> Note

+ Click the deleted pages to display them again.
* Right-click the settings preview to select Print all pages or Delete all pages.

2. Complete the setup

After completing the page selection, click OK.
When you execute print, only specified pages will be printed.

32 Important

+ Since tiling/poster printing enlarges the document when printing it, the print results may become coarse.
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Booklet Printing

The booklet printing function allows you to print data for a booklet. Data is printed on both sides of the
paper. This type of printing ensures that pages can be collated properly, in page number order, when the
printed sheets are folded and stapled at the center.

dnw

The procedure for performing booklet printing is as follows:

1. Open the printer driver setup window

2. Set booklet printing

Select Booklet from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the window.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the margin for stapling and the margin width

Click Specify... and specify the following settings in the Booklet Printing dialog box, and then click OK.
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Margin for stapling
Select which side should the stapling margin be on when the booklet is completed.

Insert blank page
To leave one side of a sheet blank, check the check box, and select the page to be left blank.

Margin
Enter the margin width. The specified width from the center of the sheet becomes the margin width
for one page.

Page Border
To print a page border around each document page, check the check box.

5. Complete the setup
Click OK on the Page Setup tab.

When you execute print, the document will be printed on one side of a sheet of paper. When the printing
of one side is complete, set the paper correctly by following the message and click OK.

When the printing of the other side is complete, fold the paper at the center of the margin and make a
booklet.

32 Important

* Booklet cannot be selected when a media type other than Plain Paper is selected for Media Type on
the Main tab.

»» Note

» The stamp and background are not printed on the inserted blank sheets with the Insert blank page
function of booklet printing.
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Duplex Printing
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The procedure for printing data on both sides of a sheet of paper is as follows:
You can also set duplex printing in Additional Features on the Quick Setup tab.

1. Open the printer driver setup window

2. Set duplex printing

Check the Duplex Printing (Manual) check box on the Page Setup tab.
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3. Select the layout

Select Normal-size, Fit-to-Page, Scaled, or Page Layout from the Page Layout list.

4. Specify the side to be stapled

The best Stapling Side is selected automatically from the Orientation and Page Layout settings. To
change the setting, select another stapling side from the list.

5. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.

6. Complete the setup
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Click OK on the Page Setup tab.

When you execute print, the document is first printed on one side of a sheet of paper. After one side is
printed, reload the paper correctly according to the message.
Then click Start Printing to print the opposite side.

32 Important

* When a media type other than Plain Paper is selected from Media Type on the Main tab, Duplex
Printing (Manual) appears grayed out and is unavailable.

* When Tiling/Poster or Booklet is selected from the Page Layout list, Duplex Printing (Manual) and
Stapling Side appear grayed out and are unavailable.

»>» Note

« If the back side of the paper becomes smudged during duplex printing, perform Bottom Plate Cleaning
in the Maintenance tab.

Related Topics

= Cleaning Inside the Printer
= Changing the Printer Operation Mode
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Stamp/Background Printing

Stamp or Background may be unavailable when certain printer drivers or operating environments are used.

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light illustration
behind the document data.

The procedure for performing stamp/background printing is as follows:

Printing a Stamp

"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab
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22> Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button
and only the stamp function can be used.

298



3. Select a stamp

Check the Stamp check box, and select the stamp to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the stamp details
If necessary, specify the following settings, and then click OK.

Define Stamp... button
To change the stamp text, bitmap, or position, click this.

Place stamp over text
To print the stamp on the front of the document, check this check box.

»» Note

» The stamp is given priority because the stamp is printed over the document data in the
sections where the stamp and the document data overlap. When this check box is
unchecked, the stamp is printed behind the document data and may be hidden in the
overlapping sections depending on the application software used.

» Place stamp over text cannot be used when the XPS printer driver is used.

When the XPS printer driver is used, the stamp is normally printed in the foreground of the
document.

Print semitransparent stamp
Check this check box to print a semi-transparent stamp on the document.
This function is available only when the XPS printer driver is used.

Stamp first page only
To print the stamp only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified stamp.

Printing a Background

Two bitmap files are pre-registered as samples.

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab

The Stamp/Background dialog box opens.

3. Select the background

Check the Background check box, and select the background to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the background details

If necessary, complete the following settings, and then click OK.
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Select Background... button
To use another background or change the layout or density of a background, click this.

Background first page only
To print the background only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified background.

»>» Note

+ The stamp and background are not printed on blank sheets inserted with the Insert blank page
function of booklet printing.

Related Topics

= Registering a Stamp
= Registering Image Data to be Used as a Background
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Registering a Stamp

This feature may be unavailable when certain printer drivers or operating environments are used.

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

Registering a New Stamp

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab
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» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button
and only the stamp function can be used.

3. Click Define Stamp...

The Stamp Settings dialog box opens.
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4. Configure the stamp while viewing the preview window

« Stamp tab

Select Text, Bitmap, or Date/Time/User Name that matches your purpose for Stamp Type.

o For Text registration, the characters must already be entered in Stamp Text. If necessary,
change the TrueType Font, Style, Size, and Outline settings. You can select the color of
the stamp by clicking Select Color....

o For Bitmap, click Select File... and select the bitmap file (.bmp) to be used. If necessary,
change the settings of the Size and Transparent white area.

o For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text. If necessary, change the settings of TrueType Font, Style, Size,
and Outline. You can select the color of the stamp by clicking Select Color....

3% Important

+ Stamp Text appears grayed out and is unavailable when Date/Time/User Name is
selected.

* Placement tab

Select the stamp position from the Position list. You can also select Custom from the Position
list and specify coordinates for X-Position and Y-Position.

You can also change the stamp position by dragging the stamp in the preview window.

To change the stamp position angle, type a value in the Orientation box directly.

3% Important

 Orientation cannot be changed when Bitmap is selected for Stamp Type on the Stamp tab.

5. Save the stamp

Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

> Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

302



6. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Changing and Registering Some of Stamp Settings

1. Select the stamp for which the settings are to be changed

Select the Stamp check box in the Stamp/Background (Stamp) dialog box. Then from the list, select
the title of the stamp to be changed.

2. Click Define Stamp...

The Stamp Settings dialog box opens.
3. Configure the stamp while viewing the preview window

4. Overwrite save the stamp

Click Save overwrite on the Save settings tab.
When you want to save the stamp with a different title, type a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Deleting an Unnecessary Stamp

1. Click Define Stamp... in the Stamp/Background (Stamp) dialog box

The Stamp Settings dialog box opens.

2. Select the stamp to be deleted

Select the title of the stamp you want to delete from the Stamps list on the Save settings tab. Then
click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
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Registering Image Data to be Used as a Background

This feature may be unavailable when certain printer drivers or operating environments are used.

You can select a bitmap file (.bmp) and register it as a new background. You can also change and register
some of the settings of an existing background. An unnecessary background can be deleted.

The procedure for registering image data to be used as a background is as follows:
Registering New Background

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab
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23> Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button
and Background cannot be used.

3. Click Select Background...

The Background Settings dialog box opens.
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4. Select the image data to be registered to the background

Click Select File.... Select the target bitmap file (.bmp), and then click Open.

5. Specify the following settings while viewing the preview window

Layout Method
Select how the background image data is to be placed.
When Custom is selected, you can set coordinates for X-Position and Y-Position.
You can also change the background position by dragging the image in the preview window.

Intensity
Set the intensity of the background image data with the Intensity slider. Moving the slider to the
right darkens the background, and moving the slider to the left lightens the background. To print
the background at the original bitmap intensity, move the slider to the rightmost position.

6. Save the background

Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

»» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

7. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Changing and Registering Some Background Settings

1. Select the background for which the settings are to be changed

Select the Background check box in the Stamp/Background dialog box. Then from the list, select
the title of the background you want to change.

2. Click Select Background...
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The Background Settings dialog box opens.
3. Specify each item on the Background tab while viewing the preview window

4. Save the background

Click Save overwrite on the Save settings tab. When you want to save the background with a
different title, enter a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Deleting an Unnecessary Background

1. Click Select Background... in the Stamp/Background dialog box

The Background Settings dialog box opens.

2. Select the background to be deleted

Select the title of the background you want to delete from the Backgrounds list on the Save settings
tab, and then click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
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Setting Up Envelope Printing

The procedure for performing envelope printing is as follows:

1. Load envelope on the printer

2. Open the printer driver setup window

3. Select the media type

Select Envelope from Commonly Used Settings on the Quick Setup tab.
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4. Select the paper size

When the Envelope Size Setting dialog box is displayed, select Envelope Com 10 or Envelope DL,
and then click OK.

5. Set the orientation

To print the addressee horizontally, select Landscape for Orientation.

A

6. Select the print quality

Select High or Standard that matches your purpose for Print Quality.

7. Complete the setup

Click OK.
When you execute print, the information is printed on the envelope.
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Displaying the Print Results before Printing

If you are using the XPS printer driver, replace "Canon IJ Preview" with "Canon IJ XPS Preview" when

reading this information.

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

You can also set the print results display on the Quick Setup tab.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.
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3. Complete the setup
Click OK.
When you execute print, the Canon IJ Preview opens and displays the print results.
32 Important

* In the Manual Color Adjustment dialog box, the Color Adjustment tab contains the Print a pattern
for color adjustment check box. When this check box is selected, the Preview before printing
appears grayed out and is unavailable.

Related Topic

= Canon |J Preview
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Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

The procedure for specifying a custom size is as follows:

You can also set a custom size in Printer Paper Size on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select Custom... for Page Size on the Page Setup tab.
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3. Set the custom paper size

Specify Units, and enter the Width and Height of the paper to be used. Then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.
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32 Important

« If the application software that created the document has a function for specifying height and width
values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

 Printing may be disabled depending on the size of the specified user-defined media.

For information about printable sizes for user-defined media, see "Media Types You Can Use."
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Editing the Print Document or Reprinting from the Print History

This function is unavailable when the standard |J printer driver is used.

In the Canon IJ XPS preview window, you can edit the print document or retrieve the document print history
to print the document.

The procedure for using the Canon IJ XPS Preview is as follows:
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23> Note

By clicking % View Thumbnails, you can display or hide thumbnails of the print documents selected
in the Document Name list.

« Clicking % Undo reverses the change that just performed.
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Editing and Printing a Print Document

When printing multiple documents or pages, you can combine documents, change the print sequence of
the documents or pages, or delete documents or pages.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

3. Complete the setup

Click OK.
The Canon IJ XPS Preview will start and the print result will be displayed before printing.

4. Editing print documents and print pages

* Combining print documents

You can combine multiple print documents to form a single document. By combining print
documents, you can prevent blank pages from being inserted when you execute duplex printing
or page layout printing.

From the Document Name list, select the documents to be combined. On the Edit menu, select
Combine Documents from Documents to combine the documents in the listed sequence.

To select multiple print documents, hold down the Ctrl key and click the documents to be
merged, or hold down the Shift key and press the upper arrow or lower arrow key. You can also
click a blank area in the document list and drag the mouse to select multiple documents.

When you combine documents, the documents selected before the combining are deleted from
the list and the combined document is added to the list.

Changing the sequence of print documents or print pages

> To change the sequence of the print documents, go to the Document Name list, and select
the print document to be moved. Next, on the Edit menu, select Move Document from
Documents, and select the appropriate item. You can also click and drag a print document
to change the print sequence.

> To change the sequence of the print pages, click View Thumbnails from the Option menu,
and select the print page to be moved. Next, on the Edit menu, select Move Page from
Pages, and select the appropriate item. You can also click and drag a print page to change
the print sequence.

Deleting print documents and print pages

> To delete a print document, select the target document from the Document Name list, and
on the Edit menu, choose Documents and then Delete Document.

o To delete a print page, click View Thumbnails from the Option menu, and select the print
page to be deleted. Next, on the Edit menu, select Delete Page from Pages.

 Print page recovery

You can recover pages that were deleted with Delete Page.

To recover pages, select the View Deleted Pages check box from the Option menu, and select
the pages to be recovered from among the displayed thumbnail pages. Then from the Edit menu
chose Pages and then Restore Page.
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After editing the print documents or print pages, you can change the print settings on the Page
Information, Layout and Manual Color Adjustment tabs as necessary.

22 Important

» To display the multiple documents in the list, open the preview and execute print again.

» To return the print documents to their original condition before they were edited in the preview,
on the Edit menu, select Reset Documents from Documents.

« |If the documents to be combined have different print settings, a message may be displayed.
Check the contents of the displayed message before combining the documents.

« If the documents to be combined have different output paper sizes and duplex printing or page
layout printing is to be performed, the printer may not produce the expected print results for
certain print pages.

Check the preview before printing.

» Depending on the print settings of the print document, some functions may not be available in

the Canon IJ XPS preview.

»» Note

* You can rename Document Name to any name.

5. Executing print

Click Print.
When you execute print, the printer uses the specified settings to print the data.

Reprinting from the Print History

When you click Save Print History on the File menu to enable the setting, the document printed from the
preview is saved, and you can reprint the document with the same settings.

1. Displaying the print history

Open the printer driver setup window. Then on the Maintenance tab, select View Print History.
The saved print document is displayed in the preview.

3% Important

« To limit the number of print history registrations, click History Entry Limit on the File menu.
« If the limit on the number of registration is exceeded, the print history registrations are deleted
starting from the oldest one.

2. Selecting a print document

From the Document Name list, select the document to be printed.

3. Executing print

Click Print.

Related Topic

= Displaying the Print Results before Printing
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Changing the Print Quality and Correcting Image Data

» Setting the Print Quality Level (Custom)

» Printing a Color Document in Monochrome
» Specifying Color Correction

» Optimal Photo Printing of Image Data

» Adjusting Colors with the Printer Driver

» Printing with ICC Profiles

» Adjusting Color Balance

» Adjusting Color Balance Using Sample Patterns (Printer Driver)
» Adjusting Brightness

» Adjusting Intensity

» Adjusting Contrast

» Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Setting the Print Quality Level (Custom)

The print quality level can be set in the Custom.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select the print quality

On the Main tab, select Custom for Print Quality, and click Set....
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3. Setting the print quality level

Drag the slider bar to select the print quality level and click OK.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

32 Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.
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Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Intensity

= Adjusting Contrast
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

You can also set a grayscale printing in Additional Features on the Quick Setup tab.

1. Open the printer driver setup window

2. Set grayscale printing

Check the Grayscale Printing check box on the Main tab.
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3. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.

22 Important

* When the Grayscale Printing check box is checked, the printer driver processes image data as sSRGB
data. In this case, actual colors printed may differ from those in the original image data.
When using the grayscale printing function to print Adobe RGB data, convert the data to sSRGB data
using an application software.
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»» Note

» During Grayscale Printing, inks other than black ink may be used as well.
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, the printer driver adjusts the colors by using Canon Digital Photo Color so that data is printed with
color tints that most people prefer. This method is suitable for printing sRGB data.

When you want to print by using the color space (Adobe RGB or sRGB) of the image data effectively, select
ICM (ICC Profile Matching). When you want to use an application software to specify a printing ICC profile,
select None.

The procedure for specifying color correction is as follows:

You can also set color correction on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
With Canon Digital Photo Color, you can print sSRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.
Specify the input profile to be used.

None
The printer driver does not perform color correction. Select this value when you are specifying an
individually created printing ICC profile in an application software to print data.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

3% Important

» When ICM is disabled in the application software, ICM is unavailable for Color Correction and the
printer may not be able to print the image data properly.

* When the Grayscale Printing check box on the Main tab is checked, Color Correction appears
grayed out and is unavailable.

Related Topics

= Optimal Photo Printing of Image Data
= Adjusting Colors with the Printer Driver
= Printing with ICC Profiles
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Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
Adobe RGB and sRGB are popularly used as common color spaces. Adobe RGB has a wider color space
than sRGB.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space (Adobe RGB or sRGB) of the image data
or the application software to be used.

There are two typical printing methods.
Check the color space (Adobe RGB or sRGB) of the image data and the application software to be used,
and then select the printing method suited to your purpose.

Adjusting Colors with the Printer Driver
Describes the procedure for printing sSRGB data by using the color correction function of the printer
driver.
» To print using Canon Digital Photo Color

The printer prints data with color tints that most people prefer, reproducing colors of the original
image data and producing three-dimensional effects and high, sharp contrasts.
* To print by directly applying editing and touch-up results of an application software

When printing the data, the printer brings out subtle color difference between dark and light
areas, while leaving the darkest and lightest areas intact.

When printing the data, the printer applies fine adjustment results, such as brightness
adjustments made with an application software.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of Adobe RGB or sRGB effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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Adjusting Colors with the Printer Driver

You can specify the color correction function of the printer driver to print SRGB data with color tints that most
people prefer through the use of Canon Digital Photo Color.

When printing from an application software that can identify ICC profiles and allows you to specify them, use
a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.
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4. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the printer driver adjusts the colors when printing the data.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction
= Adjusting Color Balance
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= Adjusting Brightness
= Adjusting Intensity
= Adjusting Contrast
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Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space (Adobe RGB
or sRGB) of the data effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself from your application software, be
sure to select color management items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select None for Color Correction.
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4. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.
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5. Complete the setup

Click OK on the Main tab.

When you execute print, the printer uses the color space of the image data.

Specify an ICC Profile with the Printer Driver, and then Print

Print from an application software that cannot identify input ICC profiles or does allow you to specify one
by using the color space of the input ICC profile (sSRGB) found in the data. When printing Adobe RGB

data, you can print the data with the Adobe RGB color space even if the application software does not
support Adobe RGB.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select ICM (ICC Profile Matching) for Color Correction.
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4. Select the input profile

Select an Input Profile that matches the color space of the image data.
» For sRGB data or data without an input ICC profile:

Select Standard.
* For Adobe RGB data:

Select Adobe RGB (1998).
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32 Important

» When the application software specifies an input profile, the input profile setting of the printer
driver becomes invalid.

* When no input ICC profiles are installed on your computer, Adobe RGB (1998) will not be
displayed.

5. Set the other items

If necessary, click Color Adjustment tab, and adjust Cyan, Magenta, Yellow, Brightness, Intensity,
and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness
=
=

Adjusting Intensity
Adjusting Contrast
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Adjusting Color Balance

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

-

No adjustment  Adjust color balance

The procedure for adjusting color balance is as follows:

You can also set color balance on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Adjust color balance
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There are individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when the
corresponding slider is moved to the right, and becomes weaker when the corresponding slider is moved
to the left. For example, when cyan becomes weaker, the color red becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

22 Important

* When the Grayscale Printing check box on the Main tab is checked, the color balance (Cyan,
Magenta, Yellow) appear grayed out and are unavailable.

Related Topics

Setting the Print Quality Level (Custom)

Specifying Color Correction

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Color Balance Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the color balance.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the color balance while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....
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4. Setting pattern print
When the Pattern Print dialog box opens, set the following items, and then click OK.

() rtenaty Contrast
_LHIJIS.E'H 1" Z2¢28cm (Same o8 Pags Sire) v |

Parameters to Adjust
Select Cyan/Magenta/Yellow.

32 Important

* When the Grayscale Printing check box on the Main tab is checked, Cyan/Magenta/Yellow
appear grayed out and are unavailable.

Printer Paper Size
Select the paper size to be used for pattern printing.

23> Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot
be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

23> Note

» Largest and Large cannot be selected when certain paper sizes or output paper sizes are
selected.

Color Variation Between Instances
Set the amount of color change between neighboring patterns.
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»» Note

* Large is about double the size of Medium, and Small is about half the size of Medium.

5. Checking the print results of pattern print

On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
color balance that you set is the center value.
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2 Important

* Normally, patterns are printed with the color balance settings as the center values. However,
when Black Only is selected for Ink Cartridge Settings on the Maintenance tab, the color
balance settings are not applied to pattern printing.

6. Adjusting the color balance

Look at the print results and select the image that you like best. Then enter the color balance numbers
indicated at the bottom of that image into the Cyan, Magenta, and Yellow fields on the Color
Adjustment tab.

Clear the Print a pattern for color adjustment check box, and click OK.
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> Note

* You can also set color balance on the Quick Setup tab by choosing Photo Printing under
Commonly Used Settings, and then choosing Color/intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the color balance that was adjusted by the
pattern print function.

32 Important

* When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following
items are grayed out and cannot be set:
* Preview before printing on the Main tab
+ Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing (Manual) is
set, only Stapling Side can be set.)

* You can print a pattern only if Normal-size is selected for Page Layout on the Page Setup tab.

* When the Grayscale Printing check box on the Main tab is checked, Cyan, Magenta, and Yellow
appear grayed out and are unavailable.

» Depending on your application software, this function may not be available.

Related Topics

= Adjusting Color Balance

= Adjusting Intensity

= Adjusting Contrast

= Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Brightness

You can change the brightness of the overall image data during printing.
This function does not change pure white or pure black but it changes the brightness of the intermediate
colors.

The following sample shows the print result when the brightness setting is changed.

Light is selected Normal is selected Dark is selected

The procedure for adjusting brightness is as follows:

You can also set brightness on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Specify the brightness

Select Light, Normal, or Dark for Brightness, and click OK. The current settings are displayed in the
settings preview on the left side of the printer driver.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the specified brightness.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Intensity

= Adjusting Contrast
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Adjusting Intensity

You can dilute (brighten) or intensify (darken) the colors of the overall image data during printing.
The following sample shows the case when the intensity is increased so that all colors become more intense
when the image data is printed.

No adjustment Higher intensity

The procedure for adjusting intensity is as follows:

You can also set intensity on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Adjust intensity

Moving the Intensity slider to the right intensifies (darkens) the colors, and moving the slider to the left
dilutes (brightens) the colors.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the adjusted intensity.

Related Topics

Setting the Print Quality Level (Custom)

Specifying Color Correction

Adjusting Color Balance

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Contrast

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)

L3R 2R 2% B 2R A
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Adjusting Contrast

You can adjust the image contrast during printing.

To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

You can also set contrast on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

Plam Paper
Lemer B572117 22x2 Bom

L]

The Manual Color Adjustment dialog box opens.

3. Adjust the contrast

Moving the Contrast slider to the right increases the contrast, and moving the slider to the left decreases
the contrast.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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4.

After adjusting each color, click OK.
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Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics

L3R 2R 2R B 2R B

Setting the Print Quality Level (Custom)

Specifying Color Correction

Adjusting Color Balance

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Intensity

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the intensity/contrast.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the intensity/contrast while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....
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4. Setting pattern print

When the Pattern Print dialog box opens, set the following items, and then click OK.

Parameters to Adjust
Select Intensity/Contrast.

Printer Paper Size
Select the paper size to be used for pattern printing.

22> Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot
be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

23> Note

» Largest and Large cannot be selected when certain paper sizes or output paper sizes are
selected.

Color Variation Between Instances
Set the amount of color change between neighboring patterns.

23> Note

» Large is about double the size of Medium, and Small is about half the size of Medium.

5. Checking the print results of pattern print
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On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
intensity/contrast that you set is the center value.
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6. Adjusting the intensity/contrast

Look at the print results and select the image that you like best. Then enter the intensity/contrast
numbers indicated at the bottom of that image into the Intensity and Contrast fields on the Color
Adjustment tab.

Clear the Print a pattern for color adjustment check box, and click OK.
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»» Note

* You can also set intensity/contrast on the Quick Setup tab by choosing Photo Printing under
Commonly Used Settings, and then choosing Color/Intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the intensity/contrast that was adjusted by
the pattern print function.

22 Important

* When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following
items are grayed out and cannot be set:
* Preview before printing on the Main tab
+ Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing (Manual) is
set, only Stapling Side can be set.)

* You can print a pattern only if Normal-size is selected for Page Layout on the Page Setup tab.
» Depending on your application software, this function may not be available.

Related Topics

= Adjusting Color Balance

= Adjusting Color Balance Using Sample Patterns (Printer Driver)
= Adjusting Intensity

= Adjusting Contrast
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Overview of the Printer Driver

» Canon IJ Printer Driver

» How to Open the Printer Driver Setup Window
» Canon IJ Status Monitor

» Checking the Ink Status from Your Computer
» Canon IJ Preview

» Deleting the Undesired Print Job

» Instructions for Use (Printer Driver)
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Canon |IJ Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

Printer Driver Types

On Windows Vista SP1 or later, you can install the XPS printer driver in addition to the regular printer
driver.
The XPS printer driver is suited to print from an application software that supports XPS printing.

22 Important

» To use the XPS printer driver, the standard printer driver must already be installed on your computer.

Installing the Printer Driver

» To install the regular printer driver, load the Setup CD-ROM that comes with the printer, and then
install the driver from Start Setup Again.

» To install the XPS printer driver, load the Setup CD-ROM that comes with the printer, and then select
XPS Driver from Add Software.

Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX Printer" (where "XXX" is your model name) to specify the regular printer driver or select "XXX
Printer XPS" (where "XXX" is your model name) to specify the XPS printer driver.

Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

Related Topic

= How to Open the Printer Driver Setup Window
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How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

»» Note

» Depending on application software you use, command names or menu names may vary and
there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon

Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Select as described below:

« If you are using Windows 8.1 or Windows 8, from the Desktop charms, select Settings ->
Control Panel -> Hardware and Sound -> Devices and Printers.

* If you are using Windows 7, select the Start menu -> Devices and Printers.

« If you are using Windows Vista, select the Start menu -> Control Panel -> Hardware and

Sound -> Printers.
« If you are using Windows XP, select the start menu -> Control Panel -> Printers and Other
Hardware -> Printers and Faxes.

2. Right-click your model name icon, and then select Printing preferences from the
displayed menu

The printer driver setup window appears.

3% Important

» Opening the printer driver setup window through Printer properties (Windows 8.1, Windows 8,
Windows 7) or Properties (Windows Vista, Windows XP) displays such tabs regarding the
Windows functions as the Ports (or Advanced) tab. Those tabs do not appear when opening
through Printing preferences or application software. For tabs regarding Windows functions,
refer to the user's manual for the Windows.
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Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon IJ Status Monitor appears as a button on the task bar.

13» Note

» To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup
window and click View Printer Status on the Maintenance tab.

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.

When Errors Occur

The Canon IJ Status Monitor is automatically displayed if an error occurs (e.g., if the printer runs out of
paper or if the ink is low).

1. Lasd paper s the mesr iy, 2. Press the pinters Stes
botion.

In such cases, take the appropriate action as described.
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Checking the Ink Status from Your Computer

You can check the remaining ink level and the FINE cartridge types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Maintenance tab, click View Printer Status.
The Canon IJ Status Monitor opens and displays an image of the ink status.
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»» Note

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.

» When you receive a notice about the remaining ink level, a mark appears above the ink icon.
For example: &
The ink is running low. Prepare a new ink cartridge.

3. If necessary, click Ink Details

You can check the ink-related information.

If a warning or error related to the remaining ink amount occurs, a notification icon is displayed at the top
of the image in the Ink Details dialog box.
In such cases, take the appropriate action as described on the screen.

»» Note

* You can also display the Ink Details dialog box by selecting the ink icon on the Canon IJ Status
Monitor.
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Canon |IJ Preview

The Canon IJ Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

32 Important

* If you are using the XPS printer driver, see "Editing the Print Document or Reprinting from the Print
History."

Related Topic

= Displaying the Print Results before Printing
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Deleting the Undesired Print Job

If you are using the XPS printer driver, replace "Canon |J Status Monitor" with "Canon |J XPS Status
Monitor" when reading this information.

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Display the Canon IJ Status Monitor

Click the icon of the Canon IJ Status Monitor displayed on the task bar.
The Canon |J Status Monitor appears.

2. Display the print jobs

Click Display Print Queue.
The print queue window opens.

3. Delete the print jobs

Select Cancel All Documents from the Printer menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

22 Important

» Users who have not been granted access permission for printer management cannot delete the print
job of another user.

»» Note

* When you perform this operation, all print jobs are deleted. If the print queue list contained a necessary
print job, start the printing process over from the beginning.
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

Restrictions on the Printer Driver

» With some applications, the Copies setting in the Page Setup tab of the printer driver may not be
enabled.
In this case, use the copies setting in the Print dialog box of the application software.
* If the selected Language in the About dialog box of the Maintenance tab does not match the
operating system interface language, the printer driver setup window may not be displayed properly.
» Do not change the Advanced tab items of the printer properties. If you change any of the items, you
will not be able to use the following functions correctly.
Also, if Print to file is selected in the Print dialog box of the application software and with applications
that prohibit EMF spooling, such as Adobe Photoshop LE and MS Photo Editor, the following
functions will not operate.
> Preview before printing on the Main tab
o Prevention of Print Data Loss in the Print Options dialog box on the Page Setup tab
o Page Layout, Tiling/Poster, Booklet, Duplex Printing (Manual), Specify Margin..., Print from
Last Page, Collate, and Stamp/Background... (Stamp...) on the Page Setup tab
o Print a pattern for color adjustment on the Color Adjustment tab in the Manual Color
Adjustment dialog box

» Since the resolution in the preview display differs from the printing resolution, text and lines in the
preview display may appear different from the actual print result.

» With some applications, the printing is divided into multiple print jobs.
To cancel printing, delete all divided print jobs.

« Ifimage data is not printed correctly, display the Print Options dialog box from the Page Setup tab
and change the setting of Disable ICM required from the application software. This may solve the
problem.

»» Note

» Disable ICM required from the application software cannot be used when the XPS printer
driver is used.

* Do not start up the Canon IJ Network Tool while printing.
* Do not print when the Canon IJ Network Tool is running.

Points to Note About Applications with Restrictions

» There are following restrictions in Microsoft Word (Microsoft Corporation).

o When Microsoft Word has the same printing functions as the printer driver, use Word to specify
them.

o When Fit-to-Page, Scaled, or Page Layout is used for Page Layout on the Page Setup tab of
the printer driver, the document may not print normally in certain versions of Word.

o When Page Size in Word is set to "XXX Enlarge/Reduce", the document may not print normally in
certain versions of Word.
If this happens, follow the procedure below.

1. Open Word's Print dialog box.
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2. Open the printer driver setup window, and on the Page Setup tab, set Page Size to the same
paper size that you specified in Word.

Set the Page Layout that you want, and then click OK to close the window.

Without starting printing, close the Print dialog box.

Open Word's Print dialog box again.

Open the printer driver setup window and click OK.

Start printing.

N g R

« If bitmap printing is enabled in Adobe lllustrator (Adobe Systems Incorporated), printing may take time
or some data may not be printed. Print after unchecking the Bitmap Printing check box in the Print
dialog box.
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Printer Driver Description

» Quick Setup tab Description

*» Main tab Description

» Page Setup tab Description

» Maintenance tab Description

» Canon IJ Preview Description

» Canon IJ XPS Preview Description

» Canon IJ Status Monitor Description
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Quick Setup tab Description

The Quick Setup tab is for registering commonly used print settings. When you select a registered setting,
the printer automatically switches to the preset items.
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Commonly Used Settings

The names and icons of frequently used printing profiles are registered. When you select a printing
profile according to the purpose of the document, settings that match the purpose are applied.
In addition, functions that are thought to be useful for the selected printing profile are displayed in
Additional Features.
You can also change a printing profile and register it under a new name. You can delete the registered
printing profile.
You can rearrange the profiles either by dragging the individual profiles or by holding down the Ctrl key
and pressing the up or down arrow keys.
Standard
These are the factory settings.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Photo Printing
If you select this setting when printing a photo, the photo paper and photo size generally used are
set.
If Orientation and Copies were set from the application software, those settings have priority.

Business Document
Select this setting when printing a general document.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Paper Saving
Select this setting to save paper when printing a general document. The 2-on-1 Printing and
Duplex Printing (Manual) check boxes are checked automatically.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.
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Envelope
If you select this setting for printing an envelope, Media Type is set automatically to Envelope. In
the Envelope Size Setting dialog box, select the size of the envelope to be used.

»» Note

+ The combination of the Additional Features that was displayed for the printing profile that had
been selected when the added printing profile was saved is also displayed when that added

printing profile is selected.

Save...
Displays the Save Commonly Used Settings dialog box.
Click this button when you want to save the information that you set on the Quick Setup, Main, and
Page Setup tabs to Commonly Used Settings.

Delete
Deletes a registered printing profile.
Select the name of the setting to be deleted from Commonly Used Settings, and click Delete. When a
confirmation message is displayed, click OK to delete the specified printing profile.

»» Note

+ Printing profiles that are registered in the initial settings cannot be deleted.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Preview before printing
Shows what the print result will look like before you actually print the data.
Check this check box to display a preview before printing.
Uncheck this check box if you do not want to display a preview.
32 Important

* To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile
installed on your computer.

Additional Features
Displays the frequently used, convenient functions for the printing profile that you selected for
Commonly Used Settings on the Quick Setup tab.
When you move the mouse pointer near a function that can be changed, a description of that function is
displayed.
To enable a function, check the corresponding check box.
For some functions, you can set detailed settings from the Main and Page Setup tabs.

32 Important

» Depending on the printing profiles, certain function may be grayed out and you will not be able to

change them.

2-on-1 Printing
Prints two pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.
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4-on-1 Printing
Prints four pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.

Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the
paper.
To change the staple side or the margins, set the new values from the Page Setup tab.

Grayscale Printing
This function converts the data to monochrome data when printing your document.

Draft
This setting is appropriate for test printing.

Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application
software will be reversed vertically and horizontally.

Color/Intensity Manual Adjustment
Select when you set the Color Correction method and individual settings such as Cyan, Magenta,
Yellow, Brightness, Intensity, and Contrast, etc.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
Normally, the paper size is set automatically according to the output paper size setting, and the
document is printed with no scaling.
When you set 2-on-1 Printing or 4-on-1 Printing in Additional Features, you can manually set the
paper size with Page Size on the Page Setup tab.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger, the document size will be enlarged.
Also if you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
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To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
To set the print quality level individually, click the Main tab, and for Print Quality, select Custom. The
Set... becomes enabled. Click Set... to open the Custom dialog box, and then specify the desired
settings.
High
Gives priority to print quality over printing speed.
Standard
Prints with average speed and quality.

Draft
This setting is appropriate for test printing.

Paper Source
Shows the source from which paper is supplied.

Rear Tray
Paper is always supplied from the rear tray.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
32 Important

* When the application software that you used to create the document has the same function,
specify the settings on the printer driver. However, if the print results are not acceptable, specify
the function settings on the application software.

Always Print with Current Settings
Prints documents with the current settings starting from the next print execution.
When you select this function and then close the printer driver setup window, the information that you
set on the Quick Setup, Main, and Page Setup tabs are saved and printing with the same settings is
possible starting from the next print execution.

22 Important

« If you log on with a different user name, the settings that were set when this function was enabled
are not reflected in the print settings.
« If a setting was specified on the application software, it has priority.

Defaults
Restores all the settings you have changed to their default values.

Click this button to return all settings on the Quick Setup, Main, and Page Setup tabs to their default
values (factory settings).

Save Commonly Used Settings dialog box

This dialog box allows you to save the information that you set on the Quick Setup, Main, and Page
Setup tabs and add the information to the Commonly Used Settings list on the Quick Setup tab.

Name
Enter the name for the printing profile you wish to save.
Up to 255 characters can be entered.
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The name appears, with its associated icon, in the Commonly Used Settings list on the Quick
Setup tab.

Options...
Opens the Save Commonly Used Settings dialog box.
Changes the details of printing profile to be saved.

Save Commonly Used Settings dialog box

Select the icons of the printing profiles to be registered to Commonly Used Settings, and change the
items to be saved in the printing profiles.

Icon
Select the icon for the printing profile you wish to save.
The selected icon appears, with its name, in the Commonly Used Settings list on the Quick
Setup tab.

Save the paper size setting
Saves the paper size to the printing profile in Commonly Used Settings.
To apply the saved paper size when the printing profile is selected, check this check box.
If this check box is unchecked, the paper size is not saved, and consequently the paper size setting
is not applied when the printing profile is selected. Instead the printer prints with the paper size
specified with the application software.

Save the orientation setting
Saves the Orientation to the printing profile in Commonly Used Settings.
To apply the saved print orientation when the printing profile is selected, check this check box.
If this check box is unchecked, the print orientation is not saved, and consequently the Orientation
setting is not applied when the printing profile is selected. Instead the printer prints with the print
orientation specified with the application software.

Save the copies setting
Saves the Copies setting to the printing profile in Commonly Used Settings.
To apply the saved copies setting when the printing profile is selected, check this check box.
If this check box is unchecked, the copies setting is not saved, and consequently the Copies
setting is not applied when the printing profile is selected. Instead the printer prints with the copies
setting specified with the application software.

Custom Paper Size dialog box

This dialog box allows you to specify the size (width and height) of the custom paper.

Units
Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Related Topics

= Printing with Easy Setup
= Setting a Page Size and Orientation
= Setting the Number of Copies and Printing Order
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Duplex Printing
Setting Up Envelope Printing

Displaying the Print Results before Printing

Setting Paper Dimensions (Custom Size)

Printing a Color Document in Monochrome

Specifying Color Correction

Adjusting Color Balance

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Registering a Frequently Used Printing Profile
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Main tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Paper Source
Shows the source from which paper is supplied.

Rear Tray
Paper is always supplied from the rear tray.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

32 Important

» Depending on the Media Type settings, the same print results may be produced even if the Print
Quality is changed.

High

Gives priority to print quality over printing speed.
Standard

Prints with average speed and quality.

Draft
This setting is appropriate for test printing.
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Custom
Select this when you want to set the printing quality level individually.

Set...
Select Custom for Print Quality to enable this button.
Open the Custom dialog box. You can then individually set the print quality level.

Color/intensity
Selects color adjustment method.
Auto
Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast, and so on are adjusted

automatically.

Manual
Select when you set the individual settings such as Cyan, Magenta, Yellow, Brightness,

Intensity, and Contrast, etc. and Color Correction method.

Set...
Select Manual for Color/Intensity to enable this button.
In the Manual Color Adjustment dialog box, you can adjust individual color settings such as

Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast on the Color Adjustment tab, and

select the Color Correction method on the Matching tab.
»>» Note

* If you want to use an ICC profile to adjust colors, use the Manual Color Adjustment dialog
box to set the profile.

Grayscale Printing
This function converts the data to monochrome data when printing your document.
Check this check box to print a color document in monochrome.

Preview before printing
Shows what the print result will look like before you actually print the data.

Check this check box to display a preview before printing.
22 Important

* To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile
installed on your computer.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory

settings).
Custom dialog box

Set the quality level, and select the desired print quality.

Quality
You can use the slider bar to adjust the print quality level.

22 Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.
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»» Note

» The High, Standard, or Draft print quality modes are linked with the slider bar. Therefore when
the slider bar is moved, the corresponding quality and value are displayed on the left. This is the
same as when the corresponding radio button is selected for Print Quality on the Main tab.

Color Adjustment Tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, Intensity, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted. You can check the color adjustment
status easily by changing the preview image to one similar to the results to be printed with Sample
Type.
»>» Note

» The graphic is in monochrome when the Grayscale Printing check box is checked.

Sample Type
Selects a preview image displayed on the Color Adjustment tab.
If necessary, select a preview image from Standard, Portrait, Landscape, or Graphics, whichever
is most similar to the print results.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total color
balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

32 Important

* When Grayscale Printing is checked on the Main tab, Cyan, Magenta, and Yellow appear
grayed out and are unavailable.

Brightness
Selects the brightness of your print.
You cannot change the levels of pure white and black. However, the brightness of the colors between
white and black can be changed.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
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Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Print a pattern for color adjustment
When the color balance or intensity/contrast is changed, the pattern printing function prints a list of
the adjustment results along with the adjustment values.
Select this function when printing a pattern for color adjustment.

Pattern Print preferences...
Check Print a pattern for color adjustment to enable this button.
The Pattern Print dialog box opens and allows you to set pattern printing settings.

Pattern Print dialog box

Performs the setup for printing of patterns that allow you to check the color balance and intensity/
contrast of documents.

Parameters to Adjust
Select the item to be checked by pattern printing.
Cyan/Magenta/Yellow
Prints a pattern that allows you to check the cyan/magenta/yellow balance.

22 Important

* When Grayscale Printing is checked on the Main tab, Cyan/Magenta/Yellow appear
grayed out and are unavailable.

Intensity/Contrast
Prints a pattern that allows you to check the intensity/contrast balance.

Printer Paper Size
Selects the paper size to be used for pattern printing.
This setting is linked to Printer Paper Size on the Page Setup tab.

> Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot
be selected.

Amount of Pattern Instances
Sets the number of patterns to be printed.
You can select from Largest, Large, and Small. When you select a pattern size, the number of
patterns that can be printed is as follows:

»» Note

» Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.
» The setting preview on the Main tab displays an image that allows you to check the overall

layout.

Largest
Cyan/Magenta/Yellow 37
Intensity/Contrast 49
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Large
Cyan/Magenta/Yellow 19
Intensity/Contrast 25

Small
Cyan/Magenta/Yellow 7
Intensity/Contrast 9

Color Variation Between Instances
Sets the amount of color change between neighboring patterns.
Select from Large, Medium, and Small. Large produces a large amount of change, and Small
produces a small amount of change.

»» Note

» Large is about double the size of Medium, and Small is about half the size of Medium.

Matching Tab

Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICM (ICC Profile Matching), or None to match the purpose of
the print operation.

22 Important

* When Grayscale Printing is checked on the Main tab, Color Correction appears grayed out
and is unavailable.

Driver Matching
With Canon Digital Photo Color, you can print sSRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.
Specify the input profile to be used.

32 Important

« If the application software is set so that ICM is disabled, ICM (ICC Profile Matching) is
unavailable for Color Correction and the printer may not be able to print the image data

properly.

None
Disables color adjustment with the printer driver.

Input Profile
Specifies the input profile to be used when you select ICM (ICC Profile Matching) for Color
Correction.
Standard
The standard printer profile (SRGB), which supports the color space of ICM, is used. This is the
default setting.

Adobe RGB (1998)
The Adobe RGB profile, which supports a wider color space than sRGB, is used.

22 Important

» Adobe RGB (1998) is not displayed when input profiles of Adobe RGB are not installed.
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> Note

* In the XPS printer driver, ICM has become ICC Profile Matching.

Related Topics

LR 2R 2E 2 2N BE AR 2R B AR A

Setting the Print Quality Level (Custom)

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Specifying Color Correction

Adjusting Colors with the Printer Driver

Printing with ICC Profiles

Printing a Color Document in Monochrome

Displaying the Print Results before Printing
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Page Setup tab Description

The Page Setup tab allows you to determine how a document is to be arranged on the paper. Also, this tab
allows you to set the number of copies and the order of printing. If the application which created the
document has a similar function, set them with the application.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
If you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.
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Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application software will
be reversed vertically and horizontally.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
The default setting is Same as Page Size to perform normal-sized printing.
You can select a printer paper size when you select Fit-to-Page, Scaled, Page Layout, Tiling/Poster,
or Booklet for Page Layout.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger, the document size will be enlarged.
Also if you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Page Layout
Selects the size of the document you want to print and the type of printing.
Normal-size
This is the normal printing method. Select this when you do not specify any page layout.
Automatically reduce large document that the printer cannot output
If the printer cannot print the paper size of a document, the printer can automatically reduce
the size when it prints the document.
Check this check box to reduce the size when printing the document.

Fit-to-Page
This function enables you to automatically enlarge or reduce documents to fit to the paper size
loaded in the printer without changing the paper size you specified in your application software.

Scaled
Documents can be enlarged or reduced to be printed.
Specify the size in Printer Paper Size, or enter the scaling ratio in the Scaling box.
Scaling
Specifies an enlargement or reduction ratio for the document you want to print.

Page Layout
Multiple pages of document can be printed on one sheet of paper.
Specify...
Opens the Page Layout Printing dialog box.
Click this button to set details on page layout printing.

Tiling/Poster
This function enables you to enlarge the image data and divide the enlarged data into several
pages to be printed. You can also glue together these sheets of paper to create large printed
matter, such as a poster.
Specify...
Opens the Tiling/Poster Printing dialog box.
Click this button to set details on tiling/poster printing.

Booklet
The booklet printing function allows you to print data for a booklet. Data is printed on both sides of
the paper. This type of printing ensures that pages can be collated properly, in page number order,
when the printed sheets are folded and stapled at the center.
Specify...
Opens the Booklet Printing dialog box.
Click this button to set details on booklet printing.

366



Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the paper.
Check this check box to print the document on both sides.
This function can be used only when Plain Paper is selected for Media Type and one of Normal-size,
Fit-to-Page, Scaled, or Page Layout is selected.

Stapling Side
Selects the stapling margin position.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
stapling margin position. Check Stapling Side, and select from the list to change it.

Specify Margin...
Opens the Specify Margin dialog box.
You can specify the width of the margin.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
32 Important

« If the application used to create your document has a similar function, specify the number of copies
with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not need
to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate
Check this check box to group together the pages of each copy when you want to print multiple copies.
Uncheck this check box when you want to print with all pages of the same page number grouped
together.

22 Important

» When the application software that you used to create the document has the same function, give
priority to the printer driver settings. However, if the print results are not acceptable, specify the
function settings on the application software. When you specify the number of copies and the
printing order with both the application and this printer driver, the number of copies may be
multiplied numbers of the two settings or the specified printing order may not be enabled.

Print Options...
Opens the Print Options dialog box.
Changes detailed printer driver settings for print data that is sent from applications.

Stamp/Background... (Stamp...)
Opens the Stamp/Background (Stamp) dialog box.
The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light
illustration behind the document data.

»» Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and
only the stamp function can be used.

Depending on the type of printer driver you are using and the environment, Stamp and Background
may not be available.
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Custom Paper Size dialog box

This dialog box allows you to specify the size (width and height) of the custom paper.

Units
Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Pages
Specifies the number of document pages to fit on one sheet.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Tiling/Poster Printing dialog box

This dialog box allows you to select the size of the image to be printed. You can also make settings for cut
lines and paste markers which are convenient for pasting together the pages into a poster.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings of the Tiling/Poster Printing dialog box.
You can check what the print result will look like.

Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create a
larger poster.

Print "Cut/Paste" in margins
Specifies whether to print the words "Cut" and "Paste" in the margins. These words serve as
guidelines for pasting together the pages into a poster.
Check this check box to print the words.

»>» Note

» Depending on the type of printer driver you are using and the environment, this function may not
be available.
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Print "Cut/Paste" lines in margins
Specifies whether to print cut lines that serve as guidelines for pasting together the pages into a
poster.
Check this check box to print the cut lines.

Print page range
Specifies the printing range. Select All under normal circumstances.
Select Pages to specify a specific page or range.
»>» Note

+ If some of the pages have not been printed well, specify the pages that do not need to be printed
by clicking them in the settings preview of the Page Setup tab. Only the pages shown on the
screen will be printed this time.

Booklet Printing dialog box

This dialog box allows you to set how to bind the document as a booklet. Printing only on one side and
printing a page border, can also be set in this dialog box.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Booklet Printing dialog box.
You can check what the document will look like when printed as a booklet.

Margin for stapling
Specifies which side of the booklet is to be stapled.

Insert blank page
Selects whether to print the document on one side or both sides of the booklet.
Check this check box to print the document on one side of the booklet and select the side to be left
blank from the list.

Margin
Specifies the width of the stapling margin.
The specified width becomes the stapling margin from the center of the sheet.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Specify Margin dialog box

This dialog box allows you to specify the margin width for the side to be stapled. If a document does not fit
on one page, the document is reduced when printed.

Margin
Specifies the width of the stapling margin.
The width of the side specified by Stapling Side becomes the stapling margin.

Print Options dialog box

Makes changes to print data that is sent to the printer.

Depending on the type of printer driver you are using and the environment, this function may not be
available.
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Disable ICM required from the application software
Disables the ICM function required from the application software.
When an application software uses Windows ICM to print data, unexpected colors may be produced
or the printing speed may decrease. If these problems occur, checking this check box may resolve
the problems.

32 Important

* Uncheck this check box under normal circumstances.
» This function does not work when ICM is selected for Color Correction on the Matching tab of
the Manual Color Adjustment dialog box.

»» Note

» Disable ICM required from the application software tab cannot be used with the XPS printer
driver.

Disable the color profile setting of the application software
Checking this check box disables information in the color profile that was set on the application
software.
When the information in the color profile set on the application software is output to the printer driver,
the print result may contain unexpected colors. If this happens, checking this check box may resolve
the problem.

22 Important

» Even when this check box is checked, only some of the information in the color profile is
disabled, and the color profile can still be used for printing.
» Uncheck this check box under normal circumstances.

Ungroup Papers
Sets the display method of Media Type, Page Size, and Printer Paper Size.
To display the items separately, select the check box.
To display the items as a group, clear the check box.

Do not allow application software to compress print data
Compression of the application software print data is prohibited.
If the print result has missing image data or unintended colors, selecting this check box may improve
the condition.

22 Important

* Uncheck this check box under normal circumstances.

»» Note

* Do not allow application software to compress print data tab cannot be used with the XPS
printer driver.

Print after creating print data by page
The print data is created in page units, and printing starts after the processing of one page of print
data is complete.
If a printed document contains unintended results such as streaks, selecting this check box may
improve the results.

32 Important

* Uncheck this check box under normal circumstances.
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Scale images using nearest-neighbor interpolation

When an image is to be enlarged or reduced when printed, the printer uses a simple interpolation
process to enlarge or reduce the image.

If the image data in a printed document is not printed clearly, selecting this check box may improve
the results.

32 Important

* Uncheck this check box under normal circumstances.

»» Note

» Scale images using nearest-neighbor interpolation can be used only with the XPS printer
driver.

Prevention of Print Data Loss

You can reduce the size of the print data that was created with the application software and then print
the data.
Depending on the application software being used, the image data may be cut off or may not be
printed properly. In such cases, select On. If you will not be using this function, select Off.

32 Important

» When using this function, the print quality may drop depending on the print data.

Unit of Print Data Processing
Selects the processing unit of the print data to be sent to the printer.
Select Recommended under normal circumstances.

22 Important

* A large amount of memory may be used for certain settings.
Do not change the setting if your computer has a small amount of memory.

»» Note

* Unit of Print Data Processing tab cannot be used with the XPS printer driver.

Stamp/Background (Stamp...) dialog box

The Stamp/Background (Stamp...) dialog box allows you to print a stamp and/or background over or

behind the document pages. In addition to the pre-registered ones, you can register and use your original
stamp or background.

»» Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and
only the stamp function can be used.

Stamp
Stamp printing is a function that prints a stamp over a document.
Check this check box and select a title from the list to print a stamp.
Define Stamp...
Opens the Stamp Settings dialog box.
You can check the details of a selected stamp or save a new stamp.
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Place stamp over text
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a stamp over the printed document page. The printed data may be
hidden behind the stamp.
Uncheck this check box to print the document data over the stamp. The printed data will not be
hidden behind the stamp. However, the sections of the stamp that are overlapped by the document
may be hidden.

Print semitransparent stamp
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a semi-transparent stamp over the printed document page.
Uncheck this check box to print the stamp over the document data. The printed data may be hidden
behind the stamp.

»>» Note

* You can use Print semitransparent stamp only with the XPS printer driver.

Stamp first page only
Selects whether the stamp is to be printed on the first page only or on all pages when the document
has two or more pages.
Check the Stamp check box to enable this.
Check this check box to print a stamp on the first page only.

Background
Background printing is a function that allows you to print an illustration or a similar object (bitmap)
behind the document.
Check this check box to print a background and select a title from the list.

Select Background...
Opens the Background Settings dialog box.
You can register a bitmap as a background, and change layout method and intensity of the selected
background.

Background first page only
Selects whether to print the background on the first page only or print on all pages when the
document has two or more pages.
Check the Background check box to enable this.
Check this check box to print a background on the first page only.

Stamp Tab

The Stamp tab allows you to set the text and bitmap file (.bmp) to be used for a stamp.

Preview Window
Shows the status of the stamp configured in each tab.

Stamp Type
Specifies the stamp type.
Select Text to create a stamp with characters. Select Bitmap to create with a bitmap file. Select
Date/Time/User Name to display the creation date/time and user name of the printed document.
The setting items in the Stamp tab change depending on the selected type.

When Stamp Type is Text or Date/Time/User Name
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Stamp Text
Specifies the stamp text string.
Up to 64 characters can be entered.
For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text.

32 Important

» Stamp Text appears grayed out and is unavailable if Date/Time/User Name is selected.

TrueType Font
Selects the font for the stamp text string.

Style

Selects the font style for the stamp text string.
Size

Selects the font size for the stamp text string.
Outline

Selects a frame that encloses the stamp text string.
If a large font size is selected for Size, characters may extend outside of the stamp border.

Color/Select Color...
Shows the current color for the stamp.
To select a different color, click Select Color... to open the Color dialog box, and select or create a
color you wish to use as a stamp.

When Stamp Type is Bitmap
File
Specifies the name of the bitmap file to be used as the stamp.
Select File...
Opens the dialog box to open a file.
Click this button to select a bitmap file to be used as a stamp.
Size
Adjusts the size of the bitmap file to be used as a stamp.
Moving the slider to the right increases the size, moving the slider to the left decreases the size.

Transparent white area
Specifies whether to make white-filled areas of the bitmap transparent.
Check this check box to make white-filled areas of the bitmap transparent.

»» Note

+ Click Defaults to set Stamp Type to text, Stamp Text to blank, TrueType Font to Arial, Style to
Regular, Size to 36 points, Outline unchecked, and Color to gray with the RGB values (192, 192,
192).

Placement Tab

The Placement tab allows you to set the position where the stamp is to be printed.

Preview Window
Shows the status of the stamp configured in each tab.
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Position
Specifies the stamp position on the page.
Selecting Custom from the list allows you to enter values for the X-Position and Y-Position
coordinates directly.

Orientation
Specifies the angle of rotation for the stamp. The angle can be set by entering the number of
degrees.
Negative values rotate the stamp clockwise.

»» Note

+ Orientation is enabled only when Text or Date/Time/User Name is selected for Stamp Type
on the Stamp tab.

»» Note

* Click Defaults to set the stamp position to Center and the orientation to 0.

Save settings Tab

The Save settings tab allows you to register a new stamp or delete an unnecessary stamp.

Title
Enter the title to save the stamp you created.
Up to 64 characters can be entered.

»» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Stamps
Shows a list of saved stamp titles.
Specify a title to display the corresponding stamp in Title.

Save/Save overwrite
Saves the stamp.
Enter a title in Title, and then click this button.

Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps list, and click this button.

Background Tab

The Background tab allows you to select a bitmap file (.bmp) to be used as a background or determine
how to print the selected background.

Preview Window

Shows the status of the bitmap set on the Background tab.
File

Specifies the name of the bitmap file to be used as the background.
Select File...

Opens the dialog box to open a file.
Click this button to select a bitmap file (.bmp) to be used as the background.
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Layout Method
Specifies how the background image is to be placed on the paper.
When Custom is selected, you can set coordinates for X-Position and Y-Position.

Intensity
Adjusts the intensity of the bitmap to be used as a background.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity. To print the background at the original bitmap intensity, move the slider to the rightmost
position.

»» Note

» Depending on the type of printer driver you are using and the environment, this function may not be
available.

+ Click Defaults to set File to blank, Layout Method to Fill page, and the Intensity slider to the
middle.

Save settings Tab

The Save settings tab allows you to register a new background or delete an unnecessary background.

Title
Enter the title to save the background image you specified.
Up to 64 characters can be entered.

»>» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Backgrounds
Shows a list of registered background titles.
Specify a title to display the corresponding background in Title.

Save/Save overwrite
Saves the image data as a background.
After inserting the Title, click this button.

Delete
Deletes an unnecessary background.
Specify the title of an unnecessary background from the Backgrounds list, and then click this
button.
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Maintenance tab Description

The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.
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Cleaning
Performs print head cleaning.

Print head cleaning removes any blockage in the print head nozzles.

Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

e
%\33
Deep Cleaning

Performs deep cleaning.

Perform deep cleaning when two cleaning attempts do not resolve the print head problem.
»>» Note

» Deep Cleaning consumes a larger amount of ink than Cleaning.

Cleaning the print heads frequently will rapidly deplete your printer's ink supply. Therefore, perform
cleaning only when necessary.

Ink Group
When you click Cleaning or Deep Cleaning, the Ink Group window is displayed.
Selects the ink group that you want to clean the print head for.

Click Initial Check Items to display the items that you need to check before you execute cleaning
or deep cleaning.

Print Head Alignhment

Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
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Align the print head immediately after installing the print head.
When you click Print Head Alignment, the Start Print Head Alignment dialog box is displayed.

Nozzle Check

Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, click Cleaning to
clean the print head.
To display a list of items that you should check before printing the nozzle check pattern, click Initial
Check Items.
Print Check Pattern

This function prints a pattern that allows you to check whether the any of the ink nozzles are

clogged.

Click Print Check Pattern. When the confirmation message is displayed, click OK. The Pattern

Check dialog box is then displayed.

Left-side bitmap (good)

The print head nozzles are not clogged.

Right-side bitmap (bad)
The print head nozzles may be clogged.

Exit
Closes the Pattern Check dialog box, and returns to the Maintenance tab.

Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or if a specific color fails to print, even though
all ink levels are sufficiently high.

Ink Cartridge Settings
Opens the Ink Cartridge Settings dialog box.
Use this function to specify the FINE cartridge you want to use.

Bottom Plate Cleaning

Performs cleaning of the bottom plate of the printer.

To prevent smudges on the back side of a sheet of paper, perform Bottom Plate Cleaning before you
perform duplex printing.

Also perform Bottom Plate Cleaning if ink smudges caused by something other than print data appear
on the printed page.

Roller Cleaning

Cleans the paper feed rollers.

Paper feeding may fail if paper dust has stuck to the printer's paper feed rollers. In this case, clean the
paper feed rollers to improve the print result.
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Power Off
Turns off the printer from the printer driver.
Perform this function to turn off the printer when you cannot press the ON button (POWER button) on
the printer because the printer is out of your reach.
You must press the ON button (POWER button) on the printer to turn the printer on again after clicking
this button. When you use this function, you will not be able to turn the printer on from the printer driver.

‘@
Auto Power
Opens the Auto Power Settings dialog box.
Specify settings for operating the printer power automatically. Perform this function if you want to
change the auto power settings.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an error
message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

Quiet Settings

Opens the Quiet Settings dialog box.

Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
This mode comes in handy when the operating noise of the printer becomes a concern, such when
printing at night. Perform this operation when you want to change the quiet mode setting.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an error
message may appear because the computer cannot collect the printer status.

Custom Settings
Opens the Custom Settings dialog box.
Perform this function to change the settings of this printer.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an error
message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

View Print History
This function starts the Canon IJ XPS preview, and displays the print history.

»» Note

* You can use this function only with the XPS printer driver.

View Printer Status
Starts the Canon IJ Status Monitor.
Perform this function when you want to check the printer status and how a print job is proceeding.
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»» Note

+ If you are using the XPS printer driver, the "Canon IJ Status Monitor" becomes the "Canon IJ XPS
Status Monitor".

About
Opens the About dialog box.
The version of the printer driver, plus a copyright notice, can be checked.
In addition, the language to be used can be switched.

Initial Check Items

Before running Cleaning or Deep Cleaning, check that the printer power is on, and open the cover of the
printer.
Check the following items for each ink.

» Check the amount of ink remaining in the cartridge.
» Make sure that you push in the ink cartridge completely until you hear a clicking sound.
« If an orange tape is adhered to the ink cartridge, peel it off completely.
Any remaining tape will hinder ink output.
» Check that the ink cartridges are installed in their correct positions.

Start Print Head Alignment dialog box

This dialog box allows you to adjust the attachment position for the print head, or to print the current
setting value for the print head position.

Align Print Head
Aligns the print head.
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
Align the print head immediately after installing the print head.

Print Alignment Value
Click this button to check the current setting value of the print head position.
Prints the current setting value for the print head position.

Print Head Alignment dialog box

To adjust the print head position manually, click Align Print Head in the Start Print Head Alignment
dialog box, and perform the operations instructed in the messages. The Print Head Alignment dialog
box is then displayed.

This dialog box allows you to check the printed pattern and adjust the print head position.

Preview Window
Displays the pattern of Print Head Alignment, and checks the position of the selected pattern.
You can also change the setting by clicking the pattern on the screen directly.

Select the Pattern Number
Compare the printed adjustment patterns, and enter the pattern number of the pattern with the
least visible streaks or horizontal stripes into the corresponding box.
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»» Note

« If you do not know how to analyze the printed pattern, see Aligning the Print Head Position from
Your Computer.

Initial Check Items

Before running Nozzle Check, check that the printer power is on, and open the cover of the printer.
Check the following items for each ink.

» Check the amount of ink remaining in the cartridge.
» Make sure that you push in the ink cartridge completely until you hear a clicking sound.
« If an orange tape is adhered to the ink cartridge, peel it off completely.
Any remaining tape will hinder ink output.
» Check that the ink cartridges are installed in their correct positions.

Ink Cartridge Settings dialog box

When you click Ink Cartridge Settings, the Ink Cartridge Settings dialog box is displayed.

This feature enables you to specify the most appropriate FINE cartridge among installed cartridges
according to an intended use.

When one of the FINE cartridges becomes empty and cannot be replaced immediately by a new one, you
can specify the other FINE cartridge that still has ink and continue printing.

Ink Cartridge
Selects the FINE cartridge you use for printing.
Color Only
Uses the color FINE cartridge only.

Black Only
Uses the black FINE cartridge only.

Both Black and Color
Uses the FINE cartridges installed on the printer, which are color and black.

3% Important

* When a setting other than Plain Paper or Envelope is selected for Media Type on the Main tab,
Black Only is disabled because the printer uses the color FINE cartridge to print documents.

» Do not detach the FINE cartridge that is not in use. Printing cannot be performed while either
FINE cartridge is detached.

Auto Power Settings dialog box

When you click Auto Power, the Auto Power Settings dialog box is displayed.
This dialog box allows you to manage the printer power from the printer driver.

Auto Power On
Selects the auto power-on setting.
Specify Disable to prevent the printer from turning on automatically when print data is sent to it.
Make sure the printer is on and then click OK to change the printer settings.
Specify Enable to turn the printer on automatically when print data is sent to it.
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Auto Power Off
Selects the auto power-off setting.
If a printer driver operation or a printer operation is not performed within the specified time, the printer
turns off.

Quiet Settings dialog box

When you click Quiet Settings, the Quiet Settings dialog box is displayed.

Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
Select when you wish to reduce the operating noise of the printer at night, etc.

Using this function may lower the print speed.

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified period
of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to the
same time, the quiet mode will not function.

32 Important

* You can set the quiet mode from the printer, the printer driver, or ScanGear (scanner driver).
No matter how you use to set the quiet mode, the mode is applied when you perform operations
from the printer or printing and scanning from the computer.

« If you specify a time for Use quiet mode during specified hours, quiet mode is not applied to
operations (copy, direct print, etc.) performed directly from the printer.

Custom Settings dialog box

When you click Custom Settings, the Custom Settings dialog box is displayed.
If necessary, switch between various modes of printer operation.

Align heads manually
Usually, the Print Head Alignment function on the Maintenance tab is set to automatic head
alignment, but you can change it to manual head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head

alignment.
Check this check box to perform the manual head alignment.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the Orientation.
To rotate the document 90 degrees to the left when printing, select the check box.

Ink Drying Wait Time
The printer can pause before printing a subsequent page. Moving the slider to the right increases the
pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page dries,
increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.
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About dialog box

When you click About, the About dialog box is displayed.
This dialog box displays the version, copyright, and module list of the printer driver. You can select the
language to be used and switch the language displayed in the setup window.

Modules
Lists the printer driver modules.
Language
Specifies the language you wish to use in the printer driver setup window.
32 Important

« If the font for displaying the language of your choice is not installed in your system, the
characters will be garbled.

Related Topics

Cleaning the Print Heads from Your Computer
Aligning the Print Head Position from Your Computer
Use Your Computer to Print a Nozzle Check Pattern
Setting the Ink Cartridge to be Used

Cleaning Inside the Printer

Cleaning the Paper Feed Rollers from Your Computer
Managing the Printer Power

Reducing the Printer Noise

Changing the Printer Operation Mode

LR 2R 20 B 2R 2 2R 2
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Canon IJ Preview Description

Canon |J Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.
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File Menu
Selects the print operation.
Start Printing
Ends the Canon IJ Preview and then starts printing the document that is displayed on the preview
screen.
This command has the same function as the Start Printing on the toolbar.

Cancel Printing
Ends the Canon IJ Preview and cancels the printing of the document that is displayed on the

preview screen.
This command has the same function as the Cancel Printing on the toolbar.

Exit
Ends the Canon |J Preview.
Page Menu

This menu includes the following commands to select page to be displayed.
All of these commands except Page Selection... can also be selected from the toolbar.

»» Note

« If the pages are being spooled, the last spooled page becomes the last page.

« If the Page Layout setting on the Page Setup tab is specified to Page Layout, Tiling/Poster, or
Booklet, the number of pages is the number of sheets to be used for printing, and not the number
of pages in the original document created with the application software.
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« If duplex printing manually has been set, the front pages which will be printed first are all displayed
together, and then the back pages are displayed.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu

Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole

Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu

This menu includes the following command:

Displays Print Page Information
Displays print setup information (including printer paper size, media type, and page layout) for each
page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.

Help Menu

When you select this menu item, the Help window for Canon IJ Preview is displayed, and you can
check the version and copyright information.
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Start Printing button
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.

Cancel Printing button
Ends the Canon IJ Preview, and cancels the printing of the document that is displayed on the preview
screen.
You can click this button while spooling.

Print Page Information Screen
Displays print setup information for each page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.

32 Important

« If the media type and paper source are set from the application software, those settings have
priority and the changed settings may become ineffective.

Printer Paper Size
Displays the paper size of the document to be printed.

Media Type
You can select the media type of the document to be printed.

Paper Source
You can select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.
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Canon IJ XPS Preview Description

Canon |J XPS Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information which is set within the printer driver and allows you to check the
document layout, print order, and number of pages. The preview also allows you to edit the print document,
edit the print pages, change the print settings, and perform other functions.

When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.

22 Important

* To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile installed
on your computer.
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File Menu
Selects print operation and print history settings:
Print

Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.

This command has the same function as @ (Print) on the toolbar and the Print in the print
settings area.

Print All Documents
Prints all documents in the document list and closes the Canon |J XPS Preview.

Save Print History
Switches whether the documents printed from the Canon IJ XPS Preview are to be saved as print
history entries.

History Entry Limit
Switches the maximum number of print history registrations.
Select 10 Entries, 30 Entries, or 100 Entries.
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32 Important

« If the limit on the number of registration is exceeded, the print history registrations are deleted
starting from the oldest one.

Add documents from history to the list
Adds the document saved in the print history to the document list.

Exit
Ends the Canon IJ XPS Preview. The documents remaining in the document list will be deleted
from the list.
This command has the same function as the Exit in the print settings area.

Edit Menu

Selects the method for editing multiple documents or pages.

Undo
Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.
This command has the same function as the @(Undo) on the toolbar.

Documents

Selects the method for editing print documents.
Combine Documents
Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

This command has the same function as the 'ﬂ_'](Combine Documents) on the toolbar.

Reset Documents
Returns the document selected in the document list to their status before they were added to
the Canon IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

This command has the same function as the E (Reset Documents) on the toolbar.

Move Document
Use the following command to change the order of the documents selected in the document
list.

Move to First
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Move Up One
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Move Down One
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Move to Last
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.
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Delete Document
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be
selected.

This command has the same function as the 1E’Tn((Delete Document) on the toolbar.

Grayscale Printing
Allows you to change the monochrome print settings.
This command has the same functionality as the Grayscale Printing check box in the print
settings area.

Page Layout Printing...
Opens the Page Layout Printing dialog box.
This dialog box allows you to set Page Layout Printing, Pages, Page Order, and Page
Border.

Duplex Printing...
Opens the Duplex Printing dialog box.
This dialog box allows you to set Duplex Printing (Manual), Stapling Side, and Margin.

Copies...
Opens the Copies dialog box.
This dialog box allows you to set Copies, Collate, and Print from Last Page.

Pages
Selects the method for editing print pages.
Delete Page
Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

This command has the same function as the ° *(Delete Page) on the toolbar.

Restore Page
Restores pages that were deleted with the Delete Page function.
To restore pages, you must select the View Deleted Pages check box on the Option menu
and display the deleted pages as thumbnails.

Move Page
Use the following command to change the order of the currently selected pages.

Move to First
Moves the currently selected page to the beginning of the document.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.

Move Forward One
Moves the currently selected page one position in front of its current position.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.

Move Backward One
Moves the currently selected page one position after its current position.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.
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Move to Last
Moves the currently selected page to the end of the document.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.

View Menu
Selects the documents and pages to be displayed.
Documents
Use the following command to select the document to display.
First Document
Displays the first document in the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Previous Document
Displays the document located before the currently displayed document.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Next Document
Displays the document located after the currently displayed document.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Last Document
Displays the last document in the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Pages
Use the following command to select the page to be displayed.

»>» Note

« If the Page Layout setting in the printer driver is specified to Tiling/Poster, or Booklet, the
number of pages is the number of sheets to be used for printing, and not the number of pages
in the original document created with the application software.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.
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Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole
Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
Toggles the show / hide status of the following information.
View Thumbnails
Reduces all pages in the document selected in the document list and displays them at the bottom
of the preview window.

This command has the same function as the FI;II:I(VieW Thumbnails) on the toolbar.

View Document List
Displays the print document list at the top of the preview window.

View Print Settings Area
Displays the print settings area at the right side of the preview window.

View Deleted Pages
When the thumbnails are displayed, this function displays pages that were deleted with the Delete
Page function.
To check deleted pages, you must first select the View Thumbnails check box.

Keep printed documents on the list
Leaves the printed document in the document list.

Print Settings Displayed at Startup
Switches the tab of the print settings area to be displayed when the Canon IJ XPS Preview is
started.
Select Page Information, Layout, or Manual Color Adjustment.

Help Menu
When you select this menu item, the Help window for Canon IJ XPS Preview is displayed, and you can
check the version and copyright information.

= (Print)

Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon 1J XPS
Preview closes.
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'ﬂ_'](Combine Documents)
Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

1;alTe(Delete Document)
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be selected.

E (Reset Documents)
Returns the document selected in the document list to their status before they were added to the Canon
IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

%(View Thumbnails)
Reduces all pages in the document selected in the document list and displays them at the bottom of the
preview window.
To hide the print pages, click View Thumbnails again.

!r(Move to First)
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

El‘(Move Up One)
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

E’(Move Down One)

Moves the selected print document one down from its current position.

If the currently selected document is the last document, this command is grayed out and cannot be
selected.

EiL(Move to Last)
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.

£3(Undo)
Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.

- k(Delete Page)
Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

Document list
Displays the list of the print documents.
The document selected in the document list becomes the target for preview display and editing.
Document Name
Displays the name of the print document.
If you click the name of the selected print document, a text box is displayed, and you can rename
the document to any name.
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Pages
Displays the number of pages in the print document.

3% Important

» The number displayed in Pages and the output page count are different.
» To check the output page count, check the status bar at the bottom of the preview window.

Status
Displays the status of the print documents.
Documents that are undergoing data processing are displayed as Processing data.

22 Important

» Documents showing Processing data cannot be printed or edited.
Wait until the data processing ends.

Print Settings Area Screen
Allows you to check and change the print settings of the documents selected in the document list.
Print Settings Area is displayed on the right side of the preview window.
Page Information tab
The print settings are displayed for each page.
You can change the media type and paper source settings.
Printer Paper Size
Displays the paper size of the document to be printed.

Media Type
Allows you to select the media type of the document to be printed.

Paper Source
Allows you to select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.

Layout tab
You can specify settings for page layout printing.
To apply the specified settings, click Apply.
If the page layout print settings cannot be changed for the print document, the individual items are
grayed out and cannot be selected.

Manual Color Adjustment tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta,

Yellow, Brightness, Intensity, and Contrast options.

Cyan/Magenta/Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a
color weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.
This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document.
Use your application software if you want to change the total color balance significantly. Use
the printer driver only if you want to adjust the color balance slightly.
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32 Important

* When Grayscale Printing is checked, Cyan, Magenta, and Yellow appear grayed out
and are unavailable.

Brightness
Selects the brightness of your print.
Pure white and black will not change, but colors between white and black will change.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left
decreases the intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on this tab to their default values (factory settings).

Grayscale Printing
Allows you to change the monochrome print settings.

Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the
paper.
If the duplex print settings cannot be changed for the print document, this item is grayed out and is
unavailable.

32 Important

* When you select Booklet for Page Layout, Duplex Printing (Manual) of the print settings
area will be set automatically. In this case, Duplex Printing (Manual) is grayed out and is
unavailable.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
If the numbers of copies cannot be changed for the print document, this item is grayed out and is
unavailable.

Exit
Ends the Canon IJ XPS Preview.
The documents remaining in the document list will be deleted from the list.

Print
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.
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Canon |J Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.

b Canon MG2500 series Printer - USBOON = = n
Opticen Ik Details  Help
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Canon |J Status Monitor Features

The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the FINE cartridge type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

Canon IJ Status Monitor Overview

Canon |J Status Monitor allows you to check the status of the printer and ink with graphics and messages.
You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon |J Status Monitor shows an icon when a warning or error occurs to the printer.
1’ Indicates that a warning (operator call error) has occurred or the printer is working.
@ : There has been an error which requires a service.

FINE cartridge
Canon |J Status Monitor shows an icon when a low ink warning or a no ink error occurs.
In addition, this function displays graphics showing the estimated ink levels of the FINE cartridge.
In this case, click the graphics to open the Ink Details dialog box. You can check the detail
information such as the remaining ink level and the FINE cartridge types for your printer.

Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.
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Display Print Queue
Shows the print window used to manage the print job that is being printed or being in the print
queue.

Cancel Printing
Cancels the current print job.

32 Important

» The Cancel Printing button is enabled only while print data is being sent to the printer.
Once the print data has been sent, the button is grayed out and becomes unavailable.

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon |J
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job
Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Warning Automatically
When a Low Ink Warning Occurs
Starts the Canon IJ Status Monitor window automatically and displays it in front of the
other windows when a low ink warning occurs.

Start when Windows is Started
Starts the Canon IJ Status Monitor automatically when you start Windows.

Ink Details Menu
Select this menu to display the Ink Details dialog box. Check the detail information such as the
remaining ink level and the FINE cartridge types for your printer.
Ink Details dialog box
This function displays graphics and messages showing the FINE cartridge type and the
estimated ink levels.
Ink Information (displayed at left)
Shows the FINE cartridge types with graphics.
If a warning or error related to the remaining ink level occurs, the printer driver displays
an icon to let you know.
If the icon is displayed, operate the printer according to the instructions displayed on the
screen.

Message (displayed at right)
Shows information such as the ink status and ink colors with sentences.

Ink Model Number
Shows the FINE cartridge types for your printer.

Close
Closes the Ink Details dialog box to return to Canon IJ Status Monitor.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and
you can check the version and copyright information.
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Updating the MP Drivers

» Obtaining the Latest MP Drivers
» Deleting the Unnecessary MP Drivers
» Before Installing the MP Drivers

» Installing the MP Drivers
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Obtaining the Latest MP Drivers

The MP Drivers include a printer driver and ScanGear (scanner driver).

By updating the MP Drivers to the latest version of the MP Drivers, unresolved problems may be solved.

You can access our website and download the latest MP Drivers for your model.

22 Important

* You can download the MP Drivers for free, but any Internet access charges incurred are your

responsibility.
» Before installing the latest MP Drivers, delete the previously installed version.

Related Topics

= Before Installing the MP Drivers
= |nstalling the MP Drivers
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Deleting the Unnecessary MP Drivers

The MP Drivers which you no longer use can be deleted.
When deleting the MP Drivers, first exit all programs that are running.

The procedure to delete the unnecessary MP Drivers is as follows:

1. Start the uninstaller

« If you are using Windows 8.1 or Windows 8, from the Desktop charms, select Settings -> Control
Panel -> Programs -> Programs and Features.
From the program list, select "XXX MP Drivers" (where "XXX" is your model name) and then click

Uninstall.
« If you are using Windows 7 or Windows Vista, select Start menu -> Control Panel -> Programs -

> Programs and Features.
From the program list, select "XXX MP Drivers" (where "XXX" is your model name) and then click

Uninstall.

« If you are using Windows XP, select Start menu -> Control Panel -> Add or Remove Programs.
From the program list, select "XXX MP Drivers" (where "XXX" is your model name) and then click
Remove.

The confirmation window for uninstalling the model appears.

2» Important

* In Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog box
may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Execute. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the MP Drivers is complete.

22 Important

* Printer driver, XPS printer driver, and ScanGear (scanner driver) will be deleted when you uninstall the
MP Drivers.
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Before Installing the MP Drivers

This section describes the items that you should check before installing the MP Drivers. You should also
refer to this section if the MP Drivers cannot be installed.

Checking the Printer Status

* Turn off the printer.

Checking the Personal Computer Settings

» Terminate all running applications.
* Log on as a user who has the administrator account.

22 Important

» Before installing the latest MP Drivers, delete the previously installed version.

Related Topics

= Obtaining the Latest MP Drivers
= |nstalling the MP Drivers
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Installing the MP Drivers

You can access our web site through the Internet and download the latest MP Drivers and XPS printer driver
for your model.

The procedure for installing the downloaded MP Drivers is as follows:
1. Turn off the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

3% Important

* In Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog box
may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the MP Drivers

Take the appropriate action as described on the screen.

4. Complete the installation

Click Complete.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

32 Important

* You can install the XPS printer driver with the same procedure for installing the MP Drivers. However,
when installing the XPS printer driver, first complete installation of the MP Drivers.

* You can download the MP Drivers and XPS printer driver for free, but any Internet access charges
incurred are your responsibility.

» Before installing the latest MP Drivers, delete the previously installed version.

Related Topics

= Obtaining the Latest MP Drivers
= Deleting the Unnecessary MP Drivers
= Before Installing the MP Drivers
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Printing from a Digital Camera

» Printing Photographs Directly from a PictBridge (Wireless LAN) Compliant
Device

» About PictBridge (Wireless LAN) Print Settings
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Printing Photographs Directly from a PictBridge (Wireless LAN)
Compliant Device

You can connect a PictBridge (Wireless LAN) compliant device such as a digital camera, camcorder, or
mobile phone to the machine through wireless LAN, and print recorded images directly without using a
computer.

Connectable devices:
PictBridge (Wireless LAN) compliant device
Printable image data format:

The machine accepts images™ taken with a camera compliant with the Design rule for Camera File system
and PNG files.

* Exif 2.2/2.21/2.3 compliant
3% Important

* LAN connection with the machine is required to use this function.

»>» Note

* PictBridge is the Standard to print your photos directly without using a computer, connecting a device
such as a digital still camera, digital camcorder, or camera-equipped mobile phone.

In this manual, PictBridge printing with the wireless LAN connection is referred to as "PictBridge
(Wireless LAN)."

» When printing photos with the PictBridge (Wireless LAN) compliant device connected to the machine,
we recommend the use of the AC adapter supplied with the device. If you are using the device battery,
be sure to charge it fully.

» Depending on the model or brand of your device, you may have to select a print mode compliant with
PictBridge (Wireless LAN) before connecting the device. You may also have to turn on the device or
select Play mode manually after connecting the device to the machine.

Perform necessary operations on the PictBridge (Wireless LAN) compliant device before connecting it
to this machine according to instructions given in the device's instruction manual.

1. Make sure that the machine is turned on.

2. Load paper.

3. Connect the PictBridge (Wireless LAN) compliant device to the machine.

Detect the machine with the PictBridge (Wireless LAN) compliant device and connect the PictBridge
(Wireless LAN) compliant device to the machine with wireless LAN.

»» Note

* For details on how to detect the machine, refer to your PictBridge (Wireless LAN) compliant
device's instruction manual.

4. Specify the print settings such as the paper type and layout.
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You can perform settings using the menu on the LCD of your PictBridge (Wireless LAN) compliant
device. Select the size and type of paper that you loaded in the machine.

= Settings on a PictBridge (Wireless LAN) Compliant Device

5. Start printing from your PictBridge (Wireless LAN) compliant device.
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About PictBridge (Wireless LAN) Print Settings

Settings on a PictBridge (Wireless LAN) Compliant Device

This section describes the PictBridge (Wireless LAN) function of the machine. For the print settings on a
PictBridge (Wireless LAN) compliant device, refer to the instructions given in the device's instruction
manual.

»» Note

* In the following description, names of setting items are given according to those used in Canon-brand
PictBridge (Wireless LAN) compliant devices. Setting item names may be different depending on the
brand or model of your device.

» Some setting items explained below may not be available on some devices. When you cannot
change print settings on a device, the printer prints images as follows:

Paper size: 4" x 6"/ 10 x 15 cm
Paper type: Photo

Layout: 1-up, Bordered
Date/File No. Print: Not printed

The following settings can be used when printing from a PictBridge (Wireless LAN) compliant device.

Paper size 4" x 6"/ 10 x 15 cm, 5" x 7™, A4, 8.5" x 11"(Letter)

* Can be selected only on certain Canon-brand PictBridge (Wireless LAN) compliant devices.
(May not be selected depending on the device.)

Paper type » Default: Photo Paper Plus Glossy || PP-201
* Photo:

Photo Paper Plus Glossy Il PP-201
* Plain:

Ad4/Letter sized plain paper

Layout Default (Bordered), Index, Bordered*

* With a Canon brand PictBridge (Wireless LAN) compliant device, selecting items with "i" mark
allows you to print shooting info (Exif Data) on the margins of the specified data (1-up). (May not
be available with some Canon-brand PictBridge (Wireless LAN) compliant devices.)

Print date & file | Default (Off: No printing), Date, File No., Both, Off
no.

Trimming Default (Off: No trimming), On (follow the camera's setting), Off
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Copying

Making Copies JBasic

Switching the Page Size between A4 and
Letter
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Making Copies

Load the original on the platen glass to copy.

1. Make sure that the machine is turned on.

2. Load A4 or Letter-sized plain paper.

3. Load the original on the platen glass.

> Note

* You can switch the size of paper loaded in the rear tray between A4 and Letter.

= Switching the Page Size between A4 and Letter

4. Press the Color button for color copying, or the Black button for black & white copying.

The machine starts copying.

Remove the original on the platen glass after copying is complete.

To make multiple copies

Press the Color button or the Black button repeatedly according to the number of copies you want.

Press the same button (Color button or Black button) as the one which you previously pressed.

22 Important

Do not open the document cover or remove the original from the platen glass until scanning is
completed.

While the machine is scanning the original, the ON lamp keeps flashing.
If the original covers the whole page, area (B) in the figure below cannot be printed.

G (A)

e T T e

SO

(A) The direction in which the paper is ejected
(B) Unprintable area

For details on the printable area:

For A4 sized paper:

= Other Sizes than Letter, Leqgal, Envelopes

For Letter-sized paper:

= | etter, Legal
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»» Note

» To cancel copying, press the Stop button.
* To set the print quality to "Draft" (speed priority)
You can set the print quality to "Draft" (speed priority) following the procedure below.
1. Press and hold down the Color or Black button for 2 or more seconds in step 4.
The ON lamp flashes once.
2. Release the button.
The machine starts copying.

When the print quality is set to "Draft", print speed is given priority over quality. To give priority to
quality, press the Color or Black button for less than 2 seconds to copy in the print quality "Standard".
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Switching the Page Size between A4 and Letter

This setting is useful if you usually load Letter-sized paper in the rear tray.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 10 times.

3. Release the Stop button.

The ON lamp starts flashing instead of remaining lit.

4. Press the Black button to select A4, or the Color button to select Letter.

The ON lamp stops flashing and remains lit, then the paper size is changed.

> Note

* When you switch the page size to A4 or Letter, load paper of the selected size.
When the page size is set to A4, load A4 plain paper.
When the page size is set to Letter, load Letter-sized plain paper.

* This setting is retained even if the machine is turned off.

408



Scanning

Scanning from a Computer
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Scanning from a Computer

» Scanning with IJ Scan Utility

» Scanning with Application Software that You are Using (ScanGear)
» Useful Information on Scanning

» |J Network Scanner Selector EX Menu and Setting Screen

» Other Scanning Methods

» Placing Items (When Scanning from a Computer)

» Network Scan Settings
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Scanning with IJ Scan Utility

» What Is IJ Scan Utility (Scanner Software)?
» Starting IJ Scan Utility

» Easy Scanning with Auto Scan 7Basic

» Scanning Documents

» Scanning Photos

» Scanning with Favorite Settings

» Scanning Items Larger than the Platen (Image Stitch)
» Scanning Multiple Items at One Time

» Saving after Checking Scan Results

» Sending Scanned Images via E-mail

» Extracting Text from Scanned Images (OCR)

» |J Scan Utility Screens
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What Is IJ Scan Utility (Scanner Software)?

IJ Scan Utility is an application that allows you to easily scan documents, photos, etc.

You can complete from scanning to saving at one time by simply clicking the corresponding icon in the 1J
Scan Utility main screen.

=5 Canon U Scan Utility “
Product Namea: Caron SariaL b

= =) Wl =) B 5

At Doument Photo Cushom Stitch ScanGear

instrxctons Settngs...

What You Can Do with IJ Scan Utility

Scan Easily according to Purposes

You can scan by simply clicking an icon such as Auto to scan easily, Document to sharpen text in a
document or magazine for better readability, or Photo to scan with settings suitable for photos,
according to the item type or your purpose.

»» Note

» Refer to "lJ Scan Utility Main Screen" for details on the IJ Scan Utility main screen.

Save Scanned Images Automatically

Scanned images are automatically saved in a preset folder. You can change the folder as required.

»» Note

* The default save folders are as follows.

* Windows 8.1: Documents folder

* Windows 8: My Documents folder

* Windows 7: My Documents folder

» Windows Vista: Documents folder

* Windows XP: My Documents folder

» Refer to "Settings Dialog Box" for how to specify a folder.

Integrate with Applications

You can utilize scanned images through integration with other applications; display scanned images in
your favorite application, attach them to e-mails, extract text from images, and more.
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2% Important

+ Some functions are available only when My Image Garden is installed.

12> Note

» Refer to "Settings Dialog Box" for how to set the applications to integrate with.
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Starting IJ Scan Utility

»>» Note

* If you have more than one scanner or have changed the connection from USB connection to network
connection, set up the network environment from IJ Scan Utility.

= Network Scan Settings

Follow the steps below to start IJ Scan Utility.

Windows 8.1/Windows 8:

Select IJ Scan Utility on the Start screen to start IJ Scan Utility.

If IJ Scan Utility is not displayed on the Start screen, select the Search charm, then search for "IJ Scan
Utility".

Windows 7/Windows Vista/Windows XP:

From the Start menu, select All Programs > Canon Utilities > IJ Scan Utility > IJ Scan Utility to start IJ
Scan Utility.

|y Canon U Scan Utility Ex

Prothact Mame: Caran ErieE b

m ] B = s

Auta Dooument Fhoto Cushom Stitch ScaniGear

instruchons ' | Settings...
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Easy Scanning with Auto Scan

You can scan easily by automatically detecting the item type.

22 Important

 The following types of items may not be scanned correctly. In that case, adjust the cropping frames
(scan areas) in whole image view of ScanGear (scanner driver) and scan again.

» Photos that have a whitish background

* Items printed on white paper, hand-written documents, business cards, etc.
» Thin items

» Thick items

1. Make sure that your scanner or printer is turned on.

2. Place items on the platen of your scanner or printer.

= Placing Items (When Scanning from a Computer)

3. Start IJ Scan Utility.

4. Click Auto.

=y Cancn U Scan Utility EX

Praduict Name: CAr SarHE bt

=) =] W =) Bl

Auto Dooument Fhoto Cushom Stibch ScanGear

Enstruchons Sektings...

Scanning starts.

»» Note

+ Click Cancel to cancel the scan.

» To apply suitable corrections based on the item type, click Settings..., then select the Apply
recommended image correction checkbox in the Settings (Auto Scan) dialog box.

» Scanned images are saved in the folder set for Save in in the Settings (Auto Scan) dialog box
displayed by clicking Settings.... In the Settings (Auto Scan) dialog box, you can also make advanced
scan settings.

* Refer to the following pages to scan by specifying the item type.

= Scanning Photos
= Scanning Documents
= Scanning with Favorite Settings
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Scanning Documents

You can scan items placed on the platen with settings suitable for documents.

1. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

2. Start IJ Scan Utility.

3. Click Settings..., then set the paper size, resolution, etc. in the Settings (Document Scan)

dialog box as required.

When setting is completed, click OK.

4. Click Document.

=5 Canon L' Scan Utility

Praduct Name: Canan TR

K
m|a |l = W s

Auta Deament Phot Cushom Stitch

instructons ' | Settings...

Scanning starts.

»» Note

 Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Document Scan) dialog box
displayed by clicking Settings.... In the Settings (Document Scan) dialog box, you can also make
advanced scan settings.
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Scanning Photos

You can scan photos placed on the platen with settings suitable for photos.

1. Place the photo on the platen.

= Placing Items (When Scanning from a Computer)

2. Start IJ Scan Utility.

3. Click Settings..., then set the paper size, resolution, etc. in the Settings (Photo Scan)

dialog box as required.

When setting is completed, click OK.

4. Click Photo.

12y Canon L' Scan Utility

Praduct Name: Canan SR

EX]
o G| W= B s
Ak Deoument Phate FLanGear
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instructons ' | Settings...

Scanning starts.

»» Note

+ Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Photo Scan) dialog box
displayed by clicking Settings.... In the Settings (Photo Scan) dialog box, you can also make
advanced scan settings.
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Scanning with Favorite Settings

You can scan items placed on the platen with your favorite settings saved beforehand.

This is convenient for saving frequently used settings or when specifying scan settings in detail.

1. Start IJ Scan Utility.

2. Click Settings..., then set the item type, resolution, etc. in the Settings (Custom Scan)
dialog box as required.

When setting is completed, click OK.
2> Note

» Once the settings are made, you can scan with the same settings from the next time.

3. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

4. Click Custom.

=5 Canan U Scan Utility

Praduict Name: CAri ErHE
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Scanning starts.

»» Note

+ Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Custom Scan) dialog box
displayed by clicking Settings.... In the Settings (Custom Scan) dialog box, you can also make
advanced scan settings.
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Scanning Items Larger than the Platen (Image Stitch)

You can scan the left and right halves of an item larger than the platen and combine them back into one
image. Iltems up to approximately twice as large as the platen are supported.

13 Note

» The following explains how to scan from the item to be placed on the left side.

1. Start IJ Scan Utility.

2. Click Settings..., then set the item type, resolution, etc. in the Settings (Scan and Stitch)
dialog box as required.

When setting is completed, click OK.

3. Click Stitch.

The Image Stitch window appears.

4. In Select Output Size, select an output size according to the paper size.

Select ulput See

a3 fasxz)

Soan Deedton

[5can fiam Lot

Soan Image 1

Start Scanaing Image 1 |
—

Sean Inage 2

Start Seanning Image £

] Adhust oropping Samas

5. Make sure that Scan from Left is selected in Scan Direction.
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XIQSDa?

Sean Image 2

Start Scanning Image £

[ Aechust cropping Sames

6. Place the item that is to be displayed on the left side of the screen face-down on the platen.

7. Click Start Scanning Image 1.

XAlgag?

Sean Image 2

Start Scanning Image

[T Aedhust erapping Samas

The first item is scanned and appears in 1.
22> Note

¢ Click Cancel to cancel the scan.

8. Place the item that is to be displayed on the right side of the screen face-down on the
platen.
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9. Click Start Scanning Image 2.

TVEEE;

Select hitput Size

a3 fasx 2

Scan Image 1

Start Scanning Image L

Sean Image 2

The second item is scanned and appears in 2.

23> Note

¢ Click Cancel to cancel the scan.

10. Adjust the scanned images as required.

Use the Toolbar to rotate or zoom in/out, or drag the images to adjust their positions.

Select Output Size

a3 fasx 2
Sean Deggiian

|szan rom Lett

Sean Image 1

Start Seanning Image |

Sean Inage 2

Start Seanning Image &

[0 Achust cropping Sames

23 Note

» Select the Adjust cropping frames checkbox to specify the area to be saved.
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= Adjusting Cropping Frames in the Image Stitch Window

» To scan an item again, select the image in the Preview area or the thumbnail at the top of the

screen, then click x (Delete). The selected image is deleted, allowing you to scan the item
again.

11. Click Save.

Soan Image 1

Start Scanming Image L

Gean Image 2

Start Seanning Imonge

The combined image is saved.

23 Note

+ Refer to "Image Stitch Window" for details on the Image Stitch window.
* You can make advanced scan settings in the Settings (Scan and Stitch) dialog box displayed by
clicking Settings....
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Scanning Multiple Items at One Time

You can scan two or more photos (small items) placed on the platen at one time and save each image
individually.

32 Important

» The following types of items may not be scanned correctly. In that case, adjust the cropping frames
(scan areas) in whole image view of ScanGear (scanner driver) and scan again.

» Photos that have a whitish background

* |tems printed on white paper, hand-written documents, business cards, etc.
* Thin items

» Thick items

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" for your model
from Home of the Online Manual for details.

Using Auto Scan:

Whether there are multiple items or not is detected automatically. Click Auto and scan.

= Easy Scanning with Auto Scan

Not Using Auto Scan:

In the Settings dialog box, set Paper Size to Auto scan and scan.

> Note

» The screens for scanning with favorite settings are used as examples in the following descriptions.

1. Place the items on the platen.

= Placing Items (When Scanning from a Computer)

2. Start IJ Scan Utility.

3. Click Settings....

=5 Canon U Scan Utility “

Praduct Name: Canan TR b

= =) | =) B 5

Auta Deament Phot Cushom Stitch SanGear

instruxctons Settngs...

The Settings dialog box appears.

4. Click Custom Scan.
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ﬁf\d%h@ﬂuf@

|I-Dnu.rru'r|s

|mute

PG Insge Quality: |standard

POF Compresson: |5|nﬂm-l
[+ Creabe & FOF fie $at supports keyword search

[ '5ave to.a subduider with cunrent dabe

Al ateeh Ta vy

5. Select Select Source according to the items to be scanned.

PEG Inage Quakty

[ 5ave to o subdidar wth current dabe.

[ ched: scan results

Appscaon Sattngs
() Dy v a0 appbcation:

6. Select Auto scan for Paper Size, then click OK.
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JPEG Image Gualbyr
[ '5ave to.a subdnider wih cunrent date
[ ched: scan results

Appboaten Bettings
() Oy Wi ppbcation:

The IJ Scan Utility main screen appears.

23» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box
= Settings (Custom Scan) Dialog Box

7. Click Custom.

Multiple items are scanned at one time.

13 Note

+ Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the corresponding Settings dialog box
displayed by clicking Settings.... In each Settings dialog box, you can also make advanced scan
settings.
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Saving after Checking Scan Results

You can check the scan results, then save the images to a computer.

=% Important

* You cannot check the scan results before saving when scanned using Auto scan.

22> Note

» The screens for scanning photos are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

in Litility

The Settings dialog box appears.

3. Click Photo Scan.

JPEG Image Gualiby:
[]'5ave toa subduider with cunrent dabe

[ chad: semn rasults

Appbeanon Sattng
18] Dy vy a0 ppibcation:

4. Select the Check scan results checkbox, then click OK.
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JPEG Imags Cualby:
[ '5ave to.a subdnider with cunrent date
[ Ched: scan results

Appboanen Sattngs
() Oy Wi ppbcation:

The IJ Scan Utility main screen appears.

23» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box

= Settings (Custom Scan) Dialog Box
= Settings (Scan and Stitch) Dialog Box
= Settings (ScanGear) Dialog Box

5. Click Photo.

in Utility

Scanning starts.

When scanning is completed, the Save Settings dialog box appears.

22> Note

¢ Click Cancel to cancel the scan.

6. Change the image order or file save options as required.

You can change the image order or file save options in the Save Settings dialog box.
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»» Note

* The default save folders are as follows.

* Windows 8.1: Documents folder

* Windows 8: My Documents folder

* Windows 7: My Documents folder

» Windows Vista: Documents folder

+ Windows XP: My Documents folder

. Click OK.

Scanned images are saved according to the settings.
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Sending Scanned Images via E-mail

You can send scanned images via e-mail.

22> Note

» The screens for scanning photos are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

The Settings dialog box appears.

3. Click Photo Scan.

JPEG Image Qualibyr
[ '5ave toa subduider with cunrent dabe

[ ched: semn results

Apalieanan Bt
() Oy v a5 Bppbcation:

4. Select Attach to e-mail in Application Settings, then select an e-mail client.
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JPEG Imags Qualby:

[ 5ave to.a subdnider with cunrent dabe

[ chedk scan results
Applenten Sattngs

{7 D wih an appbcation:

(Z15and to an appication:

(2 5end b fobder:

(8] Attach by & -madr

{7100 notskart any apphcation

22> Note

* You can add e-mail clients to use for attachments from the pull-down menu.
« If None (Attach Manually) is selected, manually attach scanned and saved images to e-mail.

5. Click OK.

JPEG Image Gualiby:
[l mave i subfobcher with cunrent dabe
[ ched: semn rasults

Appboaen Settngs

() Bipen wizh an apphcation:
(21 Band to.an epplcaton:
(T1sand to a folder:

(8] Attach b e -mad:

(7100 nobskard any apphoation

The IJ Scan Utility main screen appears.

12> Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Auto Scan) Dialog Box
= Settings (Document Scan) Dialog Box
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= Settings (Photo Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (ScanGear) Dialog Box

6. Click Photo.

= Canocn 1) Scan Utility

Praduct Name: Canan BT

EX]
i) = | 5
Auta Dooument Fhoto SCanGear

Enstruchons ' | Settings...

Scanning starts.

When scanning is completed, the specified e-mail client starts and the images will be attached to a new
message.

»» Note

* Click Cancel to cancel the scan.

» The scanned images are saved according to the settings made in the Settings dialog box.

* When the Check scan results checkbox is selected in the Settings dialog box, the Save Settings
dialog box appears. After you set the save options and click OK, the scanned images are saved
and automatically attached to a new message of the specified e-mail client.

7. Specify the recipient, enter the subject and message, then send e-mail.

Refer to the manual of your e-mail client for e-mail settings.
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Extracting Text from Scanned Images (OCR)

Scan text in scanned magazines and newspapers and display it in your text editor.

22> Note

* You can extract text when scanning via Document, Custom, or ScanGear.
» The screens for scanning documents are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

Canon 1) Scan Utility

L |

E = | 5

The Settings dialog box appears.

3. Click Document Scan.

[ Creabe & FOF fe $at supports keyword saarch

[ 5ave to o subiolder wh cunrent dabe

[ chedh: somn results

Al AT AT

12> Note

» For Resolution, only 300 dpi or 400 dpi can be set when Start OCR is selected in Application
Settings.

4. Select Start OCR for Application Settings, then select the application in which you want
to display the result.
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JPEG Image Qualityr
[ 5ave toa subdider with cunrent dabe

[ ched: semn rasults

Appbennan et
(71 Oy v Eppbcation:
(Z1 5end to-an 2pphcation:
(Z15and to a folder:

(71 artach boe-mad:

(8] Start DCR

{TIDo notskart any spphcation

22> Note

« If a compatible application is not installed, the text in the image is extracted and appears in your
text editor.
Text to be displayed is based on Document Language in the Settings (General Settings) dialog
box. Select the language you want to extract in Document Language and scan.

* You can add the application from the pull-down menu.

5. Click OK.

FPEG Inage Quakty
[ 5w to s sbiniclar wth current cabe

[ Ched: scan results

Appbcaan Sattig
(7 Dy widh an appbcation:
(T1'5and toan sppication:
(Z15end to.n folder:

(Z1 dittach boe-mad:

(8] Stert DCR:

(7100 notskart any apphcation

The IJ Scan Utility main screen appears.
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»» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (ScanGear) Dialog Box

. Click Document.

Canon IV Scan Utility

Praduct Name: Canadn farEE

Enstruchons | Settings...

Scanning starts.

When scanning is completed, the scanned images are saved according to the settings, and the extracted
text appears in the specified application.

> Note

* Click Cancel to cancel the scan.
» Text displayed in your text editor is for guidance only. Text in the image of the following types of
documents may not be detected correctly.

Documents containing text with font size outside the range of 8 points to 40 points (at 300 dpi)
Slanted documents

Documents placed upside down or documents with text in the wrong orientation (rotated
characters)

Documents containing special fonts, effects, italics, or hand-written text

Documents with narrow line spacing

Documents with colors in the background of text

Documents containing multiple languages
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IJ Scan Utility Screens

» |J Scan Utility Main Screen

» Settings Dialog Box

Settings (Auto Scan) Dialog Box
Settings (Document Scan) Dialog Box
Settings (Photo Scan) Dialog Box
Settings (Custom Scan) Dialog Box
Settings (Scan and Stitch) Dialog Box
Settings (ScanGear) Dialog Box
Settings (General Settings) Dialog Box

©E & & & ® © ¥

» Save Settings Dialog Box

» Image Stitch Window
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IJ Scan Utility Main Screen

Follow the steps below to start IJ Scan Utility.

Windows 8.1 / Windows 8:

Select IJ Scan Utility on the Start screen to start IJ Scan Ultility.

If IJ Scan Utility is not displayed on the Start screen, select the Search charm, then search for "IJ Scan
Utility".

Windows 7/Windows Vista/Windows XP:

From the Start menu, select All Programs > Canon Utilities > IJ Scan Utility > IJ Scan Utility to start IJ
Scan Utility.

You can complete from scanning to saving at one time by simply clicking the corresponding icon.

Sy Canon I Scan Utility “

Pracuct Name: Canon SariEE b

= =) Wl =) B 5

At Doument Photo Cushom Stitch ScanGear

instrxctons Settngs...

Product Name
Displays the name of the product that IJ Scan Utility is currently set to use.

If the displayed product is not the one you want to use, select the desired product from the list.
In addition, for network connection, select one with "Network" after the product name.

»» Note

» Refer to "Network Scan Settings" for how to set up a network environment.

Auto
Detects the item type automatically and saves them to a computer. The data format for saving will also
be set automatically.

Save settings and the response after scanning can be specified in the Settings (Auto Scan) dialog

box.

Document
Scans items as documents and saves them to a computer.
Scan/save settings and the response after scanning can be specified in the Settings (Document Scan)
dialog box.

Photo
Scans items as photos and saves them to a computer.

Scan/save settings and the response after scanning can be specified in the Settings (Photo Scan)
dialog box.

Custom
Scans items with your favorite settings and saves the images to a computer. The item type can be
automatically detected.

Scan/save settings and the response after scanning can be specified in the Settings (Custom Scan)
dialog box.
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Stitch
Displays the Image Stitch window in which you can scan the left and right halves of an item larger than
the platen and combine the scanned images back into one image.

Scan/save settings and the response after scanning can be specified in the Settings (Scan and Stitch)
dialog box.

ScanGear
Starts ScanGear (scanner driver) in which you can make image corrections and color adjustments
when scanning.

Scan/save settings and applications can be specified in the Settings (ScanGear) dialog box.

Instructions
Opens this guide.

Settings...
Displays the Settings dialog box in which you can specify the scan/save settings and the response after
scanning.
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Settings Dialog Box

A0
There are two tabs in the Settings dialog box: E: (Scanning from a Computer) and [ (General
Settings). When you click a tab, the view in the red frame switches and you can make advanced settings to
functions on each tab.

|t

:smd

:EIH'n‘.h'd

[ Create & FOF fie $at suoports keyword search

[ 5awe b2 & sutdoider with ourrent date

Apoliston Gattngs
8] Dgeen i 7 dpplcation:
(1 Bend o o pppiboation:
(1 Send ta a fobders Hane
(] Aty b g mad: 1. Henee (Aitach Marualy]

71D pa L skt any aoplcatien

E: (Scanning from a Computer) Tab

You can specify how to respond when scanning from IJ Scan Utility or My Image Garden.

= Settings (Auto Scan) Dialog Box

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box

= Settings (Custom Scan) Dialog Box
=Y
-

Settings (Scan and Stitch) Dialog Box
Settings (ScanGear) Dialog Box

]
Iﬁ (General Settings) Tab

You can set the product to use, file size restriction on e-mail attachment, language to detect text in
images, and folder in which to save images temporarily.

= Settings (General Settings) Dialog Box
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Settings (Auto Scan) Dialog Box
Click Auto Scan on the (Scanning from a Computer) tab to display the Settings (Auto Scan) dialog
box.

In the Settings (Auto Scan) dialog box, you can make advanced scan settings to scan by automatically
detecting the item type.

Settings (Auto Scan)

I

=) S )

Bave Settings

Fie Maimez: MG L ( }
E] Photo Scan 2
Save e I Doouments w
|i|*1 Custom Scan [uata Format: o -
PEG Inage Qualty: Standard w
[ﬂ] Szan erd S51ch
FOF Compressons Standard v
% SeprCanr [] Create & POF fie St supports keyword search

[ 5ave ta a sutduider with current date

Appbcton Setngs

8] Dipeen with an appication: 1 Cancn My Irsage Garden w (3}
(1 Eand o pppiboation: | Peeview

(1 Bend to & fobders Hone

(0 ey b & sl 1. Hone (Attach Marualy]

1D ik S sy oyl i

nestructions Defaults o

= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

3% Important

» When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

Supported Items

Photos, postcards, business cards, magazines, newspapers, documents, and BD/DVD/CD.

32 Important

» To scan the following types of items, specify the item type and size in the Settings (Document Scan)
dialog box, Settings (Photo Scan) dialog box, or Settings (Custom Scan) dialog box, then click
Photo, Document, or Custom in the IJ Scan Utility main screen. You cannot scan correctly with Auto.

* A4 size photos

» Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as paperback
pages with the spine cut off

* Items printed on thin white paper

» Long narrow items such as panoramic photos
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» Reflective disc labels may not be scanned as expected.
* Place items to be scanned on the platen correctly. Otherwise, items may not be scanned correctly.

Refer to "Placing Items (When Scanning from a Computer)" for how to place items.

»» Note

» To reduce moire in scans, set Select Source to Magazine in the Settings (Document Scan) dialog
box or Settings (Custom Scan) dialog box, then click Document or Custom in the IJ Scan Utility main
screen.

(1) Scan Options Area

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

32 Important

» The color tone may differ from the source image due to corrections. In that case, deselect the
checkbox and scan.

»>» Note

» Scanning takes longer than usual when you enable this function.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

* Windows 8: My Documents folder

» Windows 7: My Documents folder

» Windows Vista: Documents folder

» Windows XP: My Documents folder

3% Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Auto is selected. The following data formats are automatically applied according to the item type
when saving.

 Photos, postcards, BD/DVD/CD, and business cards: JPEG
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+ Magazines, newspapers, and documents: PDF

32 Important

» The save format may differ depending on how you place the item.

= Placing Items (When Scanning from a Computer)

JPEG Image Quality
You can specify the image quality of JPEG files.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.
Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.
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Do not start any application
Saves to the folder specified in Save in.

»» Note

+ Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Document Scan) Dialog Box

Click Document Scan on the E: (Scanning from a Computer) tab to display the Settings (Document
Scan) dialog box.

In the Settings (Document Scan) dialog box, you can make advanced scan settings to scan items as
documents.

-
Elj Auts Sean ) )
E'I; Ceecusreent Soan Cilor Mool Codor w
Paper Size: Lether w
E] Phaho Scan
Foaspiurtion: 3000 el w
'_l| Custom Soan :-r:lmﬁu:msarmgs
Save Get
@ o o Satch e ! .
File izt | bl (2}
% SeprCan Sawe e , DCoouments w
Duata Fodrnat: |POF Putzple Pages) w
POF Cofrpr essons :EIanchn:I w
[ Create a POF fie St supports keyword search
[ 5ave ta & sutduider with current dabe
[[] chek scam results
Apobcaton Settncs
() Dy i o ppsbcation: .5 Carnan My mage Ganden bl (3}
71 Cand ba my Bppicabon: 1. Preview
(1 Send ta a folders Hane
7 Antzy by & enad: 1. Hone (Sitach Marualy)
(I Steet OCR: <] Dzt & Test
710 Pk SERY Ay BepknsBan
Mo Functord
Insiructions Defaults oK

= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

32 Important

» When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area

Select Source
Select the type of item to be scanned.

» Scanning documents: Document
» Scanning magazines: Magazine

Color Mode
Select the color mode in which to scan the item.
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Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

Custom 5ize Setting E
wideh nches (1,00 -8.50)
Heightz | 1100 | ivches {100 - 11.68)
Lirat: inches W
| oK | Defalts | Cencel

»>» Note

+ Click Defaults to restore the specified settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.

= Resolution

»>» Note

» Only 300 dpi or 400 dpi can be set when Start OCR is selected in Application Settings.

Image Processing Settings

Click .| (Plus) to set the following.
2> Note

* When Color Mode is Black and White, only Reduce gutter shadow, Correct slanted text
document, and Detect the orientation of text document and rotate image appear.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

22 Important

» The color tone may differ from the source image due to corrections. In that case, deselect
the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.
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Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots
are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.

»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

* When you enabile this function, scanning may take longer than usual with network
connection.

Correct slanted text document
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

22 Important

 The following types of documents may not be corrected properly since the text cannot be
detected correctly.

* Documents in which the text lines are inclined more than 10 degrees or the angles vary
by line

* Documents containing both vertical and horizontal text

» Documents with extremely large or small fonts

» Documents with small amount of text

» Documents containing figures/images

* Hand-written text

+ Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text document.

Detect the orientation of text document and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text in
the scanned document.

32 Important

+ Only text documents written in languages that can be selected from Document Language
in the Settings (General Settings) dialog box are supported.

» The orientation may not be detected for the following types of settings or documents since
the text cannot be detected correctly.

* Resolution is outside the range of 300 dpi to 600 dpi

» Font size is outside the range of 8 points to 48 points

» Documents containing special fonts, effects, italics, or hand-written text
* Documents with patterned backgrounds
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In that case, select the Check scan results checkbox and rotate the image in the Save
Settings dialog box.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

» Windows 8.1: Documents folder

* Windows 8: My Documents folder

» Windows 7: My Documents folder

* Windows Vista: Documents folder

» Windows XP: My Documents folder

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
32 Important

* You cannot select JPEG/Exif when Color Mode is Black and White.
+ When Start OCR is selected in Application Settings, you cannot select PDF or PDF (Multiple
Pages).

»» Note

» With network connection, scanning may take longer than usual when you set TIFF or PNG in
Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
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» When Black and White is selected in Color Mode, this option does not appear.

JPEG Image Quality
You can specify the image quality of JPEG files.

3% Important

» This appears only when JPEG/EXxif is selected in Data Format.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder

Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.
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Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

> Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Photo Scan) Dialog Box

Click Photo Scan on the E: (Scanning from a Computer) tab to display the Settings (Photo Scan)
dialog box.

In the Settings (Photo Scan) dialog box, you can make advanced scan settings to scan items as photos.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

32 Important

* When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

(1) Scan Options Area

Select Source
Photo is selected.

Color Mode
Select the color mode in which to scan the item.

Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.
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»» Note

+ Click Defaults to restore the specified settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.
= Resolution
Image Processing Settings

Click | * (Plus) to set the following.

3% Important

* When Color Mode is Black and White, Image Processing Settings is not available.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

» Windows 8: My Documents folder

* Windows 7: My Documents folder

» Windows Vista: Documents folder

* Windows XP: My Documents folder

22 Important

» When the Settings dialog box is displayed from My Image Garden, this option does not appear.
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Data Format
Select the data format in which to save the scanned images.

You can select JPEG/EXxif, TIFF, or PNG.
32 Important

* You cannot select JPEG/Exif when Color Mode is Black and White.

»» Note

» With network connection, scanning may take longer than usual when you set TIFF or PNG in
Data Format.

JPEG Image Quality
You can specify the image quality of JPEG files.

32 Important

 This appears only when JPEG/EXxif is selected in Data Format.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder

Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.
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> Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Custom Scan) Dialog Box
Click Custom Scan on the (Scanning from a Computer) tab to display the Settings (Custom Scan)
dialog box.

In the Settings (Custom Scan) dialog box, you can make advanced scan settings to scan according to your
preference.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

32 Important

* When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area

Select Source

Select the type of item to be scanned. Select Auto to detect the item type automatically and to set
Color Mode, Paper Size, and Resolution automatically as well.

22 Important

* Item types supported by Auto are photos, postcards, business cards, magazines, newspapers,
documents, and BD/DVD/CD.
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» To scan the following types of items, specify the item type or size. You cannot scan correctly with
Auto.
* A4 size photos

» Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as
paperback pages with the spine cut off

* ltems printed on thin white paper

» Long narrow items such as panoramic photos

» Reflective disc labels may not be scanned as expected.

* Place items correctly according to the type of item to be scanned. Otherwise, items may not be
scanned correctly.

Refer to "Placing Iltems (When Scanning from a Computer)" for how to place items.

»>» Note

» To convert text in the image into text data after scanning, specify Select Source instead of
selecting Auto.

» To reduce moire, set Select Source to Magazine.

Color Mode
Select the color mode in which to scan the item.

»» Note

» Only Color is available when Select Source is Auto.

Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

Custom 5Size Setting ﬂ
idth nches (100 -8.50)
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»» Note

» Only Auto is available when Select Source is Auto.

+ Click Defaults in the screen in which you can specify the paper size to restore the specified
settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.

= Resolution

»>» Note

* Only Auto is available when Select Source is Auto.
» Only 300 dpi or 400 dpi can be set when Start OCR is selected in Application Settings.
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Image Processing Settings

Click | T | (Plus) to set the following. Available setting items vary by Select Source.

* When Select Source is Auto:

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

32 Important

» The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

* When Select Source is Photo:

3% Important

* When Color Mode is Black and White, Image Processing Settings is not available.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

* When Select Source is Magazine or Document:

»» Note

* When Color Mode is Black and White, only Reduce gutter shadow, Correct slanted text
document, and Detect the orientation of text document and rotate image appear.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

32 Important

» The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.

Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.
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Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.

»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

* When you enable this function, scanning may take longer than usual with network
connection.

Correct slanted text document
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

32 Important

» The following types of documents may not be corrected properly since the text cannot
be detected correctly.

* Documents in which the text lines are inclined more than 10 degrees or the angles
vary by line

» Documents containing both vertical and horizontal text

» Documents with extremely large or small fonts

» Documents with small amount of text

» Documents containing figures/images

Hand-written text

» Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text document.

Detect the orientation of text document and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text
in the scanned document.

22 Important

* Only text documents written in languages that can be selected from Document
Language in the Settings (General Settings) dialog box are supported.

» The orientation may not be detected for the following types of settings or documents
since the text cannot be detected correctly.

» Resolution is outside the range of 300 dpi to 600 dpi

» Font size is outside the range of 8 points to 48 points

» Documents containing special fonts, effects, italics, or hand-written text
» Documents with patterned backgrounds

In that case, select the Check scan results checkbox and rotate the image in the Save
Settings dialog box.
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(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»>» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

» Windows 8: My Documents folder

* Windows 7: My Documents folder

* Windows Vista: Documents folder

* Windows XP: My Documents folder

22 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, PDF (Multiple Pages), or Auto.
22 Important

* When Auto is selected, the save format may differ depending on how you place the item.

= Placing ltems (WWhen Scanning from a Computer)

* You cannot select JPEG/Exif when Color Mode is Black and White.
* When Start OCR is selected in Application Settings, you cannot select PDF, PDF (Multiple
Pages), or Auto.

»» Note

» Auto appears only when Auto is selected for Select Source.
+ With network connection, scanning may take longer than usual when you set TIFF or PNG in
Data Format.

JPEG Image Quality
You can specify the image quality of JPEG files.

3% Important

» This appears only when JPEG/Exif or Auto is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.
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High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

22 Important

* This appears only when PDF, PDF (Multiple Pages), or Auto is selected in Data Format.
» When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

22 Important

» This appears only when PDF, PDF (Multiple Pages), or Auto is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).
If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

3% Important

» This does not appear when Select Source is Auto.
» When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.
You can specify the application from the pull-down menu.

Send to an application

Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder

Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.
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Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

> Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Scan and Stitch) Dialog Box
Click Scan and Stitch on the (Scanning from a Computer) tab to display the Settings (Scan and
Stitch) dialog box.

In the Settings (Scan and Stitch) dialog box, you can make advanced scan settings for scanning items
larger than the platen.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

22 Important

* When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area
Select Source
Select the type of item to be scanned.

» Scanning photos: Photo
» Scanning documents: Document
» Scanning magazines: Magazine

22> Note

» To reduce moire, set Select Source to Magazine.
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Color Mode
Select the color mode in which to scan the item.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.
= Resolution
Image Processing Settings

Click . * (Plus) to set the following. Available setting items vary by Select Source.

22 Important

» When Color Mode is Black and White, Image Processing Settings is not available.

* When Select Source is Photo:
Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.
* When Select Source is Magazine or Document:

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.

Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder
* Windows 8: My Documents folder

461



» Windows 7: My Documents folder
* Windows Vista: Documents folder
» Windows XP: My Documents folder

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format

Select the data format in which to save the scanned images.
You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
32 Important

* You cannot select JPEG/Exif when Color Mode is Black and White.

»» Note

» With network connection, scanning may take longer than usual when you set TIFF or PNG in
Data Format.

PDF Compression
Select the compression type for saving PDF files.
Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

3% Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
» When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»>» Note

1
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

JPEG Image Quality
You can specify the image quality of JPEG files.

22 Important

» This appears only when JPEG/EXxif is selected in Data Format.

Save to a subfolder with current date

Select this checkbox to create a current date folder in the folder specified in Save in and save

scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).
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If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»>» Note

+ Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions

Opens this guide.

Defaults

You can restore the settings in the displayed screen to the default settings.
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Settings (ScanGear) Dialog Box
Click ScanGear on the (Scanning from a Computer) tab to display the Settings (ScanGear) dialog
box.

In the Settings (ScanGear) dialog box, you can specify how to save images when scanning items by
starting ScanGear (scanner driver) and how to respond after saving them.
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= (1) Save Settings Area
= (2) Application Settings Area

22 Important

* When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

(1) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.
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» Windows 8.1: Documents folder

* Windows 8: My Documents folder

» Windows 7: My Documents folder

* Windows Vista: Documents folder

» Windows XP: My Documents folder

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
3> Note

* When PDF or PDF (Multiple Pages) is selected, images up to 9600 pixels x 9600 pixels can be
scanned.

* When the Enable large image scans checkbox is selected in Save Settings, or when Start
OCR is selected in Application Settings, you can select JPEG/Exif, TIFF, or PNG.

» With network connection, scanning may take longer than usual when you set TIFF or PNG in
Data Format.

JPEG Image Quality
You can specify the image quality of JPEG files.

22 Important

» This appears only when JPEG/EXxif is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.
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Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Enable large image scans
Select this checkbox to scan images up to 21000 pixels x 30000 pixels and 1.8 GB.

32 Important

* When this checkbox is selected, you cannot select Send to an application, Send to a folder,
Attach to e-mail, or Start OCR.
» When the Settings dialog box is displayed from My Image Garden, this option does not appear.

»>» Note

* When this checkbox is not selected, images up to 10208 pixels x 14032 pixels can be scanned.

Check scan results
Displays the Save Settings dialog box after scanning.

22 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(2) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

466



> Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (General Settings) Dialog Box

0
Click the (General Settings) tab to display the Settings (General Settings) dialog box.

In the Settings (General Settings) dialog box, you can set the product to use, file size restriction on e-mail
attachment, language to detect text in images, and folder in which to save images temporarily.

32 Important

* When the Settings dialog box is displayed from My Image Garden, some options may not appear.

Settings (General Settings)
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Product Name
Displays the name of the product that IJ Scan Utility is currently set to use.

If the displayed product is not the one you want to use, select the desired product from the list.
In addition, for network connection, select one with "Network™ after the product name.

»» Note

» With network connection, Select appears on the right side of the product name. Click Select to
display IJ Network Scanner Selector EX from which you can change the scanner to use. Refer to
"Network Scan Settings" for the setting procedure.

E-mail Attachment Size
You can restrict the size of scanned images to be attached to an e-mail.
You can select Small (Suitable for 640 x 480 Windows), Medium (Suitable for 800 x 600 Windows),
Large (Suitable for 1024 x 768 Windows), or No Change.

Document Language
Select the language for detecting text in images.

Folder to Save Temporary Files
Displays the folder in which to save images temporarily. Click Browse... to specify the destination

folder.
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Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Save Settings Dialog Box

Select the Check scan results checkbox in Save Settings of the Settings dialog box to display the Save
Settings dialog box after scanning.

You can specify the data format and destination while viewing the thumbnails of scan results.

22 Important

+ After scanning from My Image Garden, the Save Settings dialog box does not appear.

Save Settings “
DS
3 @
- - “ 3
b =i ¥
E - S
- e -1:5 . 1 "_ ‘t‘\_r\ <
oo
Save Sattgs
Fi bame: |1MG v (3)
Savein: || Documents v
Data Farmat: |pEG BN v
IPEC Image Quality: Istandard v
[CI5ave to a subfaider with current date
oK Canxel

= (1) Preview Operation Buttons
= (2) Scan Results Area
= (3) Save Settings Area

(1) Preview Operation Buttons

£ ah
' el (Rotate Left 90°)/(Rotate Right 90°)
Rotates scanned images 90 degrees counter-clockwise or clockwise.

£ 1
Select the image you want to rotate, then click lﬂ—l_l (Rotate Left 90°) or IE—I (Rotate Right 90°).
22 Important

» The preview operation buttons do not appear when the Enable large image scans checkbox is
selected in the Settings (ScanGear) dialog box.

(2) Scan Results Area

Displays the thumbnails of the scanned images. You can change the save order of images via drag-and-
drop. The file names for saving appear below the thumbnails.
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(3) Save Settings Area

File Name

Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»>» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

» Windows 8: My Documents folder

* Windows 7: My Documents folder

* Windows Vista: Documents folder

* Windows XP: My Documents folder

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
22 Important

* You cannot select PDF or PDF (Multiple Pages) in the following cases.

* When scanned by clicking Photo in the IJ Scan Utility main screen

» The Enable large image scans checkbox is selected in Save Settings of the Settings
(ScanGear) dialog box

» Start OCR is selected in Application Settings of the Settings (Document Scan), Settings
(Custom Scan), or Settings (ScanGear) dialog box

* You cannot select JPEG/Exif when Color Mode is Black and White.

»» Note

» With network connection, scanning may take longer than usual when you set TIFF or PNG in
Data Format.

JPEG Image Quality
You can specify the image quality of JPEG files.

22 Important

» This appears only when JPEG/EXxif is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

471



32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
» When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

22 Important

* This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»>» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date

Select this checkbox to create a current date folder in the folder specified in Save in and save

scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.
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Image Stitch Window

Click Stitch in the IJ Scan Utility main screen to display the Image Stitch window.

You can scan the left and right halves of an item larger than the platen and combine them back into one
image. You can scan items up to approximately twice as large as the platen.

Select Qutput Size

la3adxz)

Sean Dwegtion

|sesn B Len

Sran Image 1

= (1) Settings and Operation Buttons
= (2) Toolbar

= (3) Thumbnail View Area

= (4) Preview Area

22> Note

» The displayed items vary depending on the select source and view.

(1) Settings and Operation Buttons

Select Output Size
B4 (B5 x 2)
Scans the left and right halves of a B4 size item separately.

A3 (Ad x 2)
Scans the left and right halves of an A3 size item separately.

11 x 17 (Letter x 2)
Scans the left and right halves of an item twice as large as Letter size separately.

Full Platen x 2
Scans the left and right halves of an item twice as large as the platen separately.

Scan Direction
Scan from Left
Displays the first scanned image on the left side.

Scan from Right
Displays the first scanned image on the right side.

473



Scan Image 1
Start Scanning Image 1
Scans the first item.
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Scan Image 2
Start Scanning Image 2
Scans the second item.
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Start Scanning Image |
Seae Image 2
SAar L Scanning Image 2
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Adjust cropping frames
You can adjust the scan area in preview.

If no area is specified, the image of the size selected in Select Output Size will be saved. If an area
is specified, only the image in the cropping frame will be scanned and saved.

= Adjusting Cropping Frames in the Image Stitch Window

Save
Save
Saves the two scanned images as one image.
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Cancel
Cancels Stitch scan.

(2) Toolbar

You can delete the scanned images or adjust the previewed images.

x (Delete)

Deletes the scanned image.

™
N (Enlarge/Reduce)
Allows you to enlarge or reduce the preview image.

Left-clicking the Preview area enlarges the displayed image.

Right-clicking the Preview area reduces the displayed image.
£
Eal’ (Rotate Left)

Rotates the preview image 90 degrees counter-clockwise.

i
s (Invert Vertically)
Rotates the preview image 180 degrees.

3
o (Rotate Right)
Rotates the preview image 90 degrees clockwise.
4
& (Open Guide)
Opens this page.
(3) Thumbnail View Area

Displays the thumbnails of the scanned images. Appears blank if none has been scanned.

(4) Preview Area

Displays the scanned images. You can adjust the layout by dragging the scanned image or check the
results of the settings made in "(1) Settings and Operation Buttons."
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When no image has been scanned:

After scanning the first item by clicking Start Scanning Image 1:

The image is scanned in the direction specified in Scan Direction, and 2 appears next to it.

After scanning the second item by clicking Start Scanning Image 2:

The two scanned images appear.
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Related Topic

= Scanning ltems Larger than the Platen (Image Stitch)
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Scanning with Application Software that You are Using (ScanGear)

» What Is ScanGear (Scanner Driver)?

» Scanning with Advanced Settings Using ScanGear (Scanner Driver)
» Starting ScanGear (Scanner Driver)

» Scanning in Basic Mode

» Scanning in Advanced Mode

» Scanning Multiple Documents from the ADF (Auto Document Feeder) in
Advanced Mode

» Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)
» Correcting Images and Adjusting Colors with ScanGear (Scanner Driver)

» ScanGear (Scanner Driver) Screens

» Placing Items (When Scanning from a Computer)

» Adjusting Cropping Frames (ScanGear)

» General Notes (Scanner Driver)

22 Important

* Available functions and settings vary depending on your scanner or printer.
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What Is ScanGear (Scanner Driver)?

ScanGear (scanner driver) is software required for scanning documents. It enables you to specify the output
size and make image corrections when scanning.

ScanGear can be started from IJ Scan Utility or applications that are compatible with a standard interface
called TWAIN. (ScanGear is a TWAIN-compatible driver.)

What You Can Do with This Software

This software enables you to preview scan results or set document type and output size, etc. when
scanning documents. It is useful when you want to scan in a specific color tone, as it allows you to make
various corrections and adjust brightness, contrast, etc.

Screens

There are two modes: Basic Mode and Advanced Mode.

Switch modes by clicking a tab on the upper right of the screen.

Basic Mode | Advanced Mode

23» Note

» ScanGear starts in the last used mode.
» Settings are not retained when you switch modes.

Basic Mode

Use the Basic Mode tab to scan easily by following three simple on-screen steps ( o e and
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Advanced Mode

Use the Advanced Mode tab to specify the color mode, output resolution, image brightness, color tone,
etc. when scanning.
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Scanning with Advanced Settings Using ScanGear (Scanner
Driver)

» Starting ScanGear (Scanner Driver)
» Scanning in Basic Mode
» Scanning in Advanced Mode

» Scanning Multiple Documents from the ADF (Auto Document Feeder) in
Advanced Mode

» Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)
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Starting ScanGear (Scanner Driver)

Use ScanGear (scanner driver) to make image corrections and color adjustments when scanning. ScanGear
can be started from IJ Scan Ultility or other applications.

»» Note

» Set up the network environment if you have more than one scanner or have a network compatible
model and changed the connection from USB connection to network connection.

Starting IJ Scan Utility

Follow these steps to start ScanGear from IJ Scan Utility.

1. Start IJ Scan Utility.

Refer to "Starting IJ Scan Utility" for your model from Home of the Online Manual for how to start IJ
Scan Utility.

2. Click ScanGear in the IJ Scan Utility main screen.

The ScanGear screen appears.

Starting from an Application

Follow these steps (example) to start ScanGear from an application.

The procedure varies depending on the application. For details, refer to the application's manual.
1. Start the application.

2. On the menu of the application, select the machine.

> Note

* When you want to use a network compatible model by connecting to a network, select one with
"Network" displayed after the product name.

3. Select the command to scan a document.

The ScanGear screen appears.
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Scanning in Basic Mode

Use the Basic Mode tab to scan easily by following the on-screen steps.

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" to scan multiple
documents at one time from the Platen.

When scanning from the ADF (Auto Document Feeder), documents are scanned without preview.

2 3% Important

» The following types of documents may not be scanned correcitly. In that case, click @ (Thumbnail)
on the Toolbar to switch to whole image view and scan.

» Photos that have a whitish background

* Documents printed on white paper, hand-written text, business cards, etc.
* Thin documents

* Thick documents

» The following types of documents may not be scanned correctly.

» Documents smaller than 1.2 inches (3 cm) square
» Photos that have been cut to various shapes

22> Note

* When using a model supporting ADF duplex scanning, you can scan both sides of the documents
automatically from the ADF.

1. Place the document on the Platen or ADF, then start ScanGear (scanner driver).

= Placing Items (When Scanning from a Computer)
= Starting ScanGear (Scanner Driver)

2. Set Select Source according to the document placed on the Platen or ADF.
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2% Important

» Some applications do not support continuous scanning from the ADF. For details, refer to the
application's manual.

23 Note

» To scan magazines containing many color photos, select Magazine (Color).

3. Click Preview.

Preview image appears in the Preview area.
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2 Important

» Preview is not displayed when an ADF type is selected for Select Source.

22> Note

» Colors are adjusted based on the document type selected in Select Source.

4. Set Destination.

122> Note

» Skip ahead to Step 7 when an ADF type is selected for Select Source.

5. Set Output Size according to purpose.

Output size options vary by the item selected in Destination.

6. Adjust the cropping frames (scan areas) as required.

Adjust the size and position of the cropping frames on the preview image.

= Adjusting Cropping Frames (ScanGear)

7. Set Image corrections as required.
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8. Click Scan.
Scanning starts.

»» Note

* Click d (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Related Topic

= Basic Mode Tab
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Scanning in Advanced Mode

Use the Advanced Mode tab to specify the color mode, output resolution, image brightness, color tone, etc.
when scanning.

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" to scan multiple
documents at one time.

Refer to "Scanning Multiple Documents from the ADF (Auto Document Feeder) in Advanced Mode" to scan
multiple documents placed on the ADF (Auto Document Feeder).

2 3% Important

» The following types of documents may not be scanned correcitly. In that case, click @ (Thumbnail)
on the Toolbar to switch to whole image view and scan.

» Photos that have a whitish background

* Documents printed on white paper, hand-written text, business cards, etc.
* Thin documents

* Thick documents

» The following types of documents may not be scanned correctly.

» Documents smaller than 1.2 inches (3 cm) square
» Photos that have been cut to various shapes

1. Place the document on the Platen, then start ScanGear (scanner driver).

= Placing Items (When Scanning from a Computer)
= Starting ScanGear (Scanner Driver)

2. Click the Advanced Mode tab.

The tab switches to Advanced Mode.

22> Note

» Settings are not retained when you switch modes.
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3. Set Input Settings according to the document or purpose.

4. Click Preview.

Preview images appear in the Preview area.

P EEEEE X

5. Set Output Settings.

6. Adjust the cropping frame (scan area), correct image, and adjust colors as required.

= Adjusting Cropping Frames (ScanGear)

= Image Settings
= Color Adjustment Buttons

7. Click Scan.
Scanning starts.

22> Note

* Click @ (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Related Topic

= Advanced Mode Tab
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Scanning Multiple Documents from the ADF (Auto Document
Feeder) in Advanced Mode

Use the Advanced Mode tab to specify the image brightness, color tone, etc. and scan multiple documents
placed on the ADF (Auto Document Feeder) at one time. When using a model supporting ADF duplex
scanning, you can scan both sides of the documents automatically from the ADF.

When scanning from the ADF, documents are scanned without preview.

1. Place the documents on the ADF of the machine, then start ScanGear (scanner driver).

= Placing Documents (ADF (Auto Document Feeder))
= Starting ScanGear (Scanner Driver)

2. Click the Advanced Mode tab and select Document (ADF Simplex) or Document (ADF
Duplex) for Select Source.
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> Note

» Settings are not retained when you switch modes.
* You can select Document (ADF Duplex) when using a model supporting ADF duplex scanning.

3. Set Input Settings according to the document or purpose.

4. Set Output Settings.

5. Make image corrections and color adjustments as required.

= Image Settings
= Color Adjustment Buttons

6. Click Scan.

Scanning starts.
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»» Note

* Click d (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Related Topic

= Advanced Mode Tab
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Scanning Multiple Documents at One Time with ScanGear
(Scanner Driver)

You can scan two or more photos (small documents) on the Platen at one time on the Basic Mode tab and
Advanced Mode tab.

This section explains how to scan multiple documents from the Basic Mode tab.

32 Important

+ To scan multiple documents as a single image, scan in whole image view.
» The following types of documents may not be cropped correctly. In that case, adjust the cropping
frames (scan areas) in whole image view and scan.

» Photos that have a whitish background

» Documents printed on white paper, hand-written text, business cards, etc.
» Thin documents

» Thick documents

= Scanning Multiple Documents in Whole Image View

» The following types of documents may not be scanned correctly.

» Documents smaller than 1.2 inches (3 cm) square
* Photos that have been cut to various shapes

»» Note

* You can also scan multiple documents at one time from the Advanced Mode tab. Use the Advanced
Mode tab to make advanced scan settings such as the color mode, output resolution, image brightness,
and color tone.

» Refer to the corresponding sections below for details on the Basic Mode tab and Advanced Mode tab.

= Basic Mode Tab
= Advanced Mode Tab

1. Place the document on the Platen, then start ScanGear (scanner driver).

= Placing ltems (When Scanning from a Computer)
= Starting ScanGear (Scanner Driver)

2. Set Select Source according to the document placed on the Platen.
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3. Click Preview.

Thumbnails of the preview images appear in the Preview area. Cropping frames are specified
automatically according to the document size.
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4. Set Destination.
5. Set Output Size according to purpose.

6. Adjust the cropping frames and set Image corrections as required.

22> Note

* You can correct each image separately. Select the frame you want to correct.
* In thumbnail view, you can only create one cropping frame per image. To create multiple cropping
frames in an image, scan in whole image view.

= Scanning Multiple Documents in Whole Image View
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7. Select the images you want to scan.

Select the checkboxes of the images you want to scan.
8. Click Scan.

Scanning Multiple Documents in Whole Image View

Follow these steps if thumbnails are not displayed correctly when previewed or if you want to scan
multiple documents as a single image.

23> Note

* Positions of slanted documents are not corrected in whole image view.

1. After previewing images, click @ (Thumbnail) on the Toolbar.

Switch to whole image view.
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+ When the whole image is displayed, the icon changesto ' (Whole Image).

2. Set Destination.

3. Set Output Size according to purpose.

Invert aspect ratio will be enabled when Output Size is set to anything but Flexible. Click this button
to rotate the cropping frame. Click again to return it to the original orientation.

4. Adjust the cropping frames.
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Adjust the size and position of the cropping frames on the preview image. You can also create two or
more cropping frames.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area
is specified, only the portion in the specified area will be scanned.

= Adjusting Cropping Frames (ScanGear)

5. Set Image corrections as required.

6. Click Scan.

Areas framed by broken lines are scanned.

»» Note

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.
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Correcting Images and Adjusting Colors with ScanGear (Scanner
Driver)

» Correcting Images (Unsharp Mask, Reduce Dust and Scratches, Fading
Correction, etc.)

» Adjusting Colors Using a Color Pattern
» Adjusting Saturation and Color Balance
» Adjusting Brightness and Contrast

» Adjusting Histogram

» Adjusting Tone Curve

» Setting Threshold
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Correcting Images (Unsharp Mask, Reduce Dust and Scratches,
Fading Correction, etc.)

The Image Settings functions on the Advanced Mode tab of ScanGear (scanner driver) allow you to
enhance the outline of the subjects, reduce dust/scratches, and correct faded colors when scanning images.
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Setting Items

Click ¥ (Arrow) of a function and select an item from the pull-down menu.
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32 Important

» Do not apply these functions to images without moire, dust/scratches, or faded colors. The color tone
may be adversely affected.

» Refer to "Image Settings" for details and precautions on each function.

23%» Note

» Refer to "Scanning in Advanced Mode" to start the Advanced Mode tab of ScanGear and scan.

Adjusting the image brightness and color tone

Set Image Adjustment to Auto, Photo, Magazine, or Document according to the document type.

None Auto
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Reducing show-through in text documents or lightening the base color in
recycled paper, newspapers, etc. when scanning documents

Set Reduce Show-through to ON.

OFF ON

Sharpening slightly out-of-focus images

Set Unsharp Mask to ON.

OFF ON

Reducing gradations and stripe patterns

Set Descreen to ON.
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»» Note

+ Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon
where uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned. Descreen is the function for reducing this moire effect.

Reducing dust and scratches

Set Reduce Dust and Scratches to Low, Medium, or High according to the degree of dust and
scratches.

None Medium

O

Correcting photos that have faded with time or due to colorcast

Set Fading Correction to Low, Medium, or High according to the degree of fading or colorcast.

None Medium

Reducing graininess

Set Grain Correction to Low, Medium, or High according to the degree of graininess.

None Medium

Correcting shadows that appear between pages when scanning open booklets

Set Gutter Shadow Correction to Low, Medium, or High according to the degree of shadows.

None Medium
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Adjusting Colors Using a Color Pattern

You can preview color changes and reproduce natural colors by using the color pattern function in
ScanGear (scanner driver)'s Basic Mode tab.
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Color Adjustment

Correct colors that have faded with time or due to colorcast. "Colorcast" is a phenomenon where a
specific color affects the entire picture due to the weather or ambient strong colors.
Click an arrow in Color Adjustment to emphasize the corresponding color.

Cyan & red, magenta & green, and yellow & blue are complementary color pairs (each pair produces a
shade of gray when mixed). You can reproduce the natural colors of the scene by reducing the cast color
and increasing the complementary color.

It is recommended that you find a portion in the image where it should be white, and adjust the colors so
that the portion turns white.
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Preview image appears in the center. Preview image colors change as you adjust them.
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Below is an example of correcting a bluish image.

Since Blue and Green are too strong, click the Yellow and Magenta arrows to correct.

Before

»» Note

» Color adjustments are applied only to the cropping frames (scan areas) or the frame selected in
thumbnail view.

* You can select multiple frames or cropping frames by clicking them while pressing the Ctrl key.

* You can also select a color tone from the color pattern displayed on the left of the Color Pattern
screen.

* You can also use this function to add a specific tint to an image. Increase the magenta to add a warm
tint, and increase the blue to add a cool tint.
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Adjusting Saturation and Color Balance

You can brighten colors that have faded with time or due to colorcast by using e (Saturation/Color
Balance) in ScanGear (scanner driver)'s Advanced Mode tab.

Saturationy/Color Balance
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¥>» Note

* Click Defaults to reset all adjustments in the current window.

Saturation
Adjust the image's saturation (vividness). You can brighten colors that have faded with time, etc.

Move 4 (Slider) under Saturation to the left to decrease the saturation (darken the image), and to the
right to increase the saturation (brighten the image). You can also enter a value (-127 to 127).
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»>» Note

» The natural color tone of the original image may be lost if you increase saturation too much.

Color Balance

Adjust images that have a colorcast. "Colorcast" is a phenomenon where a specific color affects the entire
picture due to the weather or ambient strong colors.
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Move 4 (Slider) under Color Balance to the left or right to emphasize the corresponding color.
Cyan & Red

Magenta & Green

Yellow & Blue

These are complementary color pairs (each pair produces a shade of gray when mixed). You can
reproduce the natural colors of the scene by reducing the cast color and increasing the complementary
color.

It is usually difficult to correct the image completely by adjusting only one color pair. It is recommended
that you find a portion in the image where it should be white, and adjust all three color pairs so that the
portion turns white.

You can also enter a value (-127 to 127).

Below is an example of an image in which the "Cyan & Red" pair has been adjusted.

Coler Balames

Cyan
g .

Cyan is increased Red is increased

502



Adjusting Brightness and Contrast

You can adjust images that are too dark or bright, or too flat due to lack of contrast by using
(Brightness/Contrast) in ScanGear (scanner driver)'s Advanced Mode tab.

Imbage Seltimgs

Inace Aduminent = HAute [
Uirsharg Mgk ; oH ¥
Dheareen @ OFF bl I
&l ol 77| [custen w
o Oty

BrightnessContrast
Chaned : Mater v "
Erighiness ; ] =
Duark Bright
% m—
Conirask o o
Lo High
i’} _.:i__ i ]

Defaults Tlose

D faults s

2> Note

. Click ¥ (Down arrow) to switch to detailed view. Click A (Up arrow) to return to the previous view.
* Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

»>» Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.
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Brightness
Adjust the image brightness.

Move 4 (Slider) under Brightness to the left to darken and right to brighten the image. You can also
enter a value (-127 to 127).

Erightness ; o K
Diark Bright
= =
Darkened Original image Brightened

> Note

» Highlights may be lost if you brighten the image too much, and shadows may be lost if you darken

the image too much.

Contrast

"Contrast" is the degree of difference between the brighter and darker parts of an image. Increasing
contrast will increase the difference, thus sharpening the image. Decreasing contrast will decrease the
difference, thus softening the image.

Move 4 (Slider) under Contrast to the left to decrease and right to increase the contrast of the image.

You can also enter a value (-127 to 127).

Conirast ] %
Low High
0 == °
Decreased contrast Original image Increased contrast

=

»» Note

* Increasing the contrast is effective in adding a three-dimensional feel to soft images. However,
shadows and highlights may be lost if you increase the contrast too much.
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Adjusting Histogram

You can adjust the image color tone by using a graph (histogram) showing brightness distribution, via b

(Histogram) in ScanGear (scanner driver)'s Advanced Mode tab.

Histogram  BEM
Imbge Selimgy
= Chanred @ Madter e
Impge Adurinent : Auto h
Lirsharp Magk ; ol w *
Chesiresn 2 COFF ¥ /
CUE | v v
! Befindts T
F i Pt
Ao || & || 2 255
Gray Balanoe ¢ o
SR G a:
Do Faits: e
»» Note

* Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

»» Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Reading Histograms

You can see the histogram of a specified area for each Channel. The higher the histogram peak, the
more data is distributed to that level.
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(1) Bright area

(2) Dark area

(3) Whole image

_— - = iy _m
More data is distributed to the More data is distributed to the Data is widely distributed between the
highlight side. shadow side. highlight and shadow.

Adjusting Histograms (Using the Slider)

Select a Channel, then move 4 (Black-point Slider) or 2> (White-point Slider) to specify the level to be

set as the shadow or highlight.

———

 All parts to the left of . (Black-point Slider) will be black (level 0).

* The parts at .~ (Mid-point Slider) will turn to the color exactly between the black-point and white-

point.

+ All parts to the right of .2 (White-point Slider) will turn white (level 255).

When Image Adjustment is set to anything but None, the adjustments shown below are performed

automatically.

Moving the Black-point and White-point Sliders

Move the Black-point Slider or White-point Slider to adjust brightness.

Images with more data distributed to the highlight side

Move the Black-point Slider toward the highlight side.

Images with more data distributed to the shadow side

Move the White-point Slider toward the shadow side.

Images with widely distributed data

Move the Black-point Slider toward the highlight side, and White-point Slider toward the shadow side.
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Moving the Mid-point Slider

Move the Mid-point Slider to specify the level to be set as the middle of the tonal range.

Images with more data distributed to the highlight side

Move the Mid-point Slider toward the highlight side.

Images with more data distributed to the shadow side

Move the Mid-point Slider toward the shadow side.

Adjusting Histograms (Using the Droppers)

When you select a Channel and click the Black-point, Mid-point, or White-point Dropper, the mouse
pointer on the preview image changes to a dropper. Click a Dropper displayed below the histogram to

change the setting.

Histogram  BEM|

I;a & um || ) ass I
Gray Balance @

SR G: 3:

* The point clicked with i (Black-point Dropper) will be the darkest point. You can also enter a value
(0 to 245).

* The point clicked with i (Mid-point Dropper) will be the middle of the tonal range. You can also
enter a value (5 to 250).
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Y

» The point clicked with
value (10 to 255).

(White-point Dropper) will be the brightest point. You can also enter a

* Click d (Dropper) for Gray Balance and click the area you want to adjust the color in the preview
image.

The clicked point will be set as the achromatic color reference, and the rest of the image is adjusted
accordingly. For instance, if snow in a photo appears bluish, click the bluish part to adjust the whole image
and reproduce natural colors.
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Adjusting Tone Curve

You can adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance

of tone input and output, via /] (Tone Curve Settings) in ScanGear (scanner driver)'s Advanced Mode
tab.

Tone Curve Sellings H
Imbge Seiimgs
Chanres] © arer L3
Inage adhutnent : fute =
Urgharg Mask ; o .l *
Cesresn OFF hll I
G {1 ] m I.f"- Custom "
i Defndis
)
Select Tone Qure ;
s (ornegban Cl
D faults Ohose
3> Note

+ Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

2> Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Reading Tone Curves

With ScanGear, scanning images via a scanner is the input, and displaying to a monitor is the output.
"Tone Curve" shows the balance of tone input and output for each Channel.
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Highlight
Output brightness
Shadow -

Shadow Highlight

Input brightness

Adjusting Tone Curve

In Select Tone Curve, select a tone curve from No correction, Overexposure, Underexposure, High
contrast, Reverse the negative/positive image, and Edit custom curve.

No correction (No adjustment)

Overexposure (Convex curve)

The midtone data of the input side is stretched toward the highlight of the output side, resulting in a bright-
toned image when viewed on a monitor.

Underexposure (Concave curve)

The midtone data of the input side is stretched toward the shadow of the output side, resulting in a dark-
toned image when viewed on a monitor.

High contrast (S curve)

The highlight and shadow of the input side are enhanced, resulting in a high-contrast image.

Reverse the negative/positive image (Downward-sloping line)

The input and output sides are reversed, resulting in a negative-positive inverted image.
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Edit custom curve

You can drag specific points on the Tone Curve to freely adjust the brightness of the corresponding areas.
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Setting Threshold

You can sharpen text in a document or reduce show-through in newspapers by adjusting the threshold level

A

via (Threshold) in ScanGear (scanner driver)'s Advanced Mode tab.

Thml‘ml‘d

A Custom *

»» Note

* This function is available when Color Mode is Black and White.
+ Click Defaults to reset all adjustments in the current window.

Adjusting Threshold

The brightness of color and grayscale images is expressed in a value between 0 and 255. However, in
creating black and white images, all colors are mapped to either black (0) or white (255). "Threshold" is
the borderline value that determines a color as black or white.

Move 4 (Slider) to the right to increase the threshold value and thus increase the black areas. Move the
slider to the left to decrease the value and thus increase the white areas. You can also enter a value (0 to
255).

Threshald Level : [128 (=

Light Dark
@

°
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ScanGear (Scanner Driver) Screens

» Basic Mode Tab
» Advanced Mode Tab

@ Input Settings

@ Output Settings

@ Image Settings

@ Color Adjustment Buttons

» Preferences Dialog Box

Scanner Tab
Preview Tab

Scan Tab

Color Settings Tab

E & & €
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Basic Mode Tab

This mode allows you to scan easily by following the on-screen steps.

This section describes the settings and functions available on the Basic Mode tab.

Mo |

Selech Sapase
Prara (Ceker]
Divgplay Prview Enage

Proviow

Destination
Privil
Dt peat Sere
Flaubis
i el BT R
I Adpast croppbsg Nrames
e Direhnas
oy Clcormoet fadeg
Lo ] Cair PHIHE.
Peripim Sosa

= (1) Settings and Operation Buttons

= (2) Toolbar
= (3) Preview Area

23 Note

» The displayed items vary by document type and view.
» The preview function is not available when scanning from the ADF (Auto Document Feeder).

(1) Settings and Operation Buttons

Select Source
Photo (Color)
Scan color photos.

Magazine (Color)
Scan color magazines.

Document (Color)
Scan documents in color.

Document (Grayscale)
Scan documents in black and white.

Document (Color) ADF Simplex
Scan documents from the ADF in color.

Document (Grayscale) ADF Simplex
Scan documents from the ADF in black and white.

Document (Color) ADF Duplex (only for models supporting ADF duplex scanning)
Scan both sides of documents from the ADF in color.

Document (Grayscale) ADF Duplex (only for models supporting ADF duplex scanning)
Scan both sides of documents from the ADF in black and white.
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32 Important

» Some applications do not support continuous scanning from the ADF. For details, refer to the
application's manual.

23 Note

* When you select a document type, the unsharp mask function will be active.

* When you select an option other than the ADF types, the image adjustment function which
adjusts images based on the document type will also be active.

* If you select Magazine (Color), the descreen function will be active.

Display Preview Image
Preview
Performs a trial scan.

1]
x

Bz Made | pchvanced Moda

o Selevt Saisie

|Phata (Caler) o

e Dinglay Preview Image

Proviow
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Prirsl -
- Dulput %o
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ir | el pEDECTTAM
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L] Py Qoereis
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g (e v

22> Note

* When using the machine for the first time, scanner calibration starts automatically. Wait a
while until the preview image appears.

Destination
Select what you want to do with the scanned image.

Print
Select this to print the scanned image on a printer.

Image display
Select this to view the scanned image on a monitor.

OCR
Select this to use the scanned image with OCR software.

"OCR software" is software that converts text scanned as an image into text data that can be
edited in word processors and other programs.

Output Size
Select an output size.

Output size options vary by the item selected in Destination.
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Flexible
Allows you to freely adjust the cropping frames (scan areas).

In thumbnail view:

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is
displayed, the portion within the cropping frame will be scanned. When no cropping frame is
displayed, each frame is scanned individually.

In whole image view:

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping
frame is displayed, the portion within the cropping frame will be scanned.

Paper Size (L, A4, etc.)
Select an output paper size. The portion within the cropping frame will be scanned at the size of
the selected paper size. You can drag the cropping frame to enlarge/reduce it while maintaining
the aspect ratio.

Monitor Size (1024 x 768 pixels, etc.)
Select an output size in pixels. A cropping frame of the selected monitor size will be displayed
and the portion within the cropping frame will be scanned. You can drag the cropping frame to
enlarge/reduce it while maintaining the aspect ratio.

Add/Delete...
Opens the Add/Delete the Output Size dialog box, in which you can specify custom output
sizes. You can select this option when Destination is Print or Image display.

Add/Delete the Outputsize IEM
Cuitpect Sae Hame ¢ Cultput Sire List 2
Mew Sesting |
Width ; 6,00
Heght: | 400
Utz - =

In the Add/Delete the Output Size dialog box, you can specify multiple output sizes and save
them at one time. Saved items will be registered to the Output Size list and can be selected,
along with the predefined items.

Adding:

Enter Output Size Name, Width, and Height, then click Add. For Unit, you can select inches or
mm when Destination is Print but you can only select pixels when Destination is Image
display. The name of the added size appears in Output Size List. Click Save to save the items
listed in Output Size List.

Deleting:

Select the output size you want to delete in Output Size List, then click Delete. Click Save to
save the items listed in Output Size List.

32 Important

* You cannot delete predefined output sizes such as A4 and 1024 x 768 pixels.
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»» Note

» Save up to 10 items.

* An error message appears when you enter a value outside the setting range. Enter a value
within the setting range.

»» Note

* For details on whether or how the cropping frame is initially displayed on a preview image, refer
to Cropping Frame on Previewed Images in "Preview Tab" (Preferences dialog box).

“Hnvert aspect ratio

Available when Output Size is set to anything but Flexible.

Click this button to rotate the cropping frame. Click again to return it to the original orientation.
Adjust cropping frames

You can adjust the scan area within the Preview area.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area
is specified, only the portion in the cropping frame will be scanned.

= Adjusting Cropping Frames (ScanGear)

Image corrections

Allows you to apply corrections to images.

32 Important

» Apply Auto Document Fix and Correct fading are available when Recommended is selected
on the Color Settings tab of the Preferences dialog box.

»» Note

+ Available functions vary by the document type selected in Select Source.

Apply Auto Document Fix
Sharpens text in a document or magazine for better readability.

32 Important

» Scanning may take longer than usual when this checkbox is selected.

» The color tone may change from the source image due to corrections. In that case, deselect
the checkbox and scan.

 Correction may not be applied properly if the scan area is too small.

Correct fading
Corrects and scans photos that have faded with time or have a colorcast.
Reduce gutter shadow

Corrects shadows that appear between pages when scanning open booklets.

32 Important

» For precautions on using this function, refer to "Gutter Shadow Correction."

Color Pattern...

Allows you to adjust the image's overall color. You can correct colors that have faded due to
colorcast, etc. and reproduce natural colors while previewing color changes.

= Adjusting Colors Using a Color Pattern
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32 Important

+ This setting is not available when you select Color Matching on the Color Settings tab of
the Preferences dialog box.

Perform Scan
Scan
Starts scanning.

»» Note

* When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

Preferences...
Opens the Preferences dialog box in which you can make scan/preview settings.

Close
Closes ScanGear (scanner driver).

(2) Toolbar

You can adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.

In thumbnail view:

In whole image view:

- ;]‘ il :E: e d U/

——

-— [ |
lﬂ] (Thumbnail) / - (Whole Image)
Switches the view in the Preview area.

= (3) Preview Area

c
= (Rotate Left)
Rotates the preview image 90 degrees counter-clockwise.

* The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

%
By (Rotate Right)
Rotates the preview image 90 degrees clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

u _“i
ﬂd& (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in the
Preview area. The scan area is reduced every time you click this button if there are croppable areas
within the cropping frame.

518



KA
KR

(Check All Frames)
Available when two or more frames are displayed.

Selects the checkboxes of the image in thumbnail view.

oo
LI (Uncheck All Frames)

Available when two or more frames are displayed.

Deselects the checkboxes of the image in thumbnail view.

E&
EE (select All Frames)

Available when two or more frames are displayed.

Selects the images in thumbnail view and outlines them in blue.

L (Select All Cropping Frames)
Available when two or more cropping frames are specified.

Turns the cropping frames into thick broken lines and applies the settings to all of them.

aned (Remove Cropping Frame)
Removes the selected cropping frame.

d (Information)

Displays the version of ScanGear and the current scan settings (document type, etc.).

i

& (Open Guide)
Opens this page.

(3) Preview Area

This is where a trial image appears after you click Preview. You can also check the results of the settings
(image corrections, color adjustments, etc.) made in "(1) Settings and Operation Buttons."

When lﬂ] (Thumbnail) is displayed on the Toolbar:

Cropping frames are specified according to the document size, and thumbnails of scanned images are
displayed. Only the images with the checkbox selected will be scanned.
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23> Note

* When multiple images are previewed, different outlines indicate different selection status.

» Focus Frame (thick blue outline): The displayed settings will be applied.

» Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and Selected
Frames simultaneously. You can select multiple images by clicking them while pressing the Citrl
key.

» Unselected (no outline): The settings will not be applied.

* Double-click a frame to zoom in on the image. Click E E (Frame Advance) at the bottom of the
screen to display the previous or next frame. Double-click the frame again to return the display to its
non-magnified state.

=
When - (Whole Image) is displayed on the Toolbar:

Iltems on the Platen are scanned and displayed as a single image. All portions in the cropping frames will
be scanned.

23> Note

* You can specify the cropping frame on the displayed image. In thumbnail view, you can only create
one cropping frame per image. In whole image view, you can create multiple cropping frames.

= Adjusting Cropping Frames (ScanGear)
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Related Topic

= Scanning in Basic Mode
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Advanced Mode Tab

This mode allows you to make advanced scan settings such as the color mode, output resolution, image
brightness, and color tone.

This section describes the settings and functions available on the Advanced Mode tab.
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= (1) Settings and Operation Buttons
= (2) Toolbar
= (3) Preview Area

13 Note

» The displayed items vary by document type and view.
« The preview function is not available when scanning from the ADF (Auto Document Feeder).

(1) Settings and Operation Buttons

Favorite Settings
You can name and save a group of settings (Input Settings, Output Settings, Image Settings, and
Color Adjustment Buttons) on the Advanced Mode tab, and load it as required. It is convenient to

save a group of settings if you will be using it repeatedly. You can also use this to reload the default
settings.

Select Add/Delete... from the pull-down menu to open the Add/Delete Favorite Settings dialog box.
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Enter Setting Name and click Add; the name appears in Favorite Settings List.

When you click Save, the item appears in the Favorite Settings list and can be selected, along with
the predefined items.

To delete an item, select it in Favorite Settings List and click Delete. Click Save to save the settings
displayed in Favorite Settings List.

»» Note

* You can set Add/Delete... in Favorite Settings after preview.
» Save up to 10 items.

Input Settings
Specify the input settings such as the document type and size.

Output Settings
Specify the output settings such as the output resolution and size.

Image Settings
Enable/disable various image correction functions.

Color Adjustment Buttons
Fine corrections to the image brightness and color tones can be made including adjustments to the
image's overall brightness or contrast and adjustments to its highlight and shadow values (histogram)
or balance (tone curve).

Zoom
Zooms in on a frame, or zooms in on the image in the area specified with a cropping frame (scan
area). When zoomed in, Zoom changes to Undo. Click Undo to return the display to its non-
magnified state.

In thumbnail view:

When multiple images are displayed in thumbnail view, clicking this button zooms in on the selected

frame. Click S8 &4 (Frame Advance) at the bottom of the screen to display the previous or next
frame.

»>» Note

* You can also zoom in on an image by double-clicking the frame. Double-click the frame again to
return the display to its non-magnified state.

In whole image view:
Rescans the image in the area specified with a cropping frame at higher magnification.

»» Note

» Zoom rescans the document and displays high-resolution image in Preview.

N (Enlarge/Reduce) on the Toolbar zooms in on the preview image quickly. However, the
resolution of the displayed image will be low.

Preview
Performs a trial scan.

523



t.‘:.{..‘.‘ t.‘:.

Scan
Starts scanning.

23 Note

* When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

* When scanning is completed, a dialog box prompting you to select the next action may appear.
Follow the prompt to complete. For details, refer to Status of ScanGear dialog after scanning
in Scan Tab (Preferences dialog box).

« It will take time to process the images if the total size of the scanned images exceeds a certain
size. In that case, a warning message appears; it is recommended that you reduce the total size.
To continue, scan in whole image view.

Preferences...
Opens the Preferences dialog box in which you can make scan/preview settings.

Close
Closes ScanGear (scanner driver).

(2) Toolbar

You can adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.

In thumbnail view:

FEREEES

In whole image view:

¥¥ OO0 @EI‘@ &)

FFE OO0 EE

E.“““j \_\_\ ‘ [= ] C"""'"

IRl 1 4

: 2 |
@ (Thumbnail) / — (Whole Image)
Switches the view in the Preview area.

—
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= (3) Preview Area

— (Clear)
Deletes the preview image from the Preview area.

It also resets the Toolbar and color adjustment settings.

(Crop)
Allows you to specify the scan area by dragging the mouse.

(Move Image)
Allows you to drag the image until the part you want to see is displayed when an image enlarged in
the Preview area does not fit in the screen. You can also move the image using the scroll bars.

S\ (Enlarge/Reduce)
Allows you to zoom in on the Preview area by clicking the image. Right-click the image to zoom out.

c
Eal’ (Rotate Left)
Rotates the preview image 90 degrees counter-clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

3
o] (Rotate Right)
Rotates the preview image 90 degrees clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

] _“i
ﬂgl_\ (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in the
Preview area. The scan area is reduced every time you click this button if there are croppable areas
within the cropping frame.

KE
KR

(Check All Frames)
Available when two or more frames are displayed.

Selects the checkboxes of the image in thumbnail view.

oo
oo

(Uncheck All Frames)
Available when two or more frames are displayed.

Deselects the checkboxes of the image in thumbnail view.

EE
EE (select All Frames)

Available when two or more frames are displayed.

Selects the images in thumbnail view and outlines them in blue.

Available when two or more cropping frames are specified.

Turns the cropping frames into thick broken lines and applies the settings to all of them.

525



X

(Remove Cropping Frame)
Removes the selected cropping frame.

d (Information)

Displays the version of ScanGear and the current scan settings (document type, etc.).

4 _
= (Open Guide)

Opens this page.

(3) Preview Area

This is where a trial image appears after you click Preview. You can also check the results of the settings
(image corrections, color adjustments, etc.) made in "(1) Settings and Operation Buttons."

When = (Thumbnail) is displayed on the Toolbar:

Cropping frames are specified according to the document size, and thumbnails of scanned images are
displayed. Only the images with the checkbox selected will be scanned.

»» Note

* When multiple images are previewed, different outlines indicate different selection status.

» Focus Frame (thick blue outline): The displayed settings will be applied.

» Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and Selected
Frames simultaneously. You can select multiple images by clicking them while pressing the Ctrl
key.

» Unselected (no outline): The settings will not be applied.

=
When (Whole Image) is displayed on the Toolbar:

Iltems on the Platen are scanned and displayed as a single image. All portions in the cropping frames will
be scanned.
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23> Note

* You can specify the cropping frame on the displayed image. In thumbnail view, you can only create
one cropping frame per image. In whole image view, you can create multiple cropping frames.

= Adjusting Cropping Frames (ScanGear)

Related Topic

= Scanning in Advanced Mode
= Scanning Multiple Documents from the ADF (Auto Document Feeder) in Advanced Mode
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Input Settings
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Input Settings allows you to set the following items:

Select Source
The type of document to be scanned is displayed. To scan from the Platen, select Platen; to scan from
the ADF (Auto Document Feeder), select Document (ADF Simplex) or Document (ADF Duplex).

22 Important

» Some applications do not support continuous scanning from the ADF. For details, refer to the
application's manual.

»» Note

* You can select Document (ADF Duplex) when using a model supporting ADF duplex scanning.

Paper Size
Select the size of the document to be scanned. This setting is available in whole image view only.

When scanning both sides of the documents automatically from the ADF, select A4 or Letter.
When you select a size, the Preview area size changes accordingly.

22 Important

» Some applications have a limit to the amount of scan data they can receive. Available scan range
is as follows.

» 21000 pixels x 30000 pixels or less

* If you change Paper Size after previewing, the preview image will be deleted.

»» Note

+ If you are not sure which size you should select for Paper Size, set Paper Size to Full Platen, then

measure the size of the document and enter the values into = (Width) and i (Height).

Original Orientation
Set the orientation and stapling side of the documents to scan from the ADF.
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Click Settings... to open the Orientation dialog box.
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22 Important

» The Orientation dialog box can only be opened when Select Source is Document (ADF
Simplex) or Document (ADF Duplex).

» Binding Location is displayed when using a model supporting ADF duplex scanning.

* Binding Location cannot be specified when Select Source is Document (ADF Simplex).

Color Mode
Select how to scan the document.

Color
Select this mode to scan color documents or to create color images. This mode renders the image
in 256 levels (8 bit) of R(ed), G(reen), and B(lue).

Grayscale
Select this mode to scan black and white photos or to create black and white images. This mode
renders the image in 256 levels (8 bit) of black and white.

Black and White
Select this mode to scan photos and documents in black and white. This mode renders the image
in black and white. The contrast in the image is divided at certain levels (threshold level) into black

and white and is rendered in two colors. The threshold level can be set with 4 (Threshold).

Input Size
In thumbnail view, the cropped document size is displayed after preview.

In whole image view, the Paper Size is displayed before preview, and the cropping frame (scan area)

size is displayed after preview.

You can adjust the cropping frame size by entering the values into g (Width) and = (Height).

Click e (Change Aspect Ratio) and change it to & (Keep Aspect Ratio) to maintain the aspect ratio

when you specify the cropping frame size.

22 Important

* Input size settings are available only when Output Size in Output Settings is Flexible. If you
select a size other than Flexible, a cropping frame calculated from Output Size and Output
Resolution is displayed, and its aspect ratio is fixed.
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»» Note

» The values you can enter will be within the range of the selected document size. The minimum size
is 96 pixels x 96 pixels when Output Resolution is 600 dpi, scaled at 100 %.

* When Auto Crop is performed in whole image view, the aspect ratio will not be maintained since
the size will be prioritized.

» Refer to "Adjusting Cropping Frames (ScanGear)" for details on cropping frames.
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Output Settings

Output Settings allows you to set the following items:

Output Resolution
Select the resolution to scan at.

The higher the resolution (value), the more detail in your image.

Select a resolution from the options displayed by clicking the button, or enter a value in 1 dpi
increments.

Refer to "Resolution” for your model from Home of the Online Manual for details.

When Select Source is Platen:

You can enter a value within the range of 25 dpi to 19200 dpi.

When Select Source is Document (ADF Simplex) or Document (ADF Duplex):
You can enter a value within the range of 25 dpi to 600 dpi.

Output Size
Select an output size.

Select Flexible to set custom sizes or select a size for printing or displaying. Select Add/Delete... to set
custom size and save it as a new output size option.

Flexible
You can specify the output resolution and scale, and adjust the cropping frames (scan areas).
In thumbnail view:

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is displayed,
the portion within the cropping frame will be scanned. When no cropping frame is displayed, each
frame is scanned individually.
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In whole image view:

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping
frame is displayed, the portion within the cropping frame will be scanned.

»>» Note

» To enlarge/reduce the scanned image, enter values into = (Width) and o (Height) in
Output Settings or specify a value (by 1 %) for %. Although the maximum value available for
% depends on the Output Resolution, it can be specified for up to 19200 dpi (the maximum
available output resolution).

Paper Size (L, A4, etc.) & Monitor Size (1024 x 768 pixels, etc.)

& (Width), *= (Height), and scale cannot be specified. The preview image will be cropped
according to the selected output size and resolution. The portion within the cropping frame will be
scanned at the size of the selected paper/monitor size. You can drag the cropping frame to
enlarge, reduce, or move it while maintaining the aspect ratio.

Add/Delete...
Opens the Add/Delete the Output Size dialog box, in which you can specify custom output sizes.

Add/Delete the Qutput Size
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In the Add/Delete the Output Size dialog box, you can specify multiple output sizes and save
them at one time. Saved items will be registered to the Output Size list and can be selected, along
with the predefined items.

Adding:

Select Print or Image display for Destination, then enter Output Size Name, Width, and Height,
then click Add. For Unit, you can select inches or mm when Destination is Print but you can only
select pixels when Destination is Image display. The name of the added size appears in Output
Size List. Click Save to save the items listed in Output Size List.

Deleting:

Select the output size you want to delete in Output Size List, then click Delete. Click Save to save
the items listed in Output Size List.

32 Important

* You cannot delete predefined output sizes such as A4 and 1024 x 768 pixels.

»>» Note

» Save up to 10 items for each destination.
* An error message appears when you enter a value outside the setting range. Enter a value
within the range displayed in the message.
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»» Note

» Refer to "Adjusting Cropping Frames (ScanGear)" for details on cropping frames.
 For details on whether or how the cropping frame is initially displayed on a preview image, refer to
Cropping Frame on Previewed Images in "Preview Tab" (Preferences dialog box).

L (Switch Aspect Ratio)
Available when Output Size is set to anything but Flexible.

Click this button to rotate the cropping frame. Click again to return it to the original orientation.

Data Size
The data size when scanned with the current settings is displayed.

»» Note

* When the data size exceeds a certain size, the value appears in red. In that case, a warning
message appears when you click Scan. It is recommended that you adjust the settings to reduce
Data Size. To continue, scan in whole image view.
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Image Settings
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32 Important

» Do not apply these functions to images without moire, dust/scratches, or faded colors. The color tone
may be adversely affected.
» Image correction results may not be reflected in the preview image.

23 Note

+ Selectable settings depend on Color Mode settings.
» Scanning may take longer than usual when you use Image Settings.

Image Settings allows you to set the following items:

Image Adjustment
When Image Adjustment is set, the brightness of the specified portion of the image is optimized. Images
can be adjusted according to the automatically detected document type or the specified document type.
The result of the adjustment will be reflected in the entire image.

None
Image Adjustment will not be applied.

Auto
Applies Image Adjustment by automatically detecting the document type. It is recommended that
you normally select this setting.

Photo
Applies Image Adjustment suitable for photos.

Magazine
Applies Image Adjustment suitable for magazines.

Document
Applies Image Adjustment suitable for text documents.
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3» Important

* You can set Image Adjustment after preview.

* You can set this setting when Recommended is selected on the Color Settings tab of the
Preferences dialog box.

»» Note

« If the image is not adjusted properly with Auto, specify the document type.
» The color tone may change from the source image due to the Image Adjustment. In that case, set
Image Adjustment to None.

Reduce Show-through
Use this function to reduce show-through in duplex documents or lighten the base color in recycled
paper and other colored paper when scanning documents.

OFF
Show-through will not be reduced.

ON
Select this to reduce show-through in duplex documents or lighten the base color. It is
recommended that you normally select this setting.

32 Important

* Reduce Show-through can be set when Recommended is selected on the Color Settings tab of
the Preferences dialog box and Document or Magazine is selected for Image Adjustment.

Unsharp Mask
Emphasizes the outline of the subjects to sharpen the image when scanning photos.

OFF
Unsharp Mask will not be applied.
ON
Emphasizes the outline of the subjects to sharpen the image. It is recommended that you normally
select this setting.
Descreen
Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon where

uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots are
scanned. Descreen is the function for reducing this moire effect.

OFF
Moire will not be reduced.

ON

Reduces moire. It is recommended that you normally select this setting.

»» Note

» Even if Descreen is set to ON, some moire effects may remain if Unsharp Mask is set to ON. In
that case, set Unsharp Mask to OFF.

Reduce Dust and Scratches

Scanned photos may contain white dots caused by dust or scratches. Use this function to reduce such
noise.

None
Dust and scratches will not be reduced.
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Low
Select this to reduce small dust particles and scratches. Large ones may remain.

Medium
It is recommended that you normally select this setting.

High
Select this to reduce large dust particles and scratches; however, evidence of the reduction
process may remain or delicate parts of the image may be removed.

32 Important

 This function may not be effective for some types of photos.

»» Note

* It is recommended that you select None when scanning printed materials.

Fading Correction
Use this function to correct photos that have faded with time or have a colorcast. "Colorcast" is a
phenomenon where a specific color affects the entire picture due to the weather or ambient strong
colors.

None
Fading Correction will not be applied.

Low
Select this to correct a small amount of fading and colorcast.

Medium
It is recommended that you normally select this setting.

High
Select this to correct a large amount of fading and colorcast. This can affect the tone of the image.

3» Important

* You can set Fading Correction after preview.

* You can set this setting when Recommended is selected on the Color Settings tab of the
Preferences dialog box.

» Correction may not be applied properly if the scan area is too small.

Grain Correction
Use this function to reduce graininess (roughness) in photos taken with high-speed or sensitized film.

None
Graininess will not be reduced.

Low
Select this when the photo is slightly grainy.

Medium
It is recommended that you normally select this setting.

High
Select this when the photo is very grainy. This can affect the gradation and sharpness of the
image.

32 Important

» Correction may not be applied properly if the scan area is too small.
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Gutter Shadow Correction
Use this function to correct shadows that appear between pages when scanning open booklets.

When you set the Gutter Shadow Correction setting in the preview image, the result will be reflected.
Preview the effects before scanning, as results vary depending on the type of document and how it is
pressed.

Unclear or blurred text/lines caused by curved pages are not corrected.

None
Gutter shadow will not be corrected.

Low
Select this when the effect level is too strong with the medium setting.

Medium
It is recommended that you normally select this setting.

High
Select this when the effect level is too weak with the medium setting.

22 Important

* You can set Gutter Shadow Correction after preview.

» Do not place objects that weigh 4.4 Ibs (2.0 kg) or more on the platen. Also, do not press on the

document with a force exceeding 4.4 Ibs (2.0 kg). If you press heavily, the scanner may not work
correctly or you might break the glass.

Align the document with the edge of the Platen. If not, the shadow will not be corrected properly.

« Shadows may not be corrected properly depending on the document. If the page background is not
white, shadows may not be detected correctly or may not be detected at all.

» While scanning, press down on the spine with the same amount of pressure you used to preview
the scan. If the binding part is not even, the shadow will not be corrected properly.

(BT

* How to place the document depends on your model and the document to be scanned.

»» Note

» Cover the document with black cloth if white spots, streaks, or colored patterns appear in scan
results due to ambient light entering between the document and the Platen.
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« If the shadow is not corrected properly, adjust the cropping frame (scan area) on the preview
image.

= Adjusting Cropping Frames (ScanGear)
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Color Adjustment Buttons

The Color Adjustment Buttons allow you to make fine corrections to the image brightness and color tones
including adjustments to the image's overall brightness or contrast and adjustments to its highlight and
shadow values (histogram) or balance (tone curve).

£ 0% €< LN

3% Important

» The Color Adjustment Buttons are not available when you select Color Matching on the Color
Settings tab of the Preferences dialog box.

22> Note

+ Selectable settings depend on Color Mode settings.
* When you adjust the image via the Color Adjustment Buttons, the results will be reflected in the preview
image.

Click a Color Adjustment Button to set the following items:

e

(Saturation/Color Balance)
Adjust the saturation (vividness) and color tone of the image. Use this function to brighten colors that
have faded with time or due to colorcast. "Colorcast" is a phenomenon where a specific color affects the
entire picture due to the weather or ambient strong colors.

= Adjusting Saturation and Color Balance

i (Brightness/Contrast)
Adjust the brightness and contrast of the image. If the image is too dark or too bright, or if the image

quality is flat due to lack of contrast, you can adjust the levels of brightness and contrast.

= Adjusting Brightness and Contrast
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- (Histogram)

A histogram allows you to see the data concentration at each brightness level of an image. You can
specify the brightest level (highlight) and darkest level (shadow) within an image, cut the levels and
expand the middle of the tonal range of the image.

= Adjusting Histogram

(Tone Curve Settings)
Adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance of
tone input and output. You can make fine adjustments to the brightness of a specific area.

= Adjusting Tone Curve

‘4 | (Final Review)
Make a final check of color adjustments. The final synthesized tone curve and the histogram derived

from the subsequent image processing will be displayed. There are no settings to make in this screen.

Final Review

Channed = gt \-

» For a color image, select a color in Channel to check either Red, Green, or Blue, or select Master
to check three colors together.

« If you place the cursor on the preview image, the portion will be enlarged and its RGB values (only
L when Color Mode is Grayscale) before and after the adjustments will be displayed.

4 (Threshold)

Set the boundary (threshold) at which black and white are divided. By adjusting the threshold level, you
can sharpen text in a document or reduce show-through in newspapers.

= Setting Threshold

Custom
You can name and save a set of tone curve and threshold settings of the Color Adjustment Buttons.

Select Add/Delete... from the pull-down menu; when Color Mode is set to anything but Black and
White, the Add/Delete Tone Curve Settings dialog box opens; when Color Mode is Black and
White, the Add/Delete Threshold Settings dialog box opens.
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Add/Delete Tone Cunve Settings n
Setting Name : Tone Curve Settings List :
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Carel

Enter Setting Name and click Add; the name appears in Tone Curve Settings List or Threshold
Settings List. Click Save to save.

To delete an item, select it in Tone Curve Settings List or Threshold Settings List and click Delete.
Click Save to save the settings displayed in Tone Curve Settings List or Threshold Settings List.

You can load and apply the saved tone curve/threshold settings to a preview image. To load the
settings, select the saved item from the pull-down menu.

»» Note

» Save up to 20 items.

Defaults
Reset all adjustments (saturation/color balance, brightness/contrast, histogram, and tone curve).
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Preferences Dialog Box

In the Preferences dialog box, you can make advanced settings to ScanGear (scanner driver) functions via
the Scanner, Preview, Scan, and Color Settings tabs.

Click Preferences... in the ScanGear screen to open the Preferences dialog box.
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Scanner Tab
Allows you to set the quiet mode, specify the folder in which to save images temporarily, and set the
music file to play during or at the end of a scan.

Preview Tab
Allows you to select what to do with Preview when ScanGear is started, how to display cropping frames
after previewing images, and the cropping size for thumbnails of scanned documents.

Scan Tab
Allows you to select what to do with ScanGear after scanning image.

Color Settings Tab
Allows you to select how to adjust color, and specify the monitor gamma value.
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Scanner Tab

On the Scanner tab, you can specify the following settings.

+ Available functions and settings vary depending on your scanner or printer.

22 Important
Preferences ﬂ
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Auto Power Settings

You can set to turn the machine on or off automatically.

Click Settings... to display the Auto Power Settings dialog box.

»» Note

« If the machine is off or bi-directional communication is disabled, a message may appear because
the computer cannot collect the machine status. In that case, click OK to exit ScanGear (scanner

driver).
Auto Power Settings “
At Powes On | Dizaie =
Ao Power Off : 24 minubes »

o] [ans

Auto Power On

Select Enable to turn on the machine automatically when data is received.

Auto Power Off

Specify the amount of time you want to set from the list. When this time lapses without any data
being received, the machine turns off automatically.

32 Important

» When using a network compatible model by connecting to a network, the power does not turn
off automatically even if Auto Power Off is set.
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Quiet Settings
The silent function allows you to reduce the operating noise of this machine. Use this when you wish to
reduce the operating noise such as when scanning or printing at night.

Click Settings... to set the quiet mode.
»» Note

* You can set the quiet mode from the operation panel of the machine, the printer driver, or
ScanGear.
No matter how the setting is made, it applies to operations from the operation panel of the machine
or when printing/scanning from a computer, etc.

» Scanning or printing may take longer than usual when this function is used.
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Do not use quiet mode
Select this option when you wish to use the machine with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the machine.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the machine during a specified
period of time.

Set the Start time and End time during which quiet mode is to be activated.

22 Important

» The time specified in Start time and in End time must be different.

« If your scanner or printer does not support fax functions, quiet mode is not applied to
operations (copy, direct print, etc.) performed directly from the machine even if the hours are
specified.

Select Folder Where Temporary Files are Saved

Displays the folder in which to save images temporarily. To change the folder, click Browse... to specify
another one.

Sound Settings
You can set the machine to play music during/at the end of a scan.

Select the Play Music During Scanning or Play Sound When Scanning is Completed checkbox,
then click Browse... and specify a sound file.

You can specify the following files.

+ MIDI file (*.mid, *.rmi, *.midi)
+ Audio file (*.wav, *.aif, *.aiff)
* MP3 file (*.mp3)
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Calibration Settings
When you set Execute at Every Scan to ON, the scanner will be calibrated every time before
previewing and scanning, to reproduce correct color tones in scanned images.

»» Note

+ Even when Execute at Every Scan is set to OFF, the scanner may be calibrated automatically in
some cases (such as immediately after you turn the machine on).
+ Calibration may take time depending on your computer.
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Preview Tab

On the Preview tab, you can specify the following settings.
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Preview at Start of ScanGear
Select what to do with Preview when ScanGear (scanner driver) is started.

Automatically Execute Preview
ScanGear will automatically start previewing at startup.

Display Saved Preview Image
The previously previewed image will be displayed.

The Color Adjustment Button settings, the Toolbar settings, and the Advanced Mode tab settings
are also saved.

None
No preview image will be displayed at startup.

»» Note

» Select None if you do not want to save the preview image.

Cropping Frame on Previewed Images
Select how to display cropping frames after previewing images.

Execute Auto Cropping on Previewed Images
The cropping frame (scan area) will automatically be displayed in the document size after
previewing.

Display the Last Frame on Previewed Images
A cropping frame of the same size as the last used cropping frame will be displayed after
previewing.

None
No cropping frame will be displayed after previewing.

Cropping Size for Thumbnail View
Select the cropping size for thumbnails of scanned documents.
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Larger
Displays 105 % (in width and height) of the area displayed for the standard size.

Standard
The standard size.

Smaller
Displays 95 % (in width and height) of the area displayed for the standard size.

»» Note

* When you change the Cropping Size for Thumbnail View setting, the preview images will be
refreshed and cropped to the new size. As the preview images are refreshed, the color
adjustments and other settings applied to them are reset.
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Scan Tab

On the Scan tab, you can specify the following settings.
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Status of ScanGear dialog after scanning
Select what to do with ScanGear (scanner driver) after scanning images.

Close ScanGear automatically
Select this to return to the original application when scanning is completed.

Do not close ScanGear automatically
Select this to return to the ScanGear screen for another scan when scanning is completed.

Display the dialog to select next action
Select this to open a screen and select what to do when scanning is completed.
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22> Note

» Even if Do not close ScanGear automatically or Display the dialog to select next action is set,
some applications may not support it.
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Color Settings Tab

On the Color Settings tab, you can specify the following settings.
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Color Adjustment
Select one of the following.

Recommended
Select this to vividly reproduce the tone of a document on the screen. It is recommended that you
normally select this setting.

Color Matching
Select this to automatically match the scanner, monitor, and color printer colors, thus reducing time and
trouble to manually match the monitor and printer colors.

Source(Scanner)
Select scanner profile.

Target
Select target profile.

Monitor
Select this checkbox to display preview image with optimum correction for monitor.

Defaults
Returns to the default Color Matching settings.

»» Note

» The Color Adjustment Buttons on the Advanced Mode tab are not available when you select
Color Matching.
+ This function is available when Color Mode is Color.

None
Select this to disable color correction provided by ScanGear (scanner driver).
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»» Note

» Depending on your scanner or printer, this setting may not be available when scanning from the ADF
(Auto Document Feeder).

* You can select one when Color Mode is Color or Grayscale.

» Color Matching is available when ScanGear, monitor, color management-compliant application (such as
Adobe Photoshop), and printer are set up correctly.

Refer to the corresponding manual for the monitor, printer, and application settings.

Monitor Gamma
By setting the gamma value of a monitor, you can adjust the input data to the brightness characteristics
of the monitor. Adjust the value if your monitor's gamma value does not match the default value set in
ScanGear, and the colors of the original image are not accurately reflected in the monitor.

Click Defaults to return to the default Monitor Gamma value (2.20).

»» Note

» Refer to the manual of your monitor to check its gamma value. If it is not written in the manual,
contact the manufacturer.
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Placing Items (When Scanning from a Computer)

Learn how to place items on the platen or ADF (Auto Document Feeder) of your scanner or printer. Place
items correctly according to the type of item to be scanned. Otherwise, items may not be scanned correctly.

32 Important

» Do not place objects on the document cover. When you open the document cover, the objects may fall

into your scanner or printer, resulting in malfunction.
+ Close the document cover when scanning.

Do not touch the operation panel buttons or LCD (Liquid Crystal Display) when opening/closing the

document cover. May result in unintended operation.

= Placing Items (Platen)
= Placing Documents (ADF (Auto Document Feeder))

Placing Items (Platen)

Place items as described below to scan by detecting the item type or size automatically.

32 Important

* When scanning by specifying the paper size in IJ Scan Utility or ScanGear (scanner driver), align an
upper corner of the item with the corner at the arrow (alignment mark) of the platen.
» Photos that have been cut to various shapes and items smaller than 1.2 inches (3 cm) square cannot

be cropped accurately when scanning.

» Reflective disc labels may not be scanned as expected.

For Photos, Postcards, Business Cards, or BD/DVD/CD

For Magazines, Newspapers, or Documents

Placing a Single Item:

Place the item face-down on the platen, with 0.4 inch (1 cm)
or more space between the edges (diagonally striped area) of
the platen and the item. Portions placed on the diagonally
striped area cannot be scanned.
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2% Important

* Large items (such as A4 size photos) that cannot be
placed away from the edges/arrow (alignment mark) of
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Place the item face-down on the platen and align an
upper corner of the item with the corner at the arrow
(alignment mark) of the platen. Portions placed on
the diagonally striped area cannot be scanned.

I

v

TR I T I r I r r Ty r r r r rr rr rrr v r

2% Important

» Refer to "Loading Originals" for your model from
Home of the Online Manual for details on the
portions in which items cannot be scanned.




the platen may be saved as PDF files. To save in a
format other than PDF, scan by specifying the data
format.

Placing Multiple Items:

Allow 0.4 inch (1 cm) or more space between the edges
(diagonally striped area) of the platen and items, and
between items. Portions placed on the diagonally striped area
cannot be scanned.
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(A} more than 0.4 inch (1 cm)
3> Note

* You can place up to 12 items.

* You can place up to four items when the Compress
scanned images upon transfer checkbox is selected in
the Settings dialog box of IJ Scan Utility.

» With network connection, items may not be scanned

correctly when five or more items are placed. In that
case, reduce the number of items placed on the platen to
four or less, then scan again.

Positions of slanted items (10 degrees or less) are
corrected automatically.

Placing Documents (ADF (Auto Document Feeder))
22 Important

» Do not leave thick items on the platen when scanning from the ADF. May result in paper jam.

 Place and align documents of the same size when scanning two or more documents.

» Refer to "Originals You Can Load" for your model from Home of the Online Manual for details on
supported document sizes when scanning from the ADF.

1. Open the document tray.
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2. Place the documents on the ADF, then adjust the document guides to the width of the
documents.

Insert the documents face-up until a beep sounds.

4

L
-

»» Note

* When scanning duplex documents, place the front sides facing up. They will not be scanned in
the correct page order if placed the other way around.
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Adjusting Cropping Frames (ScanGear)

"Cropping" is the act of selecting the area you want to keep in an image and discarding the rest when
scanning it.

On the Basic Mode tab and Advanced Mode tab, you can specify cropping frames (scan areas) on the
image(s) displayed in the Preview area of the screen.
When you perform a scan, each area specified with a cropping frame will be scanned as a separate image.

»>» Note

* In whole image view, you can specify multiple cropping frames on the preview image.
» Refer to "Adjusting Cropping Frames in the Image Stitch Window" for your model from Home of the
Online Manual for how to adjust cropping frames with IJ Scan Utility.

Initial Cropping Frame

In thumbnail view:

No cropping frame is specified. You can drag the mouse over a thumbnail to specify a cropping frame.

In whole image view:

An active cropping frame is automatically specified around the preview image. You can drag the cropping
frame in the Preview area to specify the area.

»>» Note

* You can change the auto crop setting in the Preferences dialog box. Refer to Cropping Frame on
Previewed Images in "Preview Tab" for details.

Cropping Frame Types

(1)

(1) Thick cropping frame (rotating or stationary)
Represents a selected cropping frame. Appears only in whole image view. You can select multiple
cropping frames by clicking them while pressing the Ctrl key. Output size, image corrections, and
other settings on the Basic Mode tab or Advanced Mode tab will be applied to all the selected
cropping frames.

(2) Thin cropping frame

In thumbnail view:

Output size, image corrections, and other settings on the Basic Mode tab or Advanced Mode tab
will be applied.
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In whole image view:

Represents an unselected cropping frame. The settings on the Basic Mode tab or Advanced Mode
tab will not be applied.

Adjusting a Cropping Frame

The cursor will change into = jt Rﬂ '3;] (Arrow) when it is positioned over a cropping frame. If you
click and drag the mouse in the direction of the arrow, the cropping frame will expand or contract
accordingly.

The cursor will change into G%ED (Crosshair Arrow) when it is positioned within a cropping frame. Click and
drag the mouse to move the entire cropping frame.

»>» Note

» On the Advanced Mode tab, you can specify the cropping frame size by entering the values into =
(Width) and *= (Height) in Input Settings.

* You can rotate a cropping frame 90 degrees by clicking ) (Switch Aspect Ratio). However, &
(Switch Aspect Ratio) is not available when Output Size is Flexible.

Creating Multiple Cropping Frames

In thumbnail view:

You can only create one cropping frame per image.
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In whole image view:

Click and drag the mouse in a space outside the existing cropping frame to create a new cropping frame
in the Preview area. The new cropping frame will be the active cropping frame, and the old cropping frame
will be the unselected cropping frame.

You can create multiple cropping frames and apply different scan settings to each cropping frame.
You can also select multiple cropping frames by clicking them while pressing the Ctrl key.

If you select multiple cropping frames and change the settings on a tab at the right of ScanGear, the
settings will be applied to all the selected cropping frames.

When you create a new cropping frame, it retains the settings of the latest cropping frame.
2> Note

* Create up to 12 cropping frames.
» Scanning takes longer than usual when multiple cropping frames are selected.

Deleting Cropping Frames

In thumbnail view:

To delete a cropping frame, click an area outside the cropping frame on an image.
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In whole image view:

X

To delete a cropping frame, select it and click =~ (Remove Cropping Frame) on the Toolbar.
Alternatively, press the Delete key.

When there are multiple cropping frames, all the selected cropping frames (active cropping frame and
selected cropping frames) are deleted simultaneously.
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General Notes (Scanner Driver)

ScanGear (scanner driver) is subject to the following restrictions. Keep these points in mind when using it.

Scanner Driver Restrictions

When using the NTFS file system, the TWAIN data source may not be invoked. This is because the
TWAIN module cannot be written to the winnt folder for security reasons. Contact the computer's
administrator for help.

Some computers (including laptops) connected to the machine may not resume correctly from
standby mode. In that case, restart the computer.

Do not connect two or more scanner or multifunction printers with scanner function to the same
computer simultaneously. If multiple scanning devices are connected, you cannot scan from the
operation panel of the machine and also may experience errors while accessing the devices.
Scanning may fail if the computer has resumed from sleep or standby mode. In that case, follow these
steps and scan again.

1. Turn off the machine.
2. Exit ScanGear, then disconnect the USB cable from the computer and reconnect it.
3. Turn on the machine.

ScanGear cannot be opened in multiple applications at the same time. Within an application,
ScanGear cannot be opened for the second time when it is already open.

Be sure to close the ScanGear window before closing the application.

When using a network compatible model by connecting to a network, the machine cannot be
accessed from multiple computers at the same time.

When using a network compatible model by connecting to a network, scanning takes longer than
usual.

Make sure that you have adequate disk space available when scanning large images at high
resolutions. For example, at least 300 MB of free space is required to scan an A4 document at 600
dpi in full-color.

ScanGear and WIA driver cannot be used at the same time.

Do not enter the computer into sleep or hibernate state during scanning.

Applications with Restrictions on Use

If you start Media Center included in Windows XP Media Center Edition 2005, you may not be able to
scan using the operation panel of the machine. In that case, restart the computer.

You cannot scan images with Media Center included in Windows XP Media Center Edition 2005.
Scan with other applications such as IJ Scan Utility.

Some applications may not display the TWAIN user interface. In that case, refer to the application's
manual and change the settings accordingly.

Some applications do not support continuous scanning of multiple documents. In some cases, only
the first scanned image is accepted, or multiple images are scanned as one image. For such
applications, do not scan multiple documents from the ADF (Auto Document Feeder).

To import scanned images into Microsoft Office 2000, first save them using IJ Scan Utility, then import
the saved files from the Insert menu.

When scanning Platen size images into Microsoft Office 2003 (Word, Excel, PowerPoint, etc.), click
Custom Insert in the Insert Picture from Scanner or Camera screen. Otherwise, images may not
be scanned correctly.
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* When scanning images into Microsoft Office 2007/Microsoft Office 2010 (Word, Excel, PowerPoint,
etc.), use Microsoft Clip Organizer.

* Images may not be scanned correctly in some applications. In that case, increase the operating
system's virtual memory and retry.

* When image size is too large (such as when scanning large images at high resolution), your computer
may not respond or the progress bar may remain at 0 % depending on the application. In that case,
cancel the action (for example by clicking Cancel on the progress bar), then increase the operating
system's virtual memory or reduce the image size/resolution and retry. Alternatively, scan the image
via IJ Scan Utility first, then save and import it into the application.
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Useful Information on Scanning

» Adjusting Cropping Frames in the Image Stitch Window
» Resolution
» Data Formats

» Color Matching
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Adjusting Cropping Frames in the Image Stitch Window

"Cropping" is the act of selecting the area you want to keep in an image and discarding the rest when
scanning it.

In the Image Stitch window, you can specify a cropping frame on the image displayed in the Preview area.

»>» Note

» Refer to "Adjusting Cropping Frames (ScanGear)" for your model from Home of the Online Manual for
how to adjust cropping frames with ScanGear (scanner driver).

Initial Cropping Frame

No cropping frame is specified. When you select the Adjust cropping frames checkbox, an active
cropping frame is automatically specified around the image in the Preview area. You can drag the
cropping frame to specify the area.

When you perform a scan, the image in the area specified with the cropping frame will be scanned.

Adjusting a Cropping Frame

The cursor will change into = @ Rfﬂ 'ﬁﬂ (Arrow) when it is positioned over a cropping frame. Click and
drag the mouse to expand or contract the cropping frame.

The cursor will change into 4%) (Crosshair Arrow) when it is positioned within a cropping frame. Click and
drag the mouse to move the entire cropping frame.

Deleting Cropping Frames

To delete the cropping frame, deselect the Adjust cropping frames checkbox.
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Resolution

The data in the image you have scanned is a collection of dots carrying information about brightness and
color. The density of these dots is called "resolution”, and resolution will determine the amount of detail your
image contains. The unit of resolution is dots per inch (dpi). Dpi is the number of dots per inch (2.5 cm).

The higher the resolution (value), the more detail in your image; the lower the resolution (value), the less
detail.

A

How to Set the Resolution

You can set the resolution in the following screens.
I1J Scan Utility:
Resolution on the E: (Scanning from a Computer) tab of the Settings dialog box

ScanGear (Scanner Driver):

Output Resolution in Output Settings on the Advanced Mode tab

Appropriate Resolution Settings

Set the resolution according to the use of the scanned image.

Appropriate
Item Type Use Color Mode et .
Resolution
Copyin
.pyl' g Color 300 dpi
(Printing)
Creating a postcard Color 300 dpi
Color photo
Saving to a computer Color 300 dpi
Using on a website or attachin
ng on & webs "9 color 150 dpi
to e-mail
Saving to a computer Grayscale 300 dpi
Black and white photo Using on a website or attachin
9 ) g Grayscale 150 dpi
to e-mail
Color, Grayscale, or ,
Copying yse: 300 dpi
Black and White
Text document (document or
. . , Color, Grayscale, or .
magazine) Attaching to e-mail ) 150 dpi
Black and White
Scanning text using OCR Color or Grayscale 300 dpi
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32 Important

« If you double the resolution, the data size of the scanned image quadruples. If the file is too large, the
processing speed will slow down significantly, and you will experience inconvenience such as lack of
memory. Set the minimum required resolution according to the use of the image.

»» Note

» When you will be printing the scanned image by enlarging it, scan by setting a higher resolution than
the recommended one above.
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Data Formats

You can select a data format when saving scanned images. You should specify the most suitable data
format according to how you want to use the image on which application.
Available data formats vary by application and operating system (Windows or Mac OS).

See below for the characteristics of each image data format.

PNG (Standard File Extension: .png)
A data format often used on websites.

PNG is suitable for editing saved images.

JPEG (Standard File Extension: .jpg)
A data format often used on websites and for digital camera images.

JPEG features high compression rates. JPEG images slightly degrade every time they are saved, and
cannot be returned to their original state.

JPEG is not available for black and white images.

TIFF (Standard File Extension: .tif)
A data format featuring a relatively high compatibility between various computers and applications.

TIFF is suitable for editing saved images.

»» Note

» Some TIFF files are incompatible.
* |J Scan Utility supports the following TIFF file formats.

» Uncompressed, black and white binary
» Uncompressed, RGB (8 bits per channel)
» Uncompressed, Grayscale

PDF (Standard File Extension: .pdf)
A data format for electronic documents, developed by Adobe Systems Incorporated.

It can be used on various computers and operating systems, and fonts can be embedded as well; therefore,
people in different environments can exchange the files without being aware of the differences.
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Color Matching

"Color Matching" is the act of making adjustments so that the color tones match between the original item,
the monitor display, and the color printout. On your scanner or printer, the color tones are adjusted as
shown below.

Example: When sRGB is selected as the output profile (target):

Input Profile (Source)

Scanner ‘

ScanGear (Scanner Driver)

'

Output Profile (Target)

sRGB ‘
I
I I
Qs/ Application/
Application Printer Driver
Monitor ‘ Printer ‘

The image's color space is converted from the scanner's color space to SRGB by ScanGear.

When displaying on a monitor, the image's color space is converted from sRGB to the monitor's color space
based on the operating system's monitor settings and the application's working space settings.

When printing, the image's color space is converted from sRGB to the printer's color space based on the
application's print settings and the printer driver's settings.
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IJ Network Scanner Selector EX Menu and Setting Screen

IJ Network Scanner Selector EX allows you to select the scanners or printers to be used for scanning or
printing over a network from your computer or the operation panel.

After installation, IJ Network Scanner Selector EX appears in the notification area on the desktop.

22 Important

+ If you cannot scan over a network, download and upgrade to the latest MP Drivers from our website.

* While IJ Network Scanner Selector EX is enabled, it periodically transmits packets to check whether it
can communicate with your scanner or printer over the network. When using the computer in a network
environment other than the one used to set up your scanner or printer, disable IJ Network Scanner
Selector EX.

»>» Note

« If the icon is not displayed in the notification area on the desktop, follow the procedure below to start.

* Windows 8.1/Windows 8:
Click IJ Network Scanner Selector EX on the Start screen.
If IJ Network Scanner Selector EX is not displayed on the Start screen, select the Search charm,
then search for "lJ Network Scanner Selector EX".

* Windows 7/Windows Vista/Windows XP:

From the Start menu, click All Programs > Canon Utilities > IJ Network Scanner Selector EX >
IJ Network Scanner Selector EX.

Menu

Displays a menu when you right-click =¥ (IJ Network Scanner Selector EX) in the notification area on the
desktop.

Disable Canon IJ Network Scanner Selector EX / Enable Canon IJ Network Scanner Selector EX
Enables or disables |J Network Scanner Selector EX.
When you select Disable Canon IJ Network Scanner Selector EX, you will not be able to scan over

a network from the operation panel.

Enabled: =¥, Disabled: &
32 Important

* When using a model with which you cannot scan over a network from the operation panel, you
cannot scan using the operation panel even if this setting is enabled.

Settings...
The Scan-from-PC Settings screen appears. You can select the model you want to use.

About
Displays the version information.

In the displayed dialog box, you can change the language to be used in the application. The change
will be reflected after restarting the computer.

566



Exit
Exits 1J Network Scanner Selector EX; = (Enabled) or a5 (Disabled) disappears from the
notification area on the desktop.

Scan-from-PC Settings Screen

Right-click the icon from the notification area on the desktop, then select Settings... to display the Scan-
from-PC Settings screen.

Your scanner or printer must be selected with IJ Network Scanner Selector EX before scanning over a
network.

Scanners
MAC addresses of the scanners or printers that can be used over the network are displayed.

You can select one scanner or printer per model. Selecting a scanner or printer automatically enables
scanning from the operation panel.

Instructions
Opens this guide.

Scan-from-Operation-Panel Settings
The Scan-from-Operation-Panel Settings screen appears. You can select up to three scanners and
printers in total for scanning from the operation panel. You can scan items using the operation panel
of the selected scanner or printer, and send the scanned images to your computer over a network.

32 Important

» When using a model with which you cannot scan over a network from the operation panel, that
model does not appear in Scanners and the setting is not available.

Scan-from-Operation-Panel Settings Screen

Click Scan-from-Operation-Panel Settings in the Scan-from-PC Settings screen to display the Scan-
from-Operation-Panel Settings screen.

Scanners
MAC addresses of the scanners or printers that can be used over the network are displayed.

You can select up to three scanners and printers in total at the same time. Selecting a scanner or
printer automatically enables scanning from the operation panel.

Instructions
Opens this guide.

32 Important

* When using a model with which you cannot scan over a network from the operation panel, Scan-
from-Operation-Panel Settings may appear in the Scan-from-PC Settings screen; however, the
setting is not available.

»>» Note

« If your scanner or printer does not appear, check the following, click OK to close the screen, then
reopen it and try selecting again.

* MP Dirivers is installed
» Network settings of your scanner or printer is completed after installing the MP Drivers
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* Network communication between your scanner or printer and computer is enabled
If your scanner or printer still does not appear, refer to "Problems with Network Communication” for
your model from Home of the Online Manual.

* You do not need to use this software when scanning via USB. Refer to "Uninstalling IJ Network
Scanner Selector EX" to delete it. You can scan via USB even if it is not deleted.
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Uninstalling IJ Network Scanner Selector EX

Follow the procedure below to uninstall IJ Network Scanner Selector EX from your computer.

22 Important

* You cannot scan over a network after uninstalling IJ Network Scanner Selector EX.
* Log into a user account with administrator privilege.

1. Uninstall IJ Network Scanner Selector EX.

* Windows 8.1/Windows 8:

1. Click the Settings charm > Control Panel > Programs > Programs and
Features.

2. Double-click Canon IJ Network Scanner Selector EX.

»» Note

« If the User Account Control screen appears, click Continue.

* Windows 7/Windows Vista:

1. From the Start menu, select Control Panel > Programs > Programs and
Features.

2. Select Canon IJ Network Scanner Selector EX, then click Uninstall/Change.

> Note

« If the User Account Control screen appears, click Continue.

* Windows XP:

1. From the Start menu, select Control Panel > Add or Remove Programs.

2. Select Canon IJ Network Scanner Selector EX, then click Change/Remove.

2. Click Yes when the confirmation message appears.

3. When uninstallation is complete, click OK.

»» Note

* When the message prompting you to restart your computer appears, click OK to restart your
computer.
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Other Scanning Methods

» Scanning with WIA Driver

» Scanning Using the Control Panel (Windows XP Only)
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Scanning with WIA Driver

You can scan an item from a WIA (Windows Image Acquisition)-compliant application.

WIA is a driver model implemented in Windows XP or later. It allows you to scan items without using an
application.

The procedure varies depending on the application. The following procedures are examples only.
Refer to the application's manual for details.

32 Important

* In Windows XP, you cannot scan using the WIA driver via a network connection.
» Follow these steps to enable scanning over a network.

The setting may have been completed already depending on your environment. In that case, Uninstall
appears.

1. Follow the procedure below to open Network.

* Windows 8.1/Windows 8: Select the Search charm, then click Network displayed by searching
for "Network".

* Windows 7: From the Start menu, select Computer > Network.

* Windows Vista: From the Start menu, select Network.

2. Right-click XXX_MAC address (where "XXX" is the model name) in the displayed screen, then
select Install.

Scanning with WIA Driver 2.0

The following is an example of scanning using "Windows Fax and Scan."

1. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

2. Select New on the File menu of "Windows Fax and Scan," then click Scan....

The scan setting screen appears.

»» Note

« If you have more than one scanner or printer, a scanner selection screen may appear. Double-
click the scanner you want to use.

» For USB connection: Canon XXX series (where "XXX" is the model name)
* For network connection: XXX series_MAC address (where "XXX" is the model name)

3. Specify the settings.

Scanner
The currently set product name is displayed. To change the scanner, click Change... and select

the product you want to use.

Profile
Select Photo (Default) or Documents according to the type of item to be scanned. To save a
new Profile, select Add profile.... You can specify the details in the Add New Profile dialog box.
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Source
Select a scanner type.

Paper size
This setting is not available for your scanner or printer.

Color format
Select the color mode in which to scan the item.

File type
Select a data format from JPEG, BMP, PNG, and TIFF.

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

»» Note

» When using the scanner or printer with network connection, the following resolutions can be
specified.
150 dpi / 300 dpi / 600 dpi

Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the
image. You can also enter a value (-100 to 100).

Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-100 to 100).

Preview or scan images as separate files
Select this checkbox to preview or scan multiple images as separate files.

3% Important

* When using the scanner or printer with network connection, you cannot specify Brightness,
Contrast, and Preview or scan images as separate files.

4. Click Preview to preview the image.

The preview image appears on the right.

5. Click Scan.

When scanning is completed, the scanned image appears in the application.

Scanning with WIA Driver 1.0

The following is an example of scanning using "Paint."

1. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

2. Click From scanner or camera from the File menu of Paint. (Select the command to
scan an item in the application.)
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»» Note

« If you have more than one scanner or printer, a scanner selection screen may appear. Double-
click the scanner you want to use.

» For USB connection: Canon XXX series (where "XXX" is the model name)
* For network connection: XXX series_ MAC address (where "XXX" is the model name)

3. Select the type of picture according to the item to be scanned.

Select from Color picture, Grayscale picture, Black and white picture or text, and Custom
Settings.

»» Note

* When using the scanner or printer with network connection, the options for the type of picture
may differ from those displayed with USB connection.

» To scan with the values previously set in Adjust the quality of the scanned picture, select
Custom Settings.

4. Click Adjust the quality of the scanned picture and set the preferences as required.

Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the
image. You can also enter a value (-127 to 127).

Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-127 to 127).

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

»» Note

» When using the scanner or printer with network connection, the following resolutions can be
specified.
150 dpi / 300 dpi / 600 dpi

Picture type
Select the type of scan you want for your item.

Reset
Click to restore the original settings.

22 Important

» When using the scanner or printer with network connection, you cannot specify Brightness and
Contrast.

5. Click Preview to preview the image.

The preview image appears on the right. Drag [l to specify the scan area.

6. Click Scan.
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When scanning is completed, the scanned image appears in the application.
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Scanning Using the Control Panel (Windows XP Only)

You can scan images via the Control Panel of Windows XP using the WIA driver.

22 Important

* When using the scanner or printer with network connection, you cannot scan using the WIA driver.

1. From the Start menu, select Control Panel.

2. Click Printers and Other Hardware > Scanners and Cameras, then double-click Canon
XXX series (where "XXX" is the model name).

The Scanner and Camera Wizard dialog box appears.

3. Click Next.

4. Select Picture type according to the item to be scanned.
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* To scan with the values previously set in Custom settings, select Custom.

5. Click Custom settings to set the preferences as required.
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Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the image.
You can also enter a value (-127 to 127).

Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-127 to 127).

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

Picture type
Select the type of scan you want for your item.

Reset
Click to restore the original settings.

6. Click Preview to preview the image.

The preview image appears on the right. Drag M to specify the scan area.

7. Click Next and follow the instructions.
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Placing Items (When Scanning from a Computer)

Learn how to place items on the platen of your scanner or printer. Place items correctly according to the
type of item to be scanned. Otherwise, items may not be scanned correctly.

32 Important

» Do not place objects on the document cover. When you open the document cover, the objects may fall
into your scanner or printer, resulting in malfunction.
+ Close the document cover when scanning.

Placing Items

Place items as described below to scan by detecting the item type or size automatically.

3% Important

* When scanning by specifying the paper size in IJ Scan Utility or ScanGear (scanner driver), align an
upper corner of the item with the corner at the arrow (alignment mark) of the platen.

» Photos that have been cut to various shapes and items smaller than 1.2 inches (3 cm) square cannot
be cropped accurately when scanning.

» Reflective disc labels may not be scanned as expected.

For Photos, Postcards, Business Cards, or BD/DVD/CD For Magazines, Newspapers, or Documents

Place the item face-down on the platen and align an
upper corner of the item with the corner at the arrow
(alignment mark) of the platen. Portions placed on
the diagonally striped area cannot be scanned.

Placing a Single Item:

Place the item face-down on the platen, with 0.4 inch (1 cm)
or more space between the edges (diagonally striped area) of
the platen and the item. Portions placed on the diagonally
striped area cannot be scanned.
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2% Important

» Important » Refer to "Loading Originals" for your model from
Home of the Online Manual for details on the
portions in which items cannot be scanned.

* Large items (such as A4 size photos) that cannot be
placed away from the edges/arrow (alignment mark) of

the platen may be saved as PDF files. To save in a
format other than PDF, scan by specifying the data
format.
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Placing Multiple Items:

Allow 0.4 inch (1 cm) or more space between the edges
(diagonally striped area) of the platen and items, and
between items. Portions placed on the diagonally striped
area cannot be scanned.

T

o

Tw

Tw

[ P S S S

(A} more than 0.4 inch (1 cm)

»» Note

* You can place up to 12 items.
* Positions of slanted items (10 degrees or less) are
corrected automatically.
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Network Scan Settings

You can connect your scanner or printer to a network to share it among multiple computers.

22 Important

* Multiple users cannot scan at the same time.

»» Note

» Complete the network settings of your scanner or printer beforehand from the Setup CD-ROM or by
following the instructions on the web page.
+ With network connection, scanning takes longer than USB connection.

Complete the following settings to enable scanning over a network.

Specifying Your Scanner or Printer

Use IJ Network Scanner Selector EX to specify the scanner you want to use. By specifying the scanner,
you can scan over a network from your computer.

22 Important

« If the product you want to use is changed with IJ Network Scanner Selector EX, the product used for
scanning with IJ Scan Utility changes as well.

If your scanner or printer is not selected in IJ Scan Utility, check that it is selected with IJ Network
Scanner Selector EX.

Refer to "IJ Network Scanner Selector EX Menu and Setting Screen" for your model from Home of
the Online Manual for details.

1. Check that IJ Network Scanner Selector EX is running.

If IJ Network Scanner Selector EX is running, =¥ (IJ Network Scanner Selector EX) appears in the
notification area on the desktop. Click B to check the hidden icons as well.

> Note

« If the icon is not displayed in the notification area on the desktop, follow the procedure below to
start.
* Windows 8.1 / Windows 8:
Click IJ Network Scanner Selector EX on the Start screen.
If IJ Network Scanner Selector EX is not displayed on the Start screen, select the Search
charm, then search for "IJ Network Scanner Selector EX".
* Windows 7/Windows Vista/Windows XP:

From the Start menu, click All Programs > Canon Utilities > IJ Network Scanner
Selector EX > IJ Network Scanner Selector EX.

The icon appears in the notification area on the desktop, and the Scan-from-PC Settings screen
appears. In that case, skip ahead to Step 3.
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2. In the notification area on the desktop, right-click = (IJ Network Scanner Selector EX),
then select Settings....

The Scan-from-PC Settings screen appears.

3. Select your scanner or printer from Scanners.

Normally, the MAC address of your scanner or printer is already selected after the network setup. In
that case, you do not need to select it again.

32 Important

« If multiple scanners exist on the network, multiple model names appear. In that case, you can
select one scanner per model.

4. Click OK.

Setting for Scanning with IJ Scan Utility

To scan from IJ Scan Utility using a scanner or printer connected to a network, specify your scanner or
printer with IJ Network Scanner Selector EX, then follow the steps below to change the connection status
between it and the computer.

1. Start IJ Scan Utility.

2. Select "Canon XXX series Network" (where "XXX" is the model name) for Product
Name.

»» Note

» For USB connection, select "Canon XXX series" (where "XXX" is the model name) for Product
Name.

3. Click Settings... to use another scanner connected to a network.

A0
4. Click 81/ (General Settings), then click Select in Product Name.

The Scan-from-PC Settings screen of IJ Network Scanner Selector EX appears.

Select the scanner you want to use and click OK.

5. In the Settings (General Settings) dialog box, click OK.

The IJ Scan Utility main screen reappears. You can scan via a network connection.

»» Note

+ If your scanner or printer does not appear, check the following, click OK to close the screen, then
reopen it and try selecting again.

* MP Drivers is installed
» Network settings of your scanner or printer is completed after installing the MP Drivers
* Network communication between your scanner or printer and computer is enabled
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If your scanner or printer still does not appear, refer to "Problems with Network Communication" for
your model from Home of the Online Manual.
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Troubleshooting

» The Machine Cannot Be Powered On

v

Printing Does Not Start

v

Paper Does Not Feed Properly/”"No Paper" Error Occurs

v

Print Results Not Satisfactory
Ink Is Not Ejected

v

Y

Paper Jams

Y

If an Error Occurs

Search Each Function

» Problems with Network Communication
» Problems with Printing

» Problems with Printing Quality

» Problems with Scanning

» Problems with the Machine

» Problems with Installation/Downloading
» About Errors/Messages Displayed

» If You Cannot Resolve the Problem
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Problems with Network Communication

* Problems with the Machine While Using with Network
» Cannot Detect a Machine on a Network

» Other Problems with Network
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Problems with the Machine While Using with Network

» The Machine Stopped Working Suddenly
» Ink Remaining Level Is Not Displayed on Printer Status Monitor of the Machine
» Printing Speed Is Slow

» Cannot Use the Machine on Replacing an Access Point or Changing Its settings
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The Machine Stopped Working Suddenly

= Cannot Communicate with the Machine After the Network Settings Are Changed

= Cannot Communicate with the Machine over the Wireless LAN

= Cannot Communicate with the Machine Using the Access Point Mode

= Cannot Print or Scan from a Computer Connected to the Network

Cannot Communicate with the Machine After the Network Settings Are
Changed

It may take a while for the computer to obtain the IP address, or you may need to restart your computer.

Search for the machine again after confirming a valid IP address is assigned to the computer.

Cannot Communicate with the Machine over the Wireless LAN
Make sure that the machine is turned on.

Make sure that the network settings in the machine are identical with those of
the access point.

Refer to the instruction manual provided with the access point or contact its manufacturer to check the access
point settings, and then modify the machine settings.

= How to Set an Encryption Key

Make sure that the machine is not placed far away from the access point.

The access point is located indoors within the effective range for wireless communication. Locate the machine
within 164 ft. / 50 m from the access point.

Make sure that there is no obstruction.

Wireless communication between different rooms or floors is generally poor. Adjust the location of the devices.

LI Make sure that there is no source of radio wave interference in your vicinity.

If a device (e.g. microwave oven) using the same frequency bandwidth as the wireless station is placed
nearby, the device may cause interference. Place the wireless station as far away from the interference source
as possible.

WG Make sure that the network settings of the computer are correct.
For the procedures to connect a network device to the computer and set them up, refer to the instruction

manual of your network device or contact its manufacturer.

Make sure that the radio status is good and adjust the installation positions
while monitoring the radio status with IJ Network Tool.

= Monitoring Wireless Network Status

o) I-' M Make sure that a valid wireless channel is used.
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The wireless channel to be used may be limited depending on wireless network devices installed in the
computer. Refer to the instruction manual provided with your computer or your wireless network device to
specify the valid wireless channel.

Make sure that the channel confirmed in Check 8 can communicate with the
computer.

If not, change the channel set to the access point.

Make sure that the firewall of the security software is disabled.

If the firewall function of your security software is turned on, a message may appear warning that Canon
software is attempting to access the network. If the warning message appears, set the security software to
always allow access.

If using any programs that switch the network environment, check their settings. Some programs will enable a
firewall by default.

When using a router, connect the machine and computer to the LAN side
(same network segment).

If the problem is not resolved, perform setup with the Setup CD-ROM or perform it according to the
instructions on our website.

* For placement:
Make sure that there is no barrier or obstacle between the access point and the machine.

7> Note

* When you connect the machine to a Windows XP computer by cableless setup:
Follow the procedure below to perform settings of the machine and the computer.

1. Enable the access point mode of the machine.

2. Right-click the Wireless Network Connections icon on the notification area on the desktop,
then click View Available Wireless Networks.

3. Select the network name on the screen displayed, then click Connect.

Select "XXXXXX-MGXXXXseries" ("XX" represents alphanumeric characters.) as the network
name.

4. Enter the network key on the screen displayed, then click Connect.

As a default, the serial number of the machine is used as a network key. Confirm the serial
number on the rear of the machine.

5. Perform setup with the Setup CD-ROM or perform it according to the instructions on our website.

Cannot Communicate with the Machine Using the Access Point Mode
Make sure that the machine is turned on.

Is the access point mode disabled?

Enable the access point mode following the procedure below.

1. Press and hold the Stop button until the Alarm lamp flashes 18 times.
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2. Release the Stop button.
3. Press the Color button.
The Wi-Fi lamp lights up.
4. Press and hold the Wi-Fi button until the POWER lamp flashes 3 times.
5. Release the Wi-Fi button.

The access point mode is enabled and the machine can be used as an access point.

O EIN |s the machine selected to connect external communication devices (e.g.
computers, smartphones, or tablets)?

Select an access point name (SSID) specified for the machine as a destination for external communication
devices.

Enter a password if you specify it for the machine.

OGN Make sure that external communication devices are not placed far away from
the machine.

Do not locate external communication devices too far away from the machine.

Make sure that there is no obstruction.

Wireless communication between different rooms or floors is generally poor. Adjust the location of the devices.

LWL YAl Make sure that there is no source of radio wave interference in your vicinity.

If a device (e.g. microwave oven) using the same frequency bandwidth as the wireless station is placed
nearby, the device may cause interference. Place the wireless station as far away from the interference source
as possible.

O Are you trying to connect 6 devices or more?

You can connect up to 5 devices using the access point mode.

Cannot Print or Scan from a Computer Connected to the Network

Make sure that the network settings of the computer are correct.

For the procedures to set up the computer, refer to the instruction manual of your computer or contact its
manufacturer.

If the MP Drivers are not installed, install them.

Install the MP Drivers with the Setup CD-ROM or install them from our website.

OV E I Make sure that access control is not set to the access point.

For the procedures to connect an access point and set it up, refer to the instruction manual of your access
point or contact its manufacturer.

»» Note

» To check the MAC address or the IP address of the computer, see Checking the IP Address or the MAC
Address of the Computer.
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Ink Remaining Level Is Not Displayed on Printer Status Monitor of
the Machine

Use the printer driver with bidirectional communication.

Select Enable bidirectional support in the Ports sheet of the properties dialog box of the printer driver.

= How to Open the Printer Driver Setup Window
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Printing Speed Is Slow

The machine may be printing out a large job issued from another computer.

Make sure that the radio status is good and adjust the installation positions
while monitoring the radio status with IJ Network Tool.

= Monitoring Wireless Network Status

Make sure that there is no barrier or obstacle between the access point and the machine. Wireless
communication between different rooms or floors is generally poor. The metal, concrete, or timber including the
metallic material, mud wall, or insulator may interrupt a wireless communication. If the machine cannot
communicate with the computer over a wireless LAN for the wall material, place the machine and the computer
in the same room or floor.

I Make sure that there is no source of interference in your vicinity.

If a device (e.g. microwave oven) using the same frequency bandwidth as the wireless station is placed nearby,
the device may cause interference. Place the wireless station as far away from the interference source as
possible.

589



Cannot Use the Machine on Replacing an Access Point or
Changing Its settings

When you replace an access point, perform network setup of the machine again.

Perform network setup again with the Setup CD-ROM or perform it again according to the instructions on
our website.

If the problem is not resolved, see below.

= Cannot Communicate with the Machine After Applying MAC/IP _Address Filtering or Entering an

Encryption Key to the Access Point

= \Vhen Encryption Is Enabled, Cannot Communicate With the Machine After the Encryption Type Was

Switched on the Access Point

Cannot Communicate with the Machine After Applying MAC/IP Address
Filtering or Entering an Encryption Key to the Access Point

Confirm the access point setting.

Refer to the instruction manual provided with the access point or contact its manufacturer to confirm the
access point setting. Make sure that the computer and the access point can communicate with each other
under this setting.

If you are performing MAC address filtering or IP address filtering at the
access point, confirm that the MAC address or IP address for both the computer or the
network device and the machine are registered.

If you are using a WEP or WPA/WPA2 key, make sure that the encryption
key for the computer or the network device and the machine matches that set to the
access point.

Besides the WEP key itself, the key length, key format, the key ID to use, and the authentication method must
match among the machine, the access point, and the computer.

Normally, select Auto for the authentication method. If you want to specify the method manually, select Open
System or Shared Key according to the setting of the access point.

= How to Set an Encryption Key

When Encryption Is Enabled, Cannot Communicate With the Machine After
the Encryption Type Was Switched on the Access Point

If the machine cannot communicate with the computer after the encryption type of the machine was
switched, make sure that encryption types for the computer and the access point matches that set to the
machine.

= Cannot Communicate with the Machine After Applying MAC/IP Address Filtering or Entering an
Encryption Key to the Access Point
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Cannot Detect a Machine on a Network

» Cannot Detect the Machine When Setting up Network Communication

» The Machine Cannot Be Detected in the Wireless LAN
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Cannot Detect the Machine When Setting up Network
Communication

If the machine could not be detected on the network when setting up the network communication, confirm
the network settings before redetecting the machine.

= Cannot Detect the Machine during Wireless LAN Setup: Check 1

22 Important

« If the machine cannot be detected while you are setting up the network communication using a USB
cable, the machine may be in the access point mode. In this case, finish the access point mode and
enable the wireless LAN, then try to redetect the machine.

= Using the Machine with the Access Point Mode
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Cannot Detect the Machine during Wireless LAN Setup: Check 1

Are the computer and network device (router, access point, etc.) configured
and can the computer connect to the network?

Make sure that you can view web pages on your computer.

If you cannot view any web pages:

Configure the computer and network device.

For the procedures, refer to the instruction manuals supplied with the computer and network device, or
contact their manufacturers.

If you can view web pages after configuring the computer and network device, try to set up the network
communication from the beginning.

If you can view web pages:

Go to check 2.
= Cannot Detect the Machine during Wireless LAN Setup: Check 2
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Cannot Detect the Machine during Wireless LAN Setup: Check 2

Does the firewall function of your security software or operation system for
computer interfere with setting up the network communication?

The firewall function of your security software or operation system for computer may limit communications
between the machine and your computer. Confirm the setting of firewall function of your security software
or operation system or the message appearing on your computer.

If the firewall function interferes with setting up:

* When the message appears on your computer:
If the message warning that Canon software is attempting to access the network appears on the
computer, set the security software to allow access.

* When the message does not appear on your computer:
Cancel to set up, then set the security software to allow Canon software* to access the network.

* On the Setup CD-ROM, select win > Driver > DrvSetup, then set the security software to allow the
file Setup.exe or Setup64.exe to access the network.

After setting the security software, try to set up the network communication from the beginning.

> Note

» For the operation system firewall settings or the security software firewall settings, refer to the
instruction manual of the computer or software, or contact its manufacturer.

If there is no problem with the firewall settings:

Go to check 3.
= Cannot Detect the Machine during Wireless LAN Setup: Check 3
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Cannot Detect the Machine during Wireless LAN Setup: Check 3

Check the settings of the access point.

Check the settings of the access point for the network connection such as IP address filtering, MAC
address filtering, or DHCP function.

Make sure that the radio channel of the access point and that assigned to the machine are the same.

For details on how to check the settings of the access point, refer to the instruction manual supplied with
the access point or contact its manufacturer.
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The Machine Cannot Be Detected in the Wireless LAN

Make sure that the machine is turned on.

Make sure that the Wi-Fi lamp is lit on the operation panel of the machine.

If the Wi-Fi lamp is off, the wireless LAN is disabled. Follow the procedure below to enable the wireless LAN.
1. Press and hold the Stop button until the Alarm lamp flashes 18 times.
2. Release the Stop button.
3. Press the Color button.

Wireless LAN is enabled and the Wi-Fi lamp is lit.

When the machine is connected to the computer temporarily using a USB
cable, make sure that the USB cable is connected properly.

When you set up the wireless LAN connection or change the wireless LAN settings using IJ Network Tool
through USB connection, make sure that the machine is connected to the computer with a USB cable securely.

= Connecting the Machine to the Computer Using a USB Cable

Make sure that the machine setup is completed.

If not, perform setup with the Setup CD-ROM or perform it according to the instructions on our website.

When using IJ Network Tool, click Update to search for the machine again.

= Canon |J Network Tool Screen

When searching for a machine over a network, make sure that the machine is
associated with the port.

When No Driver is displayed under Name in IJ Network Tool, there is no association. Select Associate Port on
the Settings menu, then associate the port with the machine.

= \When the Printer Driver Is Not Associated with a Port

Make sure that the network settings in the machine are identical with those of
the access point.

Refer to the instruction manual provided with the access point or contact its manufacturer to check the access
point settings, and then modify the machine settings.

= How to Set an Encryption Key

Make sure that there is no obstruction.

Wireless communication between different rooms or floors is generally poor. Adjust the location of the devices.

Make sure that the machine is not placed far away from the access point.

The access point is located indoors within the effective range for wireless communication. Locate the machine
within 164 ft. / 50 m from the access point.

SIS Make sure that there is no source of radio wave interference in your vicinity.
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If a device (e.g. microwave oven) using the same frequency bandwidth as the wireless station is placed nearby,
the device may cause interference. Place the wireless station as far away from the interference source as
possible.

Make sure that the network settings of the computer are correct.

Make sure that the computer can communicate with the access point over the wireless LAN.

Make sure that Enable bidirectional support is selected in the Ports sheet of
the properties dialog box of the printer driver.

Make sure that the firewall of the security software is disabled.

If the firewall function of your security software is turned on, a message may appear warning that Canon
software is attempting to access the network. If the warning message appears, set the security software to
always allow access.

If using any programs that switch the network environment, check their settings. Some programs will enable a
firewall by default.

When using a router, connect the machine and computer to the LAN side
(same network segment).

If the problem is not resolved, perform setup with the Setup CD-ROM or perform it according to the
instructions on our website.
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Other Problems with Network

» Forgot an Access Point Name, SSID, or a Network Key

» The Message Is Displayed on the Computer Screen During Setup
» The Administrator Password Set to the Machine Was Forgotten
» Checking Information about the Network

» Packets Are Sent Steadily

» How to Restore the Machine's Network Settings to Factory Default

598



Forgot an Access Point Name, SSID, or a Network Key

= Cannot Connect with an Access Point to \Which a WEP or WPA/WPA2 Key Is Set (You Forgot the WEP or
WPA/WPA2 Key)

= How to Set an Encryption Key

Cannot Connect with an Access Point to Which a WEP or WPA/WPA2 Key
Is Set (You Forgot the WEP or WPA/WPA2 Key)

For information on how to set up the access point, refer to the instruction manual provided with the access
point or contact its manufacturer. Make sure that the computer and the access point can communicate
with each other.

After that, set up the machine to match the settings of the access point using IJ Network Tool.

How to Set an Encryption Key

For information on how to set up the access point, refer to the instruction manual provided with the access
point or contact its manufacturer. Make sure that the computer and the access point can communicate
with each other.

After that, set up the machine to match the settings of the access point using IJ Network Tool.

* When using WEP

The key length, key format, the key to use (one of 1 to 4), and the authentication method must match
among the access point, the machine, and the computer.

In order to communicate with an access point that uses automatically generated WEP keys, you must
configure the machine to use the key generated by the access point by entering it in hexadecimal
format.

Normally, select Auto for the authentication method. Otherwise, select Open System or Shared Key
according to the setting of the access point.

When the WEP Details screen appears after clicking Set on the Search screen, follow the on-screen
instructions and set the key length, the key format, the key number, and the authentication to enter a
WEP key.

For details, see Changing the WEP Detailed Settings.

* When using WPA/WPA2

The authentication method, passphrase, and dynamic encryption type must match on the access
point, the machine, and the computer.

Enter the passphrase configured on the access point (a sequence of between 8 and 63 alphanumeric
characters, or a 64-character hexadecimal number).

Either TKIP (basic encryption) or AES (secure encryption) is selected automatically for the dynamic
encryption method.

For details, see Changing the WPA/WPAZ2 Detailed Settings.

»>» Note

» This machine supports WPA/WPA2-PSK (WPA/WPA2-Personal) and WPA2-PSK (WPA2-
Personal).
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The Message Is Displayed on the Computer Screen During Setup

= The Enter Password Screen Is Displayed During Setup

= The Screen for Setting the Encryption Is Displayed After Selecting the Access Point in the Search Screen

= "You are connecting the machine to the non encrypted wireless network" Is Displayed

The Enter Password Screen Is Displayed During Setup

The following screen is displayed if an administrator password is set to the machine which has already
been set up to use via a network.

Enter Password ﬂ
i A password has been sel 1o this panber. Enter the admin passwond, and then cick [0K]

HAdemin Passvwond

0K Cancel

Enter the administrator password you have set.

> Note

» An administrator password is already specified for the machine at the time of purchase.
For details:

= About the Administrator Password

For improving security, it is recommended to change the administrator password.

= Changing the Settings in the Admin Password Sheet

The Screen for Setting the Encryption Is Displayed After Selecting the
Access Point in the Search Screen

This screen is displayed automatically if the selected access point is encrypted. In this case, configure the
details to use the same encryption settings set to the access point.

For information on the encryption settings, see Changing the Settings in the Wireless LAN Sheet.

"You are connecting the machine to the non encrypted wireless network" Is
Displayed

Security is not configured on the access point. The machine can still be used, so continue the setup
procedure to complete it.

22 Important

* If you connect to a network that is not protected with security measures, there is a risk of disclosing
data such as your personal information to a third party.

600



The Administrator Password Set to the Machine Was Forgotten

Initialize the machine settings.

= |nitializing the Machine Settings

After initializing the machine settings, perform setup with the Setup CD-ROM or perform it according to the
instructions on our website.
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Checking Information about the Network

= Checking the IP_Address or the MAC Address of the Machine

= Checking the IP_Address or the MAC Address of the Computer

= Checking If the Computer and the Machine, or Computer and the Access Point Can Communicate

= Checking the Network Setting Information

Checking the IP Address or the MAC Address of the Machine

To check the IP address or the MAC address of the machine, print out the network setting information.

= Printing Out Network Setting Information

To display the network setting information using IJ Network Tool, select Network Information on the
View menu.

= Canon |J Network Tool Screen

Checking the IP Address or the MAC Address of the Computer

To check the IP address or MAC address assigned to the computer, follow the procedure below.

1. Select Command Prompt as shown below.

* In Windows 8.1 or Windows 8, select Command Prompt from the Start screen. If Command
Prompt is not displayed on the Start screen, select the Search charm, then search for
"Command Prompt".

* In Windows 7, Windows Vista, or Windows XP, click Start > All Programs > Accessories >
Command Prompt.

2. Enter "ipconfig/all" and press the Enter key.

The IP addresses and the MAC addresses of the network devices installed on your computer are
displayed. When the network device is not connected to the network, the IP address is not displayed.

Checking If the Computer and the Machine, or Computer and the Access
Point Can Communicate

To check that communication is available, perform the ping test.

1. Select Command Prompt as shown below.

* In Windows 8.1 or Windows 8, select Command Prompt from the Start screen. If Command
Prompt is not displayed on the Start screen, select the Search charm, then search for
"Command Prompt".

* In Windows 7, Windows Vista, or Windows XP, click Start > All Programs > Accessories >
Command Prompt.

2. Type the ping command and the IP address of the target machine or the target access
point, and then press the Enter key.

ping XXX XXX XXX. XXX
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XXX XXX XXX XXX" is the IP address of the target device.
If the communication is available, a message such as the following is displayed.
Reply from XXX XXX XXX.XXX: bytes=32 time=10ms TTL=255

When Request timed out is displayed, the communication is not available.

Checking the Network Setting Information

To check the network setting information of the machine, print out the network setting information.

= Printing Out Network Setting Information
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Packets Are Sent Steadily

While IJ Network Scanner Selector EX is enabled, it periodically transmits packets to check whether it can
communicate with the machine over the network. When using the computer in a network environment other
than the one used to set up the machine, disable IJ Network Scanner Selector EX.

To disable 1J Network Scanner Selector EX, right-click the * icon on the notification area on the
desktop, then select Disable Canon IJ Network Scanner Selector EX.
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How to Restore the Machine's Network Settings to Factory Default

22 Important

* Note that initialization erases all network settings on the machine, and printing or scanning operation
from a computer over network may become impossible. To use the machine over network, perform
setup with the Setup CD-ROM or perform it according to the instructions on our website.

Follow the procedure below to initialize the network settings.

1. Press and hold the Stop button until the Alarm lamp flashes 17 times.

2. Release the Stop button.

The network settings are initialized.
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Problems with Printing

» Printing Does Not Start
» Paper Jams
» Paper Does Not Feed Properly/"No Paper" Error Occurs

» Copying/Printing Stops Before It Is Completed
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Printing Does Not Start

Make sure that the power plug is securely plugged in, then press the ON button
to turn the machine on.

While the ON lamp is flashing, the machine is initializing. Wait until the ON lamp stops flashing and remains lit.
2> Note

* When printing large data such as a photo or graphics, it may take longer to start printing. While the ON
lamp is flashing, the computer is processing data and sending it to the machine. Wait until printing starts.

Make sure that the machine is connected to your computer properly.

When the machine is connected to your computer with a USB cable, make sure that the USB cable is securely
plugged in to the machine and the computer, then check the followings:

« If you are using a relay device such as a USB hub, disconnect it, connect the machine directly to the
computer, and try printing again. If printing starts normally, there is a problem with the relay device. Consult
the reseller of the relay device for details.

» There could also be a problem with the USB cable. Replace the USB cable and try printing again.

When you use the machine over LAN, make sure that the machine is set up to be used over network correctly.

L EMN |s the access point mode enabled?

When you print using a mode other than the access point mode, disable the access point mode in advance.

If you are printing from the computer and there are any unnecessary print jobs,
delete them.

= Deleting the Undesired Print Job

Make sure that your machine's name is selected in the Print dialog box.

The machine will not print properly if you are using a printer driver for a different printer.

Make sure that "Canon XXX series Printer" (where "XXX" is your machine's name) is selected in the Print dialog
box.

»» Note

+ To make the machine the one selected by default, select Set as Default Printer.

Configure the printer port appropriately.

Make sure that the printer port is configured appropriately.
1. Log on as a user account with administrator privilege.
2. Select items as shown below.

* In Windows 8.1 or Windows 8, select Control Panel from the Settings charm on Desktop > Hardware
and Sound > Devices and Printers.

* In Windows 7, select Devices and Printers from the Start menu.
* In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.

* In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers
and Faxes.
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3. Open the properties of the printer driver for the machine.

* In Windows 8.1, Windows 8, or Windows 7, right-click the "Canon XXX Printer" icon (where "XXX" is
your machine's name), then select Printer properties.

* In Windows Vista or Windows XP, right-click the "Canon XXX Printer" icon (where "XXX" is your
machine's name), then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX Printer" appearing in the
Printer column is selected for Print to the following port(s).

»» Note

* When the machine is used over LAN, the port name of the machine is displayed as

"CNBJNP_xxxxxxxxxx". "xxxxxxxxxx" is the character string generated from the MAC address or a
character string specified by the user when setting up the machine.

If the setting is incorrect:

Reinstall the MP Drivers with the Setup CD-ROM or install them from our website.

Printing does not start even though the machine is connected to the computer using a USB cable and
the port named "USBnnn" is selected:

In Windows 8.1 or Windows 8, select My Printer on the Start screen to start My Printer. If My Printer
is not displayed on the Start screen, select the Search charm, then search for "My Printer".

Set the correct printer port on Diagnose and Repair Printer. Follow the on-screen instructions to set
the correct printer port, then select your machine's name.

In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon Utilities,
Canon My Printer, Canon My Printer, then select Diagnose and Repair Printer. Follow the on-
screen instructions to set the correct printer port, then select your machine's name.

If the problem is not resolved, reinstall the MP Drivers with the Setup CD-ROM or install them from our
website.

Printing does not start even though the port named "CNBJNP_xxxxxxxxxx" is selected when the
machine is used over LAN:

Launch IJ Network Tool, and select "CNBJNP_xxxxxxxxxx" as you confirmed in step 4, then associate
the port with the printer using Associate Port in the Settings menu.

If the problem is not resolved, reinstall the MP Drivers with the Setup CD-ROM or install them from our
website.

Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

*When On is selected for Prevention of Print Data Loss, print quality may be reduced.

Restart your computer if you are printing from the computer.

608



Paper Jams

When paper is jammed, the Alarm lamp flashes and a troubleshooting message is displayed on the
computer screen automatically. Take the appropriate action described in the message.

For details on how to remove the jammed paper, refer to Support Code List (When Paper Is Jammed).

23> Note

* You can confirm the actions against errors with Support Codes on your computer by searching a
Support Code.

= Click Here to Search
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Paper Does Not Feed Properly/"No Paper" Error Occurs

Make sure that paper is loaded.

= | oading Paper

Make sure of the following when you load paper.

» When loading two or more sheets of paper, align the edges of the sheets before loading.

* When loading two or more sheets of paper, make sure that the paper stack does not exceed the paper load
limit.
However, proper feeding of paper may not be possible at this maximum capacity depending on the type of

paper or environmental conditions (either very high or low temperature and humidity). In such cases, reduce
the sheets of paper you load at a time to less than half of the paper load limit.

» Always load the paper in portrait orientation, regardless of the printing orientation.

* When you load the paper, load the paper with the print side facing UP. Align the paper stack against the
right side of the rear tray and slide the paper guide so that it just touches the left edge of the stack.

= | oading Paper

Check to see if the paper you are printing on is not too thick or curled.

= Media Types You Cannot Use

Make sure of the following when you load envelopes.

* When printing on envelopes, refer to Loading Paper, and prepare the envelopes before printing.

Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placed in
landscape orientation, they will not feed properly.

Confirm that the media type and the paper size settings correspond with the
loaded paper.

Make sure that there are not any foreign objects in the rear tray.

If the paper tears in the rear tray, see Paper Jams to remove it.

If there are any foreign objects in the rear tray, be sure to turn off the machine, unplug it from the power supply,
then remove the foreign object.
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Clean the paper feed roller.

= Cleaning the Paper Feed Roller

23> Note

+ Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.
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Copying/Printing Stops Before It Is Completed
Is the paper loaded?

Make sure that paper is loaded.

If the machine has run out of paper, load paper.

Do the printing documents have lots of photographs or illustrations?

As printing large data such as photos or graphics takes time for the machine and the computer to process, the
machine may appear to have stopped operating.

In addition, when printing data that uses a large amount of ink continuously on plain paper, the machine may
pause temporarily. In either case, wait until the process is complete.

»» Note

« If you are printing a document with a large printing area or printing multiple copies of a document, printing
may pause to allow the ink to dry.

Has the machine been printing continuously for a long period?

If the machine has been printing continuously for a long time, the print head or other parts around it may
overheat. The machine may stop printing at a line break for a period of time and then resume printing.

In this case, wait for a while without operation. If the printing still does not resume, interrupt your print session at
a convenient time and turn the machine off for at least 15 minutes.

/1 Caution

» The print head and the surrounding area can become extremely hot inside the machine. Never touch the
print head or nearby components.

If copying stops before it is completed, try to copy again.

If a certain time passes after some errors occurred while copying, the machine stops the operation.
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Problems with Printing Quality

» Print Results Not Satisfactory
* Ink Is Not Ejected
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Print Results Not Satisfactory

If the print result is not satisfactory due to white streaks, misaligned lines, or uneven colors, confirm the
paper and print quality settings first.

I SEN Do the page size and media type settings match the size and type of the loaded
paper?
When these settings are incorrect, you cannot obtain a proper print result.

If you are printing a photograph or an illustration, incorrect paper type settings may reduce the quality of the
printout color.

Also, if you print with an incorrect paper type setting, the printed surface may be scratched.

The method of confirming the paper and print quality settings differs depending on what you do with your
machine.

To print from a PictBridge (Wireless LAN) Confirm by using your PictBridge (Wireless LAN) compliant device.
compliant device = About PictBridge (Wireless LAN) Print Settings
To print from a computer Confirm by using the printer driver.

= Printing with Easy Setup

Make sure that the appropriate print quality is selected referring to the table in
Check 1.

Select a print quality option suitable for the paper and image for printing. If you notice blurs or uneven colors,
increase the print quality setting and try printing again.

You can confirm the print quality setting using the printer driver.

= Changing the Print Quality and Correcting Image Data

If the problem is not resolved, there may be other causes.

See also the sections below:

= Cannot Print to End of Job

= No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks

= Colors Are Unclear

= Lines Are Misaligned

= Line Does Not Print or Prints Partially

= Image Does Not Print or Prints Partially

= Printed Paper Curls or Has Ink Blots

= Paper Is Smudged/Printed Surface Is Scratched

= Back of the Paper Is Smudged

= Colors Are Uneven or Streaked

If the Printed Paper Has Been Discolored

Colors may fade with time if the printed paper is left for a long period of time.
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After printing, dry the paper sufficiently, avoid high temperatures, high humidity, and direct sunlight, and
store or display indoors at room temperature and normal humidity.

To avoid direct exposure to air, it is recommended that you store the paper in an album, plastic folder,
photo frame, etc.
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Cannot Print to End of Job

Select the setting not to compress the printing data.

If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.

Click Print Options on the Page Setup sheet on the printer driver. Select the Do not allow application
software to compress print data check box, then click OK.

* Deselect the check box after printing is complete.

Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.

Is the space of your computer's hard disk sufficient?

Delete unnecessary files to free disk space.
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No Printing Results/Printing Is Blurred/Colors Are Wrong/White
Streaks

= No Printing Results

- Printing Is Blurred
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Did you confirm the paper and print quality settings?

= Print Results Not Satisfactory

LA Print the Nozzle Check Pattern and perform any necessary maintenance
operations such as Print Head Cleaning.
Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

* If the Nozzle Check Pattern is not printed correctly:

After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the pattern.
« If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the machine and
perform another Print Head Deep Cleaning after 24 hours.

« If the problem is not resolved after performing the Print Head Deep Cleaning twice:

Ink may have run out. Replace the FINE cartridge.
LN \When a FINE cartridge runs out of ink, replace it with a new one.

When using paper with one printable surface, make sure that the paper is
loaded with the printable side facing up.

Printing on the wrong side of such paper may cause unclear prints or prints with reduced quality.

Load paper with the printable side facing up.

Refer to the instruction manual supplied with the paper for detailed information on the printable side.

Is the FINE cartridge installed properly?

If the FINE cartridge is not installed securely, ink may not be ejected correctly.
Retract the output tray extension and the paper output tray, open the cover, then remove the FINE cartridges.

Then install the FINE cartridges again. Push up the FINE cartridge until it clicks into place.

After confirming that the FINE cartridge is installed properly, close the cover.

* When copying, see also the sections below:

Is the platen glass dirty?

Clean the platen glass.
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= Cleaning the Platen Glass and Document Cover

Make sure that the original is properly loaded on the platen glass.

= | oading Originals

s the original loaded with the side to be copied facing down on the platen
glass?

Did you copy a printout done by this machine?

If you use a printout done by this machine as the original, print quality may be reduced depending on the
condition of the original.

Reprint from the computer if you can reprint from it.
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Colors Are Unclear

Is the Nozzle Check Pattern printed properly?

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

« If the Nozzle Check Pattern is not printed correctly:

After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the pattern.
« If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the machine and
perform another Print Head Deep Cleaning after 24 hours.

« If the problem is not resolved after performing the Print Head Deep Cleaning twice:

Ink may have run out. Replace the FINE cartridge.

When a FINE cartridge runs out of ink, replace it with a new one.

e |s the FINE cartridge installed properly?
If the FINE cartridge is not installed securely, ink may not be ejected correctly.
Retract the output tray extension and the paper output tray, open the cover, then remove the FINE cartridges.

Then install the FINE cartridges again. Push up the FINE cartridge until it clicks into place.

After confirming that the FINE cartridge is installed properly, close the cover.

»» Note

* Printed colors may not match screen colors due to basic differences in the methods used to produce
colors. Color control settings and environmental differences can also affect how colors appear on the
screen. Therefore, colors of printing results may be different from those on the screen.
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Lines Are Misaligned

T4

Did you confirm the paper and print quality settings?

= Print Results Not Satisfactory

Perform Print Head Alignment.

If printed lines are misaligned or print results are otherwise unsatisfactory, adjust the print head position.

= Aligning the Print Head
2> Note

« If the problem is not resolved after performing the Print Head Alignment, perform Print Head Alignment
manually referring to Aligning the Print Head Position from Your Computer.

Increase the print quality and try printing again.

Increasing the print quality in the printer driver may improve the print result.
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Line Does Not Print or Prints Partially

Is the Page Layout Printing performed or the Binding margin function used?

When the Page Layout Printing or Binding margin function is being used, thin lines may not be printed. Try
thickening the lines in the document.

Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.
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Image Does Not Print or Prints Partially

Select the setting not to compress the printing data.

If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.

Click Print Options on the Page Setup sheet on the printer driver. Select the Do not allow application
software to compress print data check box, then click OK.

* Deselect the check box after printing is complete.

Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.
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Printed Paper Curls or Has Ink Blots

= Printed Paper Has Ink Blots

P O e e O e o O e O o e O o e e O e oo,

-~ Printed Paper Curls

Did you confirm the paper and print quality settings?

= Print Results Not Satisfactory

If the intensity is set high, reduce the intensity setting and try printing again.

If you are using plain paper to print images with high intensity, the paper may absorb too much ink and become
wavy, causing paper abrasion.

You can confirm the intensity using the printer driver.

= Adjusting Intensity

Is Photo Paper used for printing photographs?

When printing data with high color saturation such as photographs or images in deep color, we recommend
using Photo Paper Plus Glossy Il or other Canon speciality paper.

= Media Types You Can Use
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Paper Is Smudged/Printed Surface Is Scratched

- Paper Is Smudged

'E BN

The Edges of Paper Are Smudged Printed Surface Is Smudged

:" Printed Surface Is Scratched

Did you confirm the paper and print quality settings?

= Print Results Not Satisfactory

Is the appropriate type of paper used?

Check to see if the paper you are printing on is suitable for your printing purpose.

= Media Types You Can Use

Load the paper after correcting its curl.

We recommend putting unused paper back into the package and keeping it on a level surface.

* For Plain Paper
Turn the paper over and reload it to print on the other side.
Leaving the paper loaded on the rear tray for a long time may cause the paper to curl. In this case, load the
paper with the other side facing up. It may resolve the problem.

* For Other Paper

If the curl on the four corners of the paper is more than 0.1 inch / 3 mm (A) in height, the paper may be
smudged or may not be fed properly. In such cases, follow the procedure described below to correct the
paper curl.

...... ¥

£
(A)

1. Roll up the paper in the opposite direction to the paper curl as shown below.
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2. Check that the paper is now flat.

We recommend printing curl-corrected paper one sheet at a time.

»» Note

» Depending on the media type, the paper may be smudged or may not be fed properly even if it is not
curled inward. In such cases, follow the procedure described below to curl the paper outward within 0.1
inch / 3 mm (B) in height before printing. This may improve the print result.

€

(C) Printing side

We recommend printing paper that has been curled outward one sheet at a time.

If the intensity is set high, reduce the intensity setting and try printing again.

If you are using plain paper to print images with high intensity, the paper may absorb too much ink and become
wavy, causing paper abrasion.

Reduce the intensity setting in the printer driver and try printing again.
1. Open the printer driver setup window.

= How to Open the Printer Driver Setup Window

2. On the Main sheet, select Manual for Color/Intensity, and then click Set....

3. Drag the Intensity slide bar on the Color Adjustment sheet to adjust the intensity.

Is printing performed beyond the recommended printing area?

If you are printing beyond the recommended printing area of your printing paper, the lower edge of the paper
may become stained with ink.

Resize your original document in your application software.

= Printing Area

Is the platen glass dirty?

Clean the platen glass.

= Cleaning the Platen Glass and Document Cover

Is the paper feed roller dirty?

Clean the paper feed roller.

= Cleaning the Paper Feed Roller
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»» Note

+ Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.

Is the inside of the machine dirty?

When performing duplex printing, the inside of the machine may become stained with ink, causing the printout to
become smudged.

Perform the Bottom Plate Cleaning to clean the inside of the machine.

= Cleaning the Inside of the Machine (Bottom Plate Cleaning)

»» Note

» To prevent the inside of the machine from stains, set the paper size correctly.

Set the time to dry the printed surface longer.

Doing so gives the printed surface enough time to dry so that paper smudged and scratched are prevented.
1. Make sure that the machine is turned on.
2. Open the printer driver setup window.

= How to Open the Printer Driver Setup Window

3. Click the Maintenance tab and then Custom Settings.
4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click OK.

5. Confirm the message and click OK.
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Back of the Paper Is Smudged

Did you confirm the paper and print quality settings?

= Print Results Not Satisfactory

LA Perform the Bottom Plate Cleaning to clean the inside of the machine.
= Cleaning the Inside of the Machine (Bottom Plate Cleaning)

> Note

» When performing duplex printing or too much printing, the inside may become stained with ink.
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Colors Are Uneven or Streaked

:" Colors Are Uneven

:" Colors Are Streaked

Did you confirm the paper and print quality settings?

= Print Results Not Satisfactory

W ¥AN Print the Nozzle Check Pattern and perform any necessary maintenance
operations such as Print Head Cleaning.
Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

* If the Nozzle Check Pattern is not printed correctly:

After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the pattern.
* If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the machine and
perform another Print Head Deep Cleaning after 24 hours.

« If the problem is not resolved after performing the Print Head Deep Cleaning twice:

Ink may have run out. Replace the FINE cartridge.

Perform Print Head Alignment.
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= Aligning the Print Head
»» Note

« If the problem is not resolved after performing the Print Head Alignment, perform Print Head Alignment
manually referring to Aligning the Print Head Position from Your Computer.
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Ink Is Not Ejected
When a FINE cartridge runs out of ink, replace it with a new one.

Is the FINE cartridge installed properly?

If the FINE cartridge is not installed securely, ink may not be ejected correctly.
Retract the output tray extension and the paper output tray, open the cover, then remove the FINE cartridges.

Then install the FINE cartridges again. Push up the FINE cartridge until it clicks into place.

Y g

»
S

After confirming that the FINE cartridge is installed properly, close the cover.

Are the print head nozzles clogged?

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

* If the Nozzle Check Pattern is not printed correctly:

After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the pattern.
« If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the machine and
perform another Print Head Deep Cleaning after 24 hours.

+ If the problem is not resolved after performing the Print Head Deep Cleaning twice:

Ink may have run out. Replace the FINE cartridge.
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Problems with Scanning

» Problems with Scanning
» Scan Results Not Satisfactory

» Software Problems
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Problems with Scanning

» Scanner Does Not Work
» ScanGear (Scanner Driver) Does Not Start

» Error Message Appears and the ScanGear (Scanner Driver) Screen Does Not
Appear

» Cannot Scan Multiple Items at One Time

» Cannot Scan Properly with Auto Scan

» Slow Scanning Speed

* "There is not enough memory." Message Is Displayed
» Computer Stops Operating during Scanning

» Scanner Does Not Work after Upgrading Windows

» Scanned Image Does Not Open
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Scanner Does Not Work
Make sure that your scanner or printer is turned on.
Connect the USB cable to a different USB port on the computer.

If the USB cable is connected to a USB hub, remove it from the USB hub and
connect it to a USB port on the computer.

Restart the computer.
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ScanGear (Scanner Driver) Does Not Start

Make sure that MP Drivers is installed.

If not installed, install MP Drivers from the Setup CD-ROM or the web page.

AN Select your scanner or printer on the application's menu.

32 Important

« If your scanner or printer name is displayed multiple times, select the one that does not include WIA.

»» Note

» The operation may differ depending on the application.
» Use the WIA driver when scanning from a WIA-compliant application.

= Scanning with WIA Driver

Make sure that the application supports TWAIN.

You cannot start ScanGear (scanner driver) from applications not supporting TWAIN.

Scan and save images with |J Scan Utility and open the files in your
application.
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Error Message Appears and the ScanGear (Scanner Driver) Screen
Does Not Appear

oL SN Make sure that your scanner or printer is turned on.

Turn off your scanner or printer, then reconnect the USB cable and replug the
power cord.

Connect the USB cable to a different USB port on the computer.

If the USB cable is connected to a USB hub, remove it from the USB hub and
connect it to a USB port on the computer.

Make sure that MP Drivers is installed.

If not installed, install MP Drivers from the Setup CD-ROM or the web page.

IO Select your scanner or printer on the application's menu.

»» Note

» The operation may differ depending on the application.

Make sure that the application supports TWAIN.

You cannot start ScanGear (scanner driver) from applications not supporting TWAIN.

Exit ScanGear if it is running on another application.
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Cannot Scan Multiple Items at One Time

Make sure that the items are placed correctly.

= Placing Items (When Scanning from a Computer)

Check if you can properly scan one item.

Some applications do not support multiple image scanning. In that case, scan each item individually.
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Cannot Scan Properly with Auto Scan

Make sure that the items are placed correctly.

= Placing Items (When Scanning from a Computer)

Multiple items scanning may not be supported.

Some applications do not support multiple image scanning. In that case, scan each item individually.
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Slow Scanning Speed

To view the image on a monitor, set the output resolution to around 150 dpi. To
print, set it to around 300 dpi.

= Resolution

Set Fading Correction, Grain Correction, etc. to None.

Refer to "Image Settings" for your model from Home of the Online Manual for details.

In 1J Scan Utility, deselect the Correct slanted text document / Detect the
orientation of text document and rotate image checkbox and scan again.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
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"There is not enough memory." Message Is Displayed

Exit other applications and try again.

oA Reduce the resolution or output size and scan again.

= Resolution
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Computer Stops Operating during Scanning

Restart the computer, reduce the output resolution in ScanGear (scanner
driver) and scan again.

Refer to "Output Settings" for your model from Home of the Online Manual for details.

AN Delete unnecessary files to obtain sufficient free hard disk space, then scan
again.
Error message may appear if there is not enough hard disk space to scan and save, when the image size is too

large (such as when scanning a large item at high resolution).

In Folder to Save Temporary Files of |J Scan Utility, specify a folder on a
drive with sufficient free space.

= Settings (General Settings) Dialog Box

Multiple devices may be connected to USB ports.

Disconnect devices other than your scanner or printer.
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Scanner Does Not Work after Upgrading Windows

Disconnect the USB cable, then uninstall (delete) and reinstall MP Drivers and 1J
Scan Utility.

Step 1: Uninstall MP Drivers.
Refer to "Deleting the Unnecessary MP Drivers" for your model from Home of the Online Manual for how to
delete MP Drivers.

Step 2: Uninstall IJ Scan Utility.

* Windows 8.1 / Windows 8:

Click the Settings charm > Control Panel > Programs > Programs and Features.
Double-click Canon IJ Scan Utility.

When a confirmation appears, click Yes.

When uninstallation is complete, click OK.

HPoODN -

IJ Scan Utility is deleted.
2> Note

* In Windows 8.1 and Windows 8, a confirmation/warning dialog box may appear when installing,
uninstalling, or starting up software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

* Windows 7 / Windows Vista:

. From the Start menu, select Control Panel > Programs > Programs and Features.
. Double-click Canon IJ Scan Utility.

. When a confirmation appears, click Yes.

. When uninstallation is complete, click OK.

A WODN -

IJ Scan Utility is deleted.
»» Note

* In Windows 7 and Windows Vista, a confirmation/warning dialog box may appear when installing,
uninstalling, or starting up software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

* Windows XP:

From the Start menu, select Control Panel > Add or Remove Programs.
Select Canon IJ Scan Utility, then click Change/Remove.

When a confirmation appears, click Yes.

When uninstallation is complete, click OK.

Ao b=

IJ Scan Utility is deleted.

Step 3: Reinstall MP Drivers and IJ Scan Utility.
Reinstall MP Drivers and IJ Scan Utility from the Setup CD-ROM or the web page.
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Scanned Image Does Not Open

If the data format is not supported by the application, scan the image again and
select a popular data format such as JPEG when saving it.

Refer to the application's manual for details. If you have any questions, contact the manufacturer of the
application.
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Scan Results Not Satisfactory

» Scan Quality (Image Displayed on the Monitor) Is Poor

» Scanned Image Is Surrounded by Extra White Areas

» Cannot Scan at the Correct Size

» Item Is Placed Correctly, but the Scanned Image Is Slanted

» Scanned Image Is Enlarged (Reduced) on the Computer Monitor

644



Scan Quality (Image Displayed on the Monitor) Is Poor

If the image is jagged, increase the scanning resolution, or select TIFF or PNG
in Data Format of the Settings dialog box.

= Resolution
= Settings Dialog Box

Set the display size to 100 %.

Some applications do not display images clearly if the display size is too small.

If moire (stripe pattern) appears, take the following measures and scan again.

+ Set one of the following settings in the Settings (Document Scan) dialog box, Settings (Custom Scan)
dialog box, or Settings (Scan and Stitch) dialog box of IJ Scan Utility, then scan from the IJ Scan Utility
main screen.

o Set Select Source to Magazine and set Color Mode to Color
o Select the Reduce moire checkbox in Image Processing Settings

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (Scan and Stitch) Dialog Box

+ On the Basic Mode tab of ScanGear (scanner driver), select Magazine (Color) in Select Source.
Refer to "Basic Mode Tab" for your model from Home of the Online Manual for details.
+ On the Advanced Mode tab of ScanGear, set Descreen in Image Settings to ON.

Refer to "Image Settings" for your model from Home of the Online Manual for details.

> Note

+ If moire appears when you scan a digital print photo, take the above measures and scan again.

Check the monitor's color depth.

Refer to Help of Windows or the monitor's manual for details on how to check the monitor's color depth.

LS Clean the platen and document cover.

If the document is in poor condition (dirty, faded, etc.), then set Reduce Dust
and Scratches, Fading Correction, Grain Correction, etc. in Image Settings on the
Advanced Mode tab of ScanGear.

Refer to "Image Settings" for your model from Home of the Online Manual for details.

If the color tone of images is different from the original document, take the
following measures and scan again.
» On the Advanced Mode tab of ScanGear, set Image Adjustment in Image Settings to None.
Refer to "Image Settings" for your model from Home of the Online Manual for details.
* On the Color Settings tab in the Preferences dialog box of ScanGear, set Color Matching.

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.
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Scanned Image Is Surrounded by Extra White Areas

Specify the scan area.

u "4
[ |
Click z-‘—L (Auto Crop) in whole image view of ScanGear (scanner driver) to automatically display the cropping
frame (scan area) according to the item size.

You can also manually specify the scan area in thumbnail view or when there are white margins along the item
(for example, in photos), or when you want to create custom cropping frames.

= Adjusting Cropping Frames in the Image Stitch Window

»» Note

+ Refer to "Adjusting Cropping Frames (ScanGear)" for your model from Home of the Online Manual for how
to adjust cropping frames with ScanGear (scanner driver).
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Cannot Scan at the Correct Size

Make sure that the items are placed correctly.

= Placing Items (When Scanning from a Computer)
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Item Is Placed Correctly, but the Scanned Image Is Slanted

When Document or Magazine is selected for Select Source, deselect the
Correct slanted text document checkbox and scan the item again.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
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Scanned Image Is Enlarged (Reduced) on the Computer Monitor

Change the display setting in the application.

Refer to the application's manual for details. If you have any questions, contact the manufacturer of the
application.

»» Note

* You cannot reduce the image size in Paint. To reduce the display size, open the images in an application.

Change the resolution setting in ScanGear (scanner driver) and scan again.

The higher the resolution, the larger the resulting image will be.

= Resolution
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Software Problems

» The E-mail Client You Want to Use Does Not Appear in the Screen for Selecting
an E-mail Client
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The E-mail Client You Want to Use Does Not Appear in the Screen
for Selecting an E-mail Client

Check that the e-mail client's MAPI is enabled.

Refer to the e-mail client's manual for how to set MAPI.

If the problem is not solved even when MAPI is enabled, select None (Attach Manually) in the screen for
selecting an e-mail client, then manually attach the image to the outgoing e-mail.
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Problems with the Machine

» The Machine Cannot Be Powered On

» The Machine Turns Off Unintentionally

» Cannot Connect to Computer with a USB Cable Properly

» Cannot Communicate with the Machine with USB Connection

» FINE Cartridge Holder Does Not Move to the Position for Replacing

» Printer Status Monitor Is Not Displayed
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The Machine Cannot Be Powered On

Press the ON button.

Make sure that the power plug is securely plugged into the power cord
connector of the machine, then turn it back on.

Unplug the machine from the power supply, then plug the machine back in and
turn the machine back on after leaving it for at least 2 minutes.

If the problem is not resolved, contact the service center.
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The Machine Turns Off Unintentionally

Deactivate the setting to turn the unit off automatically.

The machine turns off automatically according to the elapsed time you specified if you activate the setting to turn
the unit off automatically.

If you do not want the machine to turn off automatically, open the printer driver setup window and in Auto Power
under the Maintenance sheet, select Disable for Auto Power Off.

»» Note

* You can activate the setting to turn the machine on/off automatically from the operation panel of the
machine or ScanGear (scanner driver).

» From the operation panel of the machine:

= Turning on/off the Machine Automatically

* From ScanGear (scanner driver):

= Scanner Tab
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Cannot Connect to Computer with a USB Cable Properly

Printing or Scanning Speed Is Slow/Hi-Speed USB Connection Does Not
Work/"This device can perform faster" Message Is Displayed
If your system environment is not fully compatible with Hi-Speed USB, the machine will operate at a lower

speed provided under USB 1.1. In this case, the machine operates properly but printing or scanning
speed may slow down due to communication speed.

Check the following to make sure that your system environment supports Hi-
Speed USB connection.

» Does the USB port on your computer support Hi-Speed USB connection?

» Does the USB cable or the USB hub support Hi-Speed USB connection?

Be sure to use a certified Hi-Speed USB cable. We recommend that the cable is no longer than around
10 feet / 3 meters.

» Does the operating system of your computer support Hi-Speed USB connection?
Obtain and install the latest update for your computer.
* Does the Hi-Speed USB driver operate properly?

Obtain the latest version of the Hi-Speed USB driver compatible with your hardware and reinstall it on
your computer.

32 Important

+ For details on Hi-Speed USB of your system environment, contact the manufacturer of your computer,
USB cable, or USB hub.
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Cannot Communicate with the Machine with USB Connection

Make sure that the machine is turned on.

Make sure that the USB cable is connected properly.

See Connecting the Machine to the Computer Using a USB Cable to connect the USB cable properly.

Do not start up IJ Network Tool while printing.
Do not print while IJ Network Tool is running.

Make sure that Enable bidirectional support is selected in the Ports sheet of
the properties dialog box of the printer driver.

= How to Open the Printer Driver Setup Window
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FINE Cartridge Holder Does Not Move to the Position for Replacing
Is the ON lamp off?

Check if the ON lamp is lit.

The FINE cartridge holder will not move unless the power is on. If the ON lamp is off, close the cover and turn
the machine on.

Is the Alarm lamp flashing?

Close the cover, confirm the number of times the Alarm lamp is flashing, take the appropriate action to resolve
the error, and then reopen it. For details on how to resolve the error, see Support Code List.

Has the cover been left open for 10 minutes or longer?

If the cover is left open for more than 10 minutes, the FINE cartridge holder moves to the position to protect it to
prevent the print head from drying out. Close and reopen the cover to return the FINE cartridge holder to the
position for replacing.

Has the machine been printing continuously for a long period?

If the machine has been printing continuously for a long time, the FINE cartridge holder may not move to the
position for replacing since the print head may overheat.

»>» Note

* Do not open the cover while printing is in progress; otherwise, an error occurs.
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Printer Status Monitor Is Not Displayed

s the printer status monitor enabled?

Make sure that Enable Status Monitor is selected on the Option menu of the printer status monitor.
1. Open the printer driver setup window.

= How to Open the Printer Driver Setup Window

2. On the Maintenance sheet, click View Printer Status.

3. Select Enable Status Monitor on the Option menu if it is not selected.
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Problems with Installation/Downloading

» Cannot Install the MP Drivers

» Easy-WebPrint EX Does Not Start Up or Easy-WebPrint EX Menu Does Not
Appear

» How to Update MP Drivers in Network Environment

» Uninstalling IJ Network Tool
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Cannot Install the MP Drivers

« If the installation does not start even after the Setup CD-ROM is inserted into your computer's
disc drive:

Start the installation following the procedure below.
1. Select items as shown below.

> In Windows 8.1 or Windows 8, select Explorer icon in the Taskbar on the Desktop, then select
Computer from the list on the left.

> In Windows 7 or Windows Vista, click Start then Computer.

> In Windows XP, click Start then My Computer.

|
2. Double-click the ™ '! CD-ROM icon on the displayed window.
If the contents of the CD-ROM are displayed, double-click MSETUP4.EXE.
If you cannot install the MP Drivers with the Setup CD-ROM, install them from our website.

¥>» Note
+ If the CD-ROM icon is not displayed, try the following:

* Remove the CD-ROM from your computer, then insert it again.
* Restart your computer.

If the icon is not yet displayed, try different discs and see if they are displayed. If other discs are
displayed, there is a problem with the Setup CD-ROM. In this case, contact the service center.

* If you are unable to proceed beyond the Printer Connection screen:

Canon PIXMA MG2300 series |
|
Printer Connection
Make sura that the printar is connacted fo the computer, and furm on
the printer
STEP 3

Setup

Frinter Connaction

Primt Head Aligprim et

Complation

STEP 4

Inforrmation

¥ The prnter 1s not detected. Cheack the
connection

Cancel
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»» Note

» The printer is not detected. Check the connection. may be displayed depending on the
computer you use.

Make sure that the USB cable is securely plugged in to the machine and the
computer.

Follow the procedure below to connect the machine and the computer
again.

1. Turn the machine off.

2. Unplug the USB cable from the machine and the computer, then connect it again.

3. Turn the machine on.

If you cannot resolve the problem, follow the procedure below to reinstall the
MP Drivers.

1. Click Cancel.

2. Click Start Over on the Installation Failure screen.

3. Click Exit on the "PIXMA XXX" screen (where "XXX" is your machine's name), then remove the CD-
ROM.

. Turn the machine off.

4

5. Restart the computer.

6. Make sure that you have no application software running.
7

. Insert the CD-ROM again, then install the MP Drivers.

* In other cases:
Reinstall the MP Drivers.

If the MP Drivers were not installed correctly, uninstall the MP Drivers, restart your computer, and then
reinstall the MP Drivers.

= Deleting the Unnecessary MP Drivers

If you reinstall the MP Drivers, install the MP Drivers with the Setup CD-ROM or install them from our
website.

»» Note

« If the installer was forced to be terminated due to a Windows error, the system may be in an
unstable condition and you may not be able to install the drivers. Restart your computer before
reinstalling.
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Easy-WebPrint EX Does Not Start Up or Easy-WebPrint EX Menu
Does Not Appear

If Easy-WebPrint EX does not start up or its menu does not appear on Internet Explorer, confirm the
following.

Is Canon Easy-WebPrint EX displayed on the Toolbars menu in the Internet
Explorer's View menu?

If Canon Easy-WebPrint EX is not displayed, Easy-WebPrint EX is not installed on your computer. Install the
latest Easy-WebPrint EX onto your computer from our website.

»» Note

« If Easy-WebPrint EX is not installed on your computer, a message asking you to install it may be displayed
on the notification area on the taskbar. Click the message, then follow the instructions on the computer
screen to install Easy-WebPrint EX.

» While the installation or download Easy-WebPrint EX is in progress, it is necessary to access the Internet.

Is Canon Easy-WebPrint EX selected on the Toolbars menu in the Internet
Explorer's View menu?

If Canon Easy-WebPrint EX is not selected, Easy-WebPrint EX is disabled. Select Canon Easy-WebPrint EX
to enable it.
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How to Update MP Drivers in Network Environment

Download the latest MP Drivers in advance.

To obtain the latest MP Drivers, access our web site through the Internet and download the latest MP
Drivers for your model.

After uninstalling the MP Drivers, install the latest MP Drivers according to the regular procedure. When the
connection method selection screen is displayed, select Use the printer with wireless LAN connection.
The machine will be detected automatically in the network.

After making sure that the machine is detected, install the MP Drivers following the on-screen instructions.

»>» Note

* You can use the machine over a LAN without performing setup again.
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Uninstalling IJ Network Tool

Follow the procedure below to uninstall IJ Network Tool from your computer.

32 Important

» Even if IJ Network Tool is uninstalled, you can print over network or scan from the computer. However,
you cannot change the network settings over network.

* Log into a user account with administrator privilege.

1. Perform the procedure to uninstall IJ Network Tool.
* In Windows 8.1 or Windows 8:

1. Select Control Panel from the Settings charm on Desktop > Programs > Programs and
Features.

2. Select Canon IJ Network Tool from the program list, then click Uninstall.
If the User Account Control screen appears, click Continue.
* In Windows 7 or Windows Vista:
1. Click Start > Control Panel > Programs > Programs and Features.
2. Select Canon IJ Network Tool from the program list, then click Uninstall.
If the User Account Control screen appears, click Continue.
* In Windows XP:
1. Click Start > Control Panel > Add or Remove Programs.

2. Select Canon IJ Network Tool from the program list, then click Remove.

2. Click Yes when the confirmation message appears.

When the message prompting you to restart your computer is displayed, click OK to restart your
computer.
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About Errors/Messages Displayed

» If an Error Occurs
*» A Message Is Displayed

» Error Message Appears on a PictBridge (Wireless LAN) Compliant Device
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If an Error Occurs

When an error occurs in printing such as the machine is out of paper or paper is jammed, a troubleshooting

message is displayed automatically. Take the appropriate action described in the message.

When an error occurs, the Alarm lamp flashes and a Support Code (error number) is displayed on the
computer screen. For some errors, the ON lamp and the Alarm lamp flashes alternately. Check the status of
the lamps and the message, then take the appropriate action to resolve the error.

Support Code Corresponding to the Number of Flashes of the Alarm Lamp

Example of 2 times flashing:

L I L L 11 ]
(A)  (B) (A) (B)
(A) Flashes
(B) Goes off
Number of flashes | Cause Support Code
2 flashes There is no paper in the rear tray. 1000
3 flashes The cover is opened while printing is in progress. 1203
Paper is jammed in the paper output slot or in the rear tray. 1300
4 flashes The FINE cartridge is not installed properly, or the FINE cartridge not 168A
compatible with this machine is installed.
5 flashes The FINE cartridge is not installed. 1401
The FINE cartridge cannot be recognized. 1403
Appropriate ink cartridge is not installed. 1485
8 flashes The ink absorber is almost full. 1700, 1701
9 flashes The protective material for the FINE Cartridge holder or the tape may remain | 1890
attached to the holder.
11 flashes The media type and paper size are not set correctly. 4102
Cannot perform printing with the current print setting. 4103
12 flashes The specified data cannot be printed. 4100
13 flashes The ink may have run out. 1686
14 flashes The ink cartridge cannot be recognized. 1684
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15 flashes The FINE cartridge cannot be recognized.

16 flashes The ink has run out. 1688

Support Code Corresponding to the Number of Alternate Flashes of the ON
Lamp and the Alarm Lamp

Example of 2 times flashing:

HAY
(4
:
el A
e
L N N eee
L ] L ] L ] L (]
(A) (B) (A) (B)
(A) Flashes
(B) Goes off
Number of flashes Cause Support Code
2 flashes Printer error has occurred. 5100
7 flashes Printer error has occurred. 5B00, 5B01
10 flashes An error requiring you to contact the |B201, B202, B203, B204

service center has occurred.

Other cases than above

Printer error has occurred.

5011, 5012, 5200, 5400, 5700, 6000, 6500, 6800,
6801, 6900, 6901, 6902, 6910, 6911, 6930, 6931,
6932, 6933, 6936, 6937, 6938, 6940, 6941, 6942,
6943, 6944, 6945, 6946

* When a Support Code and a message are displayed on the computer screen:

Paper has nn oul
Meadia Typa : Plain Papsr
Fage Sigs - Al

1. Lo papsr il Bhe rer iy

F Emor Perssis

Canon MG2900 series Printer - USB001

2 Preas the prinler's Stast
bwon

Cancel Prnting
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»» Note

* You can confirm the actions against errors with Support Codes on your computer by searching a
Support Code.

= Click Here to Search

For details on how to resolve errors without Support Codes, see A Message |s Displayed.
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A Message Is Displayed

This section describes some of the errors or messages.

»» Note

» A Support Code (error number) is displayed on the computer for some error or message. For details on
errors with Support Codes, refer to Support Code List.

= Frror Regarding the Power Cord Being Unplugged Is Displayed

= \Writing Error/Output Error/Communication Error

= Other Error Messages

= The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is Displayed

Error Regarding the Power Cord Being Unplugged Is Displayed

The power cord may have been unplugged while the machine was still on.
Check the error message that appears on the computer, then click OK.
The machine starts printing.

See Notice for Unplugging the Power Cord for unplugging the power cord.

Writing Error/Output Error/Communication Error

If the ON lamp is off, make sure that the power plug is plugged in, then turn
the machine on.

While the ON lamp is flashing, the machine is initializing. Wait until the ON lamp stops flashing and remains lit.

Make sure that the printer port is configured appropriately in the printer driver.

* In the following instructions, "XXX" signifies your machine's name.
1. Log on as a user account with administrator privilege.
2. Select items as shown below.

* In Windows 8.1 or Windows 8, select Control Panel from the Settings charm on Desktop >
Hardware and Sound > Devices and Printers.

* In Windows 7, select Devices and Printers from the Start menu.
* In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.

* In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers
and Faxes.

3. Open the properties of printer driver for the machine.

* In Windows 8.1, Windows 8, or Windows 7, right-click the "Canon XXX Printer" icon (where "XXX" is
your machine's name), then select Printer properties.

* In Windows Vista or Windows XP, right-click the "Canon XXX Printer" icon (where "XXX" is your
machine's name), then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX Printer" appearing in
the Printer column is selected for Print to the following port(s).
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»» Note

* When the machine is used over LAN, the port name of the machine is displayed as
"CNBJNP_xxxxxxxxxx". "xxxxxxxxxx" is the character string generated from the MAC address or a
character string specified by the user when setting up the machine.

« If the setting is incorrect:
Reinstall the MP Drivers with the Setup CD-ROM or install them from our website.

* Printing does not start even though the machine is connected to the computer using a USB cable
and the port named "USBnnn" is selected:

In Windows 8.1 or Windows 8, select My Printer on the Start screen to start My Printer. If My
Printer is not displayed on the Start screen, select the Search charm, then search for "My Printer".

Set the correct printer port on Diagnose and Repair Printer. Follow the on-screen instructions to
set the correct printer port, then select your machine's name.

In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon
Utilities, Canon My Printer, Canon My Printer, then select Diagnose and Repair Printer. Follow
the on-screen instructions to set the correct printer port, then select your machine's name.

If the problem is not resolved, reinstall the MP Drivers with the Setup CD-ROM or install them from
our website.

Printing does not start even though the port named "CNBJNP_xxxxxxxxxx" is selected when the
machine is used over LAN:

Launch IJ Network Tool, and select "CNBJNP_xxxxxxxxxx" as you confirmed in step 4, then
associate the port with the printer using Associate Port in the Settings menu.

If the problem is not resolved, reinstall the MP Drivers with the Setup CD-ROM or install them from
our website.

Make sure that the machine is connected to your computer properly.

When the machine is connected to your computer with a USB cable, make sure that the USB cable is securely
plugged in to the machine and the computer, then check the followings:

* If you are using a relay device such as a USB hub, disconnect it, connect the machine directly to the
computer, and try printing again. If printing starts normally, there is a problem with the relay device.
Consult the reseller of the relay device for details.

» There could also be a problem with the USB cable. Replace the USB cable and try printing again.

When you use the machine over LAN, make sure that the machine is set up to be used over network correctly.

Make sure that the MP Drivers are installed correctly.

Uninstall the MP Drivers following the procedure described in Deleting the Unnecessary MP Drivers, then
reinstall the MP Drivers with the Setup CD-ROM or reinstall them from our website.

When the machine is connected to your computer with a USB cable, check
the status of the device on your computer.
Follow the procedure below to check the status of the device.
1. Open the Device Manager on your computer as shown below.
If the User Account Control screen is displayed, follow the on-screen instructions.

* In Windows 8.1 or Windows 8, select Control Panel from the Settings charm on Desktop >
Hardware and Sound > Device Manager.
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* In Windows 7 or Windows Vista, click Control Panel, Hardware and Sound, then Device Manager.

* In Windows XP, click Control Panel, Performance and Maintenance, System, then click Device
Manager on the Hardware sheet.

2. Double-click Universal Serial Bus controllers then USB Printing Support.

If the USB Printing Support Properties screen is not displayed, make sure that the machine is correctly
connected to the computer.

= JEEZEM Make sure that the machine is connected to your computer properly.

3. Click the General tab and make sure that there is no indication of a problem with the device.

If a device error is displayed, refer to Windowselp to resolve the error.

Other Error Messages

If an error message is displayed outside the printer status monitor, check the
following:
» "Could not spool successfully due to insufficient disk space"
Delete any unnecessary files to increase the amount of free space on the disk.
» "Could not spool successfully due to insufficient memory"
Quit other running application softwares to increase available memory.
If you cannot print yet, restart your computer and retry printing.
* "Printer driver could not be found"

Uninstall the MP Drivers following the procedure described in Deleting the Unnecessary MP Drivers, then
reinstall the MP Drivers with the Setup CD-ROM or reinstall them from our website.

» "Could not print Application name - File name"

Try printing again once the current job is complete.

The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is
Displayed
If the Inkjet Printer/Scanner/Fax Extended Survey Program is installed, a confirmation screen asking for

permission to send the printer and application software usage information will be displayed every month
for about ten years.

Read the instructions on the screen and follow the procedure below.
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p-;_‘ Thank you for your cooperation in Inkjet Printer/ScanneFax Extended Survey Program. |
I For developrment and marketing of products that better meet custormer neads, Canon requaests that the

information below, related to your Canon product, be sent to Canon (in case of using your Canon
product in China, to the legally approved ressarch company) through the Intemet.

1. Inforrration related to Canon inkjet printer/scanne/fax -
-Computer's 05 version, language, and display setting information

Davice driver and application software usage logs

2. Inforrration related to Canon inkjet peinber/fax

Printer's ID nurmber, installaton date and tme, ink wse information, number of sheets printed, and maintenance
inforrmation

If your Canon product is shared for use, collactive information recorded in the shared product will be sent.
In this survary, wa will not send ary ather information, induding your personal information, For this reason, from the

infrrrraFian that ic camf tn ic wia ara anahla o dankfe onarfir mschnan

If you agree to the abowe, dlick [Agree]. Otherwise, dick [Do not agrea].

If you wish o uninstall this program, dick [Unins@ll]. This will uninstall the program, and no further survey will be made.

H Uninstall

Do not agree Agree

« If you agree to participate in the survey program:

Click Agree, then follow the on-screen instructions. The printer usage information will be sent via the
Internet. If you have followed the on-screen instructions, the information will be sent automatically
from the second time onward and the confirmation screen will not be displayed again.

7> Note

» When the information is being sent, a caution screen such as an Internet security screen may be
displayed. In this case, confirm that the program name is "IJPLMUl.exe", then allow it.

« If you deselect the Send automatically from the next time check box, the information will not
be sent automatically from the second time onward and a confirmation screen will be displayed at
the time of the next survey. To send the information automatically, see Changing the confirmation

screen setting:.

* If you do not agree to participate in the survey program:

Click Do not agree. The confirmation screen will be closed, and the survey at that time is skipped.
The confirmation screen will be displayed again one month later.

* To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program:

To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program, click Uninstall, then follow the
on-screen instructions.

* Changing the confirmation screen setting:
1. Select items as shown below.

> In Windows 8.1 or Windows 8, select Control Panel from the Settings charm on Desktop >
Programs > Programs and Features.

> In Windows 7, or Windows Vista, select the Start menu > Control Panel > Programs >

Programs and Features.

> In Windows XP, select the Start menu > Control Panel > Add or Remove Programs.
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»» Note

* In Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog
box may appear when installing, uninstalling or starting up software.

This dialog box appears when administrative rights are required to perform a task.

If you are logged on to an administrator account, follow the on-screen instructions.

2. Select Canon Inkjet Printer/Scanner/Fax Extended Survey Program.
3. Select Change.

If you select Yes after you have followed the on-screen instructions, the confirmation screen will
be displayed at the time of the next survey.

If you select No, the information will be sent automatically.

»>» Note

+ If you select Uninstall (or Remove in Windows XP), the Inkjet Printer/Scanner/Fax
Extended Survey Program is uninstalled. Follow the on-screen instructions.
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Error Message Appears on a PictBridge (Wireless LAN) Compliant
Device

The following are the possible errors that may occur when printing directly from a PictBridge (Wireless LAN)
compliant device and the countermeasures to clear them.

»» Note

» This section describes errors that are indicated on Canon-brand PictBridge (Wireless LAN) compliant
devices. The error messages and operations may vary depending on the device you are using. For
errors on non-Canon PictBridge (Wireless LAN) compliant devices, check the status of the Alarm lamp
and take the appropriate action to clear the error. For details, see If an Error Occurs.

= Support Code List

* For the errors indicated on the PictBridge (Wireless LAN) compliant device and their solution, also refer
to the instruction manual of the device. For other troubles on the device, contact the manufacturer.

Error Message on the PictBridge (Wireless LAN) Compliant Device | Action

"Printer in use" If the machine is printing from the computer
or warming up, wait until the job ends.

When it is ready, the machine starts printing
automatically.

"No paper" Load paper, and select Continue* in the
display on your PictBridge (Wireless LAN)
compliant device.

* To resume printing, you can also press the
Color button or the Black button on the
machine instead of selecting Continue on
the device.

"Paper jam" Select Stop in the display on your PictBridge
(Wireless LAN) compliant device to stop
printing.

Remove the jammed paper, load new paper,
press the Color button or the Black button
on the machine, then try printing again.

"Printer cover open" Close the cover on the machine.

"No print head" Check the number of how many the Alarm
lamp flashes and take the appropriate action
to resolve the error.

= |f an Error Occurs

"Waste tank full"/"Ink absorber full" The ink absorber is nearly full.

Check the number of how many the Alarm
lamp flashes and take the appropriate action
to resolve the error.

= |f an Error Occurs
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"No ink"/"Ink cassette error"

Check the number of how many the Alarm
lamp flashes and take the appropriate action
to resolve the error.

= |f an Error Occurs

"Hardware Error"

Check the number of how many the Alarm
lamp flashes and take the appropriate action
to resolve the error.

= |f an Error Occurs

"Printer error"

An error requiring servicing may have
occurred.

Turn off the machine, and unplug the power
cord of the machine from the power supply.

Plug the machine back in and turn the
machine back on.

If the problem is not resolved, contact the
service center.
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If You Cannot Resolve the Problem

If you cannot resolve the problem with any of the workarounds in this chapter, please contact the seller of

the machine or the service center.

Canon support staff are trained to be able to provide technical support to satisfy customers.

/A Caution

+ If the machine emits any unusual sound, smoke, or odor, turn it off immediately. Unplug the power cord
from the outlet and contact the seller or the service center. Never attempt to repair or disassemble the

machine yourself.
+ Attempts by customers to repair or take apart the machine will invalidate any warranty regardless of

whether the warranty has expired.

Before contacting the service center, confirm the following:

* Product name:

* Your machine's name is located on the front cover of the setup manual.
» Serial number: please refer to the setup manual

+ Details of the problem

* What you tried to solve the problem, and what happened
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Support Code List

The support code appears on the computer screen when an error occurs.
"Support Code" means the error number and appears with an error message.

When an error occurs, check the support code displayed on the computer screen and take the appropriate
action.

Support Code Appears on the Computer Screen

1000 to 12Z2Z

1000 1200 1203 1300 1401 1403

1485 1682 1684 1686 1688 168A

1700 1701 1890

2000 to 2ZZZ

2900 2901

4000 to 42ZZ

4100 4102 4103

5000 to 52ZZ

5011 5012 5100 5200 5400 5700

5B00 5B01

6000 to 6ZZZ

6000 6500 6800 6801 6900 6901

6902 6910 6911 6930 6931 6932

6933 6936 6937 6938 6940 6941

6942 6943 6944 6945 6946

* A000 to ZZ2ZZ

B201 B202 B203 B204

About the support code for paper jam, you can also refer to Support Code List (When Paper Is Jammed).
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Support Code List (When Paper Is Jammed)

If the paper is jammed, remove it following the procedure appropriate for each case.
* If you can see the jammed paper at the paper output slot or the rear tray:
= 1300
« If the paper tears and you cannot remove it from the paper output slot or from the rear tray:

= Paper Is Jammed inside the Machine

« Cases other than above:

= |n Other Cases
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1300

Cause

Paper is jammed in the paper output slot or in the rear tray.

Action

Remove the jammed paper following the procedure below.

»>» Note

* If you need to turn off the machine to remove jammed paper during printing, press the Stop button to
cancel print jobs before turning off the machine.

1. Pull the paper out slowly, either from the rear tray or from the paper output slot,
whichever is easier.

Hold the paper with your hands, then pull the paper out slowly not to tear it.

L o SN

»» Note

« If you cannot pull the paper out, turn the machine off and turn it back on. The paper may be
ejected automatically.

« If the paper tears and you cannot remove the jammed paper from the paper output slot or the
rear tray, remove the paper from inside the machine.

= Paper Is Jammed inside the Machine

2. Reload the paper, and press the machine's Black or Color button.

If you turned off the machine in step 1, all print jobs in the queue are canceled. Reprint if necessary.

> Note

* When reloading the paper, confirm that you are using the paper suited for printing and are
loading it correctly.

* We recommend you use paper other than A5 sized one to print documents with photos or
graphics; otherwise, the printout may curl and cause paper exit jams.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues
after removing the paper, contact the service center.
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Paper Is Jammed inside the Machine

If the jammed paper tears and you cannot remove the paper either from the paper output slot or from the
rear tray, or if the jammed paper remains inside the machine, remove the paper following the procedure
below.

»» Note

« If you need to turn off the machine to remove jammed paper during printing, press the Stop button to
cancel print jobs before turning off the machine.

1. Turn off the machine, and unplug the power cord of the machine from the power supply.

2. Retract the paper output tray, then open the cover.

32 Important

* Do not touch the clear film (A).

If the paper or your hands touch the clear film and blot or scratch it, the machine can be damaged.

3. Make sure that the jammed paper is not under the FINE cartridge holder.

If the jammed paper is under the FINE cartridge holder, move the FINE cartridge holder to the right edge
or the left edge whichever is easier to remove the paper.

When you move the FINE cartridge holder, hold the FINE cartridge holder and slide it slowly to the right
edge or the left edge.
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6. Make sure that all the jammed paper is removed.

If the paper is torn, a piece of paper may remain inside the machine. Check the following and remove the
piece of paper if it remains.

» Does the piece of paper remain under the FINE cartridge holder?
» Does the little piece of paper remain inside the machine?

» Does the piece of paper remain in the right side or the left side space (B) inside the machine?
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7. Close the cover.
All print jobs in the queue are canceled. Reprint if necessary.

»» Note

* When reloading the paper, confirm that you are using the paper suited for printing and are loading
it correctly. If the message about paper jam is displayed on the computer screen when you
resume printing after removing all the jammed paper, a piece of paper may remain inside the
machine. In this case, confirm that no piece of paper remains inside the machine.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues
after removing the paper, contact the service center.
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In Other Cases
Make sure of the following:
Are there any foreign objects around the paper output slot?

Are there any foreign objects in the rear tray?

If there are any foreign objects in the rear tray, be sure to turn off the machine, unplug it from the power supply,
then remove the foreign object.

Is the paper curled?

Load the paper after correcting its curl.
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1000

Cause

There is no paper in the rear tray.

Action

Reload the paper on the rear tray and press the machine's Black or Color button.
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1200

Cause

The cover is open.

Action

Close the cover and wait for a while.

Do not close it while you are replacing a FINE cartridge.
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1203

Cause

The cover is opened while printing is in progress.

Action

If paper is left inside the machine, remove the paper slowly with both hands and close the cover.
Press the machine's Black or Color button to dismiss the error.
The machine ejects one blank sheet of paper and resumes printing from the next paper.

The machine will not reprint the page that was printed when the cover is opened. Try printing again.

32 Important

» Do not open or close the cover while printing is in progress, as this can damage the machine.
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1401

Cause

The FINE cartridge is not installed.

Action

Install the FINE cartridge.

If the error is not resolved, the FINE cartridge may be damaged. Contact the service center.
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1403

Cause

The FINE cartridge cannot be recognized.

Action

Replace the FINE cartridge.

If the error is not resolved, the FINE cartridge may be damaged. Contact the service center.
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1485

Cause

Appropriate ink cartridge is not installed.

Action

Printing cannot be executed because the ink cartridge is not compatible with this machine.
Install the appropriate ink cartridge.

If you want to cancel printing, press the machine's Stop button.
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1682

Cause

The FINE cartridge cannot be recognized.

Action

Replace the FINE cartridge.

If the error is not resolved, the FINE cartridge may be damaged. Contact the service center.
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1684

Cause

The ink cartridge cannot be recognized.

Action

Printing cannot be executed because the ink cartridge may not be installed properly or may not be
compatible with this machine.

Install the appropriate ink cartridge.

If you want to cancel printing, press the machine's Stop button.
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1686

Cause

The ink may have run out.

Action

The function for detecting the remaining ink level will be disabled since the ink level cannot be correctly
detected.

If you want to continue printing without this function, press the machine's Stop button for at least 5
seconds.

Canon recommends to use new genuine Canon cartridges in order to obtain optimum qualities.

Please be advised that Canon shall not be liable for any malfunction or trouble caused by continuation of
printing under the ink out condition.
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1688

Cause

The ink has run out.

Action

Replace the ink cartridge and close the cover.

If printing is in progress and you want to continue printing, press the machine's Stop button for at least 5
seconds with the ink cartridge installed. Then printing can continue under the ink out condition.

The function for detecting the remaining ink level will be disabled.

Replace the empty ink cartridge immediately after the printing. The resulting print quality is not
satisfactory, if printing is continued under the ink out condition.
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168A

Cause

The FINE cartridge is not installed properly, or the FINE cartridge not compatible with this machine is
installed.

Action

Retract the output tray extension and the paper output tray, open the cover, then remove the FINE
cartridges.

Make sure that the FINE cartridge compatible with the machine is installed.

Then install the FINE cartridges again. Push up the FINE cartridge until it clicks into place.

After installing, close the cover.
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1700

Cause

The ink absorber is almost full.

Action

Press the machine's Black or Color button to continue printing. Contact the service center.
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1701

Cause

The ink absorber is almost full.

Action

Press the machine's Black or Color button to continue printing. Contact the service center.
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1890

Cause

The protective material for the FINE cartridge holder or the tape may remain attached to the holder.

Action

Make sure that the protective material or the tape does not remain attached to the FINE cartridge holder.

If you find the protective material or the tape remains attached, retract the output tray extension and the
paper output tray to remove the protective material or the tape.

Pull down the tape to remove the protective material.

If the cover is open, close it.

If the problem is not resolved, contact the service center.
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2900

Cause

Scanning the print head alignment sheet has failed.

Action

Press the machine's Black or Color button to dismiss the error. Check the following points, perform
Automatic Print Head Alignment again.

» Make sure that the print head alignment sheet is set in the correct position and orientation on the
platen glass.

* Make sure the platen glass and the print head alignment sheet are not dirty.
» Make sure the type and size of loaded paper is suitable for Automatic Print Head Alignment.
For Automatic Print Head Alignment, always load one sheet of A4 or Letter-sized plain paper.
» Make sure if print head nozzles are clogged.
Print the nozzle check pattern to check the status of the print head.

If the error is not resolved, perform Manual Print Head Alignment.
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2901

Cause

Printing of the print head alignment pattern is complete and the machine is in waiting for scanning the
sheet.

Action

Proceed to scan the printed alignment pattern.

1. Load the print head alignment sheet on the platen glass.

Load the print head alignment sheet with the printed side facing down and align the mark ¥ onthe

upper left corner of the sheet with the alignment mark il

P ™

2. Close the document cover gently, then press the machine's Black or Color button.

The machine starts scanning the print head alignment sheet, and the print head position will be
adjusted automatically.
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4100

Cause

The specified data cannot be printed.
Action

When you print the contents on CREATIVE PARK PREMIUM, confirm the message on the computer
screen, make sure that genuine Canon FINE cartridges are all installed properly, then start printing again.
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4102

Cause

The media type and paper size are not set correctly.

Action

Press the machine's Stop button to cancel printing, change the media type or paper size setting, then
print again.

* When the media type is set to Photo Paper Plus Glossy II:

Set the paper size to 4"x6" 10x15cm (Windows)/4 x 6 (Mac), or 5"x7" 13x18cm (Windows)/5 x 7
(Mac).

* When the media type is set to Glossy Photo Paper:
Set the paper size to 4"x6" 10x15cm (Windows)/4 x 6 (Mac).
* When the media type is set to Envelope:

Set the paper size to Envelope Com 10 (Windows)/Envelope #10 (Mac) or Envelope DL (Windows/
Mac).
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4103

Cause

Cannot perform printing with the current print settings.

Action

Press the machine's Stop button to cancel printing.

Then change the print settings and print again.
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5011

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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5012

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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5100

Cause

Printer error has occurred.

Action

Cancel printing and turn off the machine.
Then confirm the following.

» Confirm that there are no materials (e.g. the protective material or jammed paper) that is preventing
the FINE cartridge holder from moving.

If any, remove the materials.
« Confirm that the FINE cartridges are installed properly.
Push up the FINE cartridge until it clicks into place.
After confirming the conditions above, turn on the machine again.

If the problem is not resolved, contact the service center.

22 Important

* When you clear the jammed paper or protective material that is preventing the FINE cartridge holder
from moving, be careful not to touch the clear film (A).

If the paper or your hands touch the clear film and blot or scratch it, the machine can be damaged.
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5200

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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5400

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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5700

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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5B00

Cause

Printer error has occurred.

Action

Contact the service center.
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5B01

Cause

Printer error has occurred.

Action

Contact the service center.
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6000

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6500

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.

712



6800

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6801

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6900

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6901

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6902

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6910

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6911

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6930

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6931

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6932

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6933

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6936

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6937

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6938

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6940

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6941

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6942

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6943

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.

730



6944

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6945

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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6946

Cause

Printer error has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.
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B201

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.

Contact the service center.
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B202

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.

Contact the service center.
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B203

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.

Contact the service center.
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B204

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the machine, and unplug the power cord of the machine from the power supply.

Contact the service center.
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